How-To Instructions

The workflows in this menu are excercises from the training manual that can be
downloaded together with the F3 Demo training data set for self-training. For
more information, please see this page on the TerraNubis website.

This is not the Training Manual, if you want to see the Training Manual,

go to this page.

Here is a list of short keys you can use in OpendTect (to pop up this list in
OpendTect either press Shift+? or go to Help>Keyboard shortcuts):

View Mode
Pan Middle Click +Drag
Rotate Shift + Middle Click + Drag Interpreidﬁon Mode
o ol ol Pick seed Left Click
Ctrl + Middle Click + Drag Remove seed/pick Ctrl+ Left Click on seed/pick

Activate Polygon Selection |y
Multi Selection y + Ctrl + Left Click
Move Single Selection Left Click+Drag

New Shift + Left Click

Finish Double Left Click

Position Mode
Activate element Left Click
De-activate element Left Click outside active element
Draggers —applied to Active Inline, Crossline, Z-slice or Random Line

Browse/Resize Volume perpendicular-to-plane | Left Click + Drag in Active Volume Fault stick
Ctrl+ Left Click on existing fault stick (outside seeds)

Left Click on existingseed

Resize Left Click+Drag (green) Anchors. Select (to edit)
Rotate (if possible) Ctrl + Left Click+Drag

perpendicular-to-plane Left Click+Drag

parallel-to-plane Shift + Left Click+ Drag

Horizon Tracking
Tracking menu Ctrl + Right Click

Autotrack k
Basemap

Retrack Ctrl+k
Inline i
Lock / Unlock 1/fu
Crossline
. Clear Selection a
Random line

Delete Selection d

Main Short keys
Show all Shortkeys shift+?

Save selected object Ctrl+s
Save as selected object shift+Ctrl+ s
Undo /Redo Ctrl+z/Ctrl+y

Toggle / Print 3D graphics stats g/G
Pop up Command Controller Ctri+r
Toggle between “infull”/ “at section” selected item display

inline/crossline/z-slice ;:3::{ = 0 p en d Te Ct P rO



https://terranubis.com/datainfo/F3-Demo-2020
https://doc.opendtect.org/6.6.0/doc/HTML_TM/Default.htm
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1.2.2a Survey Setup & Load SEG-Y

Required licenses: OpendTect.

Exercise objective:
Set up a new OpendTect survey and load 3D seismic data from SEGY using the SEGY scan wizard.

m Analysis P
Select/Setup ...

Session v
Workflow: Iranart ,

1. Go to Survey > Select/Setup. . List of all Surveys in this Survey Data Root

directory.
. . @ Survey Setup and Selection
or click on the Survey Setup icon Q . oo ot ot | Crver -
:ﬁmﬁgﬁ_zn]mm |‘Z| F3 Demo 2020 ‘:_'
F3_Demo_2020_old = o - :
2. Click on the New Survey icon ¢. I “ G
v
E 100300 1001250

When starting OpendTect for the first time, you
arrive directly in the Survey Setup & Selection
window.

Location : C:\Surveys\F3_Demo_2020

Ocencel| @) [

Workflow cont’d:

R @ Create New Survey = m} X
3. Specify a Survey hame and

Specify new survey parameters

Survey namel\My New Surve\ﬂ

Available data [] 3D 2D

(a) select Scan SEG-Y file(s), Initil setup [ Scan SEGY fle(s) a
4 Set for 2D only

1 Scan Navigation Data

43 Copy from other survey

T Read from Survey Setup file

© Enter by hand

z Domain O Depth

(b) set Time for Z Domain,

(c) Press Next. Dcancel @

OpendTect display scenes are in Time or Depth. Transformation is done on-the-fly using a given
velocity model. In the Survey Setup you choose the primary Z Domain. In the case of depth
survey, Z Domain should be Depth.




Workflow cont’d:

4. Go to the Rawdata directory of F3 Demo and Select the Input SEG-Y file: \Raw

data\Seismic_data.sgy.

-
Input file *=wildcard O Select...  * Edi
Data type [#30 Seismic Data
Quick scan result Actually use > o
SEG-Y revision 0 Ml K-
Data format From file header ~| &
Number of samples 1 1000 =
2 range start 0 Step [1
In-line range from header
Cross-line range
@ Select (ane of) the S
X-coordinate range
Y-coordinate range « - 1 F3_Demo 2020 * Rawdata ~ o
Organize = New foider - o @
~- Google Dr & *

ETAP_Feb202 Faults =

ML_Exercises, Surtace_dats 0.1% [

tmp Well_data [ Zeros

Training_Man Seismic_datasgy |

& Onebiive
v o« »
File name: | Seismic_datasgy «| |SEG-Y files (*sgy *SGY “seqyy ~
e
Qo Dcance @

Workflow cont’d:

5. The import wizard makes a quick scan of the SEG-Y volume and automatically fills-in

relevant parameters for survey set-up and import.

Input file *=wildcard |C:\Surveys\F3_Demo_2020\Rawdata\Seismic_data.sgy © Select #/ Edit
Data type 30 Selsmic Data
If needed, the parameters
required for SEG-Y import Py —— pres— =1
(under the Actually Use column) SEGY revsion |1 1 =
can be Changed manually. Data format 3 - Integer (16 bits) 3 - Integer (16 bits) Q]
Number of samples 462 (600515 traces) 462 = T
Z range 0,004 - 1.848 - 0,004 (5 or m) Start 0.004 Step |0.004
In-line range 100 - 750
Cross-line range 300 - 1250

X-coordinate range 605834.80 - 629576.30
‘Y-coordinate range 6073556.40 - 6090463.20

The bottom part shows the =
extracted geometry of the Resufing syrvey setup g ff: -
survey and the histogram of

seismic amplitudes from the

quick scan of the input SEG-Y

volume. - o250 o000 5000 w..; 5000 10000

Qoo @




Workflow cont’d:

6. Optionally, click on the icon to scan the entire input SEG-Y file.

7. Click on the q icon to examine in detail, first ‘1000’ traces (changeable) of the file.

@ Extract Survey Sety - x
Tnput file *=wildcard [C:\Surveys\F3_Demo_2020\Rawdata\Selsmic_data.sgy © Select....
Data type 13D Seismic Data
Edit option can be used if the SEG-Y
fle needs to be modified. You can| Gk scan result - Actuly e = &
: revison z
update b”‘llary headersl and trace Data format 3 - Integer (16 bits) 3 - Integer (16 bits) 2
headers using mathematical formulae | e of sumples 162 (soms15 traces) 462 =
and information from other headers. Z range 0.004 - 1,848 - 0.004 (s or m) Start [0.004 Step [0.004 e xr
In-line range 100 - 750
Cross-line range 300 - 1250
X-coordinate range 605834.80 - 629576.30
Y-coordinate range 6073556.40 - 6090463.20
Scanning the entire SEG-Y file
is useful when the survey Resulting survey setup . 0.1% &
geometry extracted from the R==
quick scan looks doubtful.
- o0z -10000 -5000 Val“: 5000 10000
Do @
R e a—— =]
Workflow cont’d: T r——
-
-
8. Examiner window: =
Use this to find out '?'?‘
what is inside the file. —
9. Check the Inline, 1605 Byte pesiiions (fn ‘r?,‘f;f:n T, 8 () e
H c0é X-coordi 73
Crossline and X/Y e i, | DumpofEBCIDIC and
coordinates : find the cos 22 afbyte int) Binary headers . e
. ey [y
c11
Correspondlng byte €12 100/300 = (605835.5,6073556.5) s evistion (L ET90_|2581 900
3 100/1250 = (625576.35,6074220 Hedian/RME 0 25816279
and Obsewe the 2;4 750/;00 = :éaszu:.a 25,6:5?5;.5] Mumber of values 462000
associated plot. == ke Cot: 28532675811

10. Optionally, check
Seismic viewer and

histogram windows.

Trace header name +
byte paosition.

Trace header information

tracl {trace sequence number within line)

‘ Trace header Plot ‘

1
‘1 P : 2 951
& [racr] 1 2 o
9 [fidr] 100 100 800
13 [tracf] o [1] |

17 [ep] 300 301 400
21 [edp] 300 301

26 [cdpt] 0 ) | v
29 fid] 1 1 P
31 [nvs] o 0 |

« »

200 400 600

Range: [1,951] (N=1000)

First 1000 Trace header Nos.

Ci\Local_Surveys'F3_Demo_2015_training_v\Rawdata\Seismic_data say

800 1000

© Close| | @ Help




Workflow cont’d:

11. Click on OK. Optionally, click on the L icon to save the import set-up parameters.

Input file *=wildcard |C:\Surveys\F3_Demo_2020\Rawdata\Seismic_data.sgy © Select ... | #Edit...

Data type (3D Seismic Data -

Quick scan result Actually use o

SEG-Y revision 1 1 ME- ]
Data format 3 - Integer (16 bits) 3 - Integer (16 bits) >l
Number of samples 462 (600515 traces) 462 - w00 2
Z range: 0.004 - 1.848 - 0.004 (s or m) Start |0.004 Step 0004 [scate xv
In-line range 100 - 750

Cross-line range 300 - 1250
X-coordinate range 605834.80 - 629576.30
Y-coordinate range 6073556.40 - 6090463.20

Resulting survey setup o 01% [3]
“ [ Zeros
1007300 100/1250 -10000 -5000 valu(el 5000 10000
Ocancel @
Workflow cont’d:
12. Survey definition is set now. Click on OK to proceed further.
 Edit Survey Parameters - (m] x

Survey name My new Survey
Location on disk C:\Surveys
Survey type Both 2D and 3D -
Ranges/coordinate settings Enter below v

“* Survey ranges % Coordinate settings 2 1/C to X/Y transformation <% Coordinate System

Inline range 100 [3][750 2] step [1 :| Nr. In-lines: 651
Cross-line range (300 %] (1250 %] step [1 =| Nr. Cross-lines: 951
Z range |4 | 1848 |Step |4 millisecond v

Display depths in ® Meter (O Feet

Seismic Reference Datum (m) |0

¥ Apply

€3 cancel e

Free space on disk: 52.56 GB




Workflow cont’d:

13. Go inside the newly created survey by either double-clicking on it or clicking on Select.

14. Press Yes when asked to import the
SEG-Y file used to set-up the survey.

=
E]survey Data Root ... |C:\Surveys oW
|F3_Demo_2020 o &
F3_Demo_2020_20jul21 pe My New Survey =
F3_Demo_2020_old - 2
My_New_Survey H; TE0300 I G
My_survey_AL

-]

4{’,

" 100300 1001250

o Import the SEG-Y data used for survey setup now?

o No O Information = Notes @ Log
L

In-line range : 100 - 750 - 1; Total: 651
Cross-line range : 300 - 1250 - 1; Total: 951
% range {ms) : 4 - 1848 - 4; Total: 462
Inl/Crl bin size : 25.00 / 25.00 (m/line)
CRS : Unlocated X¥

Area : 386.93 (sg km)
Survey type : Both 2D and 3D
In-line Orientation : 88.40 Degrees from N
Location : C:\Surveys\My New_survey

L

Dot @

Workflow cont’d:

15. Keep the default Yes (import) toggled on, in front of Copy data. Optionally, it is possible to
make a link to the input SEG-Y file in OpendTect.

16. Specify an Output Cube name (by default name of the input file is copied here).

17. Press Import.

@ Import 3D Volume

Importing C:\Surveys\F3_Demo_2020\Rawdata\Seismic_data.sgy

Copy data O No (scan&link)

Volume subselection ‘— © Select ...

Null traces @ Discard O Pass

[ Scale values:  Shift/Factor

Output Cube [ Seismic_data | © select ... “icavs ~ [ Depth

[[] Execute in Batch Options ...

O @




Workflow cont’d:

18. Once the import is finished, press OK on the notification window. Next, OpendTect will
automatically open the option to change the Z-scaling of the newly created survey. Move
the slider to set an appropriate Z scaling factor and press OK.

LY TSV =Y F P

CrossHine Step - &6 il 1100 Selemic 1 TaEn - A
Tree scene 1 ) =
¥ i
Elements Color -
8 see: :
& | E9mine y
[ @ Cross-line
X 1 @ Z-shice 200 e s . A
© Information - ® volume : 7 o
The cube is avsitable for wark | B Fecom. il i «
(47 2D Line .
¢ | @ 1. A,
The cube has varying cross-line ranges. ) * 2D Hoxi, Set Z scaling factor E
“= | HE7 Faut |11 .
In-fine range: 100 - 750 (step 1). = G et [npparent velocity {mis) B e | | 1 e
X-line range: 300 - 1250 (step 1). ] o
o | b Faush XL Fit toscene #8 To Home By
7 start: 0,004 step: 0.004 & 29 e ————
Number of samples: 462 A well we as Defaul |||
im| [ = PointSet
f oK
y | B0 Poiygon ] L]
Gaps: Gaps present B 5 snaperie
4 Prestac,
Annotations hat |
;
/ 11
1Y
IEEEEE
< >
[free mem] 22.8/31.8 GB [~

Workflow cont’d:

19. Check in the seismic manager the

@ Manage 3D Seismics

. O- Filter [* 'y
newly imported cube; Survey >
. R (] > Seismic_data < [T
Manage > Seismic > 3D. =
]
OpendTect automatically W
- marks the imported seismic
volume as the default data. =
:':' Analysis Processing Scene View Utiiies Help =
{47 Select/Setup ... =] e ,;?' »
Session v { L}
In-ine 5408 - Step[10 - 4 & ]
Import v = A
Export L4 &
1 , Altribute Sets =2
Pre-load ' | & Bodies g In-line range: 100 - 750 [1] o
Exit Color Tables cross-line range: 300 - 1250 [1]
RS ¥l ’ |Area: 375.31 (sq km)
h=4 ; SIICE . Cross-plot Data ... [Time range(ms): 4 - 1848 [4]
- VlgaLll'E:mL . Faults Storage: 16 bit signed
r . File name: Seismic data.cbvs
3 2D Line | W FauliShcksets Location: €:\Surveys\My New_Survey\Seismics
N’ 7| # 30 Horizor ™, Geomery 2D .. Size: 540.64 MB -
< - ’Z:Eu:orlzm._ Horizons » [Last modified: Fri 20 Aug 2021, 17:01:53
. FaultSticks * Layer Properties created by: assia
B Body i, PickSets/Polygons .. [Created at: Fri 20 Aug 2021, 17:00:39
dol el | Probabiity Densty Functions ... — =
8 | D Poygon | RandomdLines .. - Check info on seismic volume; e.g.
@ - > Prestack E [ysemm 3 . X
5 Annotations | e L D estack C inline/crossline ranges, storage etc.
-

Free space on disk: 52.51 GB

(Do | @




Workflow cont’d:

Tips:

+ Changing the default Z-scale setting manually at any time
+ Saving color settings with the loaded data set

+ Manually making a seismic cube the default data set

Wiln-linel

Changing the Z-scale at any time: @ Croi Add Defautt Data
i
. OlU™ Add at Well Location .
1. Add an inline: 7. Bar Add Color Biended

+ Right-click in the tree on Inline > Add and Select Data. =
« Left-click on the selected seismic data or press OK in
the window that pops-up after step 1.
2. Go to View > Z-scale.
3. Use the slider to change Z. Toggle on Save as default and

press OK.
o Zsatng ==
Utilities Help Set scaling factor
Work Area ...
P =
Viewer 2D ... R
X Fi To H
Stereo Viewing * | Fitto scene| | @ To Home |
Toolbars v

Workflow cont’d:

-s005 [ sto6 [ megic

Saving color settings with stored volumes: = Matteo terrain cube
= Matteo terrain cube red
= | atteo terrain linear
¥ Pastel
1. Select a color bar. w1 Porosity
1 Pressure

¥ Rainbow

2. Right-click on the color-bar and select Ranges/Clipping. 7™ Resunesac

3. Change the Percentage clipped and Apply a few times. Flipped
When satisfied Press Close.

Manage ...

4. By default, clipping is used meaning every line will be scaled Setas default

5005 [ oo

slightly different. To set the extreme values: manually S Rampeicirees [Eazn

overwrite the values next to the color bar and press Enter. feseeme E

Auts detect symmetry © Yes

5. Right-click on an attribute in the tree and select Save Color
(& scaling) Settings to save it as default for this attribute.

Set symmetrical © Yes

Percentage ..-- 0.5 05

& No

@ No

Save as Default

—— @ #o01|[© Gose | @ v

No

=

Cross-line Select Attribute r

2D Line

zsice
Vlge[iir:!-lgm Line DEEE) i’ '99 0 0 Bg 0 0

« Remove

-10 -




Workflow cont’d:

This is just for information purpose and
is not part of the current exercise.

Manually setting a default data set :

1.

Press the Manage Seismic icon and Select

Seismics > 3D.

2D Seismics
2D Prestack Seismics
3D Seismics | il

3D Prestack Seismics

@ Manage 3D Seismics

3D Seismics or go to Survey > Manage > o-

Filter | * r

I_] > Seismic_data <

Select a Seismic data set from the list and

click on the Default

" icon. The default s

file is marked by the >< symbol.

The advantage of having a default data set is that it
saves many clicks to select data in various places in
OpendTect. For example in this exercise we used
option “Add and Select ” to see the data. We then had
to select the data. From now on we can use “Add
default data” for in-lines, crosslines and Z-slices. -

Created at

0 In-line ramge: 100 - 750 [1]
Cress-line range: 300 - 1250 [1]
Area: 375.31 (sq km)
Time range(ms): 4 - 1848 [4]
Storage: 16 bit signed
File name: Seismic_data.chbvs
: C:\Surveys\My_New_Survey\Seismics
4 MB
ed: Fri 20 Aug 2021, 17:01:83

E’é"!&t‘-[l@“ 0e

>

Created by: assia
Fri 20 Aug 2021, 17:00:3% o

[Bo] @

Free space on disk: 52.50 GB

-11 -




Required licenses: OpendTect Pro.

2.1.1b Set up Survey using PetrelDirect

Exercise objective:

To show how an OpendTect survey can be quickly set up from an existing Petrel* project

using PetrelDirect.

Workflow:

1. Choose Select/Setup option under the Survey menu

or click on the Survey Setup icon Q .

2. Click on the Create New Survey icon ¢ in the i

Survey Setup and Selection window.

*Petre.’ is a mark of Schlumberger

Import
Export
Manage
Pre-load

Exit

=) Survey Setup and Selection x
El5urvey Data Root ... | [C:\Surveys |o @
AusNW_Shallow-Demo_2018_PdC F3 Demo 20 G
AusNW_Shallow-Demo_PdG [
F3_Demo_2018_PdG . ose |G

F3_Demo_2020
F3_Demo_2020_20jul21
F3_Demo_Fault_Extraction_2018_
Groningen_Petrel_model_depth_mn
Groningen_Petrel_model_depth_m
My_New_Survey
Survey_from_Petrel

Sil o [EICT Y|

100/300 owzse

Workflow cont’d:

3. Specify a Survey name; select Use
PetrelDirect; Set Time for Z Domain and
press Next.

4. Select a seismic data set from the
Petrel project to set up the OpendTect
survey

5. Press OK.

@ Get survey setup from Petrel = m] X

Base the OpendTect survey on

v 5 Seismic
Input Seismic Survey F3 Demo
F3 Demo ~ In Seismic ~
[Tx] O @

@ Create New Survey - O X

Specify new survey parameters

Survey name HSurvey From Petrel ”

Available data [4] 3D 2D

Initial setup [ Use PetrelDirect
= Scan SEG-Y file(s)
4 Set for 2D only
1! Scan Navigation Data
K Copy from other survey
T Read from Survey Setup file
) Enter by hand

Z Domain @ Time | O Depth

QCanceI 0

-12 -




Workflow cont’d:

6. You would see the survey
information filled-in
automatically from the selected
Petrel* project set-up. Press
OK to set-up the survey.

7. Apop-up message asking if you
want to proceed with the data
import. Select No, if you don’t
want to proceed with bulk data
import from Petrel.

o Proceed to import all listed data?

=

@ Edit Survey Parameters

Survey name Survey From Petrel

Location on disk C

\Surveys
Survey type Both 2D and 3D~
Ranges/coordinate settings Enter below v

1= Survey ranges @ Coordinate settings 2 1/C to X/Y transformation @ Coordinate System

Inine range (100 2] (750 2] step [1 2| Nr. In-lines: 651
Cross-line range \300 = \1250 <) Step \1 +| Nr. Cross-lines: 951
Zrange 0 (1848 |step 4 millisecond v

Display depths in ® Meter (O Feet

Seismic Reference Datum (m) 0 ]

= Apply

[Eo ] Ocne @

Free space on disk: 35.97 GB

-13-




1.2.3a Horizon

Required licenses: OpendTect.

Exercise objective:
Import (geometric) horizons from ASCII files. | &G r@ oo
| Session L R = — T -
% Import v AHributeSel‘ - .! M=o [RGB L]
Workflow: % Export . Eolar T‘Iabled”
4 4 Manage v ross-plot Data J
L Predoad > s :
. q aultStickSet e
1. Go to Survey>Import>Horizon>ASCII> e e .
1) Edt zons. T .
Geometry 3D. & [ ©® volume me Functions Dy ::Cci:;g ¥ single 3D Horizon
9- [ & Random L Navigation Data / 20 Geometry  * From ZMap ... Bulk 3D Horizon ...
[ &9 20 Line PointSets/Polygons * T Attributes 3D ... [
2. Inthe Import window, select the horizon '° Epdiy  Smpints )
as Input Ascii file: \Rawdata\Surface_data\ |, = = e unctons ;
F3-Horizon- FS6 xyt for example. @ | O s el ’
@- g & WE‘:’ ES ::;;;;m Model
i B4 PointSet  porzoncube Data .
HH ‘r" E [’f"gmﬁ“'n Prestack Events ...
[ # Import Horizon E@E‘
InputASCII File \Rawdata\Surface_data\F3-Horizon-FS6.1 Q, Examine
Fl ~
Aftribute(s) to import | l_f_ﬁ
Workflow cont’d:  CODDS\F3. Derno eaining RawdotaSuface date\F3-Horzan P56t - o x
File [N
3. Examine the file to determine the 5 *
header contents and to check details
for the Format Definition.
Keep this window open to fill in the
Format Definition.
4. Specify the header size (number of
lines): here, set it to No header.
Optionally define attribute(s) to be 2 Z 9
loaded as Horizon Data in the same time £ Rekoad
as the geometry : use the g icon.
You can add as many attribute as you 4 Import Horizon L= e
need They Wi” be Iisted and you can INPULASCI| File '\Rawdata\Surface_data\F 3-Horizon-FS6.nt O Select I Q Examine
decide to select them for loading. 1
Aftribute(s) to import E
Attributes can also be imported and =
added to an already existing horizon by 2
choosing: Survey > Import > Horizon > —
B File heauer_ ==
Attribute 3D... —

-14 -



Workflow cont’d:

5.

To set the Format Definition, click on Define : assign to each quantity the corresponding

column in the file.

Optionally, click on Scan Input File to test the loading parameters.

Close the scan report

Format definition |<Incomplete=

# Format Definition =18

Specify Necessary Information

B ]
Scan Input File

Area subselection l/ ) Select

Undefined Value |1e30

Xy E|Posm’nn col:1 5 [col2 £
Z |cok3 = Unit ms[lmlhseconrz]

Stop reading at

i« (@ ] (O corcel] [ @ 1o |

Workflow cont’d:

10.

11.

Specify if the undefined parts should be
filled: select No.

@ Import Horizon

= o X

Input ASCII file P0\Rawdata\Surface_data\F3-Horizon-F56.xyt| © Select .. Q\Examine

-
Attribute(s) to import o
Name the Output Horizon and select a =
color for display. L
[ Horizon is in Depth domain
To automatically load the horizon in the 3D Fleheader (Nohender | [
_scene,”tog_gle on the “Display after oot dokion e S
import” option. e
Area subselection |106/612-748/1248 (462 samples) © select ...
PTESS Import Fill undefined parts O Yes @ No
Output Hcmzon -] © select ..
Tied to Level — =
Base color [N = DarkOrange -
Qo= @ ©
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1.2.4a Well Data

Required licenses: OpendTect.

Exercise objective:

Workflow:
1. First import the well
ASCII > Track.

Well_data/F02-01_welltrack.txt
example.

If you select
Directional or Vertical
Well, you can manually
add the well head
coordinates.

To load well data from ASCII and LAS files.

track by
choosing Survey > Import > Wells >

2. Select the Well track file: /Rawdata/

for

@ Import Well Track

EIE] Anaiysis Processing Scene View Utiities CLAS Help

£ SelectSetup g -r:!_ - = Crossdineld Stepll
Session J
=
T Atcoute
Export * | Color Table
Manage * | Cross-plot Data
Pre-load Fauls .
Exit FauRStickSets
T grvoume— | Horizons
~ Random Ll Mute Functions »
& 20 Line | pickSets/Polygons. .
“ 3D Horize
m - 20 H Probability Density Functions »
orize g, X
< Faull tsmics
FaulStick  Velocity Functions .
T @ Body Wavolets
= L Wel K T
B [ ot Simple Multi-Wel
v [ Polygon | HorizonCube surface data p :
‘ & Prestack | Prestack Event Buk .
# Annotations [ PetreiDirect C
74 J3 VSP (SEG-Y)

Input type Well Track file (XYZ) ~

|We|| Track file [Vell_data\F02-0 1_DT_TVDSS.txt|| © select ...\ Bxamine

File header | No header v =

Format definition | <Incomplete> Define ...

Workflow cont’d:

3. Click on the Examine button.

File header No header

Format definition |<Defined>
First Coordinate (m)
[ Reference Datum Elevation [KB] (m ) 0

[ Total Depth [TD] ( m )

Input type |Well Track file (XYZ)

Well Track file [Vell_data\F02-01_DT_TVDSS.txt| | € Select ...
File header No header v | [

@ CA\Surveys\F3_Demo_2020\Rawdata\Well_data\FO2-01_DT_T..

0.0000 1.5693 il
5.0000 6.7446
10.0000 11.8199%
15.0000 17.0552
20.0000 22.2688
25.0000 27.4367

a Format Definition _
Specify Necessary Information

v ekt 2|[col2 |2

[Z [TVDSS]] |col:3

XY

[MD] col:4

[ stop reading at

C| Unit m (Meter)

C] Unit 'm (Meter)

4. Define the Format Definition for the well track: col-1: X, col-2: Y, col-3: Z and col-4: MD.
The default units are in meters, but can be modified from the drop-down menu.

] X

o Do @
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Workflow cont’d:

5. Select the Depth to time model

file: /Rawdata/Well_data/F02- Depth o Time model file Vell_datalF02-01_TD bt
01 _TD.txt.

File header No header v | =

6. Examine the file.

7. Define the Format Definition for Format definiion |<incomplete= | []:5] Define |
the Depth to time model; col-1:
Depth in m, col-2: TWT in sec.

@ Format Definition - 3] E3
Specify Necessary Information
Undefined Value |1e30
MD ~ | Depth |col:1 2] Unit m (Meter) ~
TWT ~| Time |col:2 5| Unit s (Seconds) ~

[[] stop reading at

ol Dcancel @

If you uncheck the Depth to Time model file, you will be able to add a constant velocity
model for this well.

Workflow cont’d:

8. Is this checkshot data? Tick yes.

Advanced options are optional

9. Provide an output name.

10. Once done, press the Import button.

Depth to Time model file _Nell_data\F02—01_DT_TVDSS,bct‘ 6 select ... O\ Examine

File header No header v| [
Format definition | <Defined> | Deﬁne
[ 15 this checkshot data? @ Yes| O No
Advanced/Optional ...
Output Well |F02-01] ~| | select ...
[ Display after import Qcose | @ ®
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Workflow cont’d:

FaultStickSet @ Select Wells
. BOdV Select Input Wells
11. Display the well in the survey: A} well - ' Fiter |*
i H * Poini - Fo2-01 =]
right click on Well > Load and 10 PolyAx Tie Wel to Seismic... 3
select your well. @ Shar  Pick New Trajectory ... @
B Prestack Events T
Annotations
[S5] oot @
...ys\My_New_Survey\WellInfo\F02-01.well .
12. To import the logs files: click on @ Manage Wiell - o X
the Manage Well Data icon O~  Fier[* o O- Log
4 -
4, and click on Import. Clro2-01 o ;
Alternatively, follow Survey > a ()
Import > Wells > ASCII > Logs. & ol
& :
I8 'Y
S
t
b
W [ 5 P 5 b (G Create ..
Workflow cont’d:
13. Press the Import button, then select las file: /Rawdata/Well_data/F02-01_logs.las.
14. Toggle MD.
15. Highlight all logs needed to import
16. Select Curve in the name after log
17 Cllck on Im Ol't @ Import Well Logs = m] x
’ p ’ Input (pseudo-)LAS logs file vdata\Well_data\F02-01_logs.las O Examine
Depth interval to load (empty=all) 30 I3150 (m)
Depth values are O TVDSS
Undefined value in logs -999.25 ‘
Curve Unit Description )
1 [ CALI in Caliper_1 (Caliper)
2 RHOB gfcc Density_1 (Density)
3 ¥IGR APL Gamma Ray_math (Gamma Ray)
4 ¥ DT us/ft P-wave_1 (P-wave) ~
[Name loq after ® curve ]O Description
Add to Well [Foz-01 ] O select ...

[©meot] @concet @
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Workflow cont’d:

18. In the well manager, click the Edit

Markers icon.

@ Manage Wells

O~ Fter [*
[ Fo2-01

In this exercise, we will import markers
from an existing file. It is also possible to

add markers manually.

Y [ & % A

0 Edit Well Markers
MName  MD(m)
Marker 1
Marker 2
Marker 3
Marker 4
Marker 5

Update display

£ O- Log
& Oeau 5
[ RHOB
= [er —
Oot [}
(] UNKNOWN
%
Q @
& &
+
+
Gl 4 Import ... | Create ...
o=
TVD{m) TVDSS[m] Color Reglonal marker
Export ... [1Z in Feet

Set as regional markers .| [,

Workflow cont’d:

19. Select the input file: /RawData/ Well

_data/F02-01_markers.txt.

20. Define the Format Definition:

@ Import Markers

File header

Input ASCII file ka\F02-01_markers.bd|

No header ~

Format definition | <Incomplete> [Z)pefine |

Existing markers (if any)

® Replace O Keep

[[] Assign random colors to|markers

@@ Qcanoel o

o

' Format Definition o |-@
Specify Necessary Information
MD E| Depth |col:1 = Unit m (Meter) E|

Marker name col2 =

Stop reading at

[ @0k || ©cancel| [ @Hep |
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Workflow cont’d:

21. Select / Modify a color for each marker by double-clicking on the appropriate row in

the Color column.

22. Press OK.

23. Once done, close the dialogs and return to OpendTect scene.

= Edit Well Markers

Name MD(m) TVD(m)
Marker 1 Seasurface 30 30
Marker 2 MFS11 553.6 553.6
Marker 3 FS11 576.02276611 | 576.02276611
Marker 4 MFS10 683.31 683.31
Marker 5 MFS9 T16.65002441  716.65002441
Marker 6 MFS8 T748.49 748.49
Marker 7 FS8 79500915527 795.00915527
Marker 8 Hame 86993859863  569.93859863
Marker @ FS7 942 27575684 94227575684

Marker 10 Truncation  1051.41040039 1051.41040039
Marker 11 Top Foresets 1094.97290039 1094.97290039
Marker 12 FSA 1106 93835449 1106 93835449
[update display] [ Import .. | [ Export . |

Set as regional markers . J E _]

roes
TVDSS(m)  Color legional marke *
0 <]
-
546.02276611 [N — =
653 31 - -l
686 65002441 B
718.49 - Fl
76500915527 [ =
839 93859063 -l
912 27575684 — -l
1021.41040039 - =
1084.07200039 - F
1076 93835449 = A
1 Z in Feet
[25) (0 coce [ @1

Workflow cont’d:

24.In the scene, display the log and/or
markers on the well : right click on the
well in the tree and follow Display
>Properties.

25. In the left- , center- or right-log tab, select
the log to display and the properties.

-] Display properties of: F02-1

left Log | Center Log Rightlog Markers Track
| Select log Gamma Ray ~
Specify data range ~ | [J Aip

Log range (min/max) 0 1140 [] Logarithmic

26. Open the Markers tab: toggle on the
desired markers and set the marker size
etc.

L wel

v
Q Polygon CLAS LogPlot 20 Log Viewer
S Prestack ty 1o wei to Seismic .. Show "

@ Annotations
! Create Aliribute Log

Frnatn | nn Moba

Show Amplitude Spectrum *
————|

@ Display properties of: F02-1

Left Log  Center Log  Right Log Track

Marker size |15 5
Marker color - 1 Blue [ use single color
Shape Cylinder ~  Height |1 5

Name size Normal
Name color || [CWhite
-

M Seasurface
[/ W MFs11
@ Fs11

(4 @ MFs10
410 mFs9

(] @ MFs8

~ [] Dynamic

same as markers

Display markers

Reset all

“rest| @

Apply Current to all wells

Il Save

[ save as Default
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1.4.4a Stacking Velocities

Required licenses: OpendTect.

Exercise objective:
Import stacking velocity functions.

Workflow:
1. Go to Survey > Import >

Velocity Functions > ASCII...
to import a velocity function.

Survey | Analysis Processing Scene View Utilities Help Estimages

£y Select/Setup ...
Session »

Import »
Export »
Manage »
Pre-load L4

Exit

& Z-slice
® Vvolume
~ Random Line
2D Line
@ 3D Horizon
4 2D Horizon
Fault
FaultStickSet
@® Body
L Well
= PointSet
[ Polygon
¥ Shapefile
X\ Prestack E...
Annotations

LA S
=~ SEG-Y

2 Sten 0 =
AttributeSet

Color Table ...
Cross-plot Data
Faults

FaultStickSets
Horizons

Mute Functions
PointSets/Polygons
Probability Density Functions
Seismics

Velocity Functions
Wavelets

Wells

Shapefile ...
HorizonCube surface data ...
Prestack Event ...

|

T AsCll ..

Workflow cont’d:

e r—

Has statics O Yes @ No

File header No header <

Format definition | <Incomplete>

Output Velocity

) Import Velocity Function

Input ASCII File tawdata\Velocity_functions.txt| € Select ..

Define

@ Import| @ Cancel @ Help

- oM

v| 6 Select .
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Workflow cont’d:

4. Set File header to Fixed size consisting of 2 lines.

= Import Velocity Function = = n
Input ASCII File lawdata\Velocity_functions.txt| | € Select ... | Q, Examine

Velocity type Vrms v

Has statics O Yes @ No
- Format Definition - o IEH

Specify Necessary Information

XY v Position col1 2 col2

Z col:3 % Unit ms (Miliseconds) v

File header ? Vims col4 &
Header size (number of lines) O Stop reading at
Format definition <Incomplete> Deﬁne :

) @ Cancel| | @ Help

Output Velocity v | © Select

@ Import| @ Cancel @ Help

Workflow cont’d:

and click Import.

= Import Velocity Function - 0 n

Input ASCII File lawdata\Velocity_functionstxt| € Select ... @, Examine
Velocity type Vims v

Has statics O Yes ® No

File header Fixed size z| =
Header size (number of lines) 2 5
Format definition <Defined> Deﬁne .
Output Velocityl Vims_function v| © Select ...

) Cancel @ Help
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2.1.1c Import data from Petrel using PetrelDirect

Required licenses: OpendTect Pro.

Exercise objective:
Import data from Petrel* to OpendTect using PetrelDirect.

Introduction
PetrelDirect is an OpendTect Pro feature for direct data transfer between CigandTect and Petrel* projects. Reading data from a
Petrel* project is available in various OpendTect workflows via insert icon , which allows to either access data directly from a

Petrel* data store via links or physically data copy to an OpendTect project:
Link to Petrel*:
« no data duplication;
« data is available only when the Petrel* project is running and PetrelDirect connection is active (i.e. Petrel* license is tied).
OpendTect copy:
« physical copy data in OpendTect format;
« no restrictions on data access (i.e. Petrel* license is not tied and data is accessible to all users).
Either method gives full potential for manfpuia@n, interpretation and processing. Writing data to a Petrel* project is also available
in various OpendTect workflows by choosing PetrelDirect output format.

PetrelDirect support the following objects:

» Full two-way access (Petrel* <> OpendTect):

Faults and FaultStickSets, 3D horizons, 2D and 3D seismic, Wavelets, Wells (tracks, time-depth models and logs)
» One way access (Petrel* > OpendTect):

2D horizons, 3D prestack seismic, Wells (markers)

Batch processing for importing objects is now available for Faults, FaultSticks, Horizons and Seismic Cubes.

A check box to use the original name is provided which should be checked in case the same needs to remain identical to the
object in the Petrel project. Any name entered into the field adjacent to this will be used as the 'base name' for the objects.

The following exercises will cover some examples of data exchange between Petrel and Opendtect .

Exercise objective:

Use PetrelDirect to import all data in one go from Petrel* to OpendTect at Survey creation.

Workflow: o Proceed ta import all listed data?
o

1. Perform the same steps as in Exercise 2.1.1b to set g
up an OpendTect survey using PetrelDirect, except s ouspe moneas

the last step. At the pop-up message asking if you i —L
want to proceed with the data import, Select Yes, to :mzzml
proceed with bulk data import from Petrel. 24 me
v (@l F6 Block
[ A ros-1
2. Select All Objects in the Datatypes and Hit OK. For a T e
large amount of data you can use the ‘Execute in §5°°°;¢§5‘“:£;.| "
Batch’ option. e

[ % Demo 0 > F54 Petrel

[ 8¢ Demo 1 > MF54 Petrel

(1484 Demo 2 > F56 Petrel

[Z1%& Demo 3 > Tep Foresets Petrel
[ ¥ Demo 4 —> Truncation Petrel

[ 8¢ Demo § --> F57 Petrel

[ 8¢ Derno 6 > Fs8 Petrel

Note that ‘Datatypes’ and ‘Filter’ can be used to list ﬁgiﬁi,,iﬂﬁiﬁiﬁfw
. [ ¢ tst2del_Inter_Demo 0 —> FS4
and select only the data of interest to be loaded. 2 st a0 > P
[ Execute in Batch Options ...
Qcort| @

*Petfei is a mark of Schlumberger
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Exercise objective:
Use PetrelDirect to import 3D seismic from Petrel* to OpendTect.

Petrel* 3D seismic cube can be accessed in OpendTect by clicking on PetrelDirect insert icon & in the following places:

» Manage 3D Seismics window (Survey > Manage > Seismics > 3D... or click on ¥, icon in the Manage Data toolbar)

+ Select window when adding a seismic attribute display at In-line/Cross-line/Z-slice/3D Horizon in the 3D scene

« Other workflows, including attribute definition and processing, etc.

Petrel* seismic data must have compatible geometry with OpendTect survey set up. The easiest way to achieve this is to get survey
set up from Petrel* when setting up a survey and choose an appropriate Petrel* seismic survey folder as the geometry source.

Workflow:

1. Perform the same steps as in Exercise 2.1.1b to set
up an OpendTect project using PetrelDirect.

2. Select Survey < Import < Seismic Data < PetrelDirect
< Cube. Select the Seismic cube from the Import
Petrel Seismic Cube window.

3. Create either Link to Petrel* or OpendTect Copy. Note S—— = ==
that the Link to Petrel option, requires Petrel License 8 ot e
to be able to use the seismic in OpendTect. 13 oo st e s 1
Volume subselection | 100/300-750/ 1250 (463 samples) O Select

Ml traces ® Discard O Poss

4. Keep the default parameters. Tick Use Original Name = o

Create ) Link to Petrel ® OpendTect Copy

Output Cube and Hit Run. e e e 0 e s e T
Eelew o

*
Petrel Is a mark of Schlumberger A by GBS Pelrel{DpendTect eopevsction

Exercise objective:
Use PetrelDirect to import Faults from Petrel* to OpendTect.

Petrel* fault interpretation can be accessed in OpendTect as Faults by clicking on PetrelDirect insert icon i the following places:
*Manage Fault window (Survey > Manage > Faults... or click on _ icon in the Manage Data toolbar)

*Select Input Fault(s) window when adding Fault(s) to the 3D scelw; 2D viewer or Basemap by right click on Fault in the tree > Add)
This workflow is similar to import FaultStickSets from Petrel to OpendTect.

Workflow:

1. Perform the same steps as in Exercise 2.1.1b to set S oo sen S
up an OpendTect project using PetrelDirect. s ?‘AA;:;:;E. |

2. Select Survey < Import < Faults < PetrelDirect. Select (2% o™ .
the Fault from the Import Fault window. r— S— -

- =] Filter —

3. Create either Link to Petrel* or OpendTect Copy. Note | - = e v .
that the Link to Petrel option, requires Petrel Licenseto . :
be able to use the Fault in OpendTect. 1 Use il N Pk 1 AL 26 Oseect.

O Execute in Batch - Options
4. Keep the default parameters. Tick Use Original Name oL

Output Cube and Hit Run.

Note that OpendTect does not support crossing fault sticks (a fault plane cannot cross itself). If faults were picked on inlines,
crosslines and horizontal slices, only the largest subset of the three will be used to import the faults. Manual editing (removing
unwanted sticks) is possible after import and might be required in some cases.

* Petrel is a mark of Schlumberger
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Exercise objective:
Use PetrelDirect to import 3D Surfaces from Petrel* to OpendTect.

Petrel 3D horizons and surfaces can be accessed in OpendTect by clicking on PetrelDirect inserticon & in the following places:

* Manage 3D Herizons window (Survey > Manage > Horizons > 3D... or clickon & icon in the Manage Data toolbar)

- Select Input Horizon(s) window when adding 3D Horizon to the 3D scene, 2D viewer or Basemap by right click on 3D Horizon in the tree > Add)
= Other workflows, including 3D Horizon gridding and filtering, creating flattened scene, etc.

This workflow is similar to import 2D Horizon from Petrel to OpendTect.

Workflow:

1. Perform the same steps as in Exercise 2.1.1b to set
up an OpendTect project using PetrelDirect.

2. Select Survey < Import < Horizon < PetrelDirect< 3D
Horizons. Select the Horizon (s) from the Import Petrel
Horizon window.

3. Create either Link to Petrel* or OpendTect Copy. Note
that the Link to Petrel option, requires Petrel License to
be able to use the Horizon in OpendTect.

Hortzon proporties/dtrdes:

Create O Lk to Petrel  OpendTect Copy.
1 U Oviginal Hame. Hextzon @ sect.

4. Keep the default parameters. Tick Use Original Name Beascee
Horizon and Hit Run.

OpendTect project is based on a particular 3D survey set up. Petrel* 3D horizons associated with 3D seismic surveys which
geometries are different and Petrel* surfaces based on grids which are different are snapped to an OpendTect grid during import.

[Ern ] @ @

*
Petrel is a mark of Schiumberger

Exercise objective:

Use PetrelDirect to import Wells from Petrel* to OpendTect.

Petrel well data (deviation survey, time-depth model, logs and well tops) can be accessed in OpendTect by clicking on PetrelDirect
insert icon [ in the following places:

* Manage Well window (Survey > Manage > Wells... or click on 4, icon in the Manage Data toolbar)

* Load Well(s) window when adding well(s) to the 3D scene or Basemap by right click on Wellin the tree > Add)

+ Other workflows, including well-to-seismic tie, Log attribute definition and processing, etc.

Workflow:

1. Perform the same steps as in Exercise 2.1.1b to set

up an OpendTect project using PetrelDirect. “ M
2. Select Survey < Import < Wells < PetrelDirect. Select o oam )
the Wells(s) from the Import Petrel Well window. :mmmmmn: v
3. Create either Link to Petrel* or OpendTect Copy. Note T R e e
that the Link to Petrel option, requires Petrel License to §
be able to use the Wells in OpendTect. . ::::‘:.‘?: .

o Scasurface

4. Keep the default parameters and Hit OK.

Selection of well logs and markers can be done using the Filters, Show only
common logs/markers switch, then Select buttons.

Create ©) Link to Petrel @ OpendTect Copy

Dcancel | @

* Petrel is a mark of Schiumberger
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Exercise objective:

Use PetrelDirect to import Wavelet from Petrel* to OpendTect.

Petrel* wavelets can be accessed in OpendTect by clicking on PetrelDirect insert icon in the following places:
» Manage Wavelets window (Survey > Manage > Wavelets or click on @ icon in the Manage Data toolbar)

Workflow:

1. Perform the same steps as in Exercise 2.1.1b to set
up an OpendTect project using PetrelDirect.

2. Select Survey < Import < Wavelets < PetrelDirect.
Select the Wavelets (s) from the Import Petrel Wavelet

W|ndOW_ @ Import Petrel Wavelet
- —&
~ [ seismic
3. Create either Link to Petrel* or OpendTect Copy. Note s
that the Link to Petrel option, requires Petrel License to ::LT;;.,P.W e
be able to use the Wavelet(s) in OpendTect. e e
ooe @
4. Keep the default parameters and Hit Run. Addad by 58’ PerelopandTact contacton

*Perref is & mark of Schiumberger

Exercise objective:
Use PetrelDirect to import Pointsets and Polygons from Petrel* to OpendTect.

Petrel pointsets and polygons can be accessed in OpendTect by clicking on PetrelDirect insert icon & in the following places:

» Manage Pointset/Polygons Windows (Survey = Manage > Pointsets/Polygons... or click on the ¥, icon in the Manage

Data toolbar). When adding from PointSet/Polygon manager, user will have a selection box to choose which kind of object they
want to import from Petrel*

* Load Pointsets (Polygons) window when adding pointsets (polygons) to the 3D scene or Basemap by right clicking on Pointsets
(Polygons) in the tree > Add). The relevant dialog box pops up.

Workflow:

1. Perform the same steps as in Exercise 2.1.1b to set
up an OpendTect project using PetrelDirect.

2. Select Survey < Import < Pointsets/Polygons < @ impa e Fiaes
PetrelDirect < Polygons (or Pointsets). Select the T =15
Polygons (s) from the Import Petrel Polygons window. 9 et rondsate rtoce_Domo 0 -> £
. . s F4 use Original Hame FickSet Group 2 ce_Dem S © Select ...
3. Create either Link to Petrel* or OpendTect Copy. Note [E] 0o ©

that the Link to Petrel option, requires Petrel License to
be able to use the Polygons/Poinsets in OpendTect.

4. Keep the default parameters, Use Original Name and
Hit Run.

*Perref is & mark of Schiumberger
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1.3.1a Display An Inline

Required licenses: OpendTect.

Exercise objective:
Display an inline in the 3D scene.

Workflow:

and Select Data.

median filter.

3. Click OK to display data in the scene.

2. In the pop up window, select 4 Dip steered

1. Right-click on Inline in the tree and select Add

Scene 1

o | Add Default Data
CWASY:| Add and Select Data
@ Volum¢  Add at Well Location ...
7 Randc  Agd Color Blended

= Select

Select first layer

© Stored

Steering

[
@
]

1 Original Seismics
3D UVQ 6 biased Texture+Energy+SystemsTracts
3D UVQ Texture+HC attribs+ Energy disk

| »

4 Dip steered median filter

E
é] Filter *

5 ChimneyCube
7a Al Cube Std
7b Al Cube from HorizonCube

On Darnacitiufuhn fram UQ AL

L oK ]l [O Canceil I @ Help ]

Visualization and processing goes faster when you load the relevant data set(s)
into memory. If you do not have sufficient memory to load an entire volume load
only the part you intend to work on. Another way to reduce memory consumption
is to re-scale data to 8-bit during pre-load.
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1.3.1b Pre-load Data

Required licenses: OpendTect.

Exercise objective:
Pre-load data

Workflow:

In the lower-right corner of the
main window you can see how
much memory is free.

1. Use it only if you have sufficient memory. To Pre-
load a stored seismic cube go to Survey > Pre-

load > Seismic.

2. Click on Add Cube.

' Seismic Data Pre-load Manager
O~

[free mem)] 23.8/31.7 GB

JERE Analysis Processing Scene Viev

&7 Select/Setup o
Session y | &= e 45
Import » 8
Export » Color
Manage »
Priosi ] Saomes— ]
Exit 4 Horizons
SR it L
= o X
il |
[ Load Cube
5] Load 2D DataSet...

% Unload Checked

@

Workflow cont’d:

3. Select 4 Dip steered median filter as input cube.
Optionally, specify a volume subselection and the
loading format. Press OK.

= Preload 30 Data

ot e [25) 3]0

v |© Select ] Nr Traces 1000 Sean

Volume subselection 100/300-750/1250 (463 samples) O select...]

To reduce memory consumption:
1) load in a smaller volume range
2) load in a different format e.g. as 8-bit

' Positions

Data format on disk: 16 bit signed. £ stimated memory usage: 546.73 MB

Yoime subselection Range

Specify Positions

v+.“d

In-line Range | 100 [<||750 < ‘ Step |1 >

Cross-line Range ,300 <1250 (= ‘ Step ‘1 s

E=]oe=

Time Range (ms) [0 [2][1848/2] step [¢ 2]

@ Cancel | | @9 Help

= Schmic OotaPr-tosd Manager =mpor <

4Dip stesred mecian fiter Bacacuse.

[Easaz owaser.

o Unioad checked...

> @

n 54673 M8
2501
501

Gl @ver)
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1.3.2a Position, Zoom, Pan, Rotate

Required licenses: OpendTect.

Exercise objective:
Learn how to zoom, pan, & rotate a 3D scene and how to move a seismic line.

Workflow:

1. Click on shift + the mouse wheel and drag
to rotate your display. To pan the scene
(i.e. move the scene horizontally &
vertically) press the scroll wheel (keep it
pressed on) and move the mouse. \

P
\ l:‘Il

2. Zoomin and out by scrolling the mouse
wheel. Or press Ctrl + the mouse wheel
(keep it pressed on) and move the mouse
back and forth.

Workflow cont’d:

Positioning elements

Elements Colof
Scene 1

A - H In-lin

3. Click on In-line in the tree > Add Default PATR Add Dofaut Dala ]

& Z-slice Add and Select Data

Data. @ Volum  Add at Well Location ...

~ Rand - Add Color Blended

7 Survey Analysis Processing Sce

B D I —
L L o T3 V2N -
4. Sele_ct the inline in the tree by clicking on iz Bt 4mmp
the line number 425. Tree stene 1 B
h Elements Colo
- - T .y . - 5:9)121
5. Fill in 250 (the new inline position) line F e Er:
number in the Slice Position toolbar. X || ¢ crovnina— ™

Use available memory: pre-load 2D, 3D, pre-stack seismic, T - o
Horizon and HorizonCube for quicker access. D semameanten
Survey > Pre-oad > Seismics =

m/\nalym Processing Scene Vie

L7 Select/Setup ... T: « ‘ O i

Session »

Import 4

Export 2

Manage » =
e 9

Exit 4] Horizons .
pj TTWPCTUSSTINE @) HorizonCube

i 7_clira
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Workflow cont’d:

Positioning elements

6. Rotate the view so you see the inline
such that it is displayed from its side' or
'end on' as much as possible in the
scene.

7. Leftclick (keep the button pressed) on
the inline in the scene and drag it to the
desired location and let it go.

8. To undo press Ctrl + Z.

If the seismic is pre-loaded the display
is uploaded instantaneously, movie-

style.

Workflow cont’d:

Positioning elements

9. From the tree, right-click on the
updated inline number and select
Display > Position option in the
pop-up menu list.

10. Position the inline at 195 and
click OK.

=& Zslic  pyplicate

= @ Volun Display Prestack Data »

Scene 1
=y In-line
v Add %
# Cros| TV 1 +istogram .

0 [
?/2 Reset Manipulation

Gridiines ...
4/ Properties ..
|/ Resolution  »

= [v] 34 Correlate with Wells
Y/ g Lock Treeitem

./ ?Snlf == Remove from Tree

@) Positioning o [@]=

Specify the element's positlofn
v

in-ine 19573
Cross-line Range 300 = 1250 <
Z Range (ms) 0 31848 £

= Apply
\O CanceIJ \ @ Help J

ks
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Workflow cont’d:

Positioning elements

11. Scrolling: Right-click on an In-line
number and select Display > Position.
Press Scroll. Elements are moved either
manually (select Control Manual) or
automatically (select Control Auto).

@) Positioning o e =
Specify the element's position
In-ine nr 195 <
Cross-line Range 300 1250 < )
& scrolling =8 EoR =x=|

Z Range (ms)

Control scrolling through In-line

Scroll step 1
OOK “ Control |
<< Step Back \Auto
@b
12. Default keyboard short cuts to move a Help
slice backwards/forwards are x and z. To Settings 21 Look and Feel ...
change this go to Ultilities > Settings > Tools g
Installation » |~ Advanced »
Keyboard shortcuts. Show Log File . | Language )
Workflow cont’d:
Positioning elements
- . Z-slice
13. In the element tree right-click on Volume = Volume! \
and select Add. This will insert an empty element in the tree. ¥ [EERIEN

Add Color Blended
Randurrrmrre:

14. Select a stored volume: right-click on <right-click> and go to Select Attribute

> Stored Cubes > 4 Dip steered median filter.

- [v] 425
v| <right-click> ra
# Cross-line
& Z-slice
= @ Volume
=] 343-506 / 656..

Display
Remove

7 2D Line Attributes

“ 3D Horizon
42D Horizon
Fault
FaultStickSet
@ Body
L well
X PickSet
[ Polygon
=\ Prestack Events

. Annntatinne

15. Left-click and drag an in-line/cross-line/z-slice, you can then go quickly

through the entire volume.

£ <right-olior— e L
~ Random Line Stored Cube _*

Steering Cube *

1 Original Seismics
5 ChimneyCube
Ta Al Cube Std
7b Al Cube from HorizonCube
8a PorosityCube from HC-NN
8b Gamma from HorizonCube
9-1 Similarity on FEF seismic
9-2 Dip-steered diffusion filter
9-3 Fault enhancement filter
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Workflow cont’d:

Look at what you have from all sides. Note that the data values are read out and displayed
in both methods (view mode and position mode), these values are displayed at the bottom
of the screen.

Show crossline 1000 in a similar manner.

= OpendTect Pro V6.2.0/win64: F3_Demo_2016 treining v6 - [Scene 1] - 8 X
Sunvey Analysis Processing Scene View Utiiies Help Estimages -8 x

GiwqBiana SEFT-AS
[ | ‘ 2 bk

In-line 120 % Step

Tree scene 1 5
Elements Cotor
Scene 1
¥ indine
# Crossine
 Zslice
~ @ Voume
v [ 343-506/656-9.
[ 4Dipsteere.. 11
~ Random Line
20 Line
< 3D Horizon
2D Horizon
Faul
FaultStickSet

IR LY Y

AR>S 9 >

wel
i pointSet
> Polygon
% shapefile
S\ Prestack Events
Annotations

[ -

3430938 (621622, 6080075, 659) Value = 3360 lfree mem| 427968

Workflow cont’d:

Show a part of a Z-slice at 700 ms TWT

Ci -li
16. Right-click on Z-slice > Add Default Data. ;'gz.r_é’f-s re /I
= Volu

A |
= [¥] < Add and Select Data

17. Rotate the view so you see the Z slice from

above. Shift + Middle Click + Drag. 5 @ Z-slice
S
18. Make the frame smaller by dragging the green ® Volumy "p =
handle points of the frame. (If the handles are 714 Reset Manipulation | gy s
not apparent click on the relevant slice to 7 handd & Lok Tresitem e e —
‘activate' them). @ 3D Ho == RemovefomTree gosoiution »
) Positioning o || &S

19. Right-click on the Z-slice number > Display >

Specify the element's position

In-line Range 100 = 472 £

Cross-line Range 300 5 900 %

Z (ms) 700 = || Scroll...

| ¥ Apply

) Cancel | @Hep |
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1.3.3a Random Line

Required licenses: OpendTect.

Exercise objective:

Workflow:

1. Pre-load the stored 4 Dip
steered median filter cube (see
exercise 1.3.1b).

2. Add arandom line: right-click
on the tree item (OpendTect
Pro users can also do this from
the basemap).

3. Resize the display element:
left-click + drag on the green
anchors (this is optional but for
the sake of this exercise let's
doit).

Add a random line and move & rotate this through a 3D seismic volume.

~ ‘R;nQnm Lina!

ISRz Nl Add Default Data

@ 3DH  Add Stored ..

@ 2D0H
Fault
Fault, New

Add Color Blended *

»

Workflow cont’d:

4. Push the line through the
seismic volume: left-click +
drag.

5. Rotate thé line: Ctrl left-click +
drag.

6. Push the line through the
volume in the new direction:
left-click + drag.
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Workflow cont’d:

7. Insert a node: right-click on
the element in the scene, or the
entry in the tree and

8. Use the green anchors to
position the node: left-click +
drag

9. As before, now push and rotate
the crooked line through the
volume using left-click + drag
and Ctrl left-click + drag,
respectively.

Add
———— oy g
= /&v: Duplcate ¥ Properties
=i Reset Manipulation Resolution  »
—— —  Create 2D Gid 2 Posiion X

& seess
Save as 2D = S
Correlate with Wells >

N

Lock Treeitem
Hide
3 Export to Google KML

Remove from Tree
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1.3.3b Random Line Through Wells

Required licenses: OpendTect.

1.

Exercise objective:
Create a random line through existing wells.

Workflow:

Right-click on Random line >
New > From Wells.

Select all four available wells and
change the well's order
accordingly: F03-4, F03-2, F02-1,
F06-1, using Change order
arrows.

Press the Preview button to see
the updated geometry in the
scene.

Give a hame to the newly created
Random line and click OK.

& Z-slice
‘ Volume
~ [Rapdom T'ina
v op| Add Default Data
@ 3p Add Stored.
4 2D/ Add Color Blended *

Fay Interactive ...
[N FaultStickSet From Existing
@ Body From Polygon
Well From Table .
¥ PickSet From Wells ..
D Polygon
/) Create Random line =B @
Select wells to set up the random line path
I:l Well Name
[ Fo2-1 |1. Change
I Fo32 Selact 2' order
| Fo34
Fo6-1 [E] 3 @
[ |, )
5
Use only wells' top position @) Yes No
| Extend outward (m) | 2500
e ]
Output Random Line E” € Select ]
v | Display Random Line on creation
I Q ok © Cancel @ Help
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2.1.2a Basemap

Required licenses: OpendTect Pro.

Exercise objective:
Use the Basemap to populate/manipulate the 3D scene.

1. Pre-load 4. Dip steered median filter (optional, see
Exercise 1.3.1b for details).

can be done in 3 ways:

:F3_Demo_2015 - [Scene 1]
Utilities Help

Work Area

Z-Scale

Viewer 2D

Stereo Viewing *

I Step 0

Toolbars >

2. To open the basemap, click on the @‘ icon or go to
View > Basemap.
3. Add aninline to the basemap and the 3D scene®. This

Add Cross-ine
Add In-iine and Cross-iine.

a) Press (once) keyboard | and drag the line to the
correct position : the line humber is shown in the - b 0 oo 4o00m
tree and in the lower left corner. ,
Basemap Tree g
b) Move the cursor in the basemap to the correct Elemen: Coor |
position; right-click and Add Inline. Seftings
V| gin-
¢) Right-click in the basemap tree > Add. 7) @ Cross
V| & Z-Slice

v| @ Seismic Outline

L R I

The basemap can be used: 1) to populate a 3D scene; 2) to pop up
2D viewers; and 3) as standalone utility, e.g. when creating output
maps. All options are controlled from the Synchronization menu.

= Basemap - Scent
Basemap Processing | Synchronization | Hi
o= I 2D Viewers ¢

v | 3D Scene f
. Basemap Tree sy

Workflow cont’d:

4. Move the inline to a new position: hover over the
inline until it shows up in bold; left-click and drag to
the new position®.

Add a crossline with pressing (once) keyboard C.

Add a random line pressing keyboard R; Left-click
to add corner points and double-click to end the line.

To insert a new node after the random line is drawn:

Hover over the random line until it shows up in bold and
then shift + click.

To delete a node ctrl + click on it.

0 000 8000m
e —

] 4000 8000m
2"

*If the basemap is synchronized with the 3D scene (as in this exercise) you can also re-

position elements using all options supported in the 3D scene, e.g. nis2 >sept - ) .
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Workflow cont’d:

% Add
7. Right-click on Well in the basemap tree Z
and select Create Group. o & | Propeties..

=] Remove All

8. Add F02-1 and FO3-2 to the group.

) Select Basemap parameters [o-e=]
9. nght-Clle on the Group and select Well symbols |!oilwe|| |+] size |5 | [7] Display Projection
Properties.
For the sake of the exercise let's assume

these wells are oil wells: select the

corresponding Well symbol and change
size to 5.

10. Repeatthe exercise for F03-4 and F06-1: 562
Give another well symbol to these two, say
oil and gas.

--507

0 4000 8000m
D e —

[

Workflow cont’d:

11. Add other elements (horizon, contour, shapefiles, ...)
and change the basemap settings (right-click on

Settings). Basemap Tree a8
12. To create final maps you can process your horizon Sl Color
before printing: under the Processing menu you will find ‘
options for filtering or gridding. Basemap Synchroniz @ In-line
e Fitering .. [ 07 i Cross-line

_|_Gridding .. & Z-slice

@ Cube Outline
~ Random Line
17 2D Line

% 3D Horizon
< Contour

~4 2D Horizon
FaultStickSet
A Well

i PointSet

[> Polygon

¥ Shapefile

[&] Image

FE Annotation

] F3_Demo o,
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2.1.3a PDF3D

Required licenses: OpendTect Pro.

Exercise objective:
Grab a 3D scene with PDF-3D for sharing via Acrobat Reader

N [ || s
- SEG-Y
Workflow: “* Save scene
‘g4 Save scene as...

1. Prepare the scene you wish to capture and
press the drop down sign adjacent to PDF-
3D icon 1. Select Save scene as...

2. Specify the Output PDF file name (e.g.
Example_pdf3d) and select Half the
resolution for the horizons.

= Save scene as - oIEN
Output PDF file name [\Example_pdf3d.pdf O Select ...
Select horizon resolution | Half v

[T] set password for open exported PDF3D

QoK || cancel | @) Help

Workflow cont’d:
Preferences
Categories: 3D and Multimedia Options
. . . Commenting - Renderer Options

3. Open the file in Acrobat Reader v8 (or higher). Documerts Prefered Renderer

gﬂ‘efs' ‘ [ Enable hardware rendering for
) o ageDislay _

4. Ensure that double-sided rendering is enabled. Rt ok i maeno

Accessibility Preferred 3D @‘!l Rendering Mode:

5. Use the left most icon on the toolbar to zoom, pan, rotate
etc.

6. Use the tree to toggle elements on and off.

Q Views
R 4 model
£ [ OpendTect Scene -- dGB
=i Well: F03-2

7 [ Log: F03-2.1
% Track F03-2
% (¢ In-Line: 425
3] ¢ Survey box
=1 ¢ Horizon: Demo 0 --> FS4
& Horizon: Demo 0 --> F:
& PDF3D-SDK Lights From File
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2.3.1a Steering Cube

Required licenses: OpendTect Pro, Dip Steering.

Exercise objective:
Compute a Steer'ngcube. Processing | Scene View Utilities CLAS l:(zlp
Create Ssismic Output & - = ., O o
Create Horizon Output~ » = = LB Sy
b Wells g
Workflow: (Re-Stat Bateh Job
Dip Steering »
- . . . . = GMT Mapping Tool Filter
1. Bring up the Create Steering Seismics window: @ Horzoncuve | oo 5
Processing > Dip Steering > Create > 3D. e V| oo smmacise.
2. Select 1 Original Seismics as input. : :
ginal celsmics P With a calculation stepout of
. 1,1,1; the dip is computed within
3. SKtZZﬁr:heafieJﬁmx?lﬁu:at'on stepout for the PCA a small cube of 3x3x3 samples
galg R around each sample in
consideration.
¥ Create Steering Cube - (m] b4
Input Cube L:“l “E} 1 Original Seismics = | © select | Steering algorithm PCA < |
Volume subselection |100/300-750/1250 (463 samples) © Select ... Filter size (sample) |inl:1 |2 jerl:1 (2 |Z:1 :|
Use fault dips O Yes ® No Maximum dip (us/m) 800
With planarity O Yes @ No
Qutput Steering «| | © select ... [ Filter result  Median
Batch execution  Single Process ~ |4+ Options ...
€ Close eHeIp
Workflowcont'd:
4. Specify a stepout of 2,2,5 to apply a median filter on the raw dips.
¥ Create Steering Cube - a X
Input Cube L:L "&} 1 Original Seismics | 6 select ... Steering algorithm PCA -
Volume subselection [100/300-750/1250 (463 samples) | |© select ... Filter size (sample) (inl:1 |3 |crl:1 3] |Z:1 :
Use fault dips O Yes @ No Rdnupldpl(isiplljano
With planarity O Yes @® No
Output Steering .| @ select ... [ Filter result  Median -
Batch execution Single Process 7] [ options .. Filter stepout (sample) |inl:2 |3 |crl:2 2] |Z:5 =
Qcose @ Hep

When adding Planarity, the output steering cube contains an additional Planarity
component along with the Inline Dip and Crossline Dip. The Planarity attribute
returns the quality of the steering cube and is used by Unconformity Tracker,
Inversion + tracker and for HorizonCube creation.
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Workflowcont'd:

time run this process.

6. Give the output SteeringCube a name (e.g. PCA111_MF225) and click OK.

# Create Steering Cube - o x
Input Cube Lﬂ ‘& 1 Original Seismics ~ 6 Select ... Steering algorithm PCA =
Volume subselection | 100/300-750/1250 (463 samples) 6 select ... Filter size (sample) linl:1 3 :crlzl 3 |Z:1 ::
T Use fault dips O Yes @ No Iodmidpiusm ) 800 |
Tip: It's recommended to T @E | O
use the SteeringCube output steeing [FRTTETTI T sl {2 Fitr result. Median .
par:meterstrlln Its namel Batch execution IR <] [ options .. Filter stepout (sample) |inl:2 3| |erl:2 2 |Z:5 =
as done in this exercise.
oclose eHelp
# Positions. - o X
Specify Positions
Volume subselection Range Bl e ]
Indine Range 420 3 [430 2| Step |1 1
Cross-line Range 300 5 1250 5| Step [t e
Time Range (ms) 0 21848 2| Step |4 &
@ok | @Dcancel @ Help
Workflowcont'd:
7. Add default data (i.e. 4 Dip e
- W Cro;
stt_a'er(_ed mea_f.'an filter) by right & ol Add and Select Data
clicking on inline 425. @ Volu  Add at Well Location ...
~ Rar - adq Color Blended
2D L
¥ In-line
8. Once again right-click on o o400 AN ‘
. . N ross-line y i i
inline 425 to display the @ Zsice Duplicate : :°"{me§”:)‘de|;f°‘“:'b“‘e
Detailed SteeringCube (SEIECt ® Voume . Reset Manipulation - orizon-ube lsp.ay
~ Random Lir “ . Systems Tracts Display
PCA111_MF225 from 2D Line t Correlate with Wells ... 'y
Steering tab).
# Select - a X
Select Layer 2
Filter |*
O stored 2 Steering BG Detailed
F n 3 Steering BG Background
©® Steerind || 3, Steering FFT225 MF113
- ; _ Attributes PCA111_MF225
Tip: It's recommended to display B
the Crossline dip component of the &
SteeringCube on an inline and vice-
versa. | Component Crossline Dip 'l
QOK | Qcanoe\ OHelp
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Workflowcont'd:

9. Use the Pastel color-bar.

10. To co-visualize seismic and cross-line component of dip, right-click on the
PCA111_MF225 in the tree > Display > Change Transparency and set the transparency
to 50%.

= | § i B @ B 2y b I

v 425
[ PCALL1 MF225.. E3
4Dips  Select Attribute

@ Cross-line Save Color Settings

# Z-slice Use Saved Color Settings

® volume Move >

¢ Random Line [ Display * M Histogram ...

7j2Dlne = Remove B Amplitude Spectrum ...

“# 3D Horizon F-K Spectrum ...
b | Change Transparency ..
AR = 20 Viewer

W Faultset = B

FaultStickSet 2D lewess Wi
@ Attribute transparency - m] x
Transparency ]
© cancel

Workflowcont’d:

11. Additional step: Go to Processing > Dip Steering > Filter > 3D and apply
Recursive Gaussian filter using the stepout of 5, 5, 2 to achieve smoothly
looking results.

Processing Scene View Utilities Help ~. -
z - = Filter St Cubs - m} X
mmu:m : ﬁ]f“.'iQ:i’-,\#",ﬁ ) Filter Steering Cube .
A wets . Input Steering Data [PCA111_MF225 ~| | © select ...
(Re-)start Batch Job ..
coue .. Volume subselection [100/300-750/1250 (463 samples) | © select [
‘A MGS Destriping ... |
- g;‘::;a B o v FiIterIRemrsiveGaumian &
Z5 Faults and Fractu > Filter > = — =
|2 :;rn:wngm;ei. Import 5 g... I |Fi|ter stepout (sample) |InI:S ;I Icr]:S ";‘| ‘2:2 [;”
@ HorizonCube » Track using Inversion ...
10 Madagascar . Set Defaut 30 SteerngCute . Output Steering [PCA111 MF225_GFS52 -] © select ...
Batch execution |Sing|e Process | .Q Options ...
. °Run Joclose eHelp.

Tip: Recursive Gaussian filter is extremely fast and is available for all OpendTect Pro users.
If you're using a free version of OpendTect, for additional smoothing we recommend applying
the Average filter, instead of the Median one. Median filter was already applied during the
steering cube computation to remove spikes (step 5 of this exercise).
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2.3.1d Dip-steered Median Filter

Required licenses: OpendTect Pro, Dip-steering.

Exercise objective:

Remove random noise from the seismic data using Dip-Steered Median Filter (DSMF).

Workflow:

1. Go to the Attribute engine: Analysis > Attributes > 3D

LU=l Processing Scenes  View Ut

“4 Volume Builder
Ei Cross-plot Data
Well

or click on the, | icon > 3D.

=
2D ...
(.|

Workflow cont'd:

2. Select the attribute: Dip
steered median filter.

Attribute set | <not saved> <All> [+]| oip steerec median fiter é] 2

3. Select Input Data: 7 DSHF Input Data 1 Original Seismics [0 seect |
Original Seismics. Stepout

4. Set the Step-out tO 11 1 Steering Uma:é-lp "gl]'s-.eenngBGBackground -: £ Select |
(the optimal step-out will
be evaluated later).

5. Select the Steering Data:
3 Steering BG background.

MEICID

6. Give a name (e.g. DSMF
for Dip Steered Median Atrute Name [0S Add as newd] (i
Filter) and Add as new. ——

Keep this attribute set
window open.
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Workflow cont’d:

7. Now in the scene, in the tree, right-click on In-line and choose

Add and Select Data.

Elements Color
Scene 1
' In-line
i Cross| Add Default Data

U X4 M Add and Select Data

@ Volum  Add at Well Location -

~ Randt  adq Color Blended
™ 20 | s

[= Seiet [E=m =y~
Select Layer 2
8. Select 1 Original Seismics from Stored tab and press | © S BT
ip steered median filter
oK Steering | 5 ChimneyCube
- Ta Al Cube Std
Aftributes Tb Al Cube from HorizonCube
— 8a PorosityCube from HC-MN
= A o oo G
rg# Filter | *
(O Cancel [ @ e
9. In the tree, right-click on inline number (i.e. 425):
Add > Attribute. 3 ln_l&em
s &
SRR Add |5 atnibute
@ Crossin  Display * | % Volume Builder Attribute
@ Z-slice Dupkcate € HorizonCube Display
® Volume Reset Manipulation 85 Systerns Tracts Displa
’T, ZHST::: ¢ Correlate with Wells ... Y By
@ 30 Horiz @ Lock Treeitem
# 2D Horiz == Remove from Tree
Fault
Workflow cont’d: i seec ===
Select Layer 2
Stored |
Steering
10. Select DSMF from Attributes tab. S
fs
B

11. Go back to the Attribute Set window and
click the attribute evaluation tool icon 'm’

to evaluate the step-out.

12. Specify Evaluate: Stepout.

13. Set the initial value “0-0",

increment “1-1”, and Nr of steps “5".

14. Press Calculate.

[20](© caxs) (@ en

Slice

= Evaluate attribute ol - )=
Set parameters

| Evaluate Stepout El

[imitial value |0 0 |

[ increment |1 1 |

Nr of steps 5 :

Store slices on 'Accept’

@ e [ @ s |
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Workflow cont'd:

15. Once the computation is done, move the slider to change the stepout value and see the
impact in the scene.

16. Assess which step-out is best (removing random noise, but not too much smearing)?
Once chosen, press Accept and close the attribute set window.

= ~ @l LEn <sie J i 5 |1 asesmes
0

£

s

785

m=

- Use the keyboard arrow keys, so |
= ' - you can focus your eyes on the

scene.

Workflow cont'd:

17. If you are satisfied with the parameters, you may want to process the attribute definition as
a volume. Follow: Processing > Create Seismic output > Attributes > Single attribute > 3D
or click on the &2 icon.

[ Survey Analysis Scenes View Ulilities Help
L@ Y Create SeismicOuput » | Awibutes > [ Single Attiowe > [P0
(425 Elsieg 10 [5] oot HorizonOutput & | 2D <=>3D Y Multi Attribute .. [ 30 |
(Re-)Start Batch Job . Angle Mute Function ... MultiCube DataStore
Tree scena 1 B N insiam r . )
" Creste Volume Attribute e
Quantity to output DSMF [<]
Volume subselection 100/300-750/1250 (463 samples) _O Select

Null traces @ Discard © Pass

Scale values: Shift/Factor

Output Cube DSMF [-]|[© setect..| (@ cBys ]

Batch execution Single Process j i+ Options ]

(© cancel| | @ Hep |

The processedattribute volume will appear as a Stored Cube (in Seismic Manager).
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2.3.1f Dip-steered Diffusion Filter

Required licenses: OpendTect Pro, Dip-steering.

Exercise objective:

Enhance low-quality seismic data near faults using a Dip-Steered Diffusion Filter.

Workflow: )
= Default Attribute Sets (=R R~~~

1. Start the attribute engine , | . Solect dckmut sriaie et

Filter *
2. Open the Default Attribute set..
Evaluate Aftributes o
AVO attributes from Intercept-Gradient E
3. Select Dip-steered diffusion filter and press OK. AVO attributes from Near-Far
dGB Evaluate Attributes

Dip-steered median filter
Dip-steered diffusion filter =

] i »

;O Cancel| | @ Help

Workflow cont’d:

4. In the pop-up window set 7 Criginal Seismics as input seismic and 3 Steering
BG Background as input steering, and press OK.

. Attribute st definition =8 Fch 57|

Select Seismic & Steering input

Input Seismic lg ‘e»| 1 Original Seismics ~ | ©) Select
Input Steering [-_é “‘é. 3 Steenng BG Background v | Select

|W“O Cancel| | @ Help |
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Workflow cont'd:

5. The attribute is defined.

= Attribute Set 3D
File

o IR TEY T

Aftribute set <not saved= [<Al= ~ | [Posttion = ? |
Dip-steered diffusion filter Input attribute | Minimum similarity ~| ) Select ...
Stepout inl:1 S oA
Time gate (ms) 0 0
Steering [Full -]
Steering Data % "¢ 3 Steering BG Background - D Select ...
+ 3
Operator | Max e
*
Cutput attribute | Dip-steered median filter =] | © Select ...
24 ‘
—
Attribute Name  Dip-steered diffusion filter [Add as new| E ]
¥ Save on Close g ECIuse € Help
1y
Workflow cont’d:

6. Keep the attribute set 3D window
open and add the Dip-steered
diffusion filter attribute in tree on

inline 425.

Scene 1

Add Default Data
W Zslice

® Volumi  Add at Well Location ...
~ Randq

2D Lin

Add Color Blended

o Select ==

Select first layer

Stored Dip-steered diffusion filter
Steering

¥ 5

[x] Canr.el: | @ Help

- 46 -




Workflow cont’d:

7. Go back to the attribute set 3D
window, and click on the attribute
evaluation icon 'm to evaluate the
step-out of the Dip-steered diffusion
filter attribute. o [ e

Set parameters

8. Specify Evaluate: Stepout | Evaluate [Stepout - |

[ nitial value 0 0 |

9. Set the initial value “0-07,

increment “1-1”, and Nr. of steps “5". [ Increment 1 1 |

Nrof steps 5 -

Slice

10. Press Calculate.

Store slices on "Accept

(@)

Workflow cont’d:

11. Once the computation is done, move the sliders to change the stepout value and see
the impact in the 3D scene.

B2 0 P a e M eeos v asesmes
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Workflow cont'd:

12. Evaluate which step-out is best (removing random noise without creating too many
artefacts)? Once chosen, press Accept and close the attribute set window.

Evaluate | Stepout -
Initial value 0 0
Increment 1 1
N of steps >

Slice U

Store slices on 'Accept’

Stepout [2,2]
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2.3.1g Dip-steered Fau

It Enhancement Filter

Required licenses: OpendTect Pro, Dip-steering.

Exercise objective:

Remove noise and sharpen edges/faults

The Fault Enhancement Filter is a

Based on a similarity threshold, the
default attribute sets in two forms:

Fault Enhancement Filter. All basi
shielded and the user can only

can be modified.

Fault Enhancement Filter (expert):

with the Fault Enhancement Filter (FEF).

combination of dip-steered median filter and

diffusion filter, modifying the seismic volume to enhance fault visibility.

data is smoothed (DSMF) away from the faults

and sharpened (DSDF) at the fault location. The filter is released with the software as

c attributes needed as inputs for the filtering are
control the amount of smoothing (dip-steered

median filter) versus sharpening (dip-steered diffusion).

The full attribute set definition is shown, which

Workflow:
1. Start the 3D attribute set window
by clicking on : |
2. Click on default attribute seticon
3. Select Fault enhancement filter

and press OK button.

Attribute Set 30
s LA TILY 35

At <t waved>

<Al

¥ | © Select

' Default Attribute Sets

Select default attribute set

Filter *

AVO attributes from Intercept-Gradient
AVO attributes from Near-Far

dGB Evaluate Attributes

Dip-steered median filter

Dip-steered diffusion filler

Fault enhancement filter

v

Q Cancel: | @ Help
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Workflow cont'd:

= Attribute set definition

4. Select the 1 Original Seismics as

Select Seismic & Steering input

'a"a‘@.

input seismics and 3 Steering BG
Background as input steering and

input Seismic (2 ) 1 Original Seismics

Input Steering kg &) 3 Steering BG Background

-|(© select...|

-|(© select

QOK‘OCamd' €@ Help |

press OK.

5. This will create a fault enhancement
filter attribute for you.

6. Keep this window open and proceed

to the next step.

Fault enhancement fier (FEF) /| MathFunctions
Formula (ke ‘nearstk + c0 * farstk’) Similarity = ¢0 ? DSMF : DSDF
For 'Similarity’ use 'Sumwlarriy =

Value for 'c0 0.7
For "DSMF' use | Dip-steered median filter (DS! = |

For 'DSDF use |Dip-steered diffusion fiter (DS ~ |

= 'sqn (Square root)

[ nset | |

]

Workflow cont'd:

7. Load the default seismic data to a small area of the Z-slice at 1640 ms, between inlines

120-400 and crosslines 350-600.

= Select

- Select first layer

Right-click on Z-slice in the tree to
add stored 7 Original Seismics.

Steering
@ [Z-slical Atlrbutes
® v Add Default Data
~ g Add and Select Data | EEE————
o 5 _Add Color Blended B Fier

1 Oniginal Seismics

4 Dip steered median filter

5 ChimneyCube

Ta Al Cube Std

7b A Cube from HorizonCube
8a PorosityCube from HC-NN
8b Gamma from HofizonCube:

.\0 Cancel £ Help

oo =

Once it is loaded, again Right-click on
Z-slice number 924 to change its position.

= Postioning =~
y Specify the element's position
4+ @ Z-slice
- (7924
91 Add L In-line Range 120 400
® Volume Display ' m Histogram )
-~ ?ST’DF Duplicate + Position Cross-line Range 350 600
ing Reset Manipulation . . .
@ 30Ho o ) ook Treeitem # Gndlme.s.. Z (ms) 1640 |2 [ Scroll ...
s 2D Hori @ . 4 Properties .. J
Faut | = Remove from Tree Resohion  * =
FaultStickSet D

|LQ& |‘0 cancel| | @ Hep |
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Workflow cont’d:

8. Apply the Fault Enhancement Filter to the constrained Z-slice at 1640 ms.

* Right-click on Z-slice number 1640 to add the FEF attribute.

= & Z-slice
SRl 1640
ZREe  Add ' [§ Attribute
® volume Display ’
~ Random Li Duplicate
' 2D Line

% Volume Processing Attribute

Reset Manioulation |

= Select [fe==s

Select Layer 2

Stored Fault enhancement filter (FEF)

Steering

@

I & ok ]'OCanceI| @ Help |

Workflow cont’d:

9. Compare 1 Original Seismics with the FEF
attribute on the constrained Z-slice 1640 ms.
I 8§ Red-White-Black

Make sure to use the same colorbar range E1 Red.White-Blue
# SandShale
for both.

B Similarity

1 SunRise [
P Tasty -
W UVQs Example (5-Classes) ~

4500 [ 4500 [raseismics
Wl Rainbow
B Rainbow Plus

y [

Did you get clear enough differences
between criginal seismicsand FEF?

Original Seismics (left) and FEF Seismics (right) displayed on Z-slice at 1640 ms.
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Workflow cont'd:

Evaluation of constant c0

A critical parameter of the Fault Enhancement Filter is c0. If the similarity
value is higher than the c0 value, then the Dip Steered Median Filtered
Seismic is used and otherwise the Diffusion Filtered Seismic is used.

10. Go back to the attribute set window, N Ev b e E=3 EoR =x=)

and click on the attribute evaluation SERTEMEER

icon 'Fh to evaluate the constant cO0. :
: Evaluate |c0 -

| Initial value 0.1 |

| Increment 0.1 |

11. Use Initial value: 0.1, Increment: 0.1,
Nr. of steps: 9 and press calculate. |Nr of steps 9 - |[ calcuate |

(@ Accept] | @ Help |

Workflow cont'd:

Evaluation of constant c0

12. Move the slider to assess which constant shows the best results (more faults visible and
less noise)? Press accept to save the constant ¢0.

SJiwabBE=T-of
= T e 2040 Sepd - F = SR yn a7 T 5 000 Semmecs
Teee seene 1

il
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Workflow cont’d:

Fault Enhanced Similarity

13. Open the Attribute set window and create a new dip-steered similarity attribute using

the FEF attribute as input. Use the default values for rest of the parameters. Name it
FEF_Similarity and Add as new.

= Attribute Set 30 RO =
File
*Pe ¥R NAE -
Altribute set <not saved> <All> ~| [ Simitarity 1 |2
Fault enhancement flter (FEF input Data | Faul enhancement fiter (FEF) =] | © Select ..
FEF_Similarit
- g Time gate (ms) -28 2
Extension | Cross -
Stepout inl1 e
Steering | Full =
Steering Data fies| &) 3 Steering 86 Background - [© seeat
*
\ 4
B!
—_
Oulput statistic |Average -
v | Attribute Name FEF_Similarity " Add as new I;.
Save on Close lo Close| | £ Help

Workflow cont’d:

Fault Enhanced Similarity

14. Create yet another dip-steered similarity attribute using the 7 Original Seismics as
input. Use the same parameters as the previous step. Name it FS_Similarity and Add

as new.
= Attiibute Set 30 o=
File
ad A N1 ¥ 1N
Atribute set <not saved> <Al - | | Simikarity = |2
Fault enhancement fiter (FEF input Data | 1 Ongmnal Seismics *| | Select...|
FEF_Similarit
|:s_{;.rr..|.;;—|,|yJf Time gate (ms) -28 28
Extension | Cross -
Stepout ind1 T et
Steering | Full z)
Steering Data fis| )] 3 Steering 86 Background - [© seect
*
\ 4
24
—
Cutput statistic |Average -
v I Attribute Name  FS_Samilarity II Add a5 new I;.
Save on Glose [Gcose] [@rer
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Workflow cont'd:

Fault Enhanced Similarity

15. Apply one-by-one the FS_Similarity (calculated using original seismic) and the
FEF_Similarity (based on the Fault Enhancement Filtered seismic) to the constrained
Z-slice at 1640 ms.

07 055 [m Smtarty -
1 Ranbow

Don't forget to use identical
Similarity colorbars!

j ‘ N b v AT ""l"‘

Dip-steered similarity from Original Seismics (left) and FEF Seismics (right)

Tip: Both Fault Enhancement Filter and Fault Enhancement Filter (expert)
can be accessed from the ‘Default Attribute Set’ using the Drawer ' icon
from the row of icons at the top.

= Default Attribute Sets =3 Ecn =]
Select default attribute set

Filter *

Evaluate Attributes o

AVO attributes from Intercept-Gradient £

AVO attributes from Near-Far I

dGB Evaluate Attributes

Dip-steered median filter

Dip-steered diffusion filter

Fault enhancement filter

Fault enhancement filter (Expert) >
n

‘ « G

©) Cancel| | @ Help
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2.3.3a Ridge Enhancement Filter

Required licenses: OpendTect.

Exercise objective:
Compute the Ridge-enhancement filer attribute for improved fault visualizations.

Processing Scenes View Utk

Workflow: - _t
“§ Volume Builder ..
Ei Cross-plot Data v
1. Start the 3D attribute engine: Analysis > Attributes > 3D. wel .

& Layer Modeling

= Fluid Contact Finder ..
i+ Neural Networks

58I v
Velocity Model Building  *
Weidl Correlation Panel ...
Workflow cont’d:
= Defauk Attribute Sets (=R =
2. Open the default attribute set . Select default attribute set

Filter *

. " Evaluate Attributes
3. Select Ridge Enhancement filter (Expert). AVO attributes from Intercept-Gradient
AVO attributes from Near-Far
Workflow - Data Enhancement (dGB)
4. Press OK Ridge enhancement filter (Expe

Fault enhancement attributes

RIrTS Samman
b

i
0 Cancel: ) Help

5. Select 4 Dip steered median filter for Input seismic and 3 Steering BG Background for Input

Steering.
. Attribute set definition =8 E=h |
6. Press OK.
Select Seismic & Steering input
Input Seismic =) I"" | 4 Dip steered median filter B 6 Select [
= S |\S Select ..
Input Steering i":’) l&;]l 3 Steering BG Background B 9 Select ...

0 T @) Help ]
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Workflow cont’d:

7. Keep everything default with the default name Ridge enhancement filter.

8. Uncheck Save on close and then Close the window.

_
File

*PeREa NWAE
Aftribute sel <nol saved> <Al>
Similarity

Calculated_or_Stored_Simi
Dip-steered median fitter (D
Dip-steered diffusion filter (
Fault enhancement filter (FE
Similarity on FEF

RS_+1_0

For 'cider’ use
For 'diag_oneder use

For 'diag_twoder’ use

Attribute Set 3D

<

Mathematics v ?

[ MathFunctions v| sqrt (Square root Insert —

Formula (like 'nearsti + ¢0 * farstk’) max(inider cider,diag_oneder,diag_twoder)

For ‘inider’ use SecondDerivative~

SecondDerivative v

SecondDerivative v

SecondDerivative »

- o lEN|

RS_-1_1 t
SecondDerivative_Inline
SecondDervative_Crossling '
SecondDervatve_Diagonal |
SecondDervatve_Diagonal :-’."
RidgeEnhancementF ilter
Laplace on similarity —
< > Aftribute Name |RidgeEnhancementF iter Add as new [l
o
Workflow cont’d: Elements Colot
Scene 1
N Inline
9. Right-click on Z-slice in the tree > Add and e
@ Volume  Add Default Data
Select Data. R o i
* 2D Line  Add Color Blended
S AN U
10. As visualization of the full z-slice will take = sdest el

some time, we will limit the inline and
crossline ranges. So, press Cancel in the stored

pop-up window.

11. Right-click on the Z-slice number > Display

> Position.

Select fiest layer

RS_1_-1
RS_1_-1
Steering s -1 1
SecondDerivative_inling
& anributes | SecondDerivative_Crossline
SecondDerivative_Diagonall
]

RidgeEnhancementF iter
;::'. Laplace on similasity

(o] Qs

Elements
Scene 1
W In-line
W Cross-line
& Z-slice
v EEn
Add *

Al
© volur IEETTRNNN 10 Histogram

~ Rand Duplicate P
2D Li Racal Maninukshion =

* 30 H tesel Manipuialion | 4 Gridiines

® op @ Lock Properties
Fault % Remove from Tn?e Resobdion "
FanliShirkSat
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' Positioning EI@

Specify the element's position

Workflow cont'd:

. .. In-line Range |120 = |a00
12. Load Z slice 1640ms between inlines 120-
400 and crosslines 350-600. Cross-line Range |350 | < | 600
z (ms) [16a9 5] [ seroll... |
v Applv|

I OOK | |o Cancel| ‘ @Help ‘

= Select = F@
13. In the pop-up window select Ridge Select Layer 1
enhancement filter from Attributes.
Stored RS_-1_-1 e
RS_1-1

Steering  |Rs_-1.1
SecondDerivative_Inline
9 Attributes | secondDerivative_Crossline
SecondDerivative_Diagonall

. [P R SecondDerivative_Diagonal2 L
14. Press OK to display it in the scene. '* RIREEThemEE merEateT ,
.,‘='> Laplace on similarity

©) cancel| | {3 Help

Workflow cont’'d:
15. Once the slice is displayed, click on its attribute in the tree to activate it and change the

color bar to Grey scales.

16. The result should be similar to the one shown below. Compare it with the attributes of the
previous exercise.

= Opesdlext V60.0pres- 20150821 finéd: F3 Demo_015 - [Scene 1]
Surery A Processng Scones View  Utiities.  Holp

o] 267 9 G8 [ -
o
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2.3.4a Spectral Blueing

Required licenses: OpendTect Pro, Seismic Spectral Blueing.

Exercise objective:

Workflow:

1. Go to the Attribute engine:
Analysis > Attributes > 3D or click
on the ! icon > 3D.

2. Choose Spectral Blueing attribute
from the drop-down list.

%/ Survey Analysis

L [l W e

Attribute Set 3D

Increase the vertical resolution ofthe seismic data with Seismic Spectral Blueing (SSB) technique.

3. FEIE;CtD t‘.' Original Seismics as “Alb | [SpectalBleing 2
nput Data.
P |\anrtDa[a 1 Original Seismics v| | Select |
4. Keep the default Single Operator
option selected. ® Single Operator O Time Variant
) Input wavelet [.‘;) v Select ...
5. Click Analyze and Create ... to
launch the SSB Module.
Workflow cont’d:
- Seismic Spectral Blueing: F3_Demo_2015 - Untitled - olEM
File View Tools Help
In order to design an SSB operator, I SHESE hEEszprPEH0
it is mandatory to analyze the 0 0
seismic and well data spectra by 1
. . . ] elect Input Data ?
loading some seismic traces and v — et =
time converted acoustic impedance | | ., '":"‘f’e‘s'"': '"”“:;"“’“S
% elact races
We" |ogs 5 Select Seismic 1 Original Seismics
404 3D Survey Area
® Full Start End Inc
. [ . 20 Sub | In-iine: |3
6. Click onthe (X} icon to pop up -
the Select Input Data window. . Load Traces
0 2" NumTrarm a0 [ 100
7. Keep 1 Orjgjna,‘ Seismics as o L Clear Traces  Clear Unselected Traces 120 Selected
selected seismic. Time
0] Select Horizon
Range Absolte
8. Click Load Seismic to load 40 o Ful O Honzon  fssant 500
random traces from the selected | ¢ o End 1500
seismic. a
. 20
9. Keep the default Sub option for T =
Time Range and enter 500 0 ; ; . R : — : ‘
0 0 40 &0 a0 100 0 20 40 &0 80 100
Start) and 1500 (End). Tim () .
( ) (End)
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Workflow cont’d:

10. Switch to Input Well Logs tab.

11. Click Load wells.

12. Select the well F3-04 and the
P-Impedance log.

13. Keep the default Sub option for
Time Range and enter 500
(Start) and 1500 (End).

14. Close the Select Input Data

window.

- Select Input Data

Input Seismic | Input Wel Logs

Define Format

FieldWells/Logs” Base Horz Time

-

Horz: In-Line  X-Line

Select Input Data

Input Seismic  Input Well Logs

Reload Wells Load ASCIl We Define Fomat.
FielkdWells'Logs Top Base HozTime HorSic InLine X-Lind
] fieid 5 1841
1F02-1 256 1460 undefined |2 33
Pdmpedance 250 1460
Pdmpedance_rel 256 1460
1F03-2 0 1841 undefined 122 B84
Pdmpedance 0 1841
Pimoedance rel 0 1841
. 5 1813 undefined 442 100
5 1813
(Clear Wells| Clear Unsele( mpedance_rel -5 1813
Time: F06-1 0 1625 undafinaa 244 38
PAmpedance 0 1625 SelectAl Log
—
= Pmpedance_rel 0 1825 Generate Al Log
Range
< B
® Sub Clear Wells  Clear Unselected Wells  Reshow Wells
Time
U Help Select Horizon.
Range Absote | Re
Full Honzon gt 500 500
@S OMakers gy isoq  |660
& Help % Close

Right-click on a well either

available.

generate a new acoustic impedance log if it is not

to select another or to

Workflow cont’d:

15. Once the seismic and well data
are loaded, you can see various
curves displayed in different
plots.

Take your time to scroll through
this window: left-click on any

curve and in the lower left
corner find out what does it
represent.

16. Right-click on any plot to see a
menu that allows to change
various display options, show a
legend, etc.

Zoom Dﬁie (C m+.WneeI or Shift+MB1)
Move Data (Ctr+MB1)

Unzoom/Unmove Data (MB2 or Shift+MB1)
B Unzoom AlVRe :

Show Legend

Display Options...

Screenshot 4

X Axis 4

Y Axis *

Help

a Seksmic Spectral Blueing: F3_Demo_2015 - Untitled

File View Tools Help

T HEHED Bl EE B2

L pEH O

100- ¥

g
S 60
g
<
4
20
T T T T
50 100 0 100
Freq (Hz) Freq Hz)
Log Input (time domain) LLog Input Detrend (time domain)
6000000
0054
5500000
5000000
a k e g4
il g
4500000 - 'k
4000000 | i ]
ﬁ JU 005
3500000 o -

T T
0 500 1000

Time ims}
|Dale iterm: Average (70.801, 90 816)

T
1000
Time (ms)

T
L 500
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Workflow cont’d:

17.

18.

19.

20.

Click on A to pop up the
Design Controls dialog.

Smooth the average amplitude-
frequency spectrum of seismic
data displayed on the Seismic
Mean plot.

Uncheck the Full Range option
for Fit Well Log Curves and
enter 125 Hz as the High Cut
frequency, thus limiting it to the
Nyquist frequency of input
seismic.

Observe changes on the Global
plot.

- Seismic Spectral Blueing: F3_Dema_2015 - Untitled =

File View Tools Help

MMecp saleE Bz L LE 0
Raw Seismic

Design Controls

Smooath Seismic Mean

FitWel Log Cuves
Low Cut High Cut

Smoothing Operator Length 5 [EHz

Ful Range 0 SHz[125 [ Hz
Beta: 03439
Design Operator
¥ Auto Cale 2
2 A 6046 [ : |z 112
Auo Cak.  Num Zero X 20

Energy. 909496 %

QC Against Input Seismic

& Help * Close

Amp (48)

2 ] |

- Eix'w
N I||'1:il‘l;. '.l l' I
i."-'r"n'l‘h ”||

o IEN

Seigmic Mean

T T
50 100
Frog (Hz)

1 10 100 1 10 100
Freq (Hz) Freq {Hz)
Workflow cont’d:
- Sefsmic Spectral Blueing: F3_Demo_2015 - Untitled = ‘:'n
File View Tools Help -
21. Tweak the Low and High Cut LT R LE- LR ER L i .
parameters of the Design 3 oo
Operator such that the residual /_’_A,\
operator (blue curve on the , 06
Residual Operator QC plot) | 1/ i ol
stays 0 in the frequency domain, z /
with a quick drop on both sides. 101 02
22. save the operator B by giving o] \ ‘ W\/U ]_J'wa
it a name. This operator is saved T———— T T
50 100 100 50 0 ) 50 100
as a wavelet. aq o 69
/ N
23. Save [ your session (optional). E Desonconios L
301 Smooth Seismic Mean
| Smoathing Operator Length: 5 M2
Fit Well Log Curves
Low Cut High Cut
100 - Full Range 0 + Hz 125 & Hz
Beta 03439
Design Operator
Low Cut High Cut
150 = Auto Calc. Full 8 + Hz 60 + Hz
The SSB operator is stored as a wavelet e el —
and can be visualize in the wavelet oo w0 By 999575 %
manager. Ll QG Against Input Seismic
& Help # Close
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Workflow cont’d:

a View Seismic - ~IEd

- | mine 442 :|Step 1 [= WellTolerance 1 km | [ Cross Hair @, € [l ™

The effect of the_ parameter tweakln_g 5 o7 \mine 442 - 1 Original Seismmice 5
of the Des|gn Operator is = Ij":f‘uz ) 9"!'0 Q?U _QIQO 10‘00 10‘10 10|20 10|30 10|40 1-*]'_

immediately visible in View Seismic
window which can be popped up by
clicking on and is updated
automatically.

« = Blueing

= Crosshine

Property Editor & x
- =
Hints & x
Zoom: (Cirl+Wheel)
Honizontal zoom:(Ciri+Alt+Wheel)
Vertical zoom: (Ciri+Shift*Wheel)) o70 980

¥ = 1 Oniginal Seismics

¥ | F03-4 : P-Impedance

Herizontal scroll: (Alt+Wheel) <

990 1000 1010

T T T T T T T T T T T T

1020 1030 1040 10fw

>

Workflow cont’d:

24. Close the SSB module and return to the Attribute Set 3D window.

25. Check if the newly-saved operator is selected.

26. Specify the Attribute Name and Click Add as new.

- Attribute Set 30
File

e AR TN LY 1
Aftribute 58t <not saveds= <Al> +| Spectral Blueing

S5B_on_Oriinal_Seismics Input Data | 1 Original Seismics
Analyse and Create

® Single Operator O Time Vanant

Input wavedet i | Spectral Blueing Operator_sb

Attibite name | SSB_on_Oriinal_Seismics

Add as new

i Save on Close

Close

- oEN
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Workflow cont’d:

27. Right-click on In-line in the tree and
chose Add and Select Data.

28. Select 1 Original Seismics from Stored
tab and press OK.

Elements Color
Scene 1

N |In-line
@ Crosg_Add Defautt Data

PRI Add and Select Data
@ Volur  Add at Well Location
~ Rand  Add Color Blended

= AN e .
= Select =R EoR ="
Select first layer
9@ Stored 1 Oniginal Seismics -
3D UVQ 6 biased Texture+Energy +SystemsTrac
Steering 3D UVQ Texture+HC attribs+ Energy disk
4 Dip steered median filter
Attributes 5 ChimneyCube
7a Al Cube Sid
% 7b Al Cube from HorizenCube v
Filter *
O canca] @ e

Workflow cont’d:

= iy In-ine
&) 4251
ggl Add [ Ambwe |
¥ Cross D\Spl_av " Volume Builder Attribute
; Sjl'ce Duplicate & HorizonCube Display
U Reset Manipulation = .
3 - Syste Tracts Di
~ fagd.ﬁ Display Prestack Data » psiomsiTiects Display
54 Cormelate with Wels

29. Apply the SSB attribute on inline
425 and compare the result to the
original seismic data: Right-click
on In-line 425 in the tree and
follow Add > Aftribute.

v 4 g Lock Treeitem
2D Lir == Remove from Tree
% 3D Horeor
= vl Demo 6 —> F58

30. Select SSB_on_Original_Seismics
from Attributes tab and press OK.

= Select
Select first layer

@ Attributes

o

Stored

55B_on_Original_Seismics

Steering

@ Cancel | | @ Help
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Workflow cont’d:

30. The results should be similar to the ones shown below.

1 Original Seismics SSB on Original Seismics

31. Compare the original seismic and the SSB seismic: tick on and off the overlaying
attribute in the tree.
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2.3.5a Optical Stacking

Required licenses: OpendTect.

Exercise objective:

Workflow:

1. Right-click on 3D Horizon

® Body  Track New
select Demo 6 --> FS8. el

2. Launch the Attribute Set 3D

. Fault Add at Sections Only
in the tree >=Add... and Fault  Add Color Blended ..

Create with Constant Z ..

Enhance the amplitude anomaly on a random line with optical stacking.

Aroa subselection 1007300-TS0/1 250 (463 samples) © Select

Qo || D) Cancal | ighHeip
Daey_201515urtacesDomo_6_—_FS8 hor

window. 7 Suvey Analysis S e
o Bl % ch e

2D... I
AT 1

3. Choose Volume statistics
attribute from the drop-
down list.

Aribute 500 <nol s>

4. Specify parameters as |
shown on the image to
define an RMS amplitude
give it a name and press
Add as new.

Save on Closa.

*Pe ¥R A AR

=] Vohama Statisics /7
Input Dt 4 Dip steered median fler ] O Seloct
Tima gatn (ms) 28 28 7] Aliow edgn effocts
Sheapo | Cybndes =
Swopot w0 3 o0 2
Min e of vakd traces 1
Oufipnd statestic RMS bl

Stoaring Nors -

Adtribute Hame RMS_Ampl A os v [

G Closa | | i Mo

Workflow cont’d:

5. Right-click on Demo 6 --= FS8 > Add >
Attribute.

6. Choose the RMS amplitude and click OK.
Optionally, change the color bar for RMS
amplitude to Rainbow Plus.

7. Right-click on Random Line in the tree >
New > Interactive ...

= Annotations

“® 30 Horizon
7 -

2o I | TR
! 2D Horizor 3 At

Fault D] " Volume Builder Attribute
FaultSticks Trecking ' Contour Display
® Body It ' Horizon Data
L wel Workflows *

i PickSet |l Save
[ Polygon | & save as
Sy Prestack E & Lock Treaitem
== Remove from Tree

oot S
Select Layer 2
sered  IEEST
Steering
@ Adtributes
B
[ @0k | @ cancel | @tep
O Tine Add Default Data
@ 3D Horizon | Add Stored .
+ Demo 6 >
¥ RMS_Ar Add Color Blended »
@ 2D Horizon

From Existing
From Polygon
From Table
From Wells

Fault
FaultStickSet
Body
Well

¥ PickSet
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Workflow cont’d:

8. Pick arandom line going

through the structure where the

amplitude anomaly is seen.

Using the left mouse button,

click on the map to inserta
node.

9. Right-click on a newly picked
random line in the tree > Save
as ... and type in a new name.

~ Random Line
Gl Randd
<40 o
20 Line
® 3D Horz
| Demo
¥ RM

Fault

Display Li
Duplicate

Creale 2D Gnd ...

o DT
'2DHGm Save as ..

Save as 20

amplitude map
e

= Save Random Line 2.
Select oupul Random Ling

Filnr *

i

Examgle mndom contour demo 1 > MFE

Export_Poiy! AL
Ftandam Line 1 {Irining marssal)
e el <

FaultStic & Comelate with Wels .
® Body | g Lock Treeitem Hama Optical Stncking
gt G Eort o Google KhL [T
.D Polygon == Remove from Tree
Workflow cont’d:
= Survey Analysis
10. Launch the Attribute Set QL 2; 12
3D window. %L
h T 1
11. Choose Volume statistics | L
attribute from the drop- e R L L T —
down IISt nm;;:,q,,lp. i Inpust Dt 4 D stened midisn fier -. O Salact
Tima gate (ms) 0 o < Miow adge offocts
12. Specify the following Sheps (Opecs sk
parameters to deﬁne an Mml!‘:i::x -J % Derocbon @ Porpondeculsr Limo
optical stack: 4 Dip Oukut sttt e
steered median filter as : stooring il
Input Data, [0, 0] 'rlme 7 Sivering Duta g 3 Steering BG Background =| | © Saedoct
gate, Optical stack Shape, —
Stack stepout of 15, Full
Steering by 3 Steering BG e Coteatslck s
Background. e o] LOrw

Stack stepout of 15 is equal to 375m at the bin size of 25m.
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Workflow cont’d:

® Volume
»  Rendom Line
ight-cli T | YT
13. _nght click on the random g 2o ta Deply A T
line in the tree > Add > > @ 30 Horh giféf;fnp . @ HorizonCube Display
Attribute :gﬂ Create 20 Grid . i} Systoms The =

49D Hori ® Saveas ..
. ! Fault Save as 2D ...
14. Choose the optical stack o TS S
attribute from the Attributes mwg oot oo KL

list and click OK. [ Polygor == Remaxs from Tree

»

15. Optionally evaluate the
Stack stepout parameter.

LOK |[@Gucal [ @tas.|

Compare the optical stack attribute to the input seismic data.
Discuss the results: What events have been preserved, what events have been enhanced, why?

4 Dip steered median filter - Optical Stack
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2.3.5b Seismic Feature Enhancement

Required licenses: OpendTect Pro, Spectral Feature Enhancement.

Exercise objective:
Enhance the amplitude anomaly on a random line with Seismic Feature Enhancement (SFE).
Workflow:
Processing Scenes View Utiies CLAS Help
. Atribut v = = = . @
1. Go to Analysis > ARK CLS = taSEXT-o=@
pegs . . % Volume Builder .. i &
Utilities > Seismic Feature Cross-plot | Cotor]
Wells >
Enhancement. ey ; ‘
. . Seismic Coloured Inversion
2. Keep all the SFE windows open AKX Ut * |\ Seismic Spectral Blueing ...
. ilities L b
and go to the OpendTeCt main < Fluid Contact Finder ... Ei
window. Neural Networks -
-~ Load RandomLine Geometry = = I’
3. Right-click on Random line in PR e
the tree > Add Stored .... < 3D Horizon Fiter |+
< 2D Horizon |~ Add Color Blended *
. Fault MNew 3 Example random contour demo 1 -> MFS4
4. Choose the random line created ERkSiS-CE = r—— v
in the previous exercise 2.3.5a Ropdom Line through wels exended | (9
and click OK. >
of OK 8 Cancel @ Help
...S\Locations\235a_Optical_Stacking.rdl
Workflow cont’d:
= ~ Random Line
. . . Q7] 235a_Optic....
5. Right-click on the random line name v 4 Dip ste..| A 5
in the tree > Display > Position. el la_Histogram
@ 2D Horizon Duplicate 2 Properties ...
Fault Reset Manipulation Resolution *
Fault Stick Set Create 2D Grid 3 ™
S Body @ Saveas ... osmon... "
Well nsert Node
“ Pickset Saveas2D ...
6. Keep the Random lines window open. - Random lines - oIEl
This window lists In-line and Cross-line Specify node positions
positions of all nodes of the selected
random ”ne YOU Wl" need thlS Enter X/Y or InlCrl positions .NodeomsideSurvey
information in one of the next steps. £ u [oineBISINC rose ne iy
Node 1 620677.22... 60812238... 390 902
Node2 62182286... 60796052... 324 946
Mode3 622531.80... 60783996... 275 973
Node 4 62324967... 6077769.4... 249 1001
Node 5 624182.83... 6076595.0... 201 1037
Node 6 62478343 60756865 .. 164 1060
Node7 62522516... 60741983 104 1076
|Node 8 .
Z range (ms) 0 1848
of OK 88 Cancel @ Hebp
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Workflow cont’d:

7.

10.

11.

Go back to the SFE main
window and Click on Select
Data icon =.

Clickon Input Volume in the
Select Data window

Choose 4 Dip steered median
filter in Select Volume window
and click Select.

Click on OutputVolume in
the Select Data window.

Enter a new name of the
output dataset and click
Select.

File Seismic Process Help

Seismic Feature Enhancement - untitied

= Select Volume

D H|=|0= > 5
8 Select Data ? n
Seismic
| Input Volume... I
Qutput Volume...
Traverse
Select...
Inline Crossline Insert
1 Delete
@ Help X Close
= Select Data * HEl
Seismic
Input Volume... 4 Dip steered median filter

Traverse
Select
Inline Crossline Insert
1 Delete
& Help X Close

* IEN
Fier

1 Onginal Seismics -~
3D UVQ 6 biased Texture+Ene
3D UVQ Texture+HC atiribs+ E
4 Dip steered median filter

5 ChimneyCube &
<

>

Filter options
& Help = Cancel
=B Select Volume  ? n
Filter:
1 Onginal Seismics ~

3D UVQ 6 biased Texture+Ene
3D UVQ Texture+HC atiribs+ E
4 Dip steered median filter

5 ChimneyCube -
< »

| Name Enhanced Seismic |

| Filter options

@ Help x Cancel

Workflow cont’d:

12. Enter manually the random line node positions in the Traverse section from Step 6.

ks Random lines

Specify node positions

- oIEN =

Select Data

» IEN

4 Dip steered median fitter

Table from Step 6 Seismic

Input Volume..
Enter X/Y or InVCrl positions . Node outside Survey

Output Volume..| Enhanced Seismic

X Y In-line Cross-ine |*

Node1 62067722 . 60812238 (390 902 Traverse
Node? 62182286, 60796052, (324 945 Select.
Node3 622531.80.. 6078399.6... |275 973 Inline Crossline
Node 4 62324967.. 6077769.4... |249 1001 1390 902
Node 5 62418283 . 60765950, (201 1037 2 324 946
Node6 62478343 60756865... [164 1060 32715 a73
Node7 62522516.. 6074198.3... |104 1076 4249 1001
Node 8 5 201 1037

6 164 1060
Zrange (ms) 0 1848 7 104 1076

« OK | §8 Cancel @ Hep @ Help

13. Close the Select Data window.

14. Close the Random lines window.

Alternatively, digitize the

picking a polygon that you can select as input
for Traverse by clicking on Select button.

random line by
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Workflow cont’d:

=B Seismic Feature Enhancement - untitled - olEN
File Seismic Process Help
15. Click on Aperture Designicon @ in D= ® =[@-> » =
the main SFE window. !

= Aperture Design 7 IEl
16. Enter 375 m and 75 m as Traverse Aperture Contral |sRaramedirs,
normal and parallel aperture sizes. A’:":;:g:f o ipse & Scal
17. Close the Aperture Design window. Disply idesmated

Traverse
Normal

Aperture
Size

(in project
spatial units)

sm

All traces inside the ellipse are
stacked and the result is output at the
center of ellipse.

Traverse Parallel Aperture Size 75 =
(in project spatial units) =

Qutput 3D Swath Width
# Auto Custom: 0.0 meters
Additional Decimation

Inine 1 % Cross-ine |1

Workflow cont’d:

18. Preview SFE results by clicking on p icon in the main SFE window.

19. Display Seismic by clicking on = :: icon if it is not displayed yet.

= Seismic Feature Enhancement - untitied — © [IEEN a Seismic Display - oIEl
File Sesmic Process H
el =0 > " | Separate display  Display Enhanced lll ?
Proview SFE Original seismic section
? ZIO d‘ﬂ E:ﬁ 8|0 1(|)U 1%0 1?0 1‘50 1?0 2?0 2[21‘1 2?0 Z(ISO 2Ian
— 400
500
— - - L 600
Startsthe SFE processing fr Preven SRR - = : =
700
= Sesmic Feature Enancement - untitied — © I3 - -
SFE processed section
File Semic Process  Help
oy 0 20 40 60 80 100 120 140 160 180 200 220 240 260 280
@ =a=spT = P P P I I WP PPN TP PP P T P P T P
R S e ] = ==
51057 G n 1
o157 e T Sogmu 1 4004 400
16:19'59: Processing Traverse Segment No 2 ]
16:20 00 Processing Traverse Segment No, 3
16:2002 Processing Traverse Segment No. 4 500 500
162003 Processing Traverse Segment No 5
16:20:05: Processing Traverse Segment Ho, 6 ]
182007 SFE Processing complete 9
600 — 600
700 = 700

Paps up e kot ispays e« ERETERAR
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Workflow cont’d:

20. Start Processing by clicking on ) iconin the
main SFE window.

21. Click Overwrite to output SFE results along the
traverse.

Question E3

e This process is about to write seismic data and will
over-write any data already in your output volume

This process may run for a long time

Press 'Overwrite' to continue or 'Cancel to abort

Cancel

22. Optionally, follow File > Save As ... to save your
session.

/= Seismic Feature Enhancement - untitled — & | x|
File Seismic Process Help

D@ za= D] =

16:19:57: Start SFE processing

16:19:57: Preview mode Start Processing
16:19:57: Calculating 3D swath coordinates

16:19:57: Processing Traverse Segment No. 1
16:19:59: Processing Traverse Segment No. 2
16:20:00: Processing Traverse Segment No. 3
16:20:02: Processing Traverse Segment No. 4
16:20:03: Processing Traverse Segment No. 5
16:20:05: Processing Traverse Segment No. 6
16:20:07: SFE Processing complete

Starts the SFE processing or restarts hm

F= Seismic Feature Enhancement - untitled = = IIESM
m Seismic  Process Help

O New CsN |==| p ) ™

@ Open_  Ctl+O T
& Save Ctri+S &

D swath coordinates
- averse Segment No. 1
Exit faverse Segment No. 2

16207007 Processing Traverse Segment No. 3
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2.3.5¢ Fluid Contact Finder

Required licenses: OpendTect Pro, Fluid

Contact Finder.

Exercise objective:

Enhance the amplitude anomaly associated with a structure with Fluid Contact Finder (FCF).

Workflow: ® 3D Horizon
12D Hol  Add

1. Right-click on 3D Horizon in the tree > Add ... Fault Add at Sections Only ..

i ga‘éﬂs Add Color Blended ...

. ody

2. Select Demo 6 --> FS8 and click OK. L Well Track New ...

“ PickSe Create with Constant Z ...

' Select Input Horizon (s) o] @] =]

w - Filter =

[[1>Demo 0 —>FS4 <

[7] Demo 1 --> MFS4
Demo 2 --> FS6

] Demo 3 —= Top Foresets

[”] Demo 4 --> Truncation
Demo 5 --> FST

7| Demo 6 —> FS8

\I”1 Demo 7 --> shallow

- a

x

¢4

Area subselection 100/300-750/1250 (463 samples) (© select .|

\0 Canceil [ €9 Help

...aning_vB\Surfaces\Demo_6_--__FS8.hor

down list and Select 4 Dip steered median filter

Workflow cont’d:

3. Open the attribute window g"?l'

4. Choose Similarity attribute from the drop-
data as input.

5. Set the time-gate to [-12, 12] ms.

B. Select Steering as Ful| |*ess s
and use 3 Steering BG | "5
Background.

7. Specify Output
statistics: Min.

8. Name the attribute Min .
Sim and Add as new. 9

®

3 |S!m||amy

| |2

-] |© Select..|

| Input Data |4 Dip steered median filter

[Time gate (ms) -12 12 ]

Extension |Cross

Stepout |inl:1 = e

]

Steering Data Lé & | 3 Steening BG Background

Steering | Full

=] |© Select...

| Qutput statistic  Min

| Attribute Name | Min Sim Add as new] )
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Workflow cont’d:

4 ® 30 Horizon

9. Display the attribute on Demo 6 --> FS8 by + {7l Demo 6 > Fs8

right-clicking on Z values in the tree > Select T S CEtEE b
Attribute > Attributes > Min Sim. Fonsl]  SemesHoizon Do | eedD 2] Mg
s ?.:;:‘ Tools *|  Stored 2D Data »
# PickSet| MoV | Atributes 2D
[ Polygon Steering 20 Data »

Workflow cont’d:

10. Create a new polygon by right-clicking on DS';'.';;E;

i 8P Add ...
Polygon in the tree > New. | ;\nmg:;ic
11. Name the new polygon: Bright Spot.

' Create New Polygon = -5
Name for new Polygon Bright Spof] |

Color | NN | (= OiveDrab -

[@0x] (O cancel (@ e |

12. Draw the polygon using left-click, as shown =
in the image. "PP% & Ctrl + Z to undo the action.
< | Ctrl + Left-click to delete a seed.

13. Right-click on the polygon in the tree (or in
the scene) > Close Polygon.

14. Right-click on the polygon in the tree > Save. ;

2-[2 Polygon
1] Bright Spo
= Prestack Even  Display »
#- Annotations Calculate Volume
| Close Polygon
#l Saveas
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Workflow cont’d:

15. Go to Analysis > Fluid Contact Finder (or click on the ___1#4'—" | Analysis | Processing Scene V

: ol Aftributes L

icon).
& Volume Builder ..
Ei Cross-plot Data »
& Wells 12

16. Select the Demo 6 --> FS8 horizon, leave the default Input & Layer Modeing ’
Cube 4 Dip steered median filter. fiid Contarl Findens
17. Click on Select for Volume subselection and choose Bright
Spot polygon created earlier.
= Fluid Contact Finder - Mam window = e o o eloEs
Horizon S| Demo 6 = FS8 - |© Select | P Specily Posiion
Analysis type @ Poststack © Prestack
— Volume subselection | Polygan -
Input Cube Seh ‘Eh| 4 Ow steered median fiter - | D Select
vome o — Folygon Bright Spot - [© seiect . I
Inine/Cross-line Step 1 H 1
Z range around horizon -184.8 1848
Time Range (ms) 0 Do1848 D Step 4
Include amgitudes | ANl -
Contour Z division 0 1848 Step & OCancel @ Help
QRun Q) Close | | ) Help

Workflow cont’d:

later. Also leave the Z range around horizon as default.

For the first test, contour Z division as the entire Z range of the survey. This can be restricted

18. Click Run to start the extraction and clustering of the data

" Fluid Contact Finder - Main window

Horizon g Demo 6 --> FS8
Analysis type @ Poststack © Prestack

Input Cube ;_“:; ; 4 Dip steered median filter

Volume subselection P: area 100/945-286/1134 (463 samples)
Z range around horizon -184.8 184.8
Include amplitudes |All =
Contour Z division 0 1848 Step 4

* | © Select |

* | Select ...
[O Select..._.

OCIose] [ ) Help

oo
e |
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Display types available in FCF analysis window:
Stack: traces are stacked along depth/time
contour bins and plotted as a 2D profile. The
display can be flattened on a horizon. The
stacked traces can be stored as a 3D volume if
Flattened is checked.

Single Z: traces belonging to a single contour bin
are displayed in a 2D viewer.

Directional: FCF-stacked amplitude at the
harizon as a function of the distance to a selected
position and the azimuth sector.

ST e R——
w . RN R PR T g e N Rt

: Rege— -.\gﬁ-
LTS AN traces lying along a particular contour (in 3D) on the ?-3 8

e,

= P Cantact Fider - Amabysn
Distribution of horizon Z vahies

sfas 5 54

550 5653
Vien
L = m—| L
Stack
Stacking
Wrte Cude

(SR ] (O cwse] [ @ e

The image on the left (not from F3 Demo
survey) illustrates the FCF stack concept.

Workflow cont’d:

e pp——
19. Choose Display type as Stack, uncheck
Flattened and click Run. o
This window will remain open so that e o
several FCF analyses can be run. ——— )
O Chse| | @ Heip
20. The FCF stack shows stacked | [T i ! ] i
traces along common contour (i 5 5 e e i T I
bins of Demo 6 --> FS8 = s =t ) ) ) b
horizon. The possible fluid , ’ i) 0 5= l
contact is highlighted: observe _ - ———— = S
the drastic amplitude change = P — y iy e ——
at the flank of the structure. R 5 1 e | 11
= = ! et HC-Water Contact !
=5
— [
T —
___"—‘k—:-—_:_._ —
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1.4.1a Well Tie

Required licenses: OpendTect.

Exercise objective:
Tie a well to the seismic and extract a deterministic wavelet.

Workflow: - Well
# Pick  Add ..
. . . ) I D Poly 45 Tie Wellto Seismic
- > d
1. Right-click on Well in the tree > Tie Well to Seismic... B PreS | Now WellTrack .
Annotatrorrs———
Tip:

Well to seismic tie module can be also launched via:
- Analysis > Wells > Tie Well to Seismic...
- Right-click on a well name in the tree > Tie Well To Seismic...

7 Survey | Analysis | Processing Scene View Utilities CLAS Help 4 A We||'
Ly il {4 Attibutes , ~Eg @ > B Lk [v] F06-1 i
[vI|F03-4
Tree ‘% Volume Builder ..
% Elef B Cross-plot Data , i F03-2 Dz ry) ’
- "¢ ¥ F02-1 CLAS LogPlot
gIAEes il A | Edit Logs i PickSet iy Tie Wellto Seismic
& N & Layer Modeling » | A Tie Wellto Seismic ... 0 Pol il -
- { olygon Create Attribute Log ...
xx S i N
| e T S Prestack Create Log Cube ..
- | q: nnotations ¢ it welltrack
@-| 77 sss 8 c
~ 4 Z, Thalweg Tracker ... SENE )
Velocity Model Building ~ * o Lock Treeitem
A Well Correlation Panel . == Remove from Tree

Workflow cont’d:

2. In the Tie Well to Seismic window: choose F03-4 well, check the options to be as
shown below and click Run.

- Tie Well To Seismics - oIEN
Select Data to tie Well to Seismic
Well (& [Fo3-4 v] © Select ...
Seismic | 3D Volume >
[+ Input Cube Aé ‘e | 4 Dip steered median filter v | © Select ...
Density Density ~| kg/m3 (Kg/m3) ~ 2| B
PWave | Sonic > us/m (Microsecon ~ | ¥ Sonic 3 B

Use existing depth/time model

Reference wavelet | stat 120 ~| | A, Manage Wavelets ... |\ Extract ...

[] Save as Default ) Close| @ Help
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Workflow cont’d:

" Tie F03-4 to 4 Dip steered median filter

- O
Sonic Al Synthetic: Seismics
59 4500000 027256 08 2,5 75 10 125 14
A S| e e84 | v624]
oo ||| 1109 31100 1100
1Ro0 1200 12007 ii%i
100 1300 1300 E I } I ‘E
£~ F ;
- i 368 T ismic—
11?[’7 52 2100 2200 2300 FeP | | 9%570s6 025 0 0.0250 os 1657 Syn{rFIS)etiC seismic Extracted sefeimss
4 Zintime Wavelet | stat 120 - 7 Track | Peak ortrough ¥ | Apply Changes Undo Clear picks = Clear last pick
Ozinmeter  Extracted |Og$ Computed |ogs NrTraces Quality Control .. |Match markers and horizons
OK/Save info ... Help Cancel

Al:3872880.25m/s x kg/m3 Reflectivity:0.00442575 MD:1414.09m TVD:1414.00m TVDSS:1379.90m TWT:1399.83ms

Markers are loaded by default.

28000 BLG X

Workflow cont’d:

3. Click on q icon to load already mapped horizons to be displayed on the extracted
seismic traces: Check horizons from Demo 1 to Demo 7 and click OK.

= L) Load 3D Horizon(s) - B [ x|

Synthetic: i

| rl?a‘g% Select input 3D Horizon (s)

s
99 —d 8 9 12 L
| : o =2
| [
i (m] « Filter * R
i %’
[l Demo 1> MFS4 NI= D\
Demo 2 -> FS6 4
' Demo 3 —> Top Foresets G
k‘é Demo 4 —> Truncation 2
Demo 4 —> Truncation trim & fill g
o .
T EERE

©
3
S

X @

.
| 40
1400 Demo 5 —> FS7 R R R | 2
| [v] Demo 6 —> FS8 5 5 ]
[~] Demo 7 — shallow v =
< >
1500 500 !
ry et
8/51 chosen
1570
S v
| |"Wfrse2 2100 2200 2300917 || 067056 0025 0 0.025 0051557 ‘ (ms) nline
Density Reflectivity
Zintime Wavelet | stat 120 = Track [Peak ortrough ~ | |AppijChanges| | Undo Clear picks | |Clear last pick
[ Zin meter NrTraces[s | Quality Control ...| |Match markers and horizons
OK/Save info ... Help Cancel
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Workflow cont’d:

4. Zoom in using middle-mouse scroll button and pan by pressing middle-mouse button:
hold and drag up/down until you have a display to pick matching events.

" Tie F03-4 to 4 Dip steered median filter - a x
“3312[(5’2) agusmscgo 5824569 || 334 (7;5;) Asugu;‘u 6027286 3 12 Ti-j
=T )
F3S1) ‘. ;r> ----- = J
o e T oo Tk
3 - 500 00 =F ? % ? ? ? =
1 +
Tr Trr===== === ---- =5 Tuncatio] e e dondonn] =t
o T ><Top Fores: %
C ..
00 00 || s00 20 S 5 5 > > |9
- N
FS FSOr e sme S e e S =g =S e
MF MFS|
FS4 FS4
FS3r=-=2 P FSg====zp=3 'JE § % \i 1 \%
We 200 2200 290098 || $80s6 0028 o 00260 ool fnline=>
Density | Reflectivity |
M Zintime ‘Wavelet stat 120 v Track Peakortrough ¥ Apply Changes Undo Clear pigks  Clear last pick
[ Zin meter NrTraces Quality Control .| |Match markers and horizons
OK/Save info ... Help Cancel
Sonic:1e30us/m Density:1e30kg/m3 MD:421.19m TVD:421.15m TVDSS:387.05m TWT:411.91ms
Workflow cont’d:
. . ) . ™Y
5. Activate pick mode with the icon ©g
Synthetics Seismics z B
= . 0 125 G
6. Pick matching events on the 4958 =
extracted seismic then synthetic -
traces (or synthetic then extracted 6001 e
seismic). 2
unca -t
7. Optionally, to change your picks: 7007 |i|
click Clear picks or Clear last pick if —
needed.
=

800

975

TWT (ms)

Track Peakortrough - Apply Changes

info Help

Seismic™

Undo [ Clear picks [[Clear last pick|

Display additional information ... Match markers and horizons

Cancel

VD:554.18m TVDSS:520.08m TWT:545.42ms
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Workflow cont’d:

8. After picking the events, click Apply
Changes to reflect the changes.
9. If not satisfied with the result, click

Undo to revert the most recent step.

Synthetics

Seismics

4956

As only the previous step can be reverted
using Undo button, it is recommended to
save intermediate T/D (Time/Depth) curves
by clicking on the iﬁf icon and exporting to
a text file.

Saved T/D curves can be (re-)imported at
any time via the same window or via Well

800

VWY
vt

900

F

Defio2-->FS6

975,

M an ager. TWT (ms) Seismic~
Track Peak ortrough  ~ | Apply Changes Clear picks| Clear last pick
Display additional information ... Match markers and horizons
N
info ... Help Cancel
VD:554.18m TVDSS:520.08m TWT:545.42ms
t) -
Workflow cont’d:
10. Click on Quality Control to check the Cross-Correlation Coefficient.
 Tie F03-4to 4 Dip steered median fifter - o x
Sonic Al Y 2 B
3917521 450 500 5824559 || 3343759 4500000 6027256 fNT
416 2#5—J——4152 46 23WJ——4162 =
MESk=== . @
Fstr=== --1 g
O I - a*
Fogrm== -
- -] (=)
& =T soo
o - — = a4
Tr=== =] - Tf== v e 1+
Togt==- e Togt=+ S %
1% > xe
= s =3
= 1
800] = 800 800] T 800 800 ‘
el = [ ~
Fsgr=---=zf g Fsg
MFS] MFS
Fsd Fs4
1000
10001 1000 10001 1000
Fs3 O = -
ESoR== LLL » LLLLLI LL LLLLLLL 1081
W In-line—
Won om0 2000 2009 | Do o0 o ooae0 ot ms) ine
Density Refiecthity
K zin time Wavelet | stat 120 = Track |Peak ortrough v | [Apply Changes' | Undo Clear picks | Clear last pick
[ Zin meter NrTraces[s 2] Match markers and horizons
OK/Save info Help Cancel

Sonic:1e30us/m Density:1e30kg/m3 MD:421.19m TVD:421.15m TVDSS:387.05m TWT.411.91ms
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Workflow cont’d:

11. Choose Compute Data between
Markers and select top and bottom
markers, for example FS11 and FS3,

Cross-checking parameters

_— |

Compute Data between Markers

| [FS11 ~||FS3

Set active Wavelet

® Initial - stat 120 O Estimated

Cross-Correlation Coefficient: 0.5960489 |

0
to define a window of interest. ’ e
. = 025
Note that Cross-Correlation 3 U%%WXJW\ L A
Coefficient, the graph and the ora onm S, I.’ l'H.HlU
Estimated wavelet are immediately  syeiciossmesae assseasisn |l 1!.0 L
updated. Estimated wavelet length (ms) 120 Lags (ms)
@ Close| | @ Help
= Cross-checking parameters - olEd
Compute Data between Markers ~||FS11 ~||FS3 -
12. Optionally, switch to Estimated
e g . . Set active Wavelet Cross-Correlation Coefficient: 0.6532883
(deterministic) wavelet option: see ittt 120 @ Ei]
that the synthetic traces change in "o
the main Tie Well to Seismic window. _— s
The scaler applied to the seismic has I
also changed and should be close to @4 & O L & 229 L
1 Synthetic to seismic scaler: 0.98019022 0 5,3
. 200 -100 0 100 200
Estimated wavelet length (ms) | 120 Lags (ms)
@ver
Workflow cont’d:

Click on icon to save:

* Acoustic Impedance, Reflectivity and Synthetic as well logs or as seismic cubes.
+ The initial (loaded) and/or estimated wavelet.

L Tie F03-4 to 4 Dip steered median filter - 0 “
Sonic Al Synthetics Seismics 2
(B 60 S0 et oo 05 25 5 75 10 125 1:.@
e "~ Save current data - ] X
MFS| L]
e ! Check the items to be saved ; ; Ee ]
600
=
Log(s) M Al Reflectivity (/] Synthetic r % é' Q
. Saveas @ Log O Seismic cube ) b ~
L X
.
| L B
A , % '% 5
200 Output Name [v] with suffix |from well tie > S N
1 Wavelet
ME
'S4 i Sample interval (ms) [1
=
< = Initial wavelet | stat 120 v|| € Select...
ko 210 ) Seismic
Density Deterministic wavelet [lerministic wavelet from well F03-4 v |[ &) Select...
M Zintime picks Clear last pick
O Close 0 HEIP nmarkers and horizons
OK/Save info ... Help Cancel
Sonic:458.79837036us/m Density:2165.28588867kg/m3 MD:684.35m TVD:684.31m TVDSS:650.21m TWT:682.92ms
I
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Workflow cont’d:

13. Click on OK/Save button to save the T/D curve as an active T/D model of the tied well.

= Tie F03-4 to 4 Dip steered median filter

- o x
Sonic Synthetic i
309676 450 500 5842978 || 332 301 . Tt
sor L0 £ s 07| sor7
Fs1 - Fs1 o
MFS] |®
Fs 2
3 &
o0l oLV o0
(=%
- ™ 3 LR
- - 4 o
700 7855 - 700 7007 Top Forgeets \
800 800 00 = s é. é. } } é
Fsgr=s= -- Fegr===
166 900 || M6 9007
1948358 21002200 2302902° %’tfémao 00250 0.0250.051753° (ms) ine
Density Reflectivity
Zintime Wavelet  stat 120 - Track Peakortrough v Apply Changes Undo Clearpicks  Clear last pick
[ zin meter NrTraces Quality Control .. |Match markers and horizons:
OK/Save info .. Help % Cancel
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1.4.2a 3D Auto-track

Required licenses: OpendTect.

Exercise objective:

Interpret a horizon using 3D auto tracking

Workflow: .
Survey > Pre-Load > Seismic...

For details on pre-loading see Exercise 1.3.1b.

1. Pre-load 4 Dip steered median filter.

2. Right-click on Random Line > Add Default - Random Line

. . i 2D Line Add Default Data
Data'. The d_ata dlsplayed is 4 Dip steered @ 3D Horizon Add Stored _
median filter in the middle of the survey. igu:"”m" e
A A ) ) FaultStickSet New b
3. Right-click on 3D Horizon in the tree > New > _
Auto and Manual Tracking. oHor
Fault Add at Sections Only
FaultSti Add Color Blended ...
4. The Horizon Tracking Setup control center © 5 New : > | AutoandManual Tracking .
H . ) Track Unconformity
pops up (nEXt Sllde)' D z::?;so? Thalweg Tracker ...
¥ Shapefile From Well Markers ..
&\ Prestack Events With Constant Z

Annotations

You can interpret on inlines, crosslines and random lines, in the 3D scene and 2D viewer.

Workflow cont’d:

5. Choose the tracking mode: Section Auto-track (from seeds) and Select Seed Trace as

traCkIng method. “ Horizon Tracking Settings - <New Horizon 1> - O X

Mode  Event Correlation  Properties  DipSteer

sl @® Section Auto-trac

(O Manual Draw

@ | enoa

»
@re
Method:
+ Seed trace: compares amplitudes against the seed reference (recommended for most
horizons)

« Adjacent parent: compares amplitudes against the last tracked position (increased risk of
loop-skips; recommended for easy horizons).
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Workflow cont’d:

6. Click on the Event tab.

7. Select event type Peak and leave the search window as default for now.

' Horizon Tracking Settings - <New Horizon 1> = m} X

Mode Event Correlation Properties DipSteer

s Event type wvA [JvD Display after picking a seed
Threshold type | Relative difference v
o Allowed difference (%) t25 |
(44 [ =i/ =7 '
Search window (ms) »-3 < »8 s ‘\:| Symmetric
-
Data Display window (ms) |-16  |5/(16 5| [] Symmetric

Nr Traces t5

Picked on: 4 Dip steered median filter

ANNNAN
@

Use the green lines in the waveform display to change the search window

It is possible to change the event type during the interpretation

Workflow cont’d:

8. Click on the Correlation tab.
9. Setthe use Correlation toggle to Yes.

10. Set the Correlation threshold to 60%.

" Horizon Tracking Settings - <New Horizon 1>

Mode Event Properties  DipSteer

Use Correlation @ Yes (O No WVA [JVD

compare window (ms)[-40_=][40 [z]Osymmeric [k B B B P

Correlation threshold (%) :SDO 5 Snap to Event
(>4 - — -
Data Display window (ms) .-48 5 ‘_48 £ ‘[] Symmetric

NrTraces :5 >

[Ooee] | @wer

Tracking with correlation is more accurate, but it takes more time to compute.
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Workflow cont’d:

11. Set the selection of Steering to No.

' Horizon Tracking Settings - <New Horizon 1>

Mode Event  Correlation Properties DipSteer

Use Steering O Yes @ No

3 P&y | PCA 1M Select Pre-load

y @ @

@ e

This option is only available if you have a dip-steering license.

It ensures that the correlation window follows the seismic reflectors by steering the window
along the pre-calculated dip. This option lowers the risk of loop-skips, especially in areas with
steep dips.

Workflow cont’d:

12. Optionally edit the display properties.

=+ Horizon Tracking Settings - <New Horizon 1> = m] X

Mode Event  Correlation DipSteer

Horizon Color

Linewiatn [ 3
= Seed Shape/Color | Cube v
P> -
g Seed Size I 2
~
Parents Selections
Locked | [

@

We recommend the Horizon Tracking setup window to stay open during the entire
interpretation session. Parameters can thus be adjust at all times. To re-open the window,
use the % icon in the toolbar in the lower section of OpendTect main window.
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Workflow cont’d:

13. Pick a seed on a Max event (as selected earlier) on the displayed random line.

14. Click on the €& Auto-Track icon in the Horizon Tracking Setup window.

In horizon picking mode, the cursor is a cross. You need to have the horizon active in order to
interpret. You can make it active by clicking on it in the 3D scene or on its name in the tree.

Workflow cont’d:

15. QC the auto-tracked horizon patch:
a. Select the new horizon in the tree.
b. Setthe display of the horizon to “sections only”. press the shortcut v/V key.
c. Move the random line through the patch: click and drag the line.

16. If the horizon patch looks OK but is rather small: change the amplitude correlation
parameters and redo.
In this case, change the correlate window to [-20, 20] ms.

17. Click on the Retrack-All icon €2 in the Horizon Tracking Setup window.

Correlation window [-40;40]ms Correlation window [-20;20]ms
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Workflow cont’d:

18. When satisfied with a patch, right-click on it > Tracking > Lock, so that it can no longer
be changed. Alternatively, Ctrl + right-click on it > Lock.

19. To continue, pick another seed in an empty area and repeat the exercise.

Add »
Tracking 4 Start Tracking -
Tools * | % Change Settings ..
Workflows * | v Enable Tracking
Save Lock
Save as Unlock
o Lock Treeitem Seeds [
Hide Select Parents

Show Parents Path
Select Children
Delete Selected Children —

Remove from Tree

Workflow cont’d:

20. Click on the auto-track icon €% to track more from the new seed (previously auto-
tracked horizon patch remains untouched).

One seed

Two seeds

100
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Workflow cont’d:

21. Repeat this workflow (add seeds, auto-track, QC, lock) until you have filled the entire
area with horizon patches of good confidence.

22. Now lower the constraints in the amplitude and correlation tabs.

23. Repeat steps 21 and 22 until the tracker cannot fill in holes any further without
making mistakes.

What to do when something went wrong?
There are three ways to change the results:
+ UseUndo ™ and Redo ™ cons, or CTRL-Z/ CRTL-Y shortcuts.

+ Select the area to remove with the selection & icon and press the % delete icon.

+ Use the tracking history to remove all positions (children) following the last good position
(parent). How to do this is explained next.

Workflow cont’d:

How to see the tracking history

24. Right-click in the 3D scene on a bad position on the auto-tracked horizon and Go to
Tracking > Show Parents Path.

25. Alternatively, ctrl + right-click on the bad position on the auto-tracked horizon and
select Show Parents Path.

=% Start Auto Tracking
<> Retrack From Seeds
@ Select With Polygon

Add -",‘ Select Parents
Display » Show Parents Path
Tracking @l  Start Tracking . gr'e‘:‘sc:"‘ldt@"
- b iear selection
Tools * % Change Settings ... O B St
Workflows » R elete Selecte
Enable Tracking ~ Ulds
& Save Lock Redo
# Save as Unlock @ Lock
o Lock Treeitem Seeds » & Unlock
Hide Select Parents Show Locked
N LR LRI Show Parents Path & Save
4 Select Children &l SaveAs ...

Delete Selected Children

Display Only at Sections
% Show Settings ...
4 %

Ctrl + rightclick pops up the dedicated menu containing all the tools required for 3D
horizon tracking. This menu minimizes the need to use the horizon tracking set-up window,
e.g. for auto-tracking or re-tracking from seeds.
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Workflow cont’d:

26. The nodes of the random line that appears in the 3D scene shows the tracking path
to the selected position (Parents Path).

Y

Add >

| Display 4
Tracking 4 Start Tracking
Tools ' |3 Change Settings ...
Workflows * | v Enable Tracking
Save Lock

@ Saveas Unlock

g Lock Treeitem Seeds

Hide

AT

Remove from Tree

Select Parents

Show Parents Path

Select Children

Delete Selected Children

Each node (in Green) of the random line, corresponds to a parent seed.

Each parent path is added in the tree under the Random line item and can be saved.

Workflow cont’d:

27. Additionally, the Parents Path random line is automatically displayed in a 2D viewer.
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Workflow cont’d:

28. Locate the parent position where the interpretation went off-track: Ctrl + right-click on
this position on the horizon patch (or in the 2D viewer) and select Select Children.

29. The samples tracked from this bad parent position are highlighted in the scene.
Either, right-click on them > Tracking > Delete Selected Children
or Ctrl + right-click on them > Delete Selected.

it 4
‘f Adcr

25 Display £ S
Start Tracking ...
Tools * |% Change Settings ...
Workflows * | v Enable Tracking
= Save Lock
& Save as Unlock
o Lock Treeitem Seeds
Hide Select Parents
== Remove from Tree Show Parents Path
Select Children

Delete Selected Children

Workflow for “fast” auto-tracking using “Adjacent Parent” tracking method

1. Select Adjacent Parent method in the Mode tab. Mode | Event | Correlation

@ Section Auto-track

2. Go to the Event tab and Select Relative difference as
Threshold type.

Manual Draw

Method |Adjacent Parent  ~

3. Define the allowed differences by clicking on Steps ...
(5] Horizon Tracking Settings SEEN
- Mode Event Correlation | Properties | DipSteer
— Event type Max v vJWVA  [IVD
u [Frestesme bommaranete | Patches tracked with the Adjacent
o REERheEE e d Parent method tend to be much
~ Searchwindow ()8 BJ|8 )0 Symmetri larger than with the Seed Trace
Data Display Window (ms) -16 = 16 |+ [] Symmetric method, especially if you use
Nriracesls multiple steps (next slide)
| @ Close| | @Help
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Workflow cont’d:

4. Specify the allowed differences (in %) as shown on the picture. In this example any
sample of the horizon is tracked in at-most 5 steps.

In the first step only 1% difference between neighbors is allowed. If the program is able to
find a new sample in the neighborhood with less than 1% amplitude difference, that sample
is included in the horizon and tracking moves on. Otherwise, the amplitude difference
criteria of next steps are utilized.

Be aware that loosening the constraints too much may result in loop-skips.

Event type [Peak )
Threshold fype (Relafive difference ~| Adjust the amplitude and correlation

Allowed difference (% parameters in case the tracker stops tracking

too soon.
Search window (ms) -20 [ 20 - Symmetric

5. Follow steps 8-29 of the previous workflow based on the Seed Trace method.
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1.4.2b Tracking In 2D Viewer

Exercise objective:

Interpret a 2D horizon using a 2D viewer

Workflow:

1. Add a 2D line to the 3D scene: right-click on
2D line and go Add.

2. Select the Well correlation - Line and change
the action to Load default data.

3. Once the 2D line is loaded, right-click on the
attribute name (i.e. Seis) in the tree and go
Display > 2D viewer.

~ Random Line
2D Line

@ 3D Horif  Add...
2D Hori! Create 2D Grid from 3D ...
Fault Extract from 3D ...
FanltStickSef

-~ Select 2D Lines - olEd

[u] » Filter | *

[¥] well correlation-Line ]~

&)

2D Line v
4 [v] Well corr... =
Vi[Seis ta
@ 3D Horizi  Select Attribute >
2D Horiz( Save Color Settings
Fault Display * ks Histogram
FaultSticl Remove &  Amplitude Spectrum ...
® 5\;’"‘?’ F-K Spectrum .
el
3 Change Transparency ... o o
i PickSet e In a 2D viewer, you can interpret
[ Polygon — . M
S PrestackE . T 2D Viewer - Wiggle 2D and 3D seismic.
L] -
Workflow cont’d:

2D viewer

20 Viewer - Line: Well correlation-Line - olEN

MR NOAT

3D scene

»

20000 36041
T

B8 %

]

174855

TrcNe=1004 (621012, 6083318, 208)  Vai=-398 (Sers)

it
Distance™

ReliSP=130
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Workflow cont’d:

<1 2D Horizon
4. In the 2D viewer, right-click on 2D horizon and select Fault Add ...
W FaultSet Track New ...

Track new.
FaultStickSe Create from 3D ...

5. In the Horizon tracking settings, leave the parameters as
default.

6. Optionally, close the Horizon tracking setting window

' Horizon Tracking Settings - <New 20 Horizon 1> = o x
Moge  Event  Comelation  Properies  DipSteer
- ® Section Auto-rack
™ =
. ) O Manual Draw - ™ Horizon Tracking Settings - <New 20 Herizon 1> - o X
Mod Event [+ Hati P i DipSte:
H Method | AgjacentParent + o lode orrelation Toperties ipSteer
e - Eventtype Peak = B wva CvD
®7 Irwacking fails O Exrapolate @ Stop O o~ Hori i i =
. L Thresholdtyge Relative imer " Horizon Tracking Settings - <New 20 Horizon 1> o x
—~ Alowed difference [Im[zq Mode  Event  Corelation  Properies  DipSteer
c - = - P
oo Searchwingow(ms)[&_ %] [ Sy Use Comelation @ Yes () Mo HMwwa Ovo

( - - - r
- . = =
I = Compare window (ms) 40 5|40 - Symmetric
Diata Display window (ms) |-16 |3 |16 pan (ms)| L | ] sym
wrraorss T Comelation threshold (%) [60.0 12 1 Snap to Event

4 - y
Data Display window (ms) 48 (3[48 % |[] Symmetic

Mr Traces (5

o=

Workflow cont’d:

6. Pick a seed on a Max event (as selected earlier) on the line.

7. Interpret the full line.
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Workflow cont’d:

8. In some areas the horizon does not propagate well and you may want to switch to the
manual drawing mode.

Workflow cont’d:

9. Re-open the horizon tracking settings: right-click on the <New 2D Horizon> and
Tracking = Change Settings.

10. Change the tracking mode to Manual Draw and select the Snap to event option. The
event type is defined as previously.

4 2D Horizon
7| <New 2D Horiz... =
Fault Display v

W FaunSet Tracking C Start Tracking ™ Hori . ings - <N . _
FaulStickSat Tools * | v Enable Tracking o JizchngSeting=ce 20 L o X

® Body LT D " /@ Change Seftings .. Mode  Ewvent Comelaion  Properies  DipSteer

L wel Reload Seads R = _

= PoiniSet W Seve — O Section Auto-track
Polygor Seve

o " a o Cj | ® Manual Draw [ Snap to Event

¥ Shapefile o Lock Treeitem

By Prostack Bvants | Romova from Tree ) lethod | AdjacentParent -

44
== |iftracking fails () Extrapolate Stop
.

@rer
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Workflow cont’d:

11. Draw the line where you want to interpret.

Workflow cont’d:

12. Once you are done, release the left-click button from your mouse: the line will be
automatically converted into the horizon and snapped to the Max event.
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Workflow cont’d:

13.

14.

When satisfied of the interpretation,
save the 2D horizon: right-click on
the <New 2D Horizon> in the 2D
viewer tree and select Save as (at
this point Save and Save as are
equivalent) and specify an output
name.

Close the 2D viewer.

The 2D line and the newly
interpreted 2D horizon are
displayed in the 3D scene.

2D Horizon

¥ <New 2D Horiz.. ==

Fault
FaultSet
FaultStickSet

® Body

L Well

25 PointSet

[ Polygon

@ Shapefile

=y Prestack Events

laza

Display
Tracking
Tools
‘Workflows

Reload

Save

Save as ...

Lock Treeitem
Remove from Tree

= Qutput selection
Output 20 Horizon 20_Horizor|

¥ Replace intree

o |
~ | © Select

| @ oK | |@ Cancel| | @@ Help

Note: A 3D horizon as well as Fault stick sets can also be interpreted in the 2D viewer.

Workflow cont’d:

1.

2.

3D horizon interpretation using a 2D viewer

The horizon type you are interpreting is 3D horizon.

The tracking modes are similar but on the contrary to the 2D tracking, the auto-tracking

option is ON while tracking a 3D horizon in a 2D viewer.

For auto-tracking the horizon, recommendation is to use the Seed trace method in
combination with the section auto-track option (see previous exercise 1.4.2a for more

details).

In the 2D viewer, while tracking a 3D horizon, you can switch inline/crossline by either
typing the line number or using the arrows and the step to interpret a grid like you would

do in the 3D scene.
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1.4.3a Fault Planes

Required licenses: OpendTect.

Exercise objective:
Pick a major fault plane.

Workflow:

1. Right-click on In-line in the tree > Add Default Data; 4 Dip
steered median filter.

2. Change In-line position and step: enter manually 250 and 10
in the Inline and Step fields, respectively, of the navigation
toolbar.

3. Click on . to have

|
|
@ Cross| I CBEETEE

& Z-slice Add and Select Data
® Volum  Add at Well Location ..

~ Rand¢
= 2D Lit Add ColorBIendgd
In-line 250 */step 10 2|« =)

| A major fault (highlighted
with black arrows) is present [ -

| throughout almost the entire

| geologic section.

——— —

an In-line view.

[J\( Y Viewinine |
< @ View Cross-line

’ ||| ® ViewZ

=gy View North

Q- @ View North Z

Workflow cont’d:

it

= Annotations

4. Right-click on Fault in the tree > New.

= Fault |
EBr7] 143a_Fault -
<right-cli¢c__Add >

FaultStickSet Display b

M Histogram ..
, \?voetljly H Save 4 Properties ...
# Pickset | Saveas..
[ Polygon o Lock Treeitem Only at Horizons

X Prestack Even . pemove from Tree

Well

= Fault
Sl <New Fault 1> B8] ‘
<right-clicks  Add »
) ; FaultStickSet Display »
5. Right=click on the newly added Fault > Save e W Save
as. .. PickSet
D Polygon @ Lock Treeitem

S Prestack Events
@ Annotations

6. Enter an Output Fault name and click OK. ®
Output Fault| 143a_Fault

7. Right-click on the saved Fault name >
Display > toggle on Only at Sections.

v Fault Planes
v Fault Sticks
v Use Single Color

Faulty Add..
© 5oy [T

== Remove from Tree

- oW

Output selection

vl © Select ...

Replace intree

© Cancel @ Help
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Workflow cont’d:

8. Pick the fault on the first In-line: either Left-click + drag or Left-click to pick and double-
click to end a stick.

9. Edit as needed: Leftclick + drag seeds, Ctrl + Leftclick to remove seeds, =\ orCtrl+Z
to undo the last action, 7/ or Ctrl + Y to redo.

Qi-{yp rana SEXFL-AD
3 by g == minezao [Tisteot [ 4mmp B | N W= g
Tree scene 1 -
e To be able to pick faults make sure that: e
8 *o 1) Position mode Q is selected. X
" 2) The fault is selected in the tree.
w-| S| 3) Edit Sticks icon |-« is toggled on. ©
2| — - A
. 20 Horizen E
3+ .3sjaull ] €
® | e
® - seuvys 3
& B
} [ Polygon
@ Shapefile
L e
Ek; In-line 250: 4 Dip N
24011120 (626231, 6077628, 678) Value =-132 Indine: 240 Picking steered median filter. |isanecs B

Workflow cont’d:

10. Move the In-line to a new location (for example 240): Click on -- in the navigation
toolbar or use short keys (Z and X by default) to move the In-line backward and forward.

11. Repeat steps 8, 9 and 10 for every 10t inline in the range 100-250.

7 Survey Analysis Processing Scene \View Utiities Help Estimages - & x
| r = = A =)
Qi o SEXFT-AD

W b g == indine240 < step1

Tree scene 1 )
Elements Color
Scene 1

e

v @ Iniine
é v 20
- @ 40ipsise... 11
¥ Crossiine
& | @ zsice
Volume
N 7|~ Randomuine
P 2DLine
@ 30 Horizon
2D Horizon

v 0 Fau
Y| v 41433 Faut -

'
<right-click> 11
L FaultSickSet

AN 9>

H | @ snapente
S Prestack Events
Annotations

N : — 5 In-line 240: 4 Dipk
2a0i1120 (526231, 0077628,676) Valve =132 niine: 240 Picking steered median filter.
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Workflow cont’d:

12. Right-click on the fault name in the tree > Display > toggle off Only at Sections, to see the
fault plane in 3D. (Shortcut key: v)

Fault
c§ri| 143a_Fault] -
™ <right-clic  Add
FaultStickSet Display

&) b Histogram ...

by \?\/ﬁy @ Save > Properties ...
“ PickSet #® Saveas . v Only at Sections
[ Polygon o Lock Treeitem Only at Horizons

N Prestack Even .. Remove from Tree | v Fault Planes
= Annotations T v Fault Sticks

v Use Single Color

13. Optionally display the seismic data along the fault. Right-click > Select Attribute > Stored
Cubes > 4 Dip steered median filter.

] Fauit
=[] 143a_Fault

o] <right-click> MV |
o gggﬁStii SelectAftribute * | StoredCube > BRI

Welly Display > | Attributes 3D UVAQ 6 biased Texture+Energy+SystemsTracts
# PickSet Remove ) Steering Cube » 3D UVQ Texture+HC attribs+ Energy disk

D Polygon _ 4 Dip steered median filter
Workflow cont’d:
S Fault
SNl 143a_Fauit
¥l <right-clic Add
14. Don't forget to Save your work regularly. ® by et R
Well
“ PickSet ® Saveas

15. To delete sticks from a fault plane, use Select and Remove ggroelys?;gk £yoq 8 Lock Tresitem
icons as shown below. > Annotations | vemove from Tree

G Scene View Utities Help Est
ahaSEXT
<l 4mmp

3 b g = minefzso s Joteft

x Tree scene 1 L4
Eements Golor .
® | scenet X
> Obas
6| o5 .
2 4Dipstes.. NN ‘
¥ Cross-line “
R .
® Voume
W-| ~ Renomiine N
P 2DLine %
“® 3D Horizon ]
rb N 2D Horizon l y
ER . g
- vouuaru m «
A 2 O
@~
#® | = pomset P
l ) D Polygon s
'@ Shapefile
B | S presucceens

Annotations

Select sticks & and
Remove Selected
Sticks & icons allow
to sele_ct and remove In-ine 240- 4 Dip
fault sticks. steered median filter.

o Copy Selectionto ~

24011110 (625969, 6077620, 667)
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1.4.3b Fault Sticks

Required licenses: OpendTect.

Exercise objective:

Workflow:

1. Right-click on In-line in the tree >

Add Default Data; 4 Dip steered

Pick a set of fault sticks and group these into fault planes.

@inine!
Yty Add Default Data
& Z-slice Add and Select Data

® Volum  Add at Well Location ...
~ Randc¢

(> viewinie |

median filter. 20 Lt Add Color Blended
) 9 W View Cross-line
2. Draginline position to 110 in the | ® Viewz
Position mode @ . n | @ ViewNorth
« '|® ViewNorth Z
3. Click on . to have an inline view.
4. Reduce the displayed area to the
faulted part as shown in the picture:
Left-click + drag the green square
in the upper right corner.
Workflow cont’d:
. . . _ [FaultStickSet!
5. Right-click on FaultStickSet in the tree ® \E/ivoclily Add .
e
and select New. PG New |
FaultStickSet
. . L : -
6. Right-click on the newly added o Bogy e :
FaultStickSet > Save as... L Wel B Save
= PickSet —
O Polygon
N Prestack Events g Lock Treeitem
AT = Remove from Tree
7. Enter an Output Fault Stick Set name - Qupuseiecton - om
. Output FaultStickSet | FaultStickSet_01 || © select .| @ dcB v
and click OK.
Replace in tree
@ Cancel | @ Help
FaultStickSet
i Fr— 0o
8. Right-click on the saved FaultStickSet © Body —— & Properties
: . Wel & Save
name > Display > Only at Sections. D ESKS;: & Saveas .
N Preys%ack Events @ LockTreeitem
# Annotations == Remove from Tree
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Workflow cont’d:

9. Pick the first fault stick: either Left-click + drag or Left-click to pick and double-click

to end a stick.

10. Edit as needed: Left-click + drag seeds, Ctrl + Left-click to remove seeds, ™ or

Ctrl + Z to undo the last action, 7 or Ctrl + Y to redo.

7y Survey Analysis Processing Sceme View Utilities Help Estimages
QileaEranaSEXT-eAR
3 g = mindro [lows[t ] 4mmp| 500 I P eso0 [Faseiemics

Ty + W o

bt —
o
Elements Color | (88

= i@
NSNS A NN

TRLY

—

AN

Ve ENNEE N
fi

Scene 1
v @ In-ine

~¥ @4 110

[ 4Dip steere...

@ crossiine

© Zsslice

@ Volume

~ Random Line

™ 2D Line

@ 30 Horizon

4 2D Horizon

Fault

& well

‘

 Poiniset

> Polygon

& Shapefile

&N Prestack Events
> Annotations

mIndge)  OLinnne

aulSickse
[ FaultStickSet_01

| To be able to pick fault sticks make sure that:
1) Position mode & is selected.
2) The fault stick set is selected in the tree.
™1 3) Edit Sticks icon [ is toggled on.

N
« N inline 110: 4 Dip
steered mediarbiilter.

e - -
=uﬁ.’-'a\: R x
Tl e L NN

&> CopySelectonto ~ Fault ~ Create Single New  ~ seect. | [l X . o -
110/861 (614859, 6074059, 1488) Value = 208 In-line: 110 Picking Ifree mem] 4.3/7.9 GB 01
Workflow cont’d:
= FaultStickSet \
FaultStickSet 01 — -
@ Body Display »
! el
11. Save your work regularly. Pl T

> Polygon

12. Interpret several

o Lock Treeitem
== Remove from Tree

S Prestack Events

fault sticks on inline 110. @ Annotations

7 Suvey Analysis Processing Scene
& il s QB
2 g = 110 [Z]ster]s

Tree scene 1

q
Elements Cotor]
Scene 1
v @ Indine

v @10

(4 4Dipsteere . 11

@ Cross-line

Tips:

The fault stick closest to the mouse cursor is highlighted with a
thick line. Press Ctrl to make it active and editable. i
Click on a seed of any stick to make it active and editable. .

® Zslice
@ volume
~ Random Line:

‘

=7 2D Line
@ 3D Horizon
~4 20 Horizon
Fault
FaultStickSet
FaultStickSet 01 W
® Body
A well

S AR EY ¥4

v

i Pointset

[ Polygon

@ shapefile

& Prestack Events
> Annotations

oo @ | CopySelectionto v | Fault

110/660 (614823, 6074058, 1491)

Press Shift to end a stick (alternative to double-click).

g ]

inline 110: 4 Dip
steered median filter.

1 S

WX &

v Create Single New Select

Value = 487 In-line: 110 Wwea merm) 4.37.9 68| AT

-99-




Workflow cont’d:

13. Move to inline 120: Click on «» in the navigation toolbar or use short keys (Z and X
by default) to move the inline backward and forward. Continue the interpretation for

several inlines, e.g. with a step of 10.

*j Suney Analysis Processing Scene View Utilites Help Estimages

= Al
QilecqyEianaSEXT-BTAR
P’ o = In-line 12

Tree scene 1

‘ Elements
Scene 1
¥ N In-ine
é v K120
4Dipsteere... F1
= @ Cross-line
o @ Zslice
® Volume
- ~ Random Line
< 20 Line
@ 3D Horizon
! 4 2D Horizon
A
n Fault
¥ 7|V FaultStickSet
@ FaultStickSet_01 BN
® Body
@ - Well
7 PointSet
® | D roygon O s —
HH | & snepeme .
& rusuccenny S g ks &7and
B | e elect sticks an

Remove Selected
/ Sticks & icons allow
to select and remove

.‘cnwselemnnm fault sticks.

1201674 (615165, 6074317, 1.

inline 120: 4 Dip
| steered median filter.

[free mem] 4.37.9.GB 33
e~

Workflow cont’d:

14. Add an empty Z-slice* to the scene and
Drag it to 1500 ms. Click on [} to have a
North oriented top view and resize with the
green anchors to cover more or less the
area you interpreted.

3 Z1518stepd  H4mmp 065 [ [0.95 [m Similarity

Tree scene 1 L

L]

- Elements Color|
Scene 1

& ¥ Indine
@ Cross-line

= © Z-slice

4

~ Random Line
20D Line

“ 3D Horizon

“ 2D Horizon

| o SRS

Fault
FaultStickSet
Body
Well

i PickSet

[ Polygon

S Prestack Ev.

@ Annotations

. @
Y
«

m =

We have finished picking sticks. In the
next phase sticks will be grouped into
planes. To facilitate this process we will
display a fault discontinuity attribute on
a time-slice through the sticks.

=4
2| “P20s »
8 ¥ ViewInline
% | @ View Cross-line
1] ® ViewZ
==l gy View North

CIMl View North Z

# [ & Body

*Positioning an empty
slice is faster than
positioning a slice with
data."With pre-loaded
data the speed
difference is negligible.
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Workflow cont’d:

15. Add 9-71 Similarity on FEF seismic from Stored attribute list.

—

SAN N

Observe that separately interpreted fault
sticks can be easily grouped into fault
planes when co-rendered with a 5|m|lar|ty
attribute on a Z-slice.

Workflow cont’d:

16. Select sticks located along the same lineament by clicking on &7 icon and:
- Ctrl + Left-click to select/de-select sticks one by one;
- Left-click + drag to select/de-select a group of sticks;
- Ctrl + Left-click + drag around several groups of sticks for multi-group selection.

Draw a polygon
to group fault
sticks located
along the same
lineament.

Sticks that are

not currently
selected
! remain V|olet

\.' Copy Selectionto |v|Fault v|Create Single New v v| setect... Il ¥ .\ & \ - \
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Workflow cont’d:

17. Choose Copy Selection to > Fault > Create Single New and type in a hew hame in the
toolbar. Optionally choose a fault color. Then click .

oo’ &2 |Copy Selectionto v Fault v Create Single New V|Fault_01A

S
o 4

18. Repeat previous two
steps to create more
fault planes.
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2.1.4a Thalweg Tracker

Required licenses: OpendTect Pro.

Exercise objective:
Track a channel (and its associated margins) using the Thalweg tracker.
Elements Color
Workflow: Scene 1
.,lcn,!_
Lo ) ) & 25| Add and Select Data
1. Add an inline with default data in the @ Vo Add 3t Wel Location
~ Ra__Add Color Blended
scene.
= Thalweg Tracker =8 gon ==
2 LaunCh the ThalWeg tra.Cker from the Input cube @A 4 Dip steered median fitter [] | © select..
Ana|y5|5 menu (Ana|y5|5 > Tha|Weg Area subselection | 100/300-750/1250 (463 samples) [© seeect.|
tracker) or click onll icon. siart Possion (nICr) Z(me) [R] vae
Event to track ® Minima Maxima
3. The default data volume for this Vi Treshot HaxTesteld
survey will appear automatically in e seeett
R Amplitude Sum Scaler 1 Amplitude Sum Step (ms) 1
the Input Cube field. i AT R T ———T—
1/1000 o0 S [Not Appiicable 0.000 |=
The Thalweg tracker is not a conventional S
tracker: it is using a weighted voxel FAED et
> ) A Output horizon [-] [© setect..| @acs [l
approach to track seismic facies. I R
Hence it is not limited to map channels. (Gromionoreor)
© Close|
Workflow cont’d:
4. Move the inline to 365: click on the inline 425 and type in Inj425 [+istep1_[=] 4 mp | |4500
365 in the Slice Position toolbar, or use the basemap and \ Lm"
drag the inline to the wanted position. & | scene
= Inine
‘
. . . . =4 TDIb steered me...
5. Pick an event: press % icon and pick a seed at crossline _ | @ crssine
647 at 1024ms.
Intne 365 Step 1 | dmmp| (¥ = < Bg @ - B1 2y 4 0 4| {4500 1 4500 [1aScismcs &l
of P———— - ————— —  ———— .
— - ==y
2w %k
= input cube [ [&] 4 Dip steered median fiter ~][© select
Avea subselection 100/300-750/1250 (463 samples) © select |
Start Position (WCr) 365 641 2(ms) 1024 | & P Value: 5220
= Z Min Thiphete®™ 0478 Max Threshold O
e e Scalr 1
C—— lf'% Ampitude Sum Scaler |1 Ampitude Sum Siep (ms) 1
—— ——— 5 Schedule Ma Nr Cells Cells per teration Cuteoff criteria Cuottvave | (]
e e e  Show Poits
SR e e *‘*”':'.'-_ o Bl | T —
The software will snap to the nearest event (Minima or £ i, e
Maxima, as chosen by the user) automatically for the | =)
picked position and fill the corresponding fields. — T
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Workflow cont’d:

' Thalweg Tracker =R
od RN
Input cube 4 Dip steered median filter B
Area subselection | 100/300-750/1250 (463 samples) e Select ..
Start Position (Inl/Crl) | 365 647 Z(ms) 1024 m Value: -5239
Event to track @ Minima Maxima
6. Keep default values for I — -
. . in reshol =t ax reshol
Amplitude Scaler, Amplitude
. Amplitude Scaler |1
Sum Scaler and Amplitude
Amplitude Sum Scaler 1 Amplitude Sum Step (ms) 1
Sum Step (ms). :
Schedule Max Nr Cells Cells per iteration Cut-off criteria Cut-off value | @

11000 =1

0.000

“Nothppiicable

Schedule: set the values as
shown in this screenshot.

| Track View Log

] (@ 5ok oo

Press the Track button to
start reading the input

V| Show Points  Display Settings

Output horizon

VOlume and traCkIng v] Snap to event; Search gate (ms) -4 4
%‘;@

The first row of the schedule table represents the thalweg settings e.g. Max Nr Cells = 1000
and Cells per iteration = 1.

Workflow cont’d:

9. Once the processing is finished, it will display the result as color-coded points.

) Thaiweg Tracker |E=5Eon ===
%k
input cube (&) (5] (4 Dip steered median fiter [][© setect..|
Area subselection [100/300-750/1250 (463 samples) © select .|
Start Position (IniCrl) (365 647 Z(ms) (1024 | [ ] Value: 5229
Event to track @ Minima Maxima
Min Threshold |-10478 Max Threshold [0
Amplitude Scaler |1
Ampltude Sum Scaler 1 Amplitude Sum Step (ms) |1
Schedule Max Nr Cells Cells per iteration Cut-off criteria Cut-off value ‘ Z
1/1000 =0 | Not Appiicable 0.000 I=
[ Track | [ViewLog_..]
¥ Show Points [Display Settings .|
Output horizon [*][© select .| @dcB [

71 Snap to event Search gate (ms) -4 4

B,

Greate horizon]

© Close:

Finished Tracking

Output of the extracted channel.
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Workflow cont’d:

10. If you are satisfied with the results, specify the Output horizon name. Optionally, toggle
on Snap to event, to output a horizon snapped to the nearest Minima or Maxima in a user

11. Press the Create horizon button.

W e ———
— N

e = Thalweg Tracker =3 o8~
= %k
input cube iS5 5] (4 Dip steered median fiter ] [© setect..|
Area subselection | 100/300-75011250 (463 samples) © select .|
Start Position (Crl) (365 647 2(ms)[1024 | [R] value: 5239
Eventto track @ Minima Maxima
Min Threshold |-10478 Max Threshold |0
Amplitude Scaler 1
Amplitude Sum Scaler |1 Ampiitude Sum Step (ms) |1
Schedule Max Nr Cells Gells per iteration Cut-off criteria Cutoftvaie | (i)
1/1000 =0 = INot Apy 0000 1=
[ Track | [viewLog .
7] Show Points [Display Settings _.|
Cl = —-
] Snap to event; Search gate (ms) -4 4
%J @ Close
Finished Tracking
1] .
Workflow cont’d:
=% 3D Horizon
=[] Channel-1 -
V] Amplitude 3 |
. . . . v| Amplitude Sum 3 |
12. The horizon will appear in the tree as well as in the scene. 7] Thickness 1
v Cell Number 2 |
vl lteration n
. . 7| Schedule r
13. Turn off the Show points display. =i .
e — — N
1 Thalweg Tracker (=8 Eo8 ===
> - |
"
input cube (&) (] (4 Dip steered median fiter ] [© sekect..|
Area subselection | 100/300-7501250 (463 samples) © select .|
Start Position (In/Crl) (365 647 2(ms) (1024 | [R] Value: 6239
Event to track @ Minima Maxima
Min Threshold |-10478 Max Threshold |0
Amplitude Scaler |1
Amplitude Sum Scaler 1 Amplitude Sum Step (ms) |1
Schedule Max Nr Cells Cells per iteration Cut-off criteria Cutoftvaie | (i
1/1000 =0 |not Appiicabie 0.000 =
[ Track | [ViewLog .|
Output horizon | Channel.-1 [+] [© select .| @dcB [
9] Snap to event Search gate (ms) -4 4
[Greate horizon| ‘
B,
@ Close
Finished Tracking
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Workflow cont’d:

14. To track the margins of the channel, add a second schedule step and set the
parameters as shown in the figure. Turn on Show points and press the Track button

to obtain the T

— — -
/7_2,2 Start Position (InliCrl) 365 647

g and its associated margins.

= Thalweg Tracker (o e
B %k
Input cube (5] () 4 Dip steered median fiter [][© select.]
Area subselection | 100/300-750/1250 (463 samples) [© sekect..|
2Z(ms) 1024 (%] Value: -5220
Event to track @ Minima Maxima
Min Threshold 10478 Max Threshold [0
Ampltude Scaler 1
| Amplitude Sum Scaler |1 Amplitude Sum Step (ms) | 1
= Schedule Max Nr Cells Cells per iteration Cut-off criteria Cut-off value
[1] 1000 <1 | ot Appiicable 0.000 =]
Iﬁua =12000 = Percentage [~[5000 T
[ Track J]view Log..]
Output horizon | Channel-1 [*]|© select .| @dcB =l <
7/ Snap to event Search gate (ms) [-4 4

[Create horizon]

Finished Tracking

© Close

Workflow cont’d:

and merged into a single horizon.

Several horizons can be created |

1 Thalweg Tracker

Crossplot is a utility to
perform analysis on the

extracted dataset (e.g. if
you use an acoustic
impedance (Al) volume,
you can analyze
iterations with Al data).

Display Settings control the
display and color coding of
the points of  various
extracted attributes along the
Thalweg.

/! Display Properties N =2

Attribute to display |Iteration =

o .: ] 1015

i Rainbow =

Q close

~a{E]

Input cube @ 4 Dip steered median filter

Aréa subselection | 100/300-750/1250 (463 samples)

Start Position (In/Crl) 365 647 Z(ms)

Event to track @ Minima Maxima
Min Threshold -10478
Amplitude Scaler 1

Amplitude Sum Scaler |1

[-]|© select....

1024 | [R] value: 5239

Max Threshold 0

Amplitude Sum Step (ms) 1

Schedule Max Nr Cells Cells per iteration Cut-off criteria Cut-off value H—‘
1/ 1000 =1 | Not Applicable 0.000 E
22000 = 2000 <|Percentage E] 5.000 .
[ Track | [View Log ..
| Show Points- Display Settings

Output horizon  Chapr€l-1

v Snap to event;

Finished Tracking

[+] |© select .| @ dcB [+

Search gate (ms) -4 4

i iﬁ_g lose
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2.3.1h Unconformity Tracker

Required licenses: OpendTect Pro, Dip-Steering.

Exercise objective:
Create two horizons: 1) a seismic event constrained by a few manually picked positions;
2) an unconformable event constrained by well markers.

Workflow:
1. Pre-load the default seismic data set (4 Dip steered median filter).
2. Add an in-line (Add Default Data)
3. Add the stored Random Line called: “Random Line through wells”
4. Add all 4 wells o E P
5. Go to 3D Horizon > fi:wj‘ P
New > Track Unconformity ... )EE{:II:M' :i?vmfmmdm | Aukp an Mamul Tracking

Track Unconformity ...

¥ FO6-1
¥ FO3-4
¥ F03-2

Thalweg Tracker ...
With Constant Z ...

Traditional trackers follow amplitude and phase. Unconformities do not exhibit consistent
amplitude / phase behavior and can thus not be tracked with a conventional tracker. The
unconformity tracker flattens the dip field using a constrained inversion-based algorithm.
Constraints are given in the form of picked positions and (optionally) a confidence weight
volume.

Workflow cont’d:

6. In the Unconformity tracker window, select the input steering cube for the tracking: 2.
Steering BG Detailed.

Ideally, use a detailed steering cube (see Exercise 2.3.1a) calculated on enhanced seismic.

7. Optionally, limit the output  Uncrtormey ch =
extend by using the Steering Data .é, =Y Iz Steering BG Detalled ~ ) select..|
Volume sub-selection. Volume subselection I1m_um-150,fusu (463 samgles) B Select I

Pickset Color  Options Horizon
8 OptIUna"y Char‘lge the Horlzon 1 - Edit ... IM.rf.\r'Man-:h.\an by Constraint 1 I
- H
. Horl 2
names of Pickset and
Horizon by double clicking
on the respective fields.

Horizon 3

Horlzon 4

{[1][ %

7 Execute in Batch | 4% Options ... Processing parameters ...

© Run | | Close | @ Help
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Workflow cont’'d:

9. Click on the Pick Seeds icon «s® and
pick a few points (minimum 3) on the
event you want to track.

and cross-lines. Alternatively, open an
existing pick set with interpreted points
by clicking on the corresponding icon: =

11. For the second horizon press the
wells icon 4 and select the FS7
marker from all wells.

Pickset Color  Options Horizon
Horizon 1 Constraint 1 - Edit ... Surface constrained by Const

Herizon 2 - Edit ... Surface constrained by FS7

Haorizon 3

" Sebect well madken

Select markers from one or more wells

Markers o =

I F53

[ 54

I P56

7 is?
Fas

I MFs10

L mFs11

Wells & = Fllter *

¥ P21
¥ FO3-2

% 7 2 H03-4 <
¥ FO6-1

a0

Q@ ok | O cancel

Workflow cont’d:

12. Select Processing parameters ... and read the information for each of the parameters.*

= Processing parameters
Apply faull dips ) Yes @ No

Gonfidence weight s i)
Flip weight
Confidence Power |6
Number of Horizon updates 10
Advanced CG Solver parameters
Number of CG Solver lterations 200
Solver residual error 0.01
Preconditionning fier stepout ink&é 3 crl6 2
Inversion operator weight O

Resat

O

|

ceooe coCQ

o
§
=
z

* A good “Confidence weight” volume example is the Planarity volume.
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Workflow cont’d:

13. Close the Processing parameters
window and start processing by

pressing

14. When the batch process is finished
Close the window and Add the new
horizons to the tree.

15. Add a random line to QC* the horizons.

16. Improvements can be made by (if
needed): adding more picks; adding a
confidence weight volume and by
changing the inversion parameters.

*Tips: Change the color bar of the random line to grey scale; Show the horizons at sections
only; Change the line thickness (Horizon -> Display -> Properties); Move and rotate the
random line to check whether the horizon is following the events properly.
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2.4.3a Well Correlation Panel

Required licenses: OpendTect Pro, Well Correlation Panel, HorizonCube.

Exercise objective:

Create a well correlation panel and QC the well markers using the seismic data
and a HorizonCube to guide you.

Workflow:

1. Launch the Well Correlation Panel (WCP) window: Analysis > Well Correlation Panel,
or via the =" icon.

&7 Survey Processing Scene

Q |+l Attributes v
AL
Tre ‘% Volume Builder ...
Q Ex Ei Cross-plot Data >
- L Wells v
| == Layer Modeling 4
‘ = Fluid Contact Finder ..
) = ¢ == Neural Networks v
5. 8818 4
- Z, Thalweg Tracker .
. = 1 Velocity Model Building »
< . Well Correlation Panel ...
Workflow cont’d:
. . = Well Correlation Panel =
2. Select data type: 2D line. Wel oy © You @ No
3. For Input data, select Seis FESIEIES
and select the line name Input Data |Se:5 E"O Select .| |Create from Wells‘_
Well Correlation-Line. A
4 At the bottom Of the WindOW Trace subselection R Line 0'6-1448 (463 samples) 6 Select
select all four wells available
in the list.
5 Press OK Select Well(s) to be projected on data
7 - Fiter "
v F02-1
7| FO3-2
v FO3-4
¥ F0B-1 L+ )
Pl
0 Cancel| | @ Help |
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Workflow cont’d:

6. Change the seismic color spectrum to Grey scale: click on VD and from the top bar
spin the color to Grey scale.

= el € Line: Line R =
SlRF et A x Agha B o 2 o | Mesr [rasosmes H| oot
itoms T Fiz1 Fo TR - [ o4
(r=2 - (=== 1 Greyn ] =
Elements. Colot |Zma am A Grurple b
o ||| o HorzonCube L

| Matteo terrain cube red
| Matleo larrain linear

— ) =
. I | View |Wets & Seismicsx] |, K 1] Keep zoom ratio -} @

Gamma Ray 41 56838199AP1 Porosity 0 28062165F raction Marker Top Foresets MD 1101 33m TVD 1101 33m TVDSS 1071 33m TWT 1077 00ms.

Workflow cont’d:

7. Overlay the seismic data with the HorizonCube: right-click on HorizonCube in the tree
and select Add Display.

Choose the 2D HorizonCube “HeorizonCube SC-FFT-frunc Random line between wells”.

! Well Carrelation Panel - Line: Well correlation-Line E=N EOR =%~
Qe A= Ag [ e 7 s | s | moreyscaes

Tree items & A

Elerments

[t —
« m | View Wels & Sesmicsx] | ¥ Keep 2o0m ratio {} '
TreNr=471 (611381, 6083730, 1844) Val=-1811 (Seis), Ret/'SP=1e30
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Workflow cont’d:

8. Now display a Gamma Ray (GR) log on all
wells: click on the well properties icon
A from the WCP window.

9. Inthe Log 1 tab, you may select Gamma
Ray log with a SandShale color bar.

o 5 =
R X ¥
‘Well properties},

Colof| |-28212
Porasity
- 006 04

" Display properties of: F02-1

Sefect Wel F03-2

-

Panel 1 [=] Number 1
Display well stratigraphy

Log2 | Markers
Selectlog Gamma Ray -

Log 1

Specify data range Z|

Log range (min‘max) -2.8 133.4539 [ Logarithmic

Style [ Well log 7] Seismic
Line thickness 1
Line color | [ | = Black
Fill Lef of log [=] 171 singie cotor
Fillwith Gamma Ray q flip color table

133.453¢

Apply 1o all wells|
Save as Defaul © closa | | @ How
Workflow cont’d:
10. In the Log 2 tab, leave the log selection to
None.
. /= Display properties of. F02-1 [l @ =
11. Press Apply to all wells to display S =
the Gamma Ray log on all wells displayed in Pael[1 g Mmben
the panel. '
Display well stratigraphy
. . Log1 | Log2 | Markers
12. Close this window. Select log (TN -
) 0
i 1
r I | = Dark -
Save as Default ©) Close | & Help
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Workflow cont’d:

13. Now start interpreting the depositional trends and possible systems tracts boundaries
by moving the HorizonCube slider €} up and down.

0 Well Camelation Panel - Line: Well comrelation-Line =0 ol =3
L . - A rizomn v L]
SlaresramAstrm B e ? (@] THe muononcie [
Trea items s Fi2-1 Fo6-1 F032 FO34
i | =] =
Elements. [ |
7 =vD
4 20 Horizon

265
Link to ColorTatde
Lock Top/Base distance
: osmes] (¥
Gamma Rey—roooroororr cre TVD.666.04m TVDSS:636.04m TWT.666.00ms

Workflow cont’d:

14. To edit the markers: click on the

15. Add a new defined boundary as a marker by clicking on %"
In the pop-up dialog, give a new name and color to the new marker and click Ok.

8 Well Cormelation Panel - Line: Well correlation-Line =3 ol i

Ql&etam “xw M E el 79 BB~ |mrionzencuse Bl os®
Tree flems s Fo21 FO6-1 Fez o4
Elements Colod e [Tm e e

i (%] A P
, | View Wels & Seismicsx] | & Kaep zoom ratio [} '

« i
Trehr=198 (606869, 6079406, 424) Val=-04 (Sais); RelSP=1a30
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Workflow cont’d:

16. Once the marker is added in the list, it will become an active marker: click in the well
area to add a marker. To delete a marker, use CTRL + mouse click on the marker.

17. When done with the marker interpretation, press Ok/Save button in the markers dialog.

.-Euww Comelation Panel - Line: Well comelation-Line = 100 bl
Qe A=A E o ? @ Bl % [muonzoncue [
Ll Fi

Tree items

8
3
o138
L

1

;-
IR 1E
i

il
il
[

2

l
I

F 1
View Wels & Saismics’s] ‘ .__!; Keep zoom ratio |} .

« i v
Trchr=100 (606073, 6070226, 1704)  Val=1585 (Seis),  Rel/SP=1e30
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1.4.4b Grid Stacking Velocities

Required licenses: OpendTect.

Exercise objective:
Specify the gridding workflow to grid the stacking velocity functions.

Workflow:
1. Launch the volume builder module accessible from the icon

%

/# Volume Builder: Setup

Available steps Used steps

Body shape painter

Lateral Smoother

Smoother

Horizon-based painter - Simple

Horizon-based painter - Advanced

Input Volume |§|
WellLog Interpolator

Fault Painter

HorizonCube-Well Interpolator

Voxel Connectivity Filter

On OK, store As

[] |© select .|

Name for this step

7| Process on OK I & ok ] [O Cancel] [ @ Help ]
Workflow cont’d:
) Edit step =5 EcE =<
Velocity gridder
Interpolate along Z-slices E]
3. In the following window, choose
Triangulation as an algorithm type. O —
Add ...
4. Add velocity source. Remove
Properties

[ Q ok ] OCancelH @ Help l
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Workflow cont’d:

5. Choose Type: Stored Functions and select the

was imported in the previous exercise.

6. Click OK to proceed.

input function Virms_function that

‘f\ Add velocity function source

(=% HoR ==

Type|Stored Functions |~

Input | Vrms_function

| [6 Select ...

[Go][@oows] @7 |

Workflow cont’d:

7. Name this step (e.g. Triangulation of

8. Click OK.

= Edit step o|=E
Velocity gridder
Interpolate along Z-slices B
Algorithm Triangulation a
Velocity sources
Vrms_function Add ...
Remove
Properties ...

Name for this step | Triangulation of Vrms function|

|
| @ox | OCancelH @ Help }

T
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Workflow cont’d:

9. Store the setup as Grid velocity function.

10. Toggle off Process on OK and press OK.

' Volume Builder: Setup

Horizon-based painter - Advanced
Velocity gridder

Input Volume

WellLog Interpolator

Fault Painter

HorizonCube-Well Interpolator
Voxel Connectivity Filter

-

Available steps Used steps ~
Body shape painter Triangulation of Vrms function f d
Lateral Smoother
Smoother l éxl
Horizon-based painter - Simple

On OK, store As | Grid velocity function

I~|| © Select I

I Q ok ] OCanceIH @ Help ]

Workflow cont’d:

11. Add default inline to the scene.

12. Right-click on it > Add >
Volume Builder Attribute.

13. Select Grid velocity function and press OK
to display the attribute on-the fly.

Elements Color

Scene 1
§iIn-line;

P Add Dofaut Dala ]
& Z-slice] Add and Select Data
@ Volume  Add at Well Location

~ Rando  aqq Color Blende

2D | ine- -
Elements Color
Scenel
4 @ In-line
+ [V|425,
@ 4 Add * | &l Attribute
# Cross-| Display * | @y Volume Builder Attribute
¥ Z-slice I i
o Duplicate € HorizonCube Display
olum; Reset Manipulation -
Systems Tracts Display
~ Randg Display Prestack Data  »
2DLIN 4 Correlate with Wells...
@ 3DHo
4 20 Ho B Lock Treeitem
Fault |== Remove from Tree

) Load Volume Processing Setup |- - (=)- et
Select input Volume Processing Setup
Fitter | *
Grid P-Impedance logs using HC - @
Grid function —
o
X
- | e

HC_well_interpolator_4_wells_Al_inv_«
HC_well_interpolator_4_wells_Al_train _
New_HC_well_interpolator_4_wells_Al|~
Steering

Steering_6.1

test

« il »

I Qo |© CanceIH @Hep |
...5\Misc\Grid_velocity_function.vpsetup
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Workflow cont’d:

The result should be similar to the one shown below

N
Workflow cont’d:
Scenes View Utiities Help
. . . Create Seismic Output » Attributes D
14. Go to Processing > Create Seismic Output >  Croale Horizon Ouipul » | 20 <-> 3D o
. (Re-)Start Batch Job ... Angle Mute Function .
VOIume Bu"der » Dip Steering , | % Bayesian Classification ..
= GMT Mapping Tool ... From Well Logs ...
@ HorizonCube > Prestack Processing »
Madagascar .. STty 4

| ssis ,

= W _ Re-sort Scanned SEG-Y

15. In the pop up window, select Grid Velocity function for Volume Builder setup and specify
an output name, e.g. Vrms, and press OK to start batch processing.

¥ Volume Builder: Create output o H (=] |@
Volume Builder setup | Grid velocity function B“Q Select " & Edit ..
Volume subselection - € Select ...
Output Cube | Vrms] | [O Select ] & CBVS ]

Batch execution Single Process B . Options ...
@0k | @ cancel| | @tep |
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1.4.4c TD Conversion On-the-fly

Required licenses: OpendTect.

Exercise objective:
Create a depth scene and perform velocity conversion.

. View Utiities Help
Workflow: o
1. Go to Scenes > New [Depth]. | Now Map View
New [Depth]
New [Horizon Flattened] »
( New [Wheeler]

Cascade
Tile 4
Properties ...

Save scene to 3D PDF »

v Scene 1

2. A window pops-up asking you to select or create a velocity model. Click on Edit...

# Velocity model - a X

Select velocity model to base scene on

Z transform | Velocity volume v
Velocity model (m/s) ;é) ‘i‘-_-;, Velocity model (INT) ~| € Select ..
Depth Range (m) [0 | [2100 Step [ N

© Cancel| | @ Help

Workflow cont’d:
3. Select the velocity cube i.e. Velocity model (RMS) and specify the velocity type (RMS).
4. Press OK and OpendTect will scan the file to compute the depth range for the new scene.

5. Press OKin the Velocity Model window and a new depth scene will appear.

™ Specify velocity information [ = H o} \
Velocity cube @ ") Velocity model (RMS) [1[© setect ]
Velocity type [Vims B ) Velocity model — a X
Select velocity model to base scene on
Has statics ) Yes @ No
7 wansform | Velocity volume =
Velocity model (m/s) f&| [ [ Velocity model (INT) V]| © select .| | Edi.
Depth Range (m) |0 ‘ |2100 ] Step ‘5| N
QoK [O Cancel‘ [ @ Help I € Cancel | () Help
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Workflow cont’d:

6. In the depth scene, display any stored volume on the inline 425. You will notice that the
scene now shows data in depth, which has been converted from time data using the
interval velocity you, selected. This is done on-the-fly.

Suvey Analysis Processing Scene View Utiies Help Estimages
@ Fi oo
Qi-aBEET-AD
Cross-line 0 2 Stop s ra 11 Seismics. C e g LB
<=-|-E

“Troe scene 1 7 |7 scone 1

5 Depth (using VelocityT2D") =) =) T
Elements Colo ~ :
Scene 1

W In-line -
@ Cross-ine
© Zsice a0

® Volume
~ Random Line
2D Line
© 3D Horizon
4 2D Horizon
Faut 1000

LA 1Y ¥

AR>S :>A

8
z

¥ PointSet
D Polygon
@ Shapefie
& Prestack Events
Annotations.

< >

@
Q

I <+ %

Dept

Tree scene 7

TR o
Depth (using 'Vel.
@ In-line
@ Cross-line
® Z-slice
@ Voume
~ Random Lin

20 Line
“ 3D Horizon
4 2D Horizon

FaultStickS et
® Body

Wel
* PointSet

[ Poiygon 3
@ Shapefile
& Prestack Events v [ D]

< >

liree mem) £.9/15.9.GB [

Workflow cont’d:

Conversion of Vrms to Vint

7. Go to Processing > Create Seismic output > Velocity > Velocity conversion...

Scene View Utilities Help
| Create Seismic Output » Attributes O

Create Horizon Output » 2D <=> 3D »
L Wells 4 Angle Mute Function .
(Re-)Start Batch Job "4 Bayesian Classification ...
#+ Dip Steering » From Well Logs ...

| == GMT Mapping Tool .. Prestack Processing ’

@ HorizonCube , - jon ..
Madagascar - Volume Builder Velocity Conversion

= ssis Re-sort Scanned ?EG—Y

8. Fill the fields as shown below and click OK.

) Velocity conversion [E=8 o =™

Velocity conversion

Input velocity model (2] s [ Velocity model (RMIS) ] [© Select | [ Edit... |

Area subselection - © Select ...
Ouput veocty type

Output Cube [Vin{ ][© select | & cBYS Fl

1+ Execution Options ... b

| Q ok ”OCancelH @ Help I
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Workflow cont’d:

- . T . El its Col
9. Right-click on an inline in the scene > Add and Select Data. | scene:
.a 'c"rl'lgl Add Default Data

L XA Y Add and Select Data

10. Select the new converted interval velocity. ® Volume - Add af Well Localon ...
+/ Randol - adq Color Blended

2D Ling =y

= select o | ® | @ 3D Horizon

Select first layer = gg ;Innzon

¢

FaultStickSet

@ Stored Spec Decomp FFT -

System Tracts ® Body

Steering tl_lux_fixtest_DELME
Velocity model (INT)
Attributes | Velocity model (RMS)
Vint
b] Voxel Test -

Filter *

QoK || cancel| | @ Hep

11. Right-click on an inline 425 in the scene > Add > Attribute.

Elements
“ Select = oR =5 Scene 1
2 In-li
Select first layer pair
i
o Stored Spec Decomp FFT z ¥ Cross  Display * | Volume Processing Aftribute
System Tracts ; s 0750 & HorizonCube Display
Steering tf_lux_fixtest DELME folum - Reset Manipulation 51 Systems Tracts Display
Velagity model (INT) 7 parct Display Prestack Data »
Atributes IR RMS @ 3p = Correlate with Wells
%I Voxel Test S @ 2D H(@ Lock
« i » Fault| & Remove from Tree
Fanltomm
Filter *
QoK || @ cancel|| @ Hep

Workflow cont’d:

Velocity model (RMS) | Velocity model (INT) |
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1.4.4d TD Volume Conversion In Batch

Required licenses: OpendTect.

Exercise objective:

Workflow:
1. Launch the time-depth conversion dialog.

Scenes View Utites Help

Create Seismic Output » Aftributes
Create Horizon Output » 2D <=> 3D
(Re-)Start Batch Job ... Angle Mute Function ...

Dip Steering »

Fault Extraction ... From Well Logs ...

Prestack Processing

L |

GMT Mapping Tool ...

@  HorizonCube » Velocity

Madagascar ... Volume Builder ...

P4 Bayesian Classification ...

Use the velocity volume to time-depth convert volumes in batch mode.

2 re A A
29
v . -

I 1 Seismics

Time - Depth Conversion ...

Velocity Conversion ...

In general, the depth volume does not change laterally from the original cube
(thus InL/XL step stays the same) but the depth Z range can be larger.

Workflow cont’d:

3. Define the depth range and the step

4. Selectthe Time volume to be converted

2. Select the Velocity Model (in this case, Velocity Model (INT)).

# Time to depth volume conversion

Time/Depth conversion

Direction @ Time to Depth O Depth to Time

Z transform Velocity volume <

Velocity model (m/s) né = lVeIocnty model (INT)

Depth Range (m)IO | [2100 | step El

Input Time Volume né B [4 Dip steered median filter

Area subselection |-

Output Depth Volume

 Execution Options ...

- m} X
v|| @ select .| | Edit .
|
v'I € Select .
© Select ...
~| | © select ...| @ cBYS -
€ Cancel | @) Help
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Workflow cont’d:

5. Specify the new output depth volume (e.g. D-4_DSMF).

6. Click on OK. The volume will be saved in depth and stored in the
time survey

# Time to depth volume conversion - (m} X

Time/Depth conversion

Direction @ Time to Depth O Depth to Time

Z transform | Velocity volume v
Velocity model (m/s) = *3 | Velocity model (INT) v| & select ...| | Edit ...
Depth Range (m) [0 |[2100 | step[s \
Input Time Volume Aé = [4 Dip steered median filter v‘ © Select ...
Area subselection [ | © Select ..
Output Depth Volume | D-4_DSMF| v| © select... @ cBVS ~

i+ Execution Options ...

© Cancel | g Help

Workflow cont’d:

7. To display the new depth volume, go to the depth scene. Click on the scenes,
Select New [Depth].

8. A new window will pop up, Make sure all inputs are correct, and then Press Ok.

) Velocity model - (m] X

Select velocity model to base scene on

Z transform  Velocity volume v

Velocity model (m/s) *i&, | Velocity model (INT) v| © Select...| | Edit ...

Depth Range (m) [0 |[2100 | step[d] \

€ Cancel | () Help
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Workflow cont’d:

9. Right click on inline > Add and Select data

10. In the pop-up dialog, Select the depth volume.

11. Hit Ok, and a new depth volume will be displayed

Elements Color
Dep sing ‘Velocity...

w! Add Default Data

N
“WAN| Add and Select Data

@ Volu  Add at Well Location ...
~ Rar  add Color Blended
X7 2D ke

T

.
) Select

Selectfirstlayer

Stored
Steering

Attributes

T

[0k | [© cancel] [ @ Heir |
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1.5.1a Bright Spot
Required licenses: OpendTect.

Exercise objective:

Isolate an amplitude anomaly (bright-spot) using attribute analysis and visualize the
anomaly in 3D using volume rendering
Workflow:

1. Launch the attribute set window: click on the Attribute 3D icon » | and select 3D.
2. Define the Energy attribute with default parameters.
e Attribute Set 3D

od A X LT AN

- olEN
Altribute set | <not saved> Basic vIEnergy Jl 2
Energy -28,+28] Input Data [4 Dip steered median fitter V|| © setect
Time gate (ms) -28 28
Compute gradient O Yes @ No
Output [Energy g
ry
f
4
z¥
-
Altribute Name |Energy [-28,+28] Add as new! [l
| Save on Close @ Close | @Help
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Workflow cont’d:

3. Provide an attribute name as Energy [-28,+28] and press Add as new.

- Attribute Set 3D - olEl
File
D L L2
ol B X TR T S
Attribute set | <not saved> Basic v| Energy v ?
Energy [-28,+28] Input Data 4 Dip steered median filter v| © Select
Time gate (ms) -28 28
Compute gradient ©) Yes @ No
Output Energy v,
Defined
attribute(s)
appears Iy
here. 3
AL
-
Atribute Name Energy [-28.+28] | Aod as new |l
@Close | @Help

! Save on Close

There are no restrictions on the length of the name: it may contain spaces. It is
recommended to use a name that contains all essential information of the attribute. It
helps you remember what this attribute does, and prevents having to go back to this
attribute window to see the exact definition of the attribute.

Workflow cont’d:

4. Tick the Save on Close box and press Close.
Alternatively, press the Save as icon g and press Close.

5. Provide a (new) name for the attribute set like my first attribute set and press OK.

Attribute Name  Energy [-28,+28] Add es new [l

[rsme oo O] o

- save Attribute as  — = [HESM

- Select output Attribute
=

Filter *

4 IR DR T TR =

File

X a

Add as new! [l

v

Name [my ittt 5o
) Cancel | @ Help
R

£
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Workflow cont’d:

= Wiining
& Add Default Data

Scene 1 ‘

6. In the tree, right-click on In-line and Add and Select Data
select Add Default Data. S 25 L S sonses
a8V 1.‘;1-790
7. Change the inline position to 250: select
the inline in the tree and type the position ini 2505 ptep 1 [+ 4m w4500 | ]
using the position toolbar.
= @ Indine ‘
8. Add an extra attribute layer to inline 250: o oo T A F T
right-click on the inline number in the tree @ Jours) Duplicato @ HorizonGube Display
i ~ Rand¢ R?set LT ETED £% Systems Tracts Display
and go Add > Attribute. 7 RandC Display Prestack Data »
@ 3p H¢ = Correlate with Wells ...
42D H( g Lock Treeitem
9. The attributes available are organized in FaulS e omove from Tree
three categories: Stored, Steering and _
Attributes (from the active attribute set and < Selech - ol
calculated on-the-fly). Noiotiteichih
Go to the Attributes section, select your 2 Stored
attribute Energy [-28,+28] and click Ok. O steering
s
=Y
Ocancel @ Help
Workflow cont’d:

Results should look like this.
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Workflow cont’d:

Color-bar

Visualizing the results is almost as important as the results themselves. Therefore, try
different color-bars for your attribute. Each attribute layer has its own color-bar.

1. Click on the attribute from the tree and change the color-bar.
Try: Chimney, Faults and Grey scales.

» @ ¥ > W

300857 J343010/ 11 seismics v
Dip2 ~
111 Double Rainbow

- ig! In-line -
5-[v] 250 . Eg::agk; Tasty
E erg) -28,+28] 2] 1 Experimental
vl 4 Dip steered ... 11 11 Extremes
1 Faults
E Flames

a Grey scales
1 Greyn

Workflow cont’d:
2. Right-click on the color bar: select Manage... 32373 IQﬁ;;;L'Selsmms
A Ranges/Clipping
Edit color markers Manage

Set as default

from the main window

The color can be edited by double clicking on

one black marker below the histogram. To add | |~ LR R mal__
a new marker, double click at the position you
want, select the appropriate color and click Ok. Colortable_| Statuts

Matteo ter... Default

Drag the marker to change its position. Right- Matteo fer... Default

Add, remove, change color tables

) Pastel Default
click on a marker and chose Remove color to Aly B
ressure Default
de|ete |t Rainbow Default
. Rainbow ... Default
e I |
From the table ReaWhi Dofout e —
g g g g g SandShale Default S tati N v
Right-click in the white section of the color-bar Sesmcs  Dofut SRR
. . . imilari efaul % =
displayed under the histogram and chose Edit | | sumso Dot Undefined color Transp (0%
Ul
markers... In the table that pops up, the colors UVQs Ex... Defaut ]| [Markercoby
and position of every marker can be edited: for Remove . | Import .. Fip | |Saveas
a specific marker, you can type in a new ©oK || cancel| | @ Hep
position and change the color by double-
clicking on the used color. When right-clicking .

onh a marker, you can either delete the selected
marker or add a new one above or below.
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Workflow cont’d:

Segmented vs Continuous

The color-bar can be continuous or
segmented. When changing the Segmentation
from None to fixed, you define the number of
the segment. Segmented color-bars are in
particular used when displaying a discrete BT

attribute, for example a Neural Network result: Matieo ter -

Pastel

SunRise

alters the parts of the spectrum that are Ty

displayed. Drag the seeds up to modify the :
transparency. You need to have a seed at each
extremity of the histogram: add new seeds by
double-clicking on the red line and drag the
seed laterally and vertically. To remove a seed,
do ctrl+click on the seed.

Remove

one color corresponding to one class. Porosity
Pressure

Rainbow
Rainbow ...

Transparency Red-Whit.
q 2 g Red-Whit. ..

The red line in the histogram represents the Sandshale
. . Seismics

transparency: changing the transparency line Similarity

Status

Defauit
Default
Defauit
Default
Default
Defauit
Defauit
Default
Defauit
Default
Default
Default
Default
Default
Default

Import ..

Add, remove, change color tables

Manage ColorTable - okl
— |
|Segmematlon None v |
Undefined color Transp 0% 5
& Marker color
Flip Save as .
@oK | @ cancel @ Help

b
Workflow cont’d:
3. Press Cancel to close the color-bar manager.
. o . = R |
The undefined color is the color that will be Manage ColorTable N
used for undefined values. You can adjust its | | " moe chenoe coertaves
transparency. Cokr talo [ Stk ~
atteo ter.. efaul
The changes you are making are applied in the RE e T
same time in your scene: you can actually QC | | feer, Do
the color-bar edition. Rainbon . Defaut , .
Red-Whit... Default k ﬂ
O d th th | _b dt Red-Whit... Default
nce yOu are one wi € color ar edi |ng, SandShale Default Segmentation None M

i i i Sei Default
you can save it with another name or overwrite T B Undefned colr trarce [
the color-bar you were using (not| | SuRes Defeut

a a a Mark I

recommended) by just clickihg OK and | | \UYGsEx.. Defaut v| amereoer
Continue. If you do not wish to save the omove .| [meort o ||Sawes.
modifications, click on Cancel. ©ox @ Help
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Workflow cont’d:

4. Right-click on the color-bar and select Set as default: it will set the specific color bar
by default for all the attributes to be displayed that do not have a specific color bar

attached to them.
309857' r Flipped

Ranges/Clipping ...
Manage ...
Set as default

5. Optionally, right-click on a stored attribute (volume) in the tree and select Save
Color Settings to save the color-bar and the color range: it will be used when loading
this specific attribute again.

Scene 1
= ) In-line
(vl 250
[v] Energy [-28,+28] m
0] 4 Dip steered . gty
# Cross-line Select Attribute »
& Z-slice Save Color Settings
® Vvolume Move B
~ Random Line Display b

%/ 2D Line

“ 3D Horizon - Rem?ve

The color-bar right-click menu allows you to flpp the color bar, change the
Ranges/Clipping (to set the scaling values symmetrical around zero), Manage the color
bar, Set as default.

Workflow cont’d:

Evaluate attribute parameters

Now we are going to evaluate the Time gate parameter of the energy attribute by
interactively (movie-style) evaluating its parameter settings:

1. Open the Attribute Set window: click on the Attribute . %328
seticon , i and select 3D. | Eneray [-28,+28) K]
2. Activate the Energy [-28,+28] attribute displayed on \v] 4 Dip steered ... ¥

inline 250 in the tree.

- Evaluate attribute -0 n

Set parameters

3. In the Attribute Set window, select the Energy attribute
again and press the Evaluate attribute icon 'g%,

-~ Attribute Set 3D Evaluate Time gate v
Do Initel value 28|28

a [ X

S IA T TR

Increment -4 4
Aribute set <not saved> Basic v/ Energy v
Energy [-28,+28] Input Data 4 Dip steered median filter ~ Nr of steps 2 < Calculate
_—

Time gate (ms) -28 28
Compute gradient O) Yes ~ ® No Store slices on "Accept

Output Energy v

@ Accept| @ Help
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Workflow cont’d:

® palateatribite  — O EMN
4. Select the parameter to evaluate: Time gate Set parameters
(in this case, there is only one type of
parameter to evaluate so it is selected by Evaluate Time gate >
default). Initial value -4 4
5. Provide the parameters for the time gate as Increment -4 4

shown in the image on the right.

Nr of steps 10 % | Calculate

8. Press the Calculate button. Siice

7. The slider becomes active once the on-the- Store slices on "Accept’
fly processing is finished.
Move the slider to see the results for a
certain slider position, corresponding to a Accept| | @ Help
time gate in this case: observe the changes E
in the 3D scene (see the following slides, for
instance).

Slice | U

If an attribute is defined using a time gate and/or
a step out, these parameters can be evaluated

the same way. Time gate [-16,16]

Store slices on 'Accept’

Workflow cont’d:

8. Evaluate the attribute by moving the slider position.

Time gate [-8,+8]ms

@ Evaluateattribute = — O
Set parameters
Evaluate Time gate
J Initial value -4 4
Increment -4 4
Nr of steps 10 + | Calculate

Store slices on 'Accept’

Time gate [-8,8]

_QAccept‘ @ Help
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Workflow cont’d:

@ Evaluate attribute  —

Set parameters

Evaluate Time gate
Initial value -4
Increment -4

Nr of steps 10 5 Calculate

Store slices on ‘Accept’

Time gate [-20,20]

I OAccept‘ @ Help

Time gate [-20,+20]ms

Workflow cont’d:

@ Evaluate attribute  — &

Set parameters
Evaluate Time gate
Initial value -4

Increment -4

| Nr of steps 10 3 | Calculate

Store slices on 'Accept’

Time gate [-36,36]

I QAccept‘ @ Help

Time gate [-36,+36]ms

If you Accept at this point, [-36,36]ms will become the time gate of the attribute that you
were evaluating. In this manner, you decide the optimum time gate.

You may also say that this might be a too large time gate for this feature when compared
with a narrow time gate e.g. [-16,16]ms.
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Workflow cont’d:

. i & paluateatibute  — O HEM
9. Once the best time gate has been decided, press ——
Accept to update the attribute with the selected time —
gate_ valuate Time gate
Initial value -4 4
10. Update the attribute name according to the selected Increment -4 4
time gate Nr of steps 10 % | Calculate
Slice | U
11. Optionally, click on the & icon to save the attribute set Store sices on "Accept
window or tick the Save on close box, and close the Time gate [-20,20]
window. .
Workflow cont’d:

Create a seismic output

So far, everything was done in memory. We are now going to calculate and store the
Energy attribute on disk as an OpendTect volume.

1. Click on the Create Seismic Output icon g and select 3D or go to Processing >
Create > Seismic Output > Attribute > Single Attribute > 3D

isScene View Utilities Help

(Y reate eismic "'P“' : - Single Attribute 3 o0 ..
reate Horizon Out » = :
= put 2D <=>3D 7 * | Multi Attribute ... mL
e 4 Wells 4 Angle Mute Function ... MultiCube DataStore ... | l
(Re-)Start Batch Job ... | ¢ Bayesian Classification ... ~ Along Horizon »
~ Dip Steering N From Well Logs ... =y Between Horizons ~ »
= GMT Mapping Tool ... Prestack Processing »
e | @ HorizonCube » elocky ; ’
0 Madagascar Volume Builder ...
Ed g Re-sort Scanned SEG-Y ...
yl SSIS
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Workflow cont’d:

2. Select Energy as the Quantity to output.
3. Select a volume sub-selection:

Inline range: 100 — 300, Crossline range: 900 — | = Position - o IEd|
1150, Time range: 432 - 600 ms Specify Position
Press OK.
) Volume subselection Range Ml
4. Press OK to start the processing. ‘ . . .
r’ In-line Range 100 |2 (300 < Step |1 <
) Create Volume Attribute Cross-line Range 900 |2 1150 £ Step 1 5
| Quantity to output Energy [-16,+16] | v| | © Select ... Time Range (ms) 432 5 600 < Step 4 =

Volume subselection 100/900-300/1150 (43 samples) © Select ...
QoK | @cCancel @ Hebp

Null traces @ Discard () Pass

[[] Scale values:  Shift/Factor

[ Output Cube |Energy [-16,+16] | v| © select ... @ CBVS v

Batch execution |Single Process v| |4+ Options .

@oOK | @ cCancel @ Hep

By default the processing is single-machine, To speed up, you can use the multi-
machine processing (requires plugin).

Workflow cont’d:

Volume Rendeting

The objective of the last step of this exercise is to fully visualize the bright-spot in 3D.

1. Right-click on Volume and Add. It will insert an empty volume in the tree which is
centrally positioned in the scene.

2. Position the volume: Right-click on <343-506 / 656-893 / 692-1156> and go to
Display > Position.

i ¥4 Dip ... 1
® Volijes
2~ Ra
- [v| R Add Color Blended + @ Volume
4Dip... 11 + [9)[342-506 / 656-893 / 692-1154
7] <right-click> Add il
~ Random Line Display * |l Histogram ...
2D Line Duplicate »* Properties ...
“ 3D Horizon Reset Manipulation + Position
# 2D Horizon g Lock Treeitem
Fault
FaultStickSet == Remove from Tree
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Workflow cont’d:

3. It will launch a position dialog: fill in the ranges:

Inline range: 100 — 300, Crossline range 900 — 1150, Time range: 432 — 600ms.
Press OK.

4. Select Energy from the window in the Stored category and Press OK again.

=) Positioning - O n

Specify the element's position

In-line Range 100 3/ 300 (% &%

- Select - oIEd

Select Layer 1

9-1 Similarity on FEF seismic ~
. _ 9-2 Dip-steered diffusion filter
O Cancel @) Help Steering 9-3 Fault enhancement filter

9-7 Thickness UVQ6 segment slice520
_) Attributes 9-8 UVQ6 Hor 4-8 seament

= < >

(o)
\'=> Filter *

Cross-line Range 900 £ 1150 =

Z Range (ms) 432 3 600 <

v

© Cancel | @) Help

BA

Workflow cont’d:

5. Change the color-bar to Chimney and optionally adjust the color range.

[ )
280000( I ‘810000( = Chimney 5

6. In Position mode% , leftclick (keep pressed) and drag to re-position the surfaces of
the volume or just scroll through in this manner to view the contents.

Attributes calculated on the fly can
be displayed using the volume
rendering. For large volumes, it is
recommended to store them prior
displaying to save time.
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1.5.2a Spectral Decomposition

Required licenses: OpendTect.

Exercise objective:
Study paleo-geomorphological features by displaying 3 iso-frequencies simultaneously with
color stacking.

Workflow:
2D Line
1. Right-click on 3D Horizon in the tree and click on Add
color blended... e
Choose horizon Demo 1->MFS4 from the list of horizons. ngt( o

2. Optionally, to speed up the exercise, click Select for area sub-selection and set

inline range to 200-650; crossline range to 500-1000.
Press OK to apply the changes and then click OK to display the horizon.

' Select Input Horizon (s) e B \
- * . —
! ik ' Position o -E- e
Demo 0 --> FS4 B
¥ Demo 1 —> MFS = Specify Position
rr | L) Demo 2 > FS6 a
& Demo 3 > Top Foresets
= |5 pamo 4 —> Truncation x Area subselection Range ] =
Demo 4 —> Truncation trim & fill
Demo 5 > FS7 In-line Range 200 = 650 < Step 1
Demo 6 > FS8

Cross-line Range 500 5 1000 = Step 1 :

) Cancel| | § Help

Demo 7 --> shallow

Area subselection  100/300-750/1250 (463 samples) ) Select - F
© cancel| | @ Help

emo_2015\Surfaces\Demo_1_—__ MFS4.hor

Workflow cont’d:

In the tree, the horizon appears with 4 separate attribute layers. The three lowest attribute
layers represent the RGB channels (see color flags next to each layer). Three attributes can
thus be blended into a single display.

! OpendTect Pro V6.0.0pre7-20151016/win64: F3_Demo_2015 - [Scene 1]
Survey Analysis Processing Scene View Utilties Help

Al b QB 2 TR - »| crossiine step)

11 Seismics M

N Tree scene 1 s
Eloments Colot

® | scenet

@ In-ine

& | wcussine

. @ Zslice

= ® Volume

~ Random Line
4
9
'

/

Faul
FaulStickSet

Wel
i Pickset
[ Polygon
S Prestack Events
Annotations

liree mem] 4.37.9 GB [
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Workflow cont’d:

3. To define 3 different attributes that will be loaded to the RGB channels of the horizon,

open an attribute set 3D: click on the , | icon.

@) Attribute Set 3D

2 o |1 T

"P'!‘tdr:&affL
Attribute set | <not saved> <A | Spectral Decomposition -2
Input Data 4 Dip steered median fiter | |© Select

Transform type © FFT CWT

Display Time/Frequency panel

Output frequency (Hz 50 < Step 50 =

Adtribute Name Add s new| [l

| Save on Cose

[ @cCiose || @Hew

When the extraction of an
attribute is done on a horizon,
choosing the right time gate
is critical. The time gate
represents the interval of
investigation. If a

symmetrical time gate is
chosen (e.g. [-28, +28ms])
the attribute will highlight
geological features above
and below the horizon. When
an asymmetrical time gate is
chosen (e.g. [-8, 24ms] or
[24, 8ms]) the attribute
response will highlight
geological features below or
above the horizon.

Workflow cont’d:

5. Right-click on Inline in the tree > Add Default Data
Inline 425 will be added to the scene.

Tree scene 1

Elements
Scene 1

t Data
Add at Well Location
Add Color Blended

Ad

6. Reduce Z ranges of the section, so that it just covers the horizon interval: select the

inline and drag the green anchor vertically.

7. Right-click on the 4 Dip Steered Median Filter attribute and select Display > Amplitude

Spectrum...
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Workflow cont’d:

8. Within the amplitude spectrum, identify the frequencies to be used as the low, middle
and high frequencies: the low frequency can be selected as being the first peak (e.g.
24Hz), while the high frequency as the last peak (e.g. 64 Hz).

After choosing the frequencies, close Amplitude spectrum window.

) Amplitude Spectrum for 4 Dip steered median filter o || B
| |

0 2 g[r)equency (HZ)S 100 125
Display between frequencies 0 125 Gridline step 25
Value(frequency, power) 23.7025¢ -5.38955 [v¥| Normalize (v dB scale N
iDlspIay cepstrum B Export ..

Workflow cont’d:

9. Back to the attribute set window: create the first Spectral Decomposition attribute and
set the input data to 4 Dip Steered Median Filter.

10. Set output frequency to 24Hz with a step of 4Hz.

11. Give a name to a new attribute, e.g. SD_24Hz[-8,24ms], and press Add as new.

= Attribute Set 3D o @ .
File
> [ &£
*PSVE R e
Attribute set | <not saved> Frequency [v] Spectral Decomposition &2
SD_24Hz[-8,24ms] Input Data[4 Dip steered median filter 7] |© select
Transform type @ FFT cwr
Time gate (ms) -8 24

Display Time/Frequency panel

Output frequency (Hz|240 5 Step 40 <

A

Attribute Name| SD_24Hz[-8, 24ms] | IAdd as newl a

7| Save on Glose [ @ciose | [ @ Hep
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Workflow cont’d:

12. In the same manner, create the other two attributes for middle (44Hz) and high (64Hz)
frequencies: change the output frequency value and the attribute name respectively.
Click Add as new every time when a new attribute was defined.

13. Click on Close.
Optionally, give a name to the new attribute set, e.g.. Spectral Decomposition (if Save
on Close is toggled on).

@) Attribute Set 30 o [@=
> [ X
P EE R MWL
Altribute set <not saved> Frequency [v] Spectral Decomposition 2
Input Data |4 Dip steered median fitter [+] |© setect
Transform type @ FFT O CWT
Time gate (ms) -8 24

Display Time/Frequency panel

Output frequency (Hz|24,0 = Step 4,0

t
¥
!
N
Attribute Neme [SD_24H2(-8,24ms] | [Add as new] ]
@rep |
Workflow cont’d:
[EITESIE) Scene View Utilties Help
i . . Create Sexmlc Output * hos * gtan 1 ~| ‘ _&\ = &
14. To convert your attributes into Horizon Data. ...
" i (Re-)Start Batch Job .. Horizon Curvature ... [JERINN
go to Processing > Create Horizon Output > D Seaing , | Stratal Ampiitude ..
Attributes > 3D. = GMT Mapping Tool lsocnon

@ HorizonCube »
Madagascar ..
£ ssIs >

15. Select the SD_24Hz_[-8,24]ms attribute to output and the Demo7->MSF4 horizon on
which it will be output and press Run.

16. Process the two other attributes in similar way.

) Select [E=R ]
! Calculate Horizon Data from 3D =@ Select Quantity to output
Quantity to output SD_24Hz[-8,24ms] B |0 Select >
Stored
Atribute Name SD_24Hz[-8,24ms] AT gg,g::;{gé:::}
Fill undefined parts ©) Yes @ No Ig
c )
aleulate on Horizon iy [Demo 1—> MFS4 [+]|© Select I@
Batch execution Single Process 3 [ = Options ]
' © Close l [ @ Help | ) oK I O Cancel| | @il J
L J L J X

Saving as Horizon Data is faster than calculating on the fly along a horizon. Moreover, the
process is done in batch, so can be preferred simultaneously for other Horizon Data.
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Workflow cont’d:
5[] Demo 1 —> ...
] <right-click>

. . 7| <right-click> ==
17. Display the three new Horizon Data D it ko> =
on Demot-> MFS4. rightclick the text 20 torzo SRV soed Cuoo
adjacent to the red channel > Select attribute > _ feutSick  oispay »| SteeringCube  »
. ! Save as Horizon Data »
Horizon Data and select SD_24Hz_[-8,24]ms. . W =
—_ — 2 PickSet
[ Polygon Remove Steering 2D Data »
&\ Prestack Events
Annotations Z values
) Horizon Data oo s
Select one or more attributes to be displayed
on the horizon. After loading, use 'Page Up'
and "Page Down' buttons to scroll.
Make sure the atiribute treeitem is selected
and that the mouse pointer is in the scene.
Fiter *
SD_24Hz[-8,24]ms
SD_44Hz[-8,24]Jms
SD_64Hz[-8,24]ms
[ o [[ccence
18. In the same manner, select SD_44Hz_[-,24]ms - @ 3D Horizon|
- n = [v| Demo 1 > M
data for the green channel and select 7| <right-click>
SD_64Hz_[-8,24]ms for the blue channel. . 2%‘32:32
7] SD_24Hz_[-...
@ 2D Horizon
Workflow cont’d:

19. When blending the three inputs, the results should be similar to the one shown on the
figure.

Some extra steps:

« Try to flip the green channel : right-click on the color bar, a menu pops up which allows you
to flip the color bar).

7105.71 36337.9| I 1 Seismics

Ranges/Clipping ..

« What do you notice? Do you see one feature better than the other ones? Which paleo-
geomorphological features can you interpret? What can you conclude in terms of
depositional environments, water depth, litho-facies, and direction of currents?
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Workflow cont’d:

We normally create RGB with three channels; Red, Green and Blue. A fourth attribute (called
Alpha channel) can be optionally added to highlight structural features like faults/fractures.

20. To define ‘Similarity’ attribute and add it to the fourth layer, open the Attribute set 3D

window with the , :| icon and select Similarity.

21. Select Extension: All Directions.

@) Attribute Set 3D

22. Select Min for Output statistics. ' ~® & el & Wik
Aftribute set | <not saved> <AI> [+] similarity F?
S0 240 Zims] [ mput Data 4 Dip steered median frer -] © seect...
23. Give it a name (M[n_s,‘m[la[flfy) 3'%5%".?1,75‘%} Time gete (ms) 28 |28
i
and click Add as new. S ”:“ :
tepout [inl4 4 crif 2
Steering None ]
24, Close the Attribute set window. .
¥
2t
i
9 Sevo on Ciose @
N

Workflow cont’d:

25. Right-click on the fourth element on Demo 1--> MFS4 > Select attribute > Attributes 3D

and select Min_Similarity.

@ 3D Horizon

= [v] Demo 1 -> M -
&) <right-click> B _
GEVICIIFEE  Select Attribute il Stored Cubes [ 5
2 So_tdte [ *

SD_24H ove

v 1

@ 2D Horizon 2| Display * | SteeringCubes
Fautt Save as Horizon Data Stored 2D Data
FaultStickSet Tools > | Attributes 2D

@ Body

Remove Steering 2D Data *
Well T Horizon Data (3)
i PickSet I
™ Palvnnn Zveles

SD_24Hz_[-8,24]ms
SD_44Hz_[-8,24]ms
SD_64Hz_[-8,24]ms

»
»

What do you notice? Do you see any structural features (faults, fractures)?

Extra Step: After processing several frequencies to a seismic volume, use PgUP and
\ to toggle between the processed frequencies for the different channels.

X
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2.3.1b Dip & Azimuth

OpendTect Pro, Dip-steering

Exercise objective:
Compute Dip and Azimuth attributes from a SteeringCube.
Workflow:

LUEEEN Processing Scenes View U

. . . . . § Atributes il & 20 .
1. Go to the Attribute engine: Analysis > Attributes > 3D or click

on the .| icon> 3D ;‘g‘;fg;:f;"';‘;;“ :
2. In the attribute set window, select Dip attribute.
3. Select 2 Steering BG Detailed as input and Polar dip as

output.

4. Specify a name for the attribute (e.g. Polar Dip) and Add as
new (optionally save it).

= Amidte S 10 PR ==
File
sl LR XTI Y 35
PR — oo ] e o]E3
Polar Op Saoering Data ) [/ | 2 Steenng BG Detaen [ seea
+
+
+
Iﬂ::mur Name Fotar Dig Ik a5 e b'
Save on Close o Giose| 9 Heip
Workflow cont’d: * 3D ez
20 Honz:
Fault Add at Sections Only
Fault5ticl  Add Color Blended
: W Body Track New
5. In the 3D scene, Load horizon A Consant 2
Demo 1 --> MFS4 by right-clicking = P
on 3D Horizon in the tree. . =k
- er
> Demo 0 -> F54 <
B | Demo 3 > Top Foresets ol
Dermno 4 —> Truncation
Demo 5 - FST o
Demo 6 > FS8
Demao 7 shallow
B s ot
Area subselection 100/300- 7501250 (463 samples) © Sedect .
O cnce] (@ How
* 30 Horizon ining_v6\SurfacesDemo_1_—_ MFS4.hor
7

2 zaes I (T S

' 2D
e Display * |4 Volume Builder Atiribute
FaultStickSet Tracking : Gontour Display

® Body Tools Horizon Data

6. In the tree, right-click on the loaded :‘:Lam E=E=R
horizon and follow Add > Attribute : _
select the Polar dip attribute. The :;TW
attribute is calculated on-the-fly.
Y
Alternatively, you could process the FPolar Dip attribute as %
horizon data and afterwards add it (see the sectionon [S2K] (0 cancel] (@ e |
Spectral Decomposition).
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Workflow cont’d:

7. Change the colorbar to Grey scales and the range to 0 to 70.

Workflow cont’d:

8. Save the attribute to the disk by right-clicking on it's name (i.e. Polar Dip), and
selecting Save as Horizon Data.

P4 3D|;eom"§uin‘.> MFS4 S GRiprXeiection ESSlE o
j Select Attribute y Specify attribute name
2D Herizon Move *
Fault Display ’ Attribute
T e
Lowell Tools ’ o Cancel| | GHE| ]
.« E'r'.kSEt = Remove . B

the two?

Try displaying the Azimuth attribute in the same way as Polar Dip. What differences do you see between

Ouitput | Azimuth -

= Attribute Set 30
File
A AEI TLT LEE
Atiribute set <not saved> Dip [+] |oip |2
Polar Dip Steering Data =‘> & 2 Steering BG Detailed ~| [ Select
Azimuth —

ol =]
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2.3.1c Dip-steered Similarity

Required licenses: OpendTect Pro, Dip-steering.

Exercise objective:

Compute a Similarity attribute with and without dip-steering.
Workflow:

Go to the Attribute engine: Analysis > Attributes > 3D or
click on the | icon > 3D.

In the attribute set window, select Similarity attribute.

Keep the default Input Data 4 Dip steered median filter and
default time gate [-28 +28] ms.

=N Processing Scenes  View Uil

& Volurne Builder
Ei Cross-plot Data
Well

= Attribute Set 30

Time gate (ms) -28 28
[Extension ITET=T=m—]|
[stepout [ini1 = ent1 =]

Steering None

B

File
o AL LI T
Atribute set | <not saved= <Al Blemiay,  Efk
Input Data |4 Dip steered median filter 3 © Select
Time gate (ms) -28 28 |
Extension Cross [=]
Stepout | inl:1 = |erk1
Steering |None 3
Workflow cont'd:
4. Select Extension: All Directions.
5. Keep the default stepout, i.e. inl:1; crl:1.
= Attribute Set 3D [= o=
File
PPN AW -
Attribute set | <not saved=> <All> Z Similarity Z| ?
Input Data 4 Dip steered median filter 3 _O Select J
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Workflow cont’d:

6. Specify Steering: Full and select 3 Steering BG Background.

7. Choose Output statistics: Min.

8. Give a name (e.g9. FS_Similarity) and Add as new.

|Oulpul statistic Min .l

Time gate (ms) -28 28
Extension All Directions T|
Stepout | inl:1 = e
Steering  Full .]
Steering Data a& -\‘b 3 Steering BG Background E| .O Select
t
+
+

|Allnbute Name |FS_Similarity

Add as new'|| A

Save on Close

lo Close | 9 Help

Workflow cont’d:

9. In a similar way, define a non-steered Similarity attribute by
selecting Steering: None.

10. Give it a name (e.g. NS_Similarity) and Add as new. Optionally save the

attribute set. Click on Close.

Add as new'|| F |

WS _Similarity
Time gate (ms) |-28 28
Extension All Directions T|
Stepout inl:1 = ed:A
Steering Mone '~] |
+
[Fid
—
Output statistic | Min :v
Attribute Name  NS_Similarty
Save on Close
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Workflow cont'd:

11. Display seismic data on inline 425 by
right-clicking on In-line > Add and
Select Data.
Under the Stored tab select 1 Original

Seismics.

12. Select inline number 425 in the tree,
go to the top toolbar, change it to 250

and press

enter.

Elements

Add Default Data
Add and Select Data
Add at Well Location ...

N

W@ Cn
¥ 7s
® Vol

&

" % Add Color Blended

= s )
Select first layer
e ,
4 Dup sleeied median fifter
Steering 5 ChimneyCube g
Ta Al Cube Std
Attributes 7b Al Cube from HorizonCube
. 8a PorosityCube from HC-NN
& 8b Gamma from HorizonCube i
= 6 1 Sirmitarit an EEE caicmic
g Filter
Qe @es

1 Original Seismics

7y Survey Analysis

& il WE E
In-line 250 & «*

Processing &

T |Step 1

Workflow cont'd:

13. Load first the steered similarity attribute (i.e. FS_Similarity) by right-
clicking on inline number 250 > Add > Attribute.

= W In-line
=5-[

@ Cross-line
= 7_clica

14. Similarly, load the non-steered similarity attribute (i.

5§ In-line
> WEE
¥ FS_Similarity
¥ 1 Original Seismi

splay

Pemtinmbn

Display

3

250)
71 ongna I [

% Volume Processing Attribute

4 Volume Processing Attribute

Select Layer 2

Stored

. NS_Simaarity
Steering

&
=Y

[Glows@m)

e. NS_Similarity).

(= Select

== Fon =]
Select Layer 2

Stored

FS S\mi\ams ]

Steering
s
S .

[GeJooms (@)
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Workflow cont’d:

15. Change the color-bars of both the similarity attributes to Similarity.

=- g In-line
=[] 250
EINS Similarity 06 I o9 [m Simiarty &
¥ FS_Similarity
¥ 1 Original Seismics

16. Compare the two similarities by ticking on and off the upper attribute (here
NS_Similarity).

What is the influence of dip-steering?

i ‘.-h I .'*&li .. I i m'. L 'i’!l_l.hlf'.‘.‘; |

Inline 250: Non-Steered Similarity (left) and Steered Similarity (right)

- 147 -




2.3.1e Mathematics

Required licenses: OpendTect.

Exercise objective:
Analyze the noise removed by the Dip-Steered Median Filter using the Mathematics attribute.

Workflow:

Note: This exercise uses the attribute setfrom the previous exercise. ‘

1. Define a new attribute (in addition to DSMF of previous exercise) of type Mathematics
and write the formula: ‘filtered — original’ and press Set.

Basic z| | Mathematics ZH z

I MathFunctions E sqgrt (Square root) 3 Insert
Formula (like 'nearstk + c0 * farstk’) | filttered - original | Set

| For filtered' use  DSMF [~

|For ‘original’ use [1 Original Seismics] EI

2. Use the previous attribute definition (i.e. DSMF) for filtered and the stored volume 7
Criginal Seismics for original. Give the attribute a name (e.g. Noise) and Add as new.

Workflow cont'd:

3. Right-click on inline number 425: Add > Attribute.

4. Select the Noise attribute.

W In-line

- [ Add
< DSMF _
¥ 1Onginal 5 Display " % Volume Builder Attribute
e — ATESD € HorizonCube Display
& Z-slice Reset Manipulation =
@ Volume Correl . - Systems Tracts Display

W Sdeet =3 o =
Select Layer 3

Stored  [pSMF

Steering

fs

=Y
Q Cancel: | @ Help |

Use the same color-bar for original seismic, DSMF seismic and Noise for a fair comparison.

| 4500 [T W 4500 [ Seismics Bl

- 148 -




Workflow cont’d:

Your result should look like this.
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2.3.1h Unconformity Tracker

Required licenses: OpendTect Pro, Dip-Steering.

Exercise objective:
Create two horizons: 1) a seismic event constrained by a few manually picked positions;
2) an unconformable event constrained by well markers.

Workflow:
1. Pre-load the default seismic data set (4 Dip steered median filter).
2. Add an in-line (Add Default Data)
3. Add the stored Random Line called: “Random Line through wells”
4. Add all 4 wells o
5. Go to 3D Horizon > fi:“li‘ e
New > Track Unconformity ... -EV:I%“ NMI — Auto and Manual Tracking ..

Track Unconformity ..

¥ FO8-1
¥ FO3-4
¥ FO3-2

Thalweg Tracker ...
With Constant Z ...

Traditional trackers follow amplitude and phase. Unconformities do not exhibit consistent
amplitude / phase behavior and can thus not be tracked with a conventional tracker. The
unconformity tracker flattens the dip field using a constrained inversion-based algorithm.
Constraints are given in the form of picked positions and (optionally) a confidence weight
volume.

Workflow cont’d:

6. In the Unconformity tracker window, select the input steering cube for the tracking: 2.
Steering BG Detailed.

Ideally, use a detailed steering cube (see Exercise 2.3.1a) calculated on enhanced seismic.

7. Optionally, limit the output  Uncntormty mcr B
extend by using the Steering Data .,‘='> B Iz Steering BG Detailed » 6 select..|
Volume sub-selection. Volume subselection Ilm_um-;aofusu (463 samgles) e Salacl..l

Pickset Color  Options Horizon
8. Optlonally, Change thE Hnrimnj- Edit ... Ihri.\r'»mn-:h.\knmh-,:fm\f.n.\int1I
. Horlzon 2
names of Pickset and dortson 3
Horizon by double clicking Hortzon &
on the respective fields.

{[1][ % b

7| Execute in Batch | 4.} Options ... Processing parameters ...

O Run | | D close | @ Help
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Workflow cont'd:

9. Click on the Pick Seeds icon ««* and
pick a few points (minimum 3) on the
event you want to track.

10. Optionally, pick more points on in-lines =
and cross-lines. Alternatively, open an

existing pick set with interpreted points [Epr— =]
by clicking on the corresponding icon: = selectmarkers from one o more el
et =
E -
11. For the second horizon press the L :3: ;
wells icon 4 | and select the FS7 B/
marker from all wells. £ mest1
Wells ¥ = Fllter *
Picksel  Color  Options Horizon a5 E‘
Horizon 1 Constraint 1 - Edit.. Surface constrained by Const B ~van !
Horizon 2 F - Edit... Surface constrained by FS7 ral

Haorizon 3

Qox | (O cancel

Workflow cont’d:

12. Select Processing parameters ... and read the information for each of the parameters.*

' Processing parameters
Apply faull dips ) Yes @ No

|

seect | Create

O

Gonfidence weignt i) i -
Flip weight
Confidence Power |6
Number of Horizon updates 10
Advanced GG Sover parameters
Number of CG Solver ltarations 200
Solver residual error 0.01

Preconditionning fiter stepout inl& = cr6 =

FEEEEEER

Inversion operalor weight 0

Reset

o
i
3
§

* A good “Confidence weight” volume example is the Planarity volume.
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Workflow cont’d:

13. Close the Processing parameters
window and start processing by

pressing

14. When the batch process is finished
Close the window and Add the new
horizons to the tree.

15. Add a random line to QC* the horizons.

16. Improvements can be made by (if
needed): adding more picks; adding a
confidence weight volume and by
changing the inversion parameters.

*Tips: Change the color bar of the random line to grey scale; Show the horizons at sections
only; Change the line thickness (Horizon -> Display -> Properties); Move and rotate the
random line to check whether the horizon is following the events properly.
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2.3.2a Thinned Fault Likelihood

Required licenses: OpendTect Pro, Faults & Fractures.

Exercise objective:
Create Thinned Fault Likelihood attribute.
Workflow:
1. Launch the Faults and Fractures Control Center by clicking this ;: icon.
g @ >
2. Select 3D 0.
3.
3. Select the Thinned Fault Likelihood attribute from the list and press Go...
" Faults and Fractures 3D Control Center ?’T
Available Attributes
’l Attributes Fault Likelihood (FL)
A Thinned Fault Likelihood (TFL)
Create TFL from FL
Basement Fracture
Y Filters Convolve (Edge Enhancement)
Curvature
Dip/Azimuth Attributes
. Fault Dip/Azimuth
\ ‘;\ o Fault Painter
\\ i Panes Finger Vein Attribute
: Fracture Density/Proximity
Gradient/Azimuth of Curvature
Semblance
% Tools Similarity
{ © Close ‘ | ) Help J
Workflowcont'd:
. . - Create Thinned Fault Likelihood - olEd
3' SpECIfy the l_nput CUbe 4 D',p Input Cube ‘& 4 Dip steered median filter v| © Select
Sfeefed mEdIan fh’tef'. Voluma sunsslechori 120/350-400/600 (113 samples) © Select
4. To speed up the process set
Volume sub-selection to inline N - —
. Output Cube{ TFL v elect ks
120_4007 CrOSS“ne 350_6007 Batch execution Single Process = 4.t Options
z range 1400-1848. O Close || @M
5. Choose Advanced Settfngs to @ Advanced parameters for Thinned Fault Likelihood — & Ex
view the parameters. Keep a large Z stepout | Fiter size (nlcisampie) in'2 “len2 &l[z32 2
(recommended) Maximum dip (us/m) 800
6. Keep the default parameters, With planarity () Yes  ® No
as ShOWn |n the |mage on the Fault strike scan range in degrees 0 < 360 % Nrsteps 25 =
right and Close the advanced Strike sean smoother 16 |2
parameters dlalog Fault dip scan range in degrees 25 |5 65 5 Nrsteps 6 s
. . . Dip scan smoother |20 =
; Smoothing along dip/strike )
7. Provide an Output Cube increases the continuity of a fault RS 2500
name, e.g. Thinned Fault plane. Over smoothing may also Apply thinning ® Yes No
Likelihood, and press Run. S e

-153 -



Workflow cont'd:

8. When processing is finished, display the Thinned Fault Likelihood on inline 200.
* Right-click on inline > Add Default Data.
* Change the inline number to 200. In-line 200 [~ Step 1 [~
* Right-click on inline nr. (i.e. 200) > Add Attribute; Under the Stored section, select
Thinned Fault Likelihood.

9. Apply semi-transparent color bar (e.g. Chimney) on it for better visualization.

10. The result should be similar to the one shown below.
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2.3.2b Volume Curvatu

re And Others

Required licenses: OpendTect Pro, Dip-steering.

Exercise objective:

Compute and compare various attributes

Workflow:

1.
3D.

Start the 3D attribute engine: Analysis > Attributes >

that pick up faults and fractures.

T Surey m Proceseing Scene  View  UMilit
&y 5| R i 2o
N . &% Volume Builder ... m
o In-
Wt Ei Cross-plotData
Tre & Wells
& | E1 &l Layer Modeling

= Fluid Contact Finder

t+ Meural Networks

. ssi8

Z, Thalweg Tracker ..

T \Velocity Model Building
Well Correlation Panel

TS Y )

Workflow cont’d:

3. Keep all the parameters by default a

4. Press Add as new.

2. Select Similarity attribute from the list of attributes.

nd give it a name, e.g. Non_steered_Similarity.

r ——
& Attribute Set 30 = | E ]
File
> K L o
b AR T T 1%
Adtribute set [<not saved> <A Fllsmee (7
Hor-Shared Smilariy Input Diata 4 Dip stesred median filer ][ 6 seiect.
Time gate (ms) |28 |[28
Extension Cross [=]
Stepout |inl1 ¥ o1 5
Stuering None =
t
+
=4
=
Output stasistic Average
Atribute Mame [on-Steerea Simiarity ] [ as new |
4] Save on Close [ close | | @@ Hei
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Workflow cont'd:

5. Change Steering to Full with 3 Steering BG Background.

6. Type in a new name: Steered Similarity.

7. Press Add as new.

-
9 Attribute Set 30
File

PSR AR -

Aribute Set| <not saved> <Al x| Simitansy

MOn-steered Simianty InputData 4 Dip steered median filter

Steered Similarity
Time gate (ms) 28 28

Extension | Cross =]

Stepout |ink1 & |en1

Outpul statistic Average =l

=12
[=][ © setect...

Stearing | Full -]
Steinoan ) i o ssawans ][0 s
)
4
4
.—

Asribute Narme[ Steared Similarity ] [[add a5 new |kl

J] Save on Close

Qo) [@ree

Workflow cont'd:

8. Select Curvature from the list of attributes.

9. Change output to Most pos curvature and type in a new name, e.g. Most Positive

Curvature.
10. Press Add as new.

= Attribute Set 30

File

ot B N-EIL Y A0

Non-steered Similarity InkCrl stepout 2

Steered Similarity
Most Positive Cunature Constant vidocity & Yes No

WVelocity (mfs} 2500

Cutput [Most pos curvature | =

Steering Data % ‘g 3 Steering BG Background

=] © seteat—

Aftribute Namellﬂlast Pasitive Curvature

| Eeszsnew]|ia

] Save on Close

Lo ()

| gcmse & Heip 1
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Workflow cont’d:

Curvature.

12. Press Add as new.

o Attribute Set 30

11. Change Output to Most neg curvature and type in a new name, e.g. Most Negative

[ Fue

*Pe NN WAE -

Afribute set| <nct saved> <Al =] Cunature
Non-steered Similarity
Steersd Similarty

Most Positve Curvature
Most Negative Curvature

InliCx stepout 2
Constant velocity @ Yes Mo
Velocity (m/s) 2500

Steering Dala % fi&] 3 steening BG Backgroung

(4]

== ~=)

[+][© seiea

Attibuts Nama| Most Negative Cursature

| [d as new |jil

1 Bave on Close

(@) (@)

Workflow cont’d:

13. Select Dip from the list of attributes.

14. Change Output to Polar dip and type in a new name, e.g. Polar Dip.

15. Press Add as new, Un check Save on close and Close the window.

& Attribute Set 3D

File

S IETTLEY I NE

Asribute set | <not saved=

FS- T—
Hon-seered Similarty Stesting Data % Fi) |3 steering BG Background [=]|© seiea.|
Steerad Similarity —

Mozt Positive Curvature Oulput Polar cip x

Lost Nagative Curvature

Poar Dip

o

Atrioute Name [Potar Cip

| ezsenen] il

Save on Close

L

[ Lo

[G 5] @i |
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Workflow cont'd:

16. Right-click on Z-slice in the tree = Add
and Select Data.

17. As visualization of the full z-slice will
take some time, we will limit the inline
and crossline ranges. So, press Cancel
in the pop-up window.

18. Right-click on the Z-slice number in the
tree > Display > Position.

Elements. Color
Scene 1
&' Indine
i Cross-line
& [Z-slice
@ volume _ Add Default Data
PRI s and Selct Dl |

* 2D Lin¢  Add Color Blended

@ AN e

= Select = Eoh =]

Select first layer

Stored Hon Steered Similarity

. Steared Similarity
Steering | Most Positive Curvature
Most Negitive Curvature
9 Attnbutes | Poloar Dip

ig
(@0« ][O curcal] [ @ e
Elemenis Color
Scene 1
¥ Inline
@ Cross-line
= & Z-shice
SR aga ')
© volun I 1, Histogram .
~ Rang Ouplicate i
¥ 20U Reset Manipulation il
< 30H L. kT ‘“ = f Gridlines .
ock Treeitem
204 @ 43 Properties ..
Fault == Remaove from Tras Resoluion

FaultSiekSel
® Body
& well

Workflow cont'd:

19. Position Z slice 1640ms between
inlines 120-400 and crosslines 350-600
and press OK.

20. In the pop-up window select Non-
steered Similarity from Attributes tab.

21. Press OK to display it in the scene.

-~
[ Posmoning Py
Specify the elements position
In-line Range 120 = 400 =
Cross-line Range 350 5 600 [+

w Apply |

| Qox IQCannel @) Help

) Select [F=8Hon =

Select Layer 1

LI on Steered Similarity

Steered Similarity

Steering | Most Positive Curvature

Most Negitive Curvature

@ Attributes | Poloar Dip

S
3

| gEOK | 9 Cancel‘ [ ) Help J
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Workflow cont’d:

=8| 1645
22. Right-click on the Z-slice 1640 in the tree > Add > ,‘vg\aunr:oe gispl:avt * & Volume Builder Attribute
. | uplicate
AttnbUtE- 2D Ling Reset Manipulation
% 3D Hor|

4 20 Hor Lock Treeitem

Fault |== Remaove from Tree

' Select folla =
Select Layer 2
Stored [Non Steered Similarit ]
. o R Sicoreo Smiarty
23. In the pop-up window select Steered Similarity Steering | Most Positive Curvature
. Most Negitive Curvature
from Attributes tab. & Attributes | Poloar Dip
: . =
24. Press OK to display it in the scene. B
=
[© 0o ](© conce] [ @1 |

25. In similar way display the rest three attributes.

Workflow cont’d:

26. Now you can compare them by checking/unchecking the attributes.

0781 |o.941¢m Similarity
1 Rainbow_classes

27. Click on an attribute in the tree to make it active and change the 11 Red-Whte-Black
color bar to Similarity. Do the same for all the attributes. ':' g:ﬁ:'gz":ga'“
11 Seismics
28. The result should be similar to the one shown below. Display and | Sunisse 2
compare the different attributes. What do they highlight, and why? S vids Erample (5 Classes) =

Which attributes are best under what circumstances, and for which
purpose (fault or fractures)?

N §
ﬁ;:f :

,- .‘
‘:.‘%.’.‘
...:"!

~

ol
.
%

2}
£

| oAt
J )
-"} VIR

Steered S|m|lar|ty Most Negatwe Curvature

i
)
.
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2.4.2g Stratigraphic Attributes

Required licenses: OpendTect Pro, HorizonCube.

Exercise objective:

Define and understand the HorizonCube/SSIS attributes.

Workflow:

1. Launch the 3D attribute set window. 2 -'I

2. Select a HorizonCube density attribute.

= Attribute Set 3D
File

sd B& N NI Y 1

Asvibute vel -

-l?

=] [ © Select

We suggestusing a Continuous HorizonCube as an input forthis attribute because it

requires horizons within a specified time gate. The truncated HorizonCube removes such
events and hence this attribute is not suitable for such inputs.

Workflow cont’d:

3. Specify the attribute name and add it as new.

Attribute Set 3D

- o IEl
*PS ¥R WA

Aibute et | <nol saved- ~ | |HorizonCube Density -1|2
HorzonCube Density-8.8)ms Input HorizonCube  Continuous_HC_Full v ) Seled ..
Time gate (ms) -8 8

Avibute Name HorizonCube Density-8 ims

Asd as new | [l I

[¥] Save on Close

@ close || @ Hen
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Workflow cont’d:

4. Following the previous steps (2-3), define* a few more attributes e.g.
HorizonCube layers and Systems tract (Common ID, Unique ID, and Isochron)

attributes.

Note the input HorizonCube
for this attribute is the
truncated one because the
interpretation is made on
that input.

<All> [*] HerizonCube Layer = (2

ZI © Select .

I Input HonzonCube | Continuous_HC_Full

Nr events per layer |10

<All=

& 2]

Systems Tract

I Input HorizonCube | Truncated HC_Full

Flle

Select ... ]

Select Interpretation |Systems Tracts Dem[lﬂ Level 1 =

Output SystemsTract |[$afil 0] §In} =

Sequence Model : Depositional Sequence [V
HST -1

FS5T:2

LST:3

TST -4

Undefined - &

* Per defined attribute, you will have to specify its name and press the button add as new.

Workflow cont’d:

5. Once you have defined these five attributes, save H the attribute setas e.g.
Stratigraphic Attributes. If the name already exists, then overwrite.

6. Close the attribute set window.

= Save Attribute as (=]

Select output Artribute

Filter *

30 UVQ Attribs Texturs + HC =
ChimneyCube attributes

delme

Demo attnbutes u

FaultCube atiributes K
FauEnhancementFilter with Edgs prasening fit
Imversion atinbutes -

F 1l v

Name | Stratigraphic Attiibutes]

[ @ © Cancal | [ g Help

= Attribute Set 30 = s
Fie
el ! x
UeENEn R
Arite 0 | SUratigragtec AllnDavs v1 e =] morzoncuos Doy =7
nput HosizoaCube | Comnucus_HC_Fol ¥ [ swea
Time gate jms) 4 ]
L 4
L]
]
Attt Narra | HomzonCuba Dansty|-081m add wsnew | [l
| Save on Close -— Q) Ciose ) Help
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Workflow cont'd:

7. Next you may want to display these attribute on an inline before processing.

bl Add Defout Data

+ W nan
v g" Add and Salect Data it
; *  Add at Wel Location > ¥ 4Dipsten A VW Aibute
| Add Celor Blended @ Cross-ine Drsplay ' Volume Builder Attribute
- ;7-‘-“ Duplicate # HorizonCube Display
Volurme Resel Manipulation
>; Systems Tracts Display
 RandomLine | o omelate with Wels

o Lock Treedem
s 20Horizon | = Remove from Tree

= Select = | E

Select Layer 2

SEE
) HorizenCube layers
Steefing | Systems Tracts Common ID
Systems Tracts Unique ID
@/ Attributes | Systems Tracts Isochron

&)
Y

Qo || Ocacel |[ @rep |

Workflow cont'd:

8. Following the same steps, overlay the remaining attributes on the same

inline.
=iy In-line

4 W Inane .

" s — - =

. e 35 &T::su e Systems Tracts Isochron i

® Z-sice Duplcate @ HorizonCube Dispiay Systems Tracts Unigue ID i
._\::g:mlm Reset Manipulati I Sysiams Tracts Display Systems Tracts Common 1D F1

%5 20 Line f’“'f:’"““"w* HorizonCube layers n

“ D Horoon |5 o HarizonCube Density[-8.8]lms 1

20 Harizon from Tree 4 Dip steered median filter i

A Your inline vi look like thi

B our Iniine view may I0oK lIke IS
o =1 4

after overlaying six attributes on

Select Layer 2
each other.
Stored HorizonCube Density]-8.8]ms
HorizonCube layers
Steering | Systems Tracts Common ID
Systems Tracts Unique ID
Q) Attributes | Systems Tracts Isochron

5

s

=

QOK ,:OCancei @ Help
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Workflow cont’d:

9. Your attributes may have a coloured (default undefined values) areas
which could be set to transparent by following these steps.

4500 PP v r—
Flipped - B
Ranges/Clipping ... g
Color
Set as default
15 Manage ColorTable o B ]

Add, remove, change color tables
.Cnlnr table Status -
Farosity Ediited
Porosity-1 Own
Pressure Default
Rainbow Edited

Rainbow Plus  Deault =
RedWhite-81... Edited Please specify ﬁ
Red-White-B1... Own

Red-White-81... Own = - The Edited colortable will be replaced
Red- White-Blue Default 1 Do you wish to continue?
Red-White-B1. Own

SandShale Default

Saizmics. Edited | Segmentation MNone E Abort

Seismics - test Own
Similari Edited

ity Undefined color ] nm
Samilarity_tra... Own [ . -

Siten " Eaneg v Mo coo I
Remove .. || Impot.. | | Sawas .
| gon | © Cancel Quaip

Your results may look like this:

HorizonCube Density:
Black regions in this case represents gaps in depositione g
unconformities and condensed sections.

HorizonCube Layers:
This is like an input model containing layer definition per 10th event A
good input for geologicalireservoir modeling.

Systems Tracts Comon ID:

Acrepetition of same colour in this case represents the same systems
tract, which has a common ID in this volume Again, this volume can be
use for modelling or prediction purposes.

Systems Tracts Unique ID:
All systems fracts have their own unique IDs in this volume.

Systems Tracts Isochron:

This is a thickness volume per systems tract. A good product to explain
the base-level variations based on your data. Or adding another
dimension to the Wheeler diagrams when this attribute is used as an
overlay in the Wheeler scenes (e.g. 4D Wheeler diagrams).
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1.5.3a Attributes - Attributes

Required licenses: OpendTect.

Exercise objective:

the iso-frequency attributes

Workflow:

color blended. ..

2. Launch the Attribute Set 3D w
window: click on the

;| icon.
A

Aftribute set | <not saved>

3. Choose Spectral
Decomposition from the list
of attributes.

¥ Save on Close

1. Right-click on 3D Horizon in the tree and click on Add

Choose horizon Demo-6 -> FS8 from the list of horizons.

Analyze the attribute response of the bright-spot amplitude anomaly by cross-plotting

' 2D Line
< 3D Horlzon|
2D Horizor, Load ...
Fault Add at Sections Only .

[SUoRa Add Color Biended .
9 Body Track New ...
“ Well o _

=8 Mo “<~|

ad K2 X LY 150

<A

=] ‘simitarity
Reference
Input Data | Reference shift
Sample value
Time gate (ms) Scaling
Semblance
Similarity
Systems Tract
Stepout | Texture
Texture - Directional
Steering None |+

Extension

Output statistic Average =

Attribute Name [Add &s new| [l

[Scwse || @Hep

Workflow cont’d:

&) Attribute Set 3D

pd K 2N Y 1S

Attribute set | <not saved> <Al> [v] |spectral Decomposition

FFT [-12,12]ms 24Hz Input Data 4 Dip steered median fiter

Transform type @ FFT cwT

Tmo gt (1)

[Display Time/Frequency panel|

Output frequency (Hz [24,0 < Step 40 <

[ [+ [ee] [

Attribute Name [FFT [-12,12]ms 24Hz

[Save on Close|

[E=8 8cE =
alira
] [© setect .|
| [Add as new| Fj
Qciose || @ Help
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Workflow cont’d:

7. In similar way define two more Spectral Decomposition attributes of 44Hz and 64Hz.

8. Give them appropriate names, e.g. FFT [-12,12]ms 44Hz and FFT [-12,12]ms 64Hz,
each time pressing Add as new.

9. Uncheck Save on Close and press Close.

= Attribute Set 3D [E=SEGE =<~
File

2 [ X

L AR LT IS
Adtribute set | <not saved> <AI> [+] 'Spectral Decomposition 2
FFT [-12,12Jms 24Hz Input Data 4 Dip steered median fitter [+]|© select
FFT [-12,12]ms 44Hz
FFT [12,12]ms 64Hz Transform type © FFT cwt
Time gate (ms) -12 12

Display Time/Frequency panel

oup remncy 0000 5 s 40 _1] Optionally save the
N attribute set. In this
! case “Save on close”
24/ should be checked.
Attribute Name |FFT [-12,12jms 64Hz | [[Add as e [ia
o
N

Workflow cont’d:

10. Apply these three attributes on the &35 ™
horizon (red-24Hz, green-44Hz, and 7 <ontoico m
blue-64Hz): ”DiH”'" _ e
- - orizon Attribute e tored Cub »
right-click on the red channel and go = fau " | tow I T
Select attribute > Attributes 3D > FFT [ etoay " 2% " SteeringCubes > | FFT [-12,12Ims 4dHz

Y Wl Save as Horizon Data Stored 2D Data * | FFT [-12,12]ms 64Hz

12,12]ms 24Hz. Tools » | Attributes 2D

Remove Steering 2D Data »
Horizon Data (0)

Z values

nts

11. In the same manner select for the green (44Hz) and blue (64Hz) channels.

12. Click on the View icon iy and select View North Z to observe the result.

< | View Cross-line

® ViewZ

~ I View North

il View North Z
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Workflow cont’d:

13. Right-click on the Polygon in the tree > New.

14. Type in the name Shallow bright spot and Press OK.

[>Polygon|

X Prestacl Add ...
&) Annotationsm\

(% Create New Polygon ol o=
Name for new Polygon [Shallow bright spot

Color E] = Magenta [+
I Q ok l © Cancel| | @) Help

b

v

Workflow cont’d:

15. Use left mouse button to outline a polygon.

[ Shalow brighialed

N Prestack Event  Display >
# Annotations Calculate Volume

16. When finished, right-click on this newly added polygon
. = Save
in the Tree and select Close Polygon. | e
Create Body ...
& Lock
(G Export to Google KML ...
Delete from Database
%/ Remove from Tree

¥ g -
N Prestack Event  Display '
& Annotations Calculate Volume ...
. B . * Save
17. Right-click again on the polygon name and Save. B oS
Create Body ...
& Lock
(G Export to Google KML ..
Delete from Databasef
% Remove from Tree =

v

- 166 -




Workflow cont’d:

18. Go to the menu Analysis > Cross-plot Data

> Attributes Vs Attributes...
or click on the cross-plot | | icon.

19. Select the three attributes just created.

Survey Processing Scene View Utilities Help

|+ Altributes " | Cross-line 0 ~ Ster

oy
Tre ‘% Volume Builder ...

b Els Cross-plot Data & 1.4 Well logs vs Attributes ...

- L Wells Bl & Attributes vs Attributes ..

| Layer Modeling »

Open Cross-plot ...

“‘1 Attribute cross-plotting

525 Eal =X

Select attributes and locations for cross-plot

V]~ Attribute

V] FFT [-12,12]ms 24Hz
v! FFT [-12,12]ms 44Hz
V| FFT [-12,12)ms 64Hz,
T 1[0_deefle_me_as_you_see_semblance]

[0_test HC_well_interpolator]

[1 Original Seismics]

[3D UVQ 6 biased Texture+Energy+SystemsTracts]
3D UVQ Texture+HC attribs+ Energy disk]

5 @

748 [+ Step 9 :

Select locations by Range
In-line Range 100 =

Cross-line Range 300 = 1245 < Step 9 =

Time Range (ms) 0 < /1600 = Step 400 [

Location filters - © Select ...

[ @ox HOCancelH @ Help ‘

b
Workflow cont’d:

20. Select location by — Polygon.

21. Select Shallow Bright Spot polygon.

22 Change Inline & Cross line steps to | Aoueaosploting S8 808

1 and time step to 4ms.

23. Click Select for Location filter.

Select attributes and locations for cross-plot

v~ Attribute

Y| FFT [-12,12]ms 24Hz

7| FFT [-12,12]ms 44Hz

v| FFT [-12,12]ms 64Hz
[000_mmp_test]
[00_nrg_mmp_test]
[0_deelte_me_as_you_see_semblance]
[0_test_HC_well_interpolator]
[1 Original Seismics]

Select locations by |Polygon ﬂ

Polygon Shallow Bright Spot

In-line/Cross-line Step _
Time Range (ms) 0 <1600 = Step

| Q ok ﬁQCancelH @ Help ]

]

Location filters -
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Workflow cont’d:

24. Check the Horizon option.
25. Select the horizon Demo6 -> FS8.

26. Click OK in both windows to proceed.

= e =

Specify Filter

Random -
Subsample
Range
Well
Polygon

Tabl
7] Horizon ]

Body i

Horizon Demo 6 --> FS8 B

Select @ On Horizon To a 2nd Horizon

10

Extra Z (ms) O 3 |0 -

l @ ok [OcanceIJL @ Help j

Workflow cont’d:

27. In the pop-up spreadsheet, select FFT [-12,12]Jms 24Hz to be displayed along X-axis:
click on FFT [-12,12]Jms 24Hz column and then click on Xicon.

28. Assign FFT [-12,12]ms 44Hz to Y-axis: click on FFT [-12,12]ms 44Hz column and then
click on Yy icon.

) Attribute data =N EoE =
B> (KDY Y. [ b b = oonison S e 2 b

area 100/945-286/1134 (401 samples) / On ‘Demo 6 —-> FS8&

X-Coord Y-Coord Z (ms) [X] FFT [-12,12]§[Y] FFT [-12,42| FFT [-12,12]ms *
170/1030 624029.5406... 6075815.513... 529.19 2364.31713867 [ZakBgf:krlici N 806492333984

17211029 624003.1544... 6075864.794... 530.11 3204.86523438 [LECLEMVATEN 5500.46044922
267/993 623037.1936... 6078213668... 525.91 3726.45654297 [[LETEECIENEEN 12096 81542. .
267/997 623137.1546... 6078216.461... 526.07 5122.43896484 [LERLEEEPEM 12621.10839...
266/983 622787.9801... 6078181.604... 526.76 554901123047 [EUCIYEVITEAN 11063.40527...
2671962 622262.4957... 6078192.016... 524.34 5601.13818359 ELICRALECIERN 11131.1875 ~

) Close || @ Help
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Workflow cont’d:

29. Optionally add more attributes to the Y-axis by selecting a column and pressing Y. icon. Or
remove the selection by pressing Unselect icon. Y _

30. Click on the Save icon to save the crossplot data and provide a name and click OK.

31. Press Cross-plot icon

v .
ot

to plot the selected data.

) Attribute data

“‘ XY, Y. [ X @up ¥ o = snowzson [

(= Eol =X~

| Show Inv/Crl =7

<

area 100/945-286/1134 (401 samples) / On 'Demo 6 --> FS8&'

) Create Output
Specify Output

(E=8 HoN =X

Outputto ) Text file @ OpendTect object

Fiter * f...

crossplolSD_24Hz 44Hz =

L)
=

Neme [crossplot_SD_2atz_d4tz |
Qcance\‘[ @ Help

Y-Coord

6075815.513...
6075864.794...
6078213.668...
6078216.461...
6078181.694...
6078192.016...

Z (ms)
529.19
530.11
52591
526.07
526.76
524.34

[X] FFT [-12,12] |[¥] FFT [-12,12| FFT [-12,12]ms “
2364.31713867
3294.86523438
372645654297
5122.43896484
5549.01123047
5601.13818359

6293.77832031 8064.92333984
4638.68017578 5500.46044922
6094.88916016 12096.81542...
6856.9453125 12621.10839...
4505.34326172 11063.40527...
3499.75439453 11131.1875 e

&
Workﬂow cont’d . /% area 102/932-291/1133 (401 samples) / On'Demo 6 --> FS8' Cross-plot [o e =)
snow5000% [ ¥ [Selectony vi -] & ¥ Bl @@ # B & B
- 125000
3 =094
" 100000
32. To have a better feel of the data's behavior B oo
. =1 . M
toggle the density plot Ig button in the o
scattered cross-plot window. 50000
25000
0
’ 20000 TR L1z, 12ms BA s oo
¥ Selected: 0
/% area 102/932-291/1132 (401 samples) / Pn ‘Demo 6 --> FS8' Cross-plot [E=RiEcE =
Showf100,00%| < [E] Y2 | [Selectonf YT -] R = K1 R 8 = & &
1 [t [ Rainbow [
@| 12500
3 =094
P
100000
; 75000
[T 50000
25000
T
Y Selected: 0
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Workflow cont’d:

33. Click on [ ] icon to reverse the selection
tool.

34. Using the selection tool @draw
a free-hand polygon, as shown
in green color on the figure.

35. Click Show points in 3D scene 3 button

36. In the pop-up window choose an option
Selected Points to display the selected
scattered data and Press OK.

18) area 102/932-291/1133 (401 samples) / On ‘Demo o @]
showli00,0088) > (5] Y| [Select only Y1 [-
1 1 [wRainbow
51
» 125000
3 =094
P00
100000
-
£
:\‘J_ 50000
-
=
25000 -l
oL
0 20000 40000 60000 80000 1000001
FFT [-12,12)ms 24Hz
Y Selected: 8257
= Display Properties [E=8 =8 5|
Display @ Selected Points Al points with attribute
[©K ][O Conce

Workflow cont’d:

37. In the scene, right-click on the green colored

displayed picks > Save as Pickset...

38. Give it a name, e.g. High amplitudes, and press OK.

4 Properties ...
Create Body

(= Create New PickSet oo

Selection Group [l No 1 [
Name for new PickSet] High amplitudes
Color : m Crimson Fl

| @ok |[© cancel [ @ Help ‘
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Workflow cont’d:

39. In the Cross-plot window click on @ icon
to remove the previous selection.

40. Draw a new polygon as shown
on the figure.

41. Click Show points in 3D scene :* button

42. Choose an option Selected Points to display
the selected scattered data > Press OK.

) area 102/932-291/1133 (401 samples) / On ‘Demo 6 --> FS8' Cross-plot

1 M1 [wRainbow

o @=
‘Show(i00,00% -+ (5] Y | [Select only Y1 [ G) R3&
5]

125000
[

r=094
P
100000

75000

50000

FFT[-12,12)ms 44rz

25000

0 20000 40000 60000 80000 100000
FFT [-12,12)ms 24Hz
Y Selected: 6056
/) Display Properties == 5G]

Display @ Selected Points All points with attribute

© cancel

Workflow cont’d:

43. In the scene, right-click on the green colored
displayed picks > Save as Pickset...

44. Give it a name, e.g. Low amplitudes and press OK.

4 Properties ...
Create Body »
Save as Pickset ... ¥

Remove points inside polygon

(&) Create New PickSet (== 80E =

Selection Group [l No 1 ]
Name for new PickSet| Low amplitudes |
Color @ = BlueViolet 3

| ©ox |[@ cancel| [ @Hep |
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Workflow cont’d:

Some extra steps:
» The scattered data selected in the previous figure can be displayed as pick sets. Note that the

separation of frequency highlights two different regions of the bright spot.

» The cross-plot has helped to identify the changes in the gas pocket that are possibly due to
differences in saturation/thicknesses. Optionally, you can repeat the exercise to cross-plot all
three attributes together FFT 24Hz, 44Hz and 64Hz.
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1.5.3b Attributes - Wells

Required licenses: OpendTect.

Exercise objective:
Analyze relationships between seismic attributes and well logs using cross-plots.
Workflow: |
1. Launch the Attribute Set window A > 3D or follow Analysis > Attributes > 3D.
2. Define Instantaneous Amplitude attribute: Select Instantaneous from the list of attributes
and keep all the default parameters for this exercise.
3. Typein a name, e.g. Inst_Amplitude, and Add as new, so that the attribute appears in the
list of defined attributes on the left-hand side.

) Attribute Set 3D [o o=
File
> [ b.¢
2P R Ry b
Altribute set | <not saved> <Al> [» [instantaneous 1?7
Ins_Amplitude Input Data |4 Dip steered median fitter [£] [© sstect .|
Output |Amplitude -l
+
&
z¥
—
[Attribute Neme |Inst_Amplitude | [Ada es new! |5l
Save on Close [@cose | [ @Hep

Workflow cont’d:

4. In similar way define two more attributes: Energy and Dominant Frequency (Listed
under “Frequency” option in the attribute list), using all the default parameters.

5. Close the window.

! Attribute Set 3D

File
2 IR TLY TS

=5 Eon <"

Atribute set <not saved> <Al ] [Frequency o ?
Inst_Amplitude Input Data 4 Dip steered median filter [+] | © select ‘
Energy
Dominant_Frequency Time gate (ms) -28 28
Normalize ©) Yes @ No
Window/Taper CosTaper [] [ View

Taper length% 5

Output Dominant frequency [=]

]

-

4]

=

Adtribute Name [Dominant_Frequency [adaas nev] [Zai

FEAT

Save on Close

If the Save on Close box is ticked, the attribute set will be automatically stored when closing.
\When closing an unsaved attribute set, you will the have the option to store it.
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Analysis | Processing Scene View Utilities Help Estimages
Lt
Workflow cont’d:

+| Attributes b |
& Volume Builder 4 ] 4 Sten 0 4
. i Cross-plot Data * A Welllogs vs Attributes ..
6. Go to the menu Analysis > Cross-plot Data > Wels » 0 Atributes vs Aftibutes

Layer Modeling »

Well logs Vs Attributes. ..
or click on the cross-plot

Open Cross-plot ...

Fluid Contact Finder

Neural Networks >
[ SsIs >
(2, Thalweg Tracker .

7 F1 Velocity Model Building 4
Well Correlation Panel

/',5,\ icon.

s runzun
7. Select the three defined attributes in the [Famewacessem =
Attribute section. - pmbe :
IOU,H:ngmD,(eSﬂ
[0_deelte_me_as_you_see_semblance]
[0_test_HC_well_interpolator]
[1 Original Seismics] e
Vi~ Well UiRd Log
v F02-1 V! Density
v F03-2 vl Sonic
7 F03-4 | Gamma Ray
7| F06-1 | Porosity
| P-Impedance
< P-Impedance_rel
i \E/)Znsﬂy,emted
Extract Between |Markers [+] £ Extract in time Step (m) 1
Selected zone Truncation [o] Fsa |
Distance aboves/below (m) 0 0
Log resampling method Take Nearest Sample [+
Radius around wells (m) 25
Filter position - © Select
@OK || Qcancel | @Hep
Workflow cont’d:
= Attribute/Well Cross-plotting o o=
8. Select all available wells and logs. . e :
v E%E’%m_m‘TW
. . mmp_test]
Use Ctrl+A shortcut to select all items from the list or O
tick the box on top of the item list. [ Oraina Semest .
Zilnd Well v~ Log
v Density
9. Extract between the Truncation and FS4 markers. E’”v“y

¥| P-Impedance
| P-Impedance_rel

7| Density_edited

10. Press OK button to proceed.

Extract Between Markers [¥] 1 Extractin time Step (m) 1
‘Selected zone | Truncation v| FS4 hd
Distance above/below (m) 0 0

Log resampling method Take Nearest Sample [+]
Radius around wells (m) |25

Filter position - © Select

© ool [ @10

-174 -




Workflow cont’d:

11. In the pop-up spreadsheet, select GR log to be displayed along X-axis: click on GR log
column and then on

X button.

12. Assign Dominant frequency attribute to Y-axis: click on Dominant Frequency column
and then on Yyicon.

13. Press Cross-plot button };, to plot the selected data.

) Well attribute data

F03-4 623239... 608259.
F03-4 623265... 608257
F03-4 623255... 608259
F03-4 623255... 608259,
F03-4 623265... 608257

F03-4 623239... 608259
F03-4 623239... 608259,
F03-4 623255... 608259,
F03-4 623265... 608257

well: F03-4

F03-4 623239... 608259..
F03-4 623255... 608259..
F03-4 623265... 608257 .
F03-4 623239... 608259..
F03-4 623265... 608257 ..
F03-4 623255... 608259..

F03-4 623239... 608259...

X-Coord Y-Coord Z (ms)

146.9
146.9
146.9
14713
147.13
147.13
147.37
147.37
147.37
1476
1476
147.6
147.83
147.83
147.83
148.07

* MD(m)
662.53
662.53
662.53
663.53
663.53.
663.53.
664.53
664.53
664.53
665.53
665.53
665.53
666.53
666.53
666.53

667.53...

Density
2111.7
21117
21117
2092.6
20926
20926
21377

21377
21377
21504

21504
21504
2177.9
2177.9
21779
21593

Sonic
489.19

489.19...
489.19. ..

500.03
500.03.
500.03.

47442 .
47442,
47442
46720
467.20...

467.20
451.61

451.61...
45161...

462.21

= Y_ % @mmp |4 s = snowi000%[FT

Well data:F02-1,F03-2,

Porosity ~ P-Imped:
5185  0.3363.. 4312050
51.85  0.3363.. 4312050
51.85  0.3363.. 4312050
57.806... 0.3483 4204080
57.806... 0.3483 4204080
57.806... 0.3483 4204080
56.085.. 03201 . 4500510
56.085... 0.3201 4500510
56.085... 0.3201 4500510
58.785... 0.3121 4626120
58.785... 0.3121 4626120
58.785... 0.3121 4626120
62.35 0.2950 4824330
62.35 0.2950 4824330
62.35 0.2950 4824330

...60.929... 0.3066... 4679120

03-4,F06-1 / Attributes

P-Imped: Vp
-78652... 20442
-78652... 2044.2
-78652... 2044.2

-53108... 1999.8.
-53108... 1999.8.
-53108... 19998
-21256... 2107.8
-21256... 21078
-21256... 21078
14698 21407
14698.... 21407
14698.... 2140.7.
52805, 22142
52805, 22142
52805, 22142
91507.... 2163.5...

Density_
21246...
21246...
21246...
2126.0...
2126.0...
2126.0...
21279...
21279. .
21279. .
21297
21297
21297...
21315...
21315

21315

21334...

Inst_Amg  Energy

2280.5
376.86
1680.4

1611.9.

356.73.
22928
15436
336.53
23012
316.47
1475.7
23055
2306.0
1408.5
296.79

24899...

i
&l
H

670482
499611

123512
123451
502202
662454
123395.
504850

123343
647528
640624
123296
510159,

Workflow cont’d:

14. By default, it will plot scattered points of all
wells vs. selected attribute(s). Select one
well from the combo-box to cross-plot an

individual well.

) Well data02-1,F03-2,£03-4706-1 / Attrbutes Cross-plot
ectony Y1 [+ & &' ] @ @R & 3

[E=3 808 ==

0 60
Gamma Ray
¥ Selected: 0

Additionally:

Repeat the steps 12 to 14 by selecting exclusively logs for the X axis and for the Y
axis. Optionally select consecutively two logs to be displayed on the Y axis. The
second log will be displayed as Y2.

When selecting different X and Y quantities in the table, the crossplot display window
will be automatically updated. Use the 4= and * arrows to change the Y column to
the next (or previous) column.
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2.3.2c Bodies

Required licenses: OpendTect Pro, Faults & Fractures.

Exercise objective:
Create and rank fault bodies from a fault discontinuity attribute volume.

Workflow:

. Click on the Faults and Fractures icon -
2. In the Faults and Fractures control center: Select Voxel Connectivity tool in the Planes

module.
3 P G " Faults and Fractures Control Center | =85~
. ress 0. Plane Tools
A i | Attributes | | [ iract planes

2 | Extract Skins

Fault Throw
i | Filters
\.\\\\ Planes

(@ close]| [ @ nelp

Workflow cont’d:

4. Define the first step:
a. Select Fault_Likelihood_Thinned_from_DSMF_seis as Input Cube

b. Give a Name for this step and click Ok.

- Edit step - olEd

Input Volume

Input Cube LE’} = |ult_Likel|h00d_Thinned_from_DSM F_seis v/ |© Select ...

Name for this stepl Fault_Likelihood_Thinned_from_DSMF_sei |

@ OK | © Cancel @ Help
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Workflow cont’d:

& Edit step - olEN

Voxel Connectivity Filter

5. Define the second step:
a. Select the Voxel Connectivity

Filter step and clickon . [ Keep Values larger than ~|
b. In the Edit step window, Keep [ Value 0.6 |
Values larger than 0.6. Connectivity [Full (26 neighbors) v
c. Set the body size threshold to |Keep bodies larger than [voxels] 100 = |
100. | Kept output Body size V|
d. Set the Kept output to Body-
size.

A . Rejected output ® Undefined value ) Value
e. Give a Name for this step.

f. Click on OK.

Name for this step Extract Fault Bodiesl

-lﬂm © Cancel @ Help

Vioxel Connectivity Filter is a special tool to create continuous bodies based on the
amplitudes in a stored volume. A voxel is defined as the volume around one sample. It is
thus linked to the survey bin size and sampling rate.

Workflow cont’d:

6. In the next Volume builder main window, give a name to the Volume builder setup.
7. Make sure the box Process on OK is toggled on and press OK.

! Volume Builder: Setup o ==
Available steps Used steps D
Body shape painter - Fault_likelihood_Thinned_from_DSMF_seis .’ d
Lateral Smoother Extract Fault Bodies 3 “\J
smoother

Horizon-based painter - Simple
Horizon-based painter - Advanced =l
Velocity gridder 1 *
Input Volume

WellLog Interpolator

Fault Painter
HorizonCube-wWell Interpolator
Voxel Connectivity Filter

" |

O select...
(G0 (@1

If the Process on OK box is toggled on, pressing OK will prompt you to save the Volume
Builder setup and specify an output volume name. You can also save and retrieve setups
with the icons: i and “=. Processing is then started from the Processing menu, option
Volume Builder ...

On OK, store As  Extract Fault Bodies '|
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Workflow cont’d:

8. In the Create output window, the active Volume Builder

setup is selected by default.

9. Reduce the volume to process: press Select and specify ¢ ocqjine Range

Inline, Cross-line and Time ranges as shown.
10.

Specify a name for the Output cube and press OK.

In-line Range| 120 5 400 3
350 3 600 3
Time Range (ms)| 1400 = 1848 =

Volume Builder: Create output

- o IEN

| Volume Builder setup Extract Fault Bodies

v||© Select .| W Edit ...

Volume subselection | 120/350-400/600 (113 samples)

|0utpul Cube | VCF ranked fault bodies

v| © select ... @ cCBVS -

Batch execution Single Process ~ < Options .

€) Cancel | (@) Help

Workflow cont’d:

11. To display the created volume, click on Volume in the tree and select Add fo add a

volume viewer to the 3D scene.

12. Click on the new tree item and go to Display > position. Set the viewer to the ranges
specified in the previous slide either using the menu.

Alternatively use the ﬁs icon.

: Z-slice

Volums;

~ Rand|
=/ 2D Lii Add Color Blended
# 3D Horizon

W Z-slice
® Volume
] 343-50.
| <righ, Add '
~ Random . [N 1 Histogram ...
= gg hlgﬁzc Duplicate ¥ Properties ...
120 hor , et Maripuatn
Fault o Lock Treeitem

FaultStic. = Remove from Tree
® Body

|

) Positioning

Specify the element's position

Indine Range| 120 7 400 %

Cross-line Range| 350 % 600 %

Z Range (ms)( 1400 7 1848 2

| @OoK | @cancel | @Help
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Workflow cont’d:

. . E - olEd
13. Select the volume you just created in the ' seed
. - Select Layer 1
pop up window and click Ok.
. * Stored P-Impedance_rel_F03-4 -
14. Select a color bar (e.g. Extremes). Adjust Steert Spec Decomp FFT
teering Systemn Tracts
transparency as needed and ensure that _—
. . . Attributes Velocity model (INT)
undefined values are displayed with 100% ™ Velocity model (RMS) -
transparency:. o . 2
= Fiter *

To edit the colorbar: see Exercise 1.2.2 | T

[i I | |I

Segmentation None 1=
Undefined color | J Transp 100% =
Marker color [- ]
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2.3.2d Planes

Required licenses: OpendTect Pro, Faults & Fractures.

Exercise objective:
Extract fault planes from a Fault Likelihood volume.
Workflow:
1. Click on the Faults and Fractures icon &3 .
2. In the Faults and Fractures control center: Select Extract Planes under the Plane
Category' = Faults and Fractures 3D Control Center - [m] X
3. Click on Go. Plane Tools
-I Aliributes Extract Planes
A : Voxel Connectivity
i i Filters
‘\:1 .:~ Planes
AN
@
Workflow cont’d:

4. In the Fault Skin Processing settings window create an input Fault Likelihood cube.

%, Fault skin processing settings ol -2 ]
Fault likelihood cube () Fiss) - [© select .|
Volume subselection - B Select ...

¥ Use Recursive Gaussian filter for pre-conditioning
Minimum Fault Likelihood: For Skin 0.10 7 ForSeed 0.50 2
Maximum delta: For Likelihood 0.10 T For Strike 15 = For Dip 5
Minimum Skin size 1000

Velocity (ft/s) 10000

©@Rrun || ©close | [ @ Help |
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Workflow cont’d:

5. Select 4 Dip steered median filter cube and keep the processing parameters by default.
6. Restrict the volume subselection to inline 100-400, crossline 300-750, z range 1400-1848.

Volume subselection 100/300-400/750 (113 samples)

. ¥ Advanced Settings

Output Cube Fi]

Batch execution ‘Single Process - ‘ . .~ Options I

‘2 Create Fault Likelihood | T
Input Cube E} "B, 4 Dip steered median filter - [6 Select l

- [© select ..

LORun | @ cose | [ @tep |

& Positions [?"ﬁl
Specify Positions
Volume subselection |Range 7 i{:}; 3‘ Ig
In-line Range| 100 > 400 < |Step 1 ~
Cross-line Range| 300 s 750 > |Step 1 :
Time Range (ms)| 1400 7| 1848 I (Step 4

[ ©@ok |[© cancel| [ @ el

Workflow cont’d:

7. Select the processed Fault Likelihood volume.
8. Press Run to extract fault skins.

‘@ Fault skin processing settings
Fault likelihood cube (i ) FL
Volume subselection 100/300-400/750 (113 samples)

Minimum Fault Likelihood: For Skin 0.10 7 For Seed 0.50 |2

Maximum delta: For Likelihood 0.10 7 For Strike 15
Minimum Skin size 1000 *

Velocity (ft/s) 2500

| Use Recursive Gaussian filter for pre-conditioning

- ForDip 5 —

== )

- st

[© select ...

[ ©run | €) Close H @ Help |
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Workflow cont’d:

9. A set of fault skins is now displayedin the 3D scene along with Fault skin QC window.

LY, - IPY W UL P YT B T . ESY,
2 Faultskin O sl |
" ¥ s o
RN .,
VAR T AN <
/ S \
/ . * - \. -
I - - EY
i
wloe o, c ke w
\ . ¥ | ) Show Skins ¥ Hide extracted e
[ e 0% / ®
Y . e / Display [Skin Size: Z i
\ . et . / A
\ ] s wse B Wz [cipastel i
| ~ e Selection color [N B8 Lime E,
R 1 Extract selocted .. | | Merge <€
=
¢
E 20]
1%9 5000 10000 15000 20000
Skin Size:
Filter Criteria Skin Stze. = 9 Inside Outside ¥ Keep Selected
Total rumber of skins: 112 Number of skins In range: 112
D Finish | | < Back
o Skins selected
2~
Workflow cont’d:

10. Select an individual fault by clicking on a skin (it turns green) and Extract Selected as an
individual fault plane.

o 1 BEWN " W L Y r G a o

& Fault skin QC
N
e ™~ (i
S L T SN -
Vi, e A\

‘I.‘ - -0.— \I | i
!
wl . fe w2
\ . e ! ) Show Skins ) Hide extracted iy
1|\ ees . T / ®
\ - " p—— / Display [Skin Size - i

\ TR
\ N ‘d % / wee WMoz [Cipastel Ay
| . e Selction color | NN [ BLime E.

Filter Criteria Skin Stze. = 9 Inside Outside ¥ Keep Selected
Total pumber of skins: 112 Number of skins In range: 112
@ insh | | © < Back
1 Skin selected, use Shift-Click to select more:
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Workflow cont’d:

11. Select several skins using Shift + left mouse click.
12. Check the Merge option and extract the skins as one fault.

o 1W, BV W tE P N WY G VA ESNY S
1 Fault siin QC ol@l®
4 Skins selected

% Show Skins ¥ Hide extracted
Display [Skin Size -
wee B W  [Oresel
Selection color | [ | | Lime

Extract Selected ... /| Merge

LR

am>

o
§ [24
20]
h 5000 10000 15000 20000 24410
| Skin Sloe
Filter Criterla  Skin Size. =| @ Inside Outside + Keep Selected
Total number of skins: 112 Number of skins In range: 112
| @ Finish | (O <ack| | @neip |
4 Skins selected
H -
Workflow cont’d:

13. Select all skins using Ctri+A.
14. Extract all skins as a Fault Set.

s BEEWN | ST P » BB e o Bl . B0 T L ED At B
1 Fault siin QC olars
116 Skins selected

¥ Show Skins ¥ Hide extracted

Display [Skin Size -
wes B WMz [Orasel

Selection color | [ | (5 Lime

I Extract Selected .| Merge
[24
10000 15000 20000 24410
Skin Size
Filter Criteria [Skin Size -] @ Inside ) Outside ¥ Keep Selected

Total number of skins: 112 Numiber of skins In range: 112

| @insh | O < gack| | @t |

116 Skins selected

1

S>A NS

ams
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2.3.6a Waveform Segmentation - Quick UVQ

Required licenses: OpendTect Pro, Neural Networks.

Exercise objective:

Workflow:

1. Right-click on 3D Horizon in the tree > 20 HC
Load... > Choose Demo1 2 MFS4.

Visualize seismic pattern on a mapped horizon using Quick UVQ waveform segmentation.

Scene 1 - Select Input Horizon (3] - olEN
@ In-line Bt el
@ Cross-ine Filor *
: Z-shice r T
Veolume channed- =
~ Random Lino Demol = F54
G Demo 1 —> MF54
% 20 Line Demo 2 —> FS6 =
30 Horizon Domo 3 = Top Foresots =
Demo 4 —> Truncation
Faul | Ada a1 Sections Only Demo 5 -2 FS7
Faus Deeno & > FS8
@ Bogy| /00 Cokr Blended e e =
P wen | Treck Now
= Pickg Creata with Constant Z Aroa subsalaction | 1007300-75011250 (463 samples) © Select
> Polygon
S Prestock Evonts -
s Rhotabons Ojceecsl i@}

2. In the tree, right-click on Demo1 2 MFS4
> Workflows > Quick UVQ.

omo_2015\SurfacesiDomo_1_-_ MFS4 hor

“ 3D Horizon
kdl Demo 1 —> MF.

v Z values Add '
“ 20 Horizon Display b

Fault Tracking '

FaultStickSet Tools »
® Body IETTETE Create Flattened Scene
;":’:&'Sel wl Save Compute Horizon Curvature ...
D Polygon # save as Write Flattened cube ...
& Prestack Events & Lock Calculate Isopach ...

« Annotations Delete from Database Calculate Volume ..

Pick Horizon Data ...

Quick UVQ ...

# Remove from Tree

Workflow cont'd:

to disk.

5. The time gate describes the investigation window.

3. In the Input Cube field the default 4 Dip steered median filter volume is already selected.

4. Number of classes describe how many clusters the waveforms will be divided into.

6. Optionally, a polygon can be used for sub-selection. Also, the neural network can be saved

7. Click OK to train a neural network and produce results.

= Quick UVQ

uvaQ on ‘Demo 1 --> MFS4' (unshifted)

Number of classes 10

Time gate (ms) -8

Polygon subselection

Save network

=NEr=
Input Cube IEI [E 4 Dip steered median filter

24

=)

- e Select...|

| OOK I[O Cancel :@Help ‘

In practice, we always predict less
number of classes (e.g. 5) to get a
regional understanding of a
depositional system. We then
increase the number of classes to
predict details.

Time gate can be adjusted relative
to a horizon. In this case, -8ms is
used considering a horizon is not
perfectly snapped to a peak/trough.
The focus is mostly below the
horizon by setting 24ms.

-184 -




Workflow cont’d:

8. A NN training window will pop-up. If the training is above 90% and flat, then you can press

OK button.

=

NN training [91]

Train Segmentation Neural Network [November9 2015 14:12:21]

Sample -8

_Average Match (%
100'_ ch (%

Sample -4
Sample 0

75

Sample 4

50

Sample 8
Sample 12

5]

Sample 16

Vectors trained 6400

Sample 20
Samnle 24

Pause .. Clear

) Cancel (@ Help

- olEd

It will start applying the
results on the input
horizon.

1 [11%)] Apply UVQ Neural.. — &
| |

1%

. 0 Pause . OAbort

Applying Neural Netwo Positions handled 72632

Workflow cont’d:

9. Once the NN processing is finished, you will see a NN Info window and two grids, (Class

10. Click Display... to show class centers

and Match) which are already displayed on the horizon.

= NNinfo

"Quick UVQ' Neural Network

Type:

Number of classes: 10

Tip: If you are satisfied, you may
want to save them as Horizon Data
by right-clicking on each ofthem.

Vectors classified: 2889
Class 1 vectors: 182,
Class 2 vectors:
Clasa 3 vectora:
Class 4 vectors:
Class 5 vectors:
Class 6 vectora:
Class 7 wectors: 1
Class 8 vectors:
Class 9 vectors: 1
Class 10 vectors: 233,

% 3D Horizon

Average macch:
Average macch:
Average match:
Average macch:
Average match:
Average match:
Average match:
Average macch:
Average macchi
Average match:

Center3  Centerd

-1540.89...

=¥ Demo1-—>M... =
|¥| Class n Input node relative imporcances:
[¥] Match 3] ey —
— Centerl Center2
| Z values 0|
-_—— . . sample -8 976.1010... -1006.50...

Sample -4 54.67016.. -1973.59..

and Close the Info window.

.

Sample 0 1924.287.. 1702.556...
Sampled 4646.966.. 4714.869..

Sample 3 1654.428.. 455.1835..

-1949.19...
971.1319... 3495.81...
3954.554... 5872.40...

2603.379... 2770.36...

Save Report ...

-2237.13..
-795.735..

==

Unsupesvised (segmentation/clustering)

0.903918
0.909172
0.91659
0.822117
0.919409
0.9206
0.909738
0.920202
0.908917]
0.904034

Center5 Center6 Center7 Center8 Centes”

239.771.. -539.130.. 377.387.. -1313.70.. -2817.7

621.897.. 111735 -849.821.. -2028.79.. -1928.2]

2886.94.. 2141.79.. -593.750.. 1B8.953.. 2156.68

5027.39.. 2849.06.. 1592.54. 2039.47.. 2750.72

2438.40.. 231.057.. 1532.06.. 495.336.. -932.29

»

) ]

Qo] @rer)
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Workflow cont'd:

¥ 3D Horizon

11. To match the colors, click on the Class grid, and choose Rainbow v -
color bar. :

12. Optionally, click on the color-bar icon in the class center if you want
to change the color scheme there also.

Colors are not matching....

SN

= “Quic

Workflow cont'd:

13. Your results may look like this.

[tea mem] 3.47.9.G8 [

For segmentedresults such as UVQs, we preferto use a segmented color bar. You can always
change a color bar through manager (Survey > Manage > Colour tables).
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2.3.6b Waveform Segmentation - Standard UVQ

Required licenses: OpendTect Pro, Neural Networks.

Exercise objective:

Visualize seismic patterns on a mapped horizon using the standard unsupervised neural
network method

Workflow:
1. Open the Aftribute set window » | and select the default attribute set ' named
Workflow - Unsupervised Waveform Segmentation.

2. It will pop up a window asking to provide Input Seismics, the default volume is
automatically selected. Press OK.

s Attribute set definition - oiEN
Select Seismic input
Input Cube b ‘i, | 4 Dip steered median fitter v | © Select

) Cancel | §J Help

This default attribute setis designed to extract each samples within the time window
[-100,+200]ms (with a step equal to the z step of the survey) regarding the application sample.

Uncheck Save on Close and close the Attribute Set 3D window.

-~ Attribute Set 3D - olEN
File

PPS DR W

Alftribute set <not saved> <All> ~| Reference shift v P

Sample -100 ~ Input Data 4 Dip steered median filter v| | © Select ..
Sample -96

Sample -92 Shift ink0 % cd0  Time (ms) -100

Sample -88

Sample -84

Sample -80

Sample -76

Sample -72

Sample -68

Sample -64

Sample -60

Sample -56

Sample -52 %
Sample -48

Sample -44

Sample -40

Sample -36 A
Sample -32 z4
Sample -28

Sample -24 —
Sample -20

Sample -16

Sample -12

Sample -8

Sample -4

Sample 0 v Aftribute Name Sample -100 Add as new [l

Use steering () Yes (@ Mo

@ o
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Workflow cont’d:

Q
3. Start the 3D Neural Network plugin by clicking the a—3 icon.
@

4. Select the option Pattern recognition [PickSets].

= Neural Network management

Neural Network Manager 3D

Create New Network:

- oIl

Get:

Pattern recognition [PickSets] .. | Stored Network ...

Property prediction [WelData] ... From Job file ...

Active Neural Network

Input

Store

© Close |

Qutput

@ Help

Workflow cont’d:

5. Set the analysis method to Unsupervised.

6. Select Samples within the window [-8,24]ms.

random pickset.

Click on Create button... to generate a

e Design Neural Network

Analysis method () Supervised (@ Unsupervised

Input training data set (8 Extract now Retrieve stored

u~ Select input attributes
[] Sample -28 ~ | |:gas:
| Sample -24 ‘RMS velocities:
Sample -20 ‘FFST:
| Sample -16 3D Body
[] Sample -12 Slumped body:
[v] Sample -8 :3D body:
[v] Sample -4 test 2
[ Sample 0 ‘onlap:
[v] Sample 4 :Chimney YES:
v| Sample 8 Chimney NO
[w] Sample 12
v Sample 16
[v] Sample 20
| Sample 28
[] Sample 32 -
< >

Number of classes 10 '+

Sedect Pick set | Create ...

©OK | ©Cancel @ Hep
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Workflow cont’d:

8. Create a pickset containing 1000 picks
along the horizon Demo1 2 MFS4.

9. Click OK.

s Random Pick Set Creation

Create new PickSet

| Name for new PickSet Random Pickset on Dem¢

Display color [l ™ RoyalBiue

|Numnerof picks to generate 1000 '+ |

Geometry Volume v

Volume subselection -

© Select

@ cancel @ Help

Workflow cont’d:

10. The pickset will appear in the list. Make sure that the correct set is selected.

11. Click OK.

Analysis method

Input training data set (® Extract now

[a] =  Select input attributes

Design Neural Network
Supenised (8 Unsupervised

Retrieve stored

Select Pick set  Create ...

[] Sample -28 ~||.gas
[| sample -24 RMS velocities
[] Sample -20 FFST:
Sample -16 3D Body:
[] Sample -12 Slumped body
[v] Sample -8 3D body:
(v Sample -4 test 2
V] Sample 0 onlap
v Sample 4 Chimney YES:
v Sampie 8 himpey NO
[v] Sample 16
[¥] Sample 20
Sample 24
LI Sample 28
[ Sample 32 v

<

MNumber of classes 10

>

© conca

@ Help
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Workflow cont’d:

12. A spreadsheet with statistics will pop up. Click on Run.

et

Input Data

B X Y: Y [ qmmp b o = show100.0% ]

T2 ] Show InvCrl

_ ol

<

X-Coor Y-Coort Z (ms)
Training data 61677... 60830...
Training data 62585... 60804...
Training data 61697... 60828...
Training data 61251... 60806...
Training data 61153... 60860...

1620

1264
724
1152
780

*Samplk Sample Sample Sample Sample Sample

-10459 -698
-7480  -1746
-7010 4590
-6935 1666
-6251  -1353

2869 1187 -2389
9410 9385 2672
5938 573 3880
8804 2889 -5435
1831 -1610  -3702

© Close

S ks
-5961 €
-395 T
5909 -€
-2451 3

169 3,
>

) Help

Workflow cont’d:

13. This will start the neural network training. After the Average Match curve becomes flat,
click on OK. Training with a 90% (match) is considered as a good prediction.

Ay

100 Average Match (%)

NN training [93]

O Sample -8

O Sample -4

75

Sample 0
Sample 4

50

Sample 8
Sample 12

25

Sample 16
Sample 20

train data

. Sample 24

Vectors trained 26100

[T] on OK, save as

Train Segmentation Neural Network [November9 2015 15:42:36]

Pause ...

© Cancel @ Help

_—) |

Clear ...

= Select

-190 -




Workflow cont’d:

14. The trained neural network is now active, with
appropriate input and output.

15. Click on Store .. to save the neural network to disk.

16. Click on Info...

=

Neural Network management — O n

Neural Network Manager 3D

Create New Network Get:
Pattern recognition [PickSets] ... Stored Network ..
Property prediction [WelData] - From Job file ...

Active Neural Network

Input Output

Sample -8 ~ | | Segment
Sample -4 Match
Sample 0

Sample 4

Sample 8

Sample 12

Sample 16

Sample 20 ~

@ Close || @ Help

Workflow cont’d:

17. NN info window will pop up. s
18. Click on Display to show Class Centers.

19. Close the NN info and the NN Management
windows.

Center 1

1048

4040

1903

4134

2183

10828

Center2  Center 3

1300,

G289

3060

2480,

1865,

50038,

ervised (segmentation/clustering)

1235

41193

7385

-2060.

-2520.

-4423

Centeed CenderS Cenlerd Cenler7 CentesB Cenderd Cenber 10 *
8008 . -1680.. -1202.. 4428. 1BS69. 2221 STIT2
518.22.. 95423 B7726.. 45561 17845 T203. MTZ
9481 AP 1876 55248 29338 7105 16435
4027, 403T.. 4143 3620 -1308.. 3252 3D
3813 4273 -44B3 2036 79379 -1066. -2387

25265.. 13900.. 64492.. 15418 37204 53454 -1182

Soariet

= = « class centers o[- e Samvl o
[ Sample -96
Q ] I
- Sample -92
K 25 5 75 Y]
I T Sample 68
I 7T 7]
VLol Sample -34
x. \ N ! fl \ .
- 0 { Sample -80
L
o 77 7] 7 I 7
IS (Y (
\
Y
.
'z Class ™
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Workflow cont’d:

20. Add a 3D horizon Demo1 2 MFS4
in the tree. Apply the neural
network to the horizon by right-
clicking on the horizon name in the
tree > Add > Attribute.

21. When prompted to select data,
select Segment attribute from
Neural Network tab.

22. As Segment appears in the tree
change the color bar to Rainbow.

I 2D Line

@ 3D Horizon
7| Demo 1 —> MFS4 =
| (Segment) m

+ Zvalues n
@ 2D Horizon

* = 3u Honzon

« #|Demo 1 —> UFS

41 Zvalues Add *H Atribute

;D Horizon Display * % Volume Builder Atinbute

ault Tracking Contour Display

FaulStickSet Tools Horizon Data
@ Body Waorkflows B

Wel . :
# PickSet .
> Polygon @ Saveas
Bs Prestack Ever g  Lock Tresitem
Annotations = Remave from Tree

S Select =k

Select Layer 3

stored [Seoment ]

Match

Steering

Attributes
@ Neural Network
-
=3

T

Workflow cont’d:

23. Your results may look like this.
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2.3.6c ChimneyCube

Required licenses: OpendTect Pro, Dip-steering, Neural Networks.

for steering Data and click on Ok
and close the Attribute window.

Exercise objective:
Create a ChimneyCube with the supervised Neural Network approach.
©y Survey Analysis Processing Scenes
e EA R = .
Workflow: Q - N E m
d ! Step 0
q [ 1 -
1. Open the attribute editor using the a I icon a Elements Color
and open the default attribute set NN fce‘r:ji:e
ChimneyCube via the . icon and click <4 # Cross-line
W Z-slice
on Ok. | @ Voume
- Attt Se1 30 _=Enm
I [t eaa nae
s = octout s - ONEM T
Select dafaull afinbute set - =
Filar *
Workfiow - NN Chimney Cube
# Workfiow - NN S8t Cube
3 Workfiow - NN Slump Cuba ~
- | [0%] oo [ @reo
B tete N Asd s e [l
+ G on Closa Dt | @l
Workflow cont’d:
= Attribute set definition - o IEd
2. A F_’Op .up messag? will prom pt for Select Seismic & Steering input
seismic and steering data. Please
select 4 D.lp steered median filter for Input Seismic a,‘:’; ‘& 4 Dip steered median filter v |© Select ...
seismics and 2 Steering BG Detailed | |, steering (& ‘&l 2 steering BG Detailed v [© select ...

@ Cancel @ Help

l

- Attribute Set 3D - olEN
Fie
sd RE XTI Y 15
Amributa set | <not saved> <AB = Simianty =] |2
Ingat Data 4 Dip steared median filer * O Select
Time gate (ms) -40 40
The attributes in this set Ertorsion [HiTor 0 dogrons =
should help dlfferentlate Trace positions k0 3] el 2] & im0 3] a1 3
chimneys and background I — i
. . . . Stuering Dats IS, & 2 Steoring BG Dotaed v &
noise. Visual inspection of rusiio e
the data shows chimneys s ¥
- =4
present around inline 290 =
and 690. The chimneys oA S
. : gnalNoise Outpat statistic Max
Down 100ms {SignalMoi
tapplear as Vertlcal el - ke Amribate Nome Similarty [-40,40) Paralel Acd as new | il
rais 50 o [Oo=] o
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Workflow cont’d:; [& save Attributeas — = IEIN|

Select oulpul Aliribute

Filler |*

. 30 UVQ Aftribs Texture + HC ~

3. Save the Attribute set as NN GhimaeyCube stvibdos
ChimneyCube Training and click on Ok. Demo atributes 38
FaultCube attributes ~

Inversion attributes
MyFirstAttribute v
< >

Name NN ChimneyCube Training|

& Cancel ed Help
(] (]

4. Add default data (i.e. 4 Dip steered [Tree scene 1 8|
median filter) by right-clicking on inline. Elements Colot

Scene 1.

MV Add Default Data

& Z-sli Add and Select Data

‘ Volu  Add at Well Location .
- ;‘5” Add Calor Blended
5. Click on the added inline number 425 T

and change it to 690 by entering it in the

Inl box. Qiewe|tibm=zhh-o<i
[ s - em | G
Tree scene 1 ] -
b 1

Workflow cont’d:

6. In order to pick chimneys and DE';I;SE: Add ... |
differentiate them from the background e New > [ Empty .. |
noise, two picksets are needed. X Prestack Events Generate 3D ...
Annotations Generate 2D ...

7. Click on Pickset in the tree > New
Pickset > Empty. In the pop-up you will -
give a name to this as Chimney_Yes. JP
_¥/Chimney_NO
8. Repeatthe Step 7 and create another

pickset called Chimney_NO.
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Workflow cont’d:

9. Highlight the Chimney YES pickset and
pick locations in the scene that appear
as chimneys.

10. Repeat the process for the Chimney NO
pickset, pick locations where chimneys
are not expected. Save both picksets by
right-clicking on their names.

11. Scroll to another inline using the
4== icons to make more picks. Save
both picksets.

Workflow cont’d:

12. Open the 3D neural network by
clicking on the c:ea icon.

13. Click on Pattern recognition.

Neural Network Manager 3D

Create New Network: Get:
[Pattern recognition [PickSets] | || Stored Netwark ... |

Property prediction [WelData] ... | From Job file ... |

Active Neural Network

Input Output
Store ... Info ..
@tep |
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Workflow cont’d:

14. Set Analysis method to Supervised. Deselect attributes with prefix “NoNN”from the list.
Select Chimney_Yes and Chimney_No picksets made by you. Specify 30% of the data for
test set and press OK.

) Design Neural Network o[@])[=

Analysis method © Supervised | Unsupervised

Input training dataset @ Extractnow |© Retrieve stored

O Select input attributes @~ Select output nodes
7] Similarity [-40,40] Parallel = 11000 between MFS4 and FS8: &
9] Similarity [-40,40] Diagonal B :1000 between FS7 and FS8: £
¥] Down 100ms {Similarity [-40,40] Parall: :1000 between FS6 and FS7:
] Up 100ms {Similarity [-40,40) Parallel} 7] :Chimneys yes!
] Down 100ms {Similarity [-40,40) Diago
] Up 100ms {Similarity [-40,40] Diagonal “fingerprint input:
9] Similarity [-40,40] AllDir :gas:
¥] Down 100ms {Similarity [-40,40] AlIDir :1000 Random on Demo 1-> MSF4:
¥] Up 100ms {Similarity [-40,40] AlIDir} :Random line through wells:
7] Simple Chimney Attribute :Selected Points from Well:
NoNNInput PolarDip Misclassified [NN]:
] RMS [-40,40] :RMS velocities:
7] Down 100ms {RMS [-40,40]} islumps-1:
] Up 100ms {RMS [-40,40]} - :Slump-2b: -
« i ) « i D
Percentage used fortestset 30 | %

Non-standard number of hidden nodes 14

[©o] (@ conce] (@ 1o

Workflow cont’d:
- Input Data - olEN|
B X Y, Y [ qmup b o = snow100.0% 2 [EE T showivc 27 2| B3

X-Coor Y-Coon Z(ms) " Similar Similari Down1 Up 1001 Down1 Up 100 i

. . e n Training data 62870 60BB9.. 58681 0368.. 0347 O7T61.. 0846.. 0711 0812
15 A SpreadSheet Wlth StatIStlcs WI" Training data 62703... GOB89... 9873 O0570.. 0455.. 0.789.. 0557.. 0601 0225,

pop up, here you may edit and Training data 61568... GOBSS.. 818.82 0603.. 0.835. 0967.. 0822 0955. 0.889
| th tribut b Training data 62833 G0BAO.. 53202 0621 0585 0.760.. 0856 . 0.700.. 0.678
ana .yze € attri U es by CI'O..SS- Training data 62226... G0BBT... 132162 0.621... 0480.. 0577.. 0.766.. 0636.. 0.542
plotting them against the Chimney ¢ ’
YES and NO picksets. After Ockse || @Hop

investigating, click Run.

o2 000

= HN training [6] [E=REcR == |
Train Neural Network [November16 2015 17.59:39)
(] l T
0.5] 0.5
L. . [ 025
16. The neural network training will
begin.
£V v
Vectors trained 20600 Pause Clear
On OK save as U
7| Save misclasstied [@ok ] (O cancel] [ @ Hein
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Workflow cont’d:

17. As the training of the neural network runs, the normalized
RMS and % Misclassification curves will decrease. In order
to avoid overtraining of the neural network, click OK as
soon as the normalized RMS curve becomes flat.

18. If the training graphs become flat and are not changing, you
may proceed and click OK button.

= Nritrasing (4] = e
Train Neural Network [November16 2015 18.01:18]
e
1
07
0 ST £
[
0 | ‘ 025
| sop— 0
o 0
A Ho
cﬂ I_ = ¢ — 2]
Vectors trained 54100 Resume | [ Clear
On OK, save as =
7| Save misclassied Q) Cancel | i Help

Stopping points for neural
network training

Error

Error

Error

Leveling
‘ STOP
Train set lterations
Test set
Overtraining
; &STO
Train set lterations
Tes! sel
A JsTor?
/_\\‘STOP
Train set Herations
Test set

Workflow cont’d:

You can press clear to restart the training, for example if
the neural network becomes over-trained

The colors of the input attributes change during the
training. The colors reflect the weights attached to each
input node and range from white via yellow to red. Red
nodes have the most weights attached and are thus more
important to the network for classifying the data.

Colors are very useful indicators on how to tune a network
and discard attributes that may take up a lot of CPU time
without contributing to the final result

Stopping points for neural
network training

Error

Error

Error

Leveling
‘ STOP
Train set lterations
Test set
Overtraining
) ‘STO
Train set Herations i
Test set
A JsTor?
f\\\‘STOP
Train set Rerations
Test set
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Workflow cont’d:

19. Optionally, Store the Neural Network (you will need to

provide a new name).

20. Close the Neural Network Management window.

21. Test the training results on your data. Add the neural
network attribute named Chimney YES by right-
clicking an inline (e.g. inline 690) in the tree.

“ wnne
a [7]/425 —_— -
W4Dpste  AK r i Atbde
@ Cross-line Display ' & Volume Builder Attribute
¥ Z-slice Duplicate @ HorizonCube Display
® Volume _ Reset Manipulation % Systems Tracts Display
~ Randomline |4, conetate with Wells . -
= 20 Line .
® 3D Horizon o Lock Treetem
-4 2D Horizon | = Remove from Tree

Craate Now Notwork: Gt
Pattem [PickSets]
Proparty prediction [WelData] From Job file ..
Active Neural Network
Input Output
Similanty [-40.40 | [[Chimney_YES]
Samilarity [-40,40 | [Chimney_NO|
Down 100Mms {Si | | Classification
Up 100ms {Simé | | Confidance
Down 100ms {54
Up 100ms [Simik +
< >

Stora . Info ..

oreo

Select Layer 2
() Stored (Chimney_YES
. Chimney_NO
() Steering Classification
O Attributes Confidence
| QOK ||0(:ancel| @ Help

Example of chimney display on inline 690. The red arrow indicates
increased likelihood of chimneys.
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Workflow cont’d:

22. If you are not satisfied with the
output, go back and change the
location of your picks using the
Misclassified NN pickset (generated
automatically) by right-clicking
Pickset in the tree

== = - Q’\\ \ -

Misclassified NN pickset (in red) on inline 690

5 loafiasee - O R
Select input PickSet (s)
[=] - Fiter *
¥ |Pickins [] Chimney_NO =
G [] Chimney_YES

[ Poly " l [¥] Misclassified [N}

S Pres ts [[] Random Picksat on Demo
+ Annotations

-2

© Cancel @ Help

... 2015\Locations\Misclassified__NN_ pck

Workflow cont’d:

Create Output Volume

23. When satisfied with the results, the
final step is to output the
ChimneyCube volume as a seismic
cube that is stored on disk via
Processing > Create Seismic
Output > Attributes > Single
Attribute > 3D ...

Sunes View Utilities Help

| Create Seismic Output | Attributes ________+|.. Single Atribute ___» JPI8
Create Horizon Output> 20 <=> 3D * Mulli Atiidate ... r
(Re-)Start Batch Job Angle Mute Function ... MultiCube DataStore .. |
~ Dip Steering + B Bayesian Classification .. = Along Horizon v
= GMT Mapping Tool ... From Well Logs .. " Between Horizons  + |

# HorizonCube »  Prestack Processing g
Y] Madagascar . Velocity .
! ssIS »  Volume Buider ...
mmEyGure—————————  Re-sort Scanned SEG-Y

ip steered median filter

L2 Create Volume Attribute _ o
uantity to output Chimney_* = _
24. Select the Chimney YES attribute v:m:mm ° Yes | SR
from the list, give the volume an o o o
appropriate name and click OK. S

Output Cube| ChimneyCube ) |0 Sekct | CBYS

Batch execution Single Process =) L Options ..,

- Select -8

Stord Chmnay_YES

Chimoay_NO

Adrituies Casainicabon
® Nours otwory | COTTeRCE
s

[ 0w om
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2.4.1a Data-driven HorizonCube

Required licenses: OpendTect Pro, Dip-steering, HorizonCube.

A — Tracking based data-driven HorizonCube

Exercise objective:

Create a continuous, data-driven HorizonCube in order to understandthe depositional
history of a prograding system using principles of seismic sequence stratigraphy.

icossing Scenes View Utilities H

Create Seismic Output ¥
WO I'|(f| ow: Creata Horizon Output »

(Re-)Start Batch Job

1. Go to Processing > HorizonCube > 3D... .
2. Select the Create a HorionCube option and click the =

Go.. buttonin the HorizonCube 3D Control Center.

= HorizonCube 3D Control Center mi=)
Pre-load ...
Active HorizonGube - B Select Redoad

Create a SteeringCube

4 Fiiter a SteeringCube
B, Processn
‘ Convert to SteeningCube
Create 2D Seismic Lattice

Create Horizons from SteeringCube

)
Interpolate Logs along a HorizonCube
| /\f A | Analysis

¥

Workflow cont’d:

3. Select the horizons Demo 0 2 FS4, Demo 4 2
Truncation and Demo 6 = FS8. Click on OK.

' Horizon sorter (=N O]

Select horizons

" 4

¥| Demo 0 --> FS4 -
Demo 1 —-> MFS4
Demo 2 —> FS6
Demo 3 --> Top Foresets
¥| Demo 4 —> Truncation
Demo 5 —> FS7
¥| Demo 6 —> FS8 v

Qok |[© cancel
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Workflow cont’d:

4. We will create a data driven HorizonCube in

this exercise, i.e. the type that follows the

Tracking.

5. Click Settings... in the HorizonCube Creator
3D window.

6. Set the Steering Datato

3b FFT 225 MF113 and Start at to: Center.
Check the Apply to all packages option and
click OK.

# HorizenCube Creator 3D =
|Read horizons ...
Faults -

e

© Select...| [ Clear |

HorizonCube calculation mode

Horizon Mode
Demo 6 —> FS8 Data Driven: Tracking 1
Demao 4 —> Truncation Settings ...

Demo 4 —> Truncation Data Driven: Mulii-horizon inversior ~

Demo 0 —> F&4 Settings ... e
Area subselection 100/300-750/1250 © Select ...
Output HorizonCube ~ | Select
Analyze ... |
Balch execution |Single Process =) |4k Options ...

O Run ) Close | @ Help

= Package 1: Demo 6 --> FS8 & Demo 4 --> Truncation

[ EoR ==

Calculation mode - Data Driven: Tracking

Steering Data ) [ 3b Steering FFT225 MF113 - |'O select .. |

Start at: |Center |

Processing parameters

Processing parameters include settings such as
spacing at start position, number of iterations etc.

v Apply to all packages

_QCancel | @ Help |

Workflow cont’d: ! HarizonCube Creator 3D =R R ="
Read horizons ...|
Faults - 0 Select ... | Clear
HorizonCube calculation mode
Horizon Mode =
A Demo 6 —-> FS8 Data Driven: Tracking =
8. Click Select for Area subselection and Demo 4 —> Truncation Selings o g
set to inlinerange to 400 — 450.
CIICK OK Demo 4 —-> Truncation Data Driven: Tracking -
Demo 0 > FS4 Seftings ... .
Area subselection 100/300-750/1250 ) Select ...
9. G |v§ an appropriate name, e'g'_ Output HorizonCube| HorizonCube_FFT225MF 113 -] |© setect .
HorizonCube _FFT225MF113, in the |
Output HorizonCube field and click Batch execution [Single Process -] [ 4.+ options -
Run' ORun OCbse:j @ Help ]
‘! Positions Pf|:_| oy x|

Specify Positions

Area subselection Range

Cross-line Range 302 &

J@ =2

1240

QoK ][O cencel| | @Hep |
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Workflow cont’d:

10. A Batch Processing window will pop up. Wait for the message Finished Batch
Processing and close the window.

@) Progress Viewer o || B &

00= ?

Steering Cube: 3b Steering FFTZZ5 MFI13

Event Type: Continucus

Number of Iterations: 1

Maximum Hole Size: 1éms by 100 traces

Maximum Event Spacing: léms

Initial Event Spacing: Bms

Start Position: 425/771

Start At: Center

Start Position: Center : In-line 425, Cross-line 771
Stepout: In-line: 1, Cross-line: 4

Top Horizeon: Demo 6 --> FS8

Bottom Horizon: Demo 4 --> Truncation
Nr Events: 1

In-Line Range: 400-450

Cross-Line Range: 302-1240

Process: 'Creating HorizonCube'

: 0% (185.185/s) (4m:18s)

1:1= 1% (16666.667/s) (3s)

| 12% (6250/s) (7s)

[RRRRRRRR -

Running process od_process_horizoncube.exe with PID 2864.

Workflow cont’d:

Elements Color

11. Add inline 425 in the scene
and select the attribute
4 Dip steered median filter.

 Add Dafault Data

Add at Well Location ...
Add Color Blended
“ 3D Horizon

! Select ol e
Select first layer

Filter =
9! Stored 1 Original Seismics -

4 Dip steered median filter
) ) o ) 5 ChimneyCube
12. Right-click the inline number (i.e. 425) Attributes | Ta Al Cube Std

and select Add > HorizonCube Display e oube

Q4 Darnciha iha feam HC KA

Steering

TV e QoK |||@ cencel] | @ Hep |
o 4,25; Ard "4 Astribute
@ Cross.ij  Display * | & Volume Builder Attribute
¥ Z-slice Duplicate € HorizonCube Display
® Volume Reset Manipulation % Systems Tracts Display
~ Randon 4+ Correlate with Wells .
2D Line
Lock Treeitem
@ 30 Hori © R 1I .
1 2D Hor] = Remove from Tree
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Workflow cont’d:

13. Select the HorizonCube_FFT225MF 113 that
you just created.

14. To explore HorizonCube display options
right-click on the HorizonCube in the tree >
Display > Properties. Close the window.

4 ¥ In-line
- [7] 425
[¥]|HorizonCubg ==~ 27"~ **~ ]
] 4 Dip steered Select HorizonCube  » 1

¥ Cross-line Move v

@ Z-slice Display * [ Properties..
® Volume Reload

~ Random Line = Remove

AN ina

/% Select 3DHorizonCube o -E-
Fitter *

> Continuous_HC_Full < -

Continuous_HC_Full_Trim —

Horizon FFT 225 MF 113_truncated | R‘

HorizonCube_FFT225MF113 =

Inversion based HorizonCube i

Inversion based HorizonCube Backup

Proportional_HorizonCube -

r] E——T] | »

@0k ] ©cance|| @tep |

...\Surfaces\HorizonCube_FFT225MF113.hci

___

! HorizonCube display options =5 FoR =<
Fill between lines ) Yes @ No
Use single color () Yes @ ho
Transparency | | 0
Line width 1 = Spacing 1 S
Horizontal resolution 2 trace *

| Truncate HorizonCube 2 (events per sample interval)
Top [} 0
Base {0 a7
] Link to ColorTable
I"| Lock Top/Base distance
| Apply to all
[ save as Default © Close [O—Hﬂh

Workflow cont’d:

G- E G

15. Open the HorizonCube slider by

Control Center 2D ...
Control Center 3D ...

clicking the 1531, icon. ~| HorizonCube Slider ..
! HorizonCube 3D Slider ...

16. Observe and QC the results of your
HorizonCube by using the Top and
Base sliders.

The HorizonCube slider is a very useful tool
to investigate your data and to make detailed
observation of the depositional history of your
sedimentary basin.

8 [] Link to ColorTable

J [] Lock Top/Base distance
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Workflow cont’d:

17. Observe how gaps are present in the prograding clinoforms. This is due to the
HorizonCube being created with only one iteration. Iterations can be added later.

18. The gaps are filled by finding the gaps | = baorven Advenced cptions el o=

- - @ Continuous events. Truncated events
based on a given advanced setting. -
1a Min/Max @ Fixed spacing

Advanced settings can be accessed
i R Spacing at start position (ms) 8
by Processing >HorizonCube > 3D > Frs
> N paces larger than 16 (ms)
Create > Settings > Processing o T G
parameters. Masmum Nr of terations 1 2
Stepout inl1 2 er4 2

QoK || Ocancel| | @Hep |

Workflow cont’d:

19. Open the HorizonCube 3D Control Center with theq icon.

20. In the Tools menu, select Add More Iterations and click Go.

' HorizonCube 3D Control Center [ o =
Pre-load ...
Active HorizonCube  HorizonCube_FFT225MF 113 -
|

[Add more iterations

4 7 Check crossings between Horizons
» Processin | | Edit a HorizonCube
‘ ’ Extract horizons

Fill holes in a Horizon
Filter HorizonCube

& . Get Continuous HorizonCube
M _._' Analysis || Grig HorizonCubes

Merge HorizonCubes
Medify/Recalculate HorizonCube

Trim horizons against Faults
Truncate HorizonCube
Tools |
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Workflow cont’d:

21. Leave the Extra Iterations option to 1, for each package.

22. Save with a new name, e.g. HorizonCube_FFT225 MF113_2it, and click OK.

Input HorizonCube HorizonCube_FFT225MF113
Mode

Iterations finished  Extra lterations
1 ft
= | 1 1

Package 1 |Data Driven: Tracking

a k|l >

Package 2 Data Driven: Tracking

Output HoﬂzonCubel HorizonCube_FFT225MF 113_2it - | ’9 Select l

- Execution Options ...

LQOK | [© cancel| | @ Heip |

The first column lterations finished shows how many iterations have already been processed. The
tracked HorizonCube events from previous iterations will never change, only new events can be

inserted between already existing ones

Workflow cont’d:

23. See the difference between output images of lteration 1 and Iterations 2.

Note the gaps are filled by adding more data-driven horizon during the 2"? [teration.
Further gaps can be filled by adding one or more lterations.
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Workflow cont’d:

24 Change the active HorizonCube
either by right-clicking the
HorizonCube in the tree:

or by selecting it in the
HorizonCube control center

Elements Color
Scene 1

=iy} In-line
-1-[¥] 425

Al Horizoor 191
QL) Sslect HorizonCube + | HC _trim_D0-06_dms_Siter

: zc':hs;'""e Move * | HC_trim_DO0-D6_4ms_3iter_Truncated
® Volume Display * | v HorizonCube FFT 225 MF 113
~ Random Lin  Reload Proportional_HC

2D Line %/ Remove

@ 3D Honzon "]

' HorizonCube 3D Control Center o - '
Pre-load ... |
Active HorizonCube [HorizonCube_FFT225MF 113 ~ ) Select Reload |

Create a SteeringCube

Filter a SteeringCube

Create a HorizonCube

Convert to SteeringCube

Create 2D Seismic Lattice

Create Horizons from SteeringCube
Interpolate Logs along a HorizonCube

| Processin

’
l ,f | Analysis
% Tools

Go ..

I ) Close L & Help J
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B - A Global Inversion based data-driven HorizonCube

Exercise objective:
Create a continuous and data-driven HorizonCube based on inversion algorithm to
understand the depositional history of a prograding system using principles of seismic
sequence stratigraphy. L TR
i Create Seismic Output  » = ’J_';‘i
. Create Horizon Output  » —
Workflow: . .
(Re-)Start Balch Job
1. Go to Processing > HorizonCube > 3D... e ’
= GMT Mapping Tool
¥ HorizonCube 4 2D ..
2. Select the create a HorizonCube option and click the | Yeeose ,
Go.. button in the HorizonCube 3D Control Center. T
= HorizonCube 30 Control Center =N EcR =" ]
Pre-load ...
Active HorizonCube ~ | Select .. Reload
‘ Create a SteeringCube
-‘ Processin
) onvert to SteenngCube
Create 2D Seismic Lattice
Create Horizons from Sweenn.g(;ube
I//! | Anatysis L e
% Tools
© Close 3 Help
- ¥ Horizon sorter = || (=) @
Workflow cont'd: Select horizons
3. A data-driven HorizonCube is created in a package - -
defined by top and bottom horizons. At least two o] -
. . . emo 1 --> 4
horizons are required. Select the horizons Demo 0 2 Demo 2 —> FS6

FS4, Demo 4 2 Truncation and Demo 6 -2 FS8. Click N oD ks

| Demo 4 --> Truncation
on OK. Demo 5 —-> FS7
¥| Demo 6 --> FS8 -

! HorizonCube Creator 30 =
Read Nonzons.

4. Optionally, Faults can be selected

Fauls - O Select .. Chaar

HorizonCube calculation mode

Horizon Mode
Demo & --> FS8 Data Driven: Multi-horizon inversi =
Demo 4 —> Truncation Seltings ..
Do 4 > Truncation Data Driven: Multi-horizon inversi =
In the HorizonCube creator, you Domo 0 > FS4 Sattngs ..
Choose an algorlthm’ SEttIngS Etc Area subselecton 100V300-750/1250 (463 samples) £ Select
Output HorizonCube = | Select ...
Analyze ..
Batch execution Single Process - | {r Options ...

QG Run | © Chose || @ Help
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Workflow cont’d:

5. We will create a data driven HorizonCube
using inversion based algorithm. Data Driven:
Multi-horizon inversion is defined by default.

6. Click the Settings button for the upper most

package.

7. Set the Steering Data to
PCA 111.

8. Click on the Processing Parameters.

™! HonzonCube Creator 3D
Read horizons ..

Faults 6 Select ...

HorizonCube calculation mode
Horizon Mode

Demo 6 —> FS8

o &

Clear

Data Driven: Multi-horizon inversio =

Dermo 4 —> Truncation Saltings ..

Demo 4 —> Truncaton

Demo 0 —> FS4 Settings

Area subselection 400/302-450/1240 (453 samples)
Output HorizonCube N
Analyze

Batch execution Single Process = | |4k Options ...

Drata Droven: Mulli-honzon inversio -

6 Select ..

© Select _..

:Onun © Ciose || @ Hep

= Package 1: Demo 6 --> FS8 & Demo 4 --> Truncation o ]
Calculation mode : Data Driven: Muli-horizon inversion
Stearing Data -.‘__l> e FCMH -] © Select ...
Initial Moded type | Proportional
In each package, we will be using a same initial Evont sampling method (Spacing at maximu thickness =
model (Proportional). Each proportional horizon will Spacing (ms) 4 ;
be updated using the defined processing St ot
parameters. Apply to all packages option will set
:
the same settings to all packages. T
| @ok || ©cancel|| @Hep
Workflow cont’d:
= Fault dips will be calculated from Sl =)
interpreted fault planes and merged with RTINS LS i)
reflection dips from the Steering Cube if
toggle is Yes. Confidance woight [ &) - create | ()
+ Confidence weight assigns weights to )
the Steering Cube. Planarity is a good @
confidence measure that can be
. MNumber of Horizon updates 10 ‘6
calculated here, or in the Faults &
Fractures plugin. Advanced CG Solver paramelers 0
+ Confidence power increases the Number of CG Sohver Hteraions 200 2 (7]
contrast between planar and non-planar Solver residual aror [0.07 )
features. Preconditionning filer stepout inl6 2 cidd 2 0
+ Number of horizon updates are
typically between10 or 20. HeSUIon QPeceter oA LD 9
= Number of CG solver iterations are Resol
used to solve the gradient equations. @ Hep

- Pre-conditioning smoothing reduces
spikes in the output horizons.

CG — Conjugate Gradient

In this case stick to the defaults, hence

press Close to continue.
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Workflow cont’'d:

9. We will sub-select the processing area to

400 — 450 in-lines.

10. Provide an output name: Inversion based

HorizonCube.

- P
Spacily Pustons

v st 3 | Raege

i Barge 80 = 4]

Cross-ien Barge 30 3 1750

11. Press Run to create this HorizonCube output.

FREREETRI=IRIRIRELI*]] 100%

t 2016, 14:11:48

: T8 (47.755/%) (03)

14:11:49

ished: di 11 okt 2016,

asing done.

Finished batch processing.

[E5]ows am
o

‘= HorizonCube Creator 30
Read horizons

Foulls - Clear

HorzonCube calculation mode

Haorizon Mode -

Demo 6 --> FS8 Data Driven: Muli-horizon inversi =
Demo 4 --> Truncation Setlings i

Demo 4 --> Truncation Data Driven: Muli-horizon inversi ~

Demo 0 > FS4 Seltings ...
Area subselection 400/300-450/1250 (463 samples) D Select .
Cutput HorizonCube | Inversion based HorizonCube] - I D) Select ...

Analyza

Batch execution |Single Process - | |4 Options ...

(DR ][O coce | [ @ o

Workflow cont’d:

12. When processing is finished, Add inline 425

in the scene and select the attribute
4 Dip steered median filter and OK.

i Select

Elements Color

Sc

& {Inlipes
W Cro
& 7-sl

Add Default Data

Add and Select Data
ol

" Ral Add at Well Location ...
. op| Add Color Blended
@ 3D Honzon

Select first layer

13. Right-click the inline number and select Add

> HorizonCube Display

Scene 1
4 iy In-line
4 v 425
Add »
Display
Duplicate
Reset Manipulation

« | Alfribute

* W Volume Builder Attribute

€ HorizonCube Display
Systems Tracts Display

¥ Cr¢
75
® Vol
~ Ra g

Vert. Res. E o
Correlate with Wells ...
10D B Lock Treeitem
Fa == Remove from Tree
FaultStickSet

T 2D o
@ 3D

9 Stored 1 Original Seismics

4 Dip steered median filter =
5 ChimneyCube

7a Al Cube 5td

7b Al Cube from HorizonCube
8a PorosityCube from HC-NN
8b Gamma from HorizonCube

Steering

ibutes

I O ox IO Cancek] .

© Help l
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Workflow cont’'d:

14. Select the

HorizonCube Inversion based

HorizonCube that is just created.

15. To explore HorizonCube display options

(S e e e

Filter *

> Continuous_HC_Full < =)
Continuous_HC_Full_Trim

Inversion based HorizonCube
Proportional_HorizonCube_Full =
Test_HC_ful_Inversion
Tesi_HC_full_Inversion_v2
Test_HC_full_Inversion_v3
Test_HC_full_Inversion_v4 =

OCanl:BI_I @ Help

_faces\Inversion_based HorizonCube.hci

X80

- - . . = HorizonCube display options F=2Eon
right-click the HorizonCube in the tree > e
Display > Properties. Close the window. Vow s cokor @ Yos | B NG
Transparency [ | o
Line width 1 = Spacing 1
Horizontal resclution 2 trace ©
Truncate HorizonCube 2 (events per sample inferval)
Scene 1 Top [} /]
4 iy Indine 1
e 'J'_425 Base 0 137
YU Select HorizonCube . ACHDEETIED
9 Crossin Move 0 | Lock Top/Base distance
Z Display + [ Prop 5

i N ' o

~ Random == Remove =

- 2D Line Save as Defaut \ © Hep

Workflow cont’d:

= OpendTect Pro VE.0.4/wing F3_Demeo_2018,_rainingvé - [Scene 1] =
™ Surwy Analyss Processng Scene Vew Ubkbes Help o x
QUCABEXAT-A0ASEeR Fo K@ TG L nwews o =iy s

Tron scens 1

4 Elemants
Soena 1

» @ Inding
a4z

@ Crossdne.

@ Z-sice

@ Volemo

~ Random Ling
20 Lo

® 30 Horizon

4 20 Horizon

Fantt
FanltStickSat

AP Y Y

=

=
&
£

LallFr m30 98

425531 (B11372, GOB1EIS, B3S)

¥ Imversion based Horzond.
¥ 4 Dip stoured median fer

-
Calof

v _
Value =293 {4 Dip steored median fller)  In-line: 425

cqmup oo |

[froe mee] 1.67.9 GB E"
|

An example of this HorizonCube

overlain on inline 425.
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Workflow cont'd:

= Eg(@ - B R
16. Open the HorizonCube slider. Contrd Contor 200

Control Center 30

~} HorizonCube Slider ...
TZonGu fer .

17. Observe and QC the results of your
HorizonCube by using the Top and
Base sliders.

The HorizonCube slider is a
very useful tool to investigate
your data and to make detailed
observations of the
depositional history of a
sedimentary basin.

Workflow cont’d:
Optional Steps (Filling the gaps):

You may want to fill the holes by taking some events from a HorizonCube and re-

computing the packages using the horizons. This workflow is presented in the following
slides.

18. Choose the events defining a gap from this HorizonCube. Use Top slider to know
which events are needed (e.g. events 86 & 91).
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Workflow cont’'d:

19. Open the HorizonCube manager.

20. Copy the inversion based HorizonCube with
a new name since we will be changing this
one and the other one will be our backup.
Once done, close the HorizonCube

manager.
T btanage 30 Horizeriabe = e
Fiter * iy HorizonCube data
> Continuous_HC_Ful < A= *

Contirvous_HC_Full_Trim
Inversion based HoriZonCube
Inversion biased HorizonCube 15t
Inversion based HorizonGube 2nd
Inversion Bised HonzonCube copy
based HorizonCube copy v2
rtional_HorizonCube_Ful
Test_HC_ful_lnversion
Tost_HC_ful_lmvarsion_v2
Test_HC_ful_imversion_vi

el

=

'-.rSul\ey'lm Processing Scene View Utites Help

47 SelectSetup e = iz @ @
= = == o
e L | s | § ei' s
Import .
Export
| mManage , Atribite Sets
e ' |® Bodies
Exit Color Tables
=, Cross-plot Data
o | $Crssine |5 Fauns
:i;:“ \ FaullStickSets
- me
”,
lq O Line ™ Goometry 2D
20 Ling =, Honzons
[T 4 ® 30 Horzon |+ Layer Properbes
~ < [7] Inv__0091 | 7, PickSets/Potygons
8- | 2 values ™ Probability Density Functions
- . ';Wz_g?feﬁ Random Lines
values .
2D Horizon | T4 Seismics v
&~ Fault & Seismics Prestack r
FaulStickSel  Sessions
® | @ boty B, Strasgraphy
H b Wel A, Winslots
: PickSet . Wels
E [ Patygon
5 Prestack Eve @ HorizonCube 2D
‘" Annctations *, Neural Networks 30
5515 " [
=/ Copy HorizonCube f=e
Input HorizonCube Inversion based HorizonCube ~ | D) Select ...
Package Range 1 Sl
Area subselection 400-300-450/1250 (280 samples) O Select ...

Outpat HorizonCube  Imversion based HorzonCube backup| = | © Select ..

O o

Workflow cont’'d:

21. From the HorizonCube manager,
extract events 86 & 91 from the
selected HorizonCube. >

22. The base name will be set as a prefix
with an automatically generated suffix
(e.g. Inv_0086 will be a name of the

output horizon). Press OK.

23. Once done, close the HorizonCube
manager. At this moment, we are
ready to modify an existing
HorizonCube using these two

horizons.

= Extract Horizons from HorizonCube
Selact by

SRICE %"

Package @ Event

Salect Evantis) | ¥ Event 8 (Inl: 400 to 450 Crl 30016 1250 )
Event 87 (Inl: 400 to 450; Cri- 30010 1250 )
Event &8 (Inl: 400 to 450, Crl 300 to 1250 )
Event 89 (Inl: 400 to 450; Cri- 30010 1250 )
Event 90 (Inl: 400 to 450; Crl- 300 to 1250 )
| Event 91 (Inl: 400 to 450; Cri: 300 to 1250 )
Event 92 (Inl: 400 to 450; Cri- 300 o 1250 ) -

Area subsalection 400°300-450/1

Base Horizon Name I

250 (274 samples) B Select

0%

(B0 (oo
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Workflow cont'd:

24. Open the HorizonCube control
center.

»‘-:;;IC\E,': z’lllr 1KY,

Control Center 3D ...
1 HorizonCube Slider ..
¥l HorizonCube 3D Slider ...

25. Set active HorizonCube to Inversion = Horizandiube 30 Control Center ERRC %"
based HorizonCube.
Active HorzonCube  Inversion based HonzonCube - O Salect .. Reload
26. Go to Tools and Select 3" e o
Modify/Recalculate . . « A e ot
Edit a HorizonCube
Extract horizons
4 Get Continuous HorizonCul
27_ Press Go_ |‘/{‘| Analysis Gr:!IIoulnznnCu;s e
- — e | miossty Racacuate ine |
S—— — T
K-
Facli O Setect Cnai
= O Cuse || @ Hap
Ofn | Do || B
Workflow cont'd:
(= [ — == E.
28 Select the HOI’iZOhCUbEZ lfnversfon Input HorizonCube  Inversion basad HorizonCube » | ) Select ...
. Read horzons ...
based HorizonCube.
Faults - © Select ... | Clear
29. Read horizons: (e.g.) Inv_0086 HorzonCube caculon mode
Horizon Mode Action
and InV_0091 Demo 6 —> F58 Data Driven: Muli-horizon in = [Keep -
) Dema 4 —> Truncation Settings
! Horizon sorter [ — .:|. (=] .'E
St oo Demo 4 > Truncation Data Driven. Wuli-horizon in - Keep -|
Demo 0 > F54 SHmngs ..
.-
Demo 5 —> FST -
Demo 7 —> shallow
Im2_0103
+| Inv__0086 L
+| lnv__ 0091 I
Trim_D0 --> FS4 Analyze .
E:E—Eﬁ 7: 'rl'rqu:cailon - Balch axecution | Single Process = | | &k Oplions ...
[©0K ][0 comei L LD

We will only select the horizons
which we extracted in the previous
steps.
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Workflow cont’'d:

= HorizonCube Creatar 30
30. We will choose Action keep for the Input HorizonCube  Inversion based HorizonCube - |© Select l
first package and compute for the Read horizons .. |
rest of packages. Fauts - [© select .| [ Ciear |
HorizonCube calculation mode
31. Ensure that the three packages for P Frow o —
compute have the same algorithm Demo & —> F&B Data Drven: Mubi-hori - Keep 3]
i.e. Data Driven: Multi-horizon Demo 4 > Truncetion | Sefings ..
Inversion. Demo 4 --> Truncation | Data Driven: Multi-hori vlCompn.ls ~
Inv__0D0B6 [ Setlings ... | =
32. Run
Inv_0086 Data Driven: Muti-hori ~ | Compute -]
Inv__0091 \ Settings ...
Optionally: You may choose a ;’;;?Lm {D"“ °$$f_"‘“°”'l%,
different algorithm and settings e ) '
.y e ..
(such as start position) for each o )
package. It depends on the nature Boeh scudon gl Prviees ! (b e
and data quality in a package. [©rwn ] ©cose|[ @ter |

Workflow cont’'d:

33. Once the processing is finished, Reload the HorizonCube: Inversion based
HorizonCube.

34. The results may look like this after filling the gaps:

Scene 1
4 i@ In-line
4 [V 425
. m; Select HorizonCube  »
@ Crossdine]  Mow *
& Z-slice Dispiay
® Voume Reload

~ Random L == Remove
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2.4.1b 3D Bodies From HorizonCube

Required licenses: OpendTect Pro, HorizonCube.

Exercise Objective:

Visualize a HorizonCube in 3D by using the 3D Slider - an add-on to perform analysis in 3D
along iso-timelines.

In this exercise we will investigate a prograding system in 3D by making thickness maps and

geo-bodies.
- HorizonCubse 30 Control Center
Pro-oad
Workflow: At HorzonGute | Cantinsors_ G Fl <0 souet | ioknd
1. Open the HorizonCube 3D .: L Procossin | |Make Crosspess of onzonGubo D

Control Center with the @ icon.

2. Select an active HorizonCube ol o
Continuous_HC_Full.

3. Click the Analysis button, Select
the 3D slider and press Go. O come

Keep the 3D slider window open.
You may close the HorizonCube
3D control center window.

- o

@ Hep

Workflow cont’d:

4. Add Default data for inline 425. Tree scene 1 P)

Elements Cailor
Scene 1
b dmm| Add Defaul Dala
W €6 44 and Select Data
* Add at Well Lacation

L XS
Vel
® o i

5. Right-click on the inline number > Add >
HorizonCube Display.

< i In-ine
4 7425
7 4Dip  Add |l Attribute
# Cross-line Display ' |9 Volume Builder Attribute
: i-slhce Duplicate € HorizonCube Display
'olume set Manipulatic h
~ Random Li Reset Manipuiation Systems Tracts Display
B Correlate with Wells ...
- 20 Line

@ 30 Horizor @ Lock Treeitem
1 2D Horizor == Remove from Tree
Fault
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Workflow cont’d:

6.

8.

9.

In the 3D slider window, click on
Change to pre-load the HorizonCube
Continuous HC Full.

In the Pre-load Manager press Load 3D...

Set the Event range from 260 to 310.

Press OK and close the HorizonCube
Pre-load Manager window.

Always preload with limited range when
using small RAM (under 8GB).

Pre-doaded HorizonCube None Change

Display resolation 174 [=] |Pretianguiate shders

Top |} L] Il Save
Display In fll [=] [7] use singhe coler
- HorizonCube Pre-load Manager — O n
fo Horizom Cube preloaded Load 2D
Load 3D ...
Unload
€ Close | @ Help
= Select Horizon Cube -0 “
Input HorizonCube Continuous_HC_Full v| B Select
Select by O Package ® Event
Event Range] 260 < (310 [
Area subselection 103/302-748/1248 (278 samples) © Select ...

© Cancel @) Help

Workflow cont’d:

10. Set the Top horizon display: None and

Base horizon display: In full.

11. Check Link to 2D displays option to see

the HorizonCube events on the sections
within the selected range.

12. Set Display data to Top-Base Isochron.

13. Press the Calculate button.

Note: The scene will be updated
once you press the calculate button.

) HorizonCube 3D Sikder
Pre-oaced HorzonCube Cortruous_HC_Ful Change

|| Dispiay resalution | 14 = | [Pre-nanguiste siders

|l S

Toe .} 261

DCisplay | Hone =

Base m

=

Désplay |Inhull =

[T mom s | ok s s G

Dispiay data |Top-Giase ochin ~
Calculate | |7 suto-upaste

125606}

Use single color

10000

4 ‘zr"s“ﬂc-?l

0.07903671

#loes 0025 0.05 0.074 0.1 b1l

Data range 0.00054 011019 Tiweshold 0026541

. I ESeismics

TrANSparency Bisaies -

Color semng

Q cies | | @ e
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Workflow cont’d:

Making Thickness Maps

14. Set the top slider to 302 (press ENTER to update) and the Base slider to 310
(press ENTER to update) and click Calculate.

15. The result will appear automatically in the 3D scene on the base horizon after
clicking Calculate.

Example isochron map
between events 302 and 310

Workflow cont’d:

16. Repeat the exercise for the following horizon pairs and observe the shifts in the
depositional center. Press Enter and Calculate every time after updating the numbers
for the Top and Base sliders.

Top: 265, Base 275

Top: 285, Base 302 Top: 275, Base 285
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Workflow cont’d:

Extracting Geobodies

17. For this exercise we will apply a
transparency threshold for all thinner
regions below the cut-off to preserve and
outline of a thicker region.

18. At the bottom of the 3D slider, specify
Threshold = 0.02 (Press Enter) and set
the transparency to Transparent below
threshold. (In the histogram, a thin vertical
red line will appear, which corresponds to
transparency).

& HorizonCubie 3D Slider Lo i) ot
Pre-loaded HoronCube Continuous_HC_Full Change
‘| Dispiay resolution | 14 = | |Pre-tianguiate siiders
Top [} 265 | jo) Save..|
Cesplay Home =
Base ] 275 [jd Save
Dispiay | In hull * | [7] Usae single color
) Link to 20 displays [ Lock Top/Base distance |Creale Body .|
Display data | Top-Base Isochion =
Cabeulate Aute-update
12560
100004
it a2l 0 07903671
3 5000
8
25000
dloos 0025 005 0078 01 0.1101
Value

Datarange 000054 0.11018{ Thresnota 0.02 Fi!anﬂ.mﬂa @sazied =
Transparency disabled
Color semng l _.l ASeismics ~ Transparent below treshold
- Transparent adove Mreshoid

@

Workflow cont’d:

Extracting Geobodies

19. Press the Create Body button.

20. Set mode to Automatic filling, the
threshold value will remain unchanged.

21. Set the Body value option to Above
threshold. Click Run.

22. Close 3D Slider.

5 Horicortube 10 Sder L2 ) ]|
Preinaded HorzonCuce Continuous_HC_Ful Change
H Display resclution | 14 = | |Prenanguiate sisers
Top 265" [l 5w
Display Hone =)
Base 1 275 i S
Display In ful =] 71 U singie csior

Displsy data [ Top-Base Isochien =

Caculate Auto-update
125608
100004
syt T T ]
2 5000
500
hoos 3 005 0073 01 01101
alue
e -

Datarange 000054 0.1101% Theeshold 003

coiorsonng [ I 15sismcs -

Transparent below Mreshiid =

ICEDI D

) |

s Create body from sliders

Body value (®) Above threshold

@ Close | @ Help

Below threshold
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Workflow cont’d:

Extracting Geobodies

23. The body will appear in the scene. If you are satisfied with the geobody you may saveit to
disk by right-clicking on the <New Body > in the tree > Save as..

4 @ Body | I
4 |V||<New Body 1> -
J| <right-¢ Display 3
Well Calculate Volume
~* PickSet W sae
[ Polygon
= Bl Saveas
=y Prestack Even
Annotations g LockTreeitem

== Remove from Tree
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2.4.1c Truncate HorizonCube

Required licenses: OpendTect Pro, HorizonCube.

Exercise Objective:

stratigraphic interpretation.

Truncate a HorizonCube to prepare Wheeler diagrams and perform seismic sequence

1. Open the HorizonCube 3D Control Center with the @ icon.

o~ HorizonCube 3D Control Center -0 n
Pre-load
Active HorizonGube Continuous_HC_Ful v | 0 Selecl Reload
2. Select the Truncate A Firobs na toraon
. Processn Trim against Faults
HorizonCube P A s harsons
. Edit a HorzonCube
option from the Tools Exirect horizons
R Gat Continuous HonzonCube
menu and click Go... y 6Grid HorzonGubes
IL’; | Analysis | Merge HorizenCubes
Modify/Recalculate line
%
Go
There are two types of HorizonCubes:
continuous and truncated O Cise || @Hep
Workflow cont’d:
3. Select HorizonCube FFT 225 MF 113 (created in previous exercise) as Input
HorizonCube.
4. Leavethe area sub-selection and minimum spacing as default.
5. Give an appropriate name, e.g. HorizonCube FFT 225 MF 113_truncated,
and press OK.
= Filter Horizon Cube = EoR = |
Truncate HorizonCube
Input HorizonCube| HorizonGube FFT 225 MF 113 -l © Select ..
Area subselection 102/302-748/1248 (463 samples) © Select ...
Tlp |f thE truncated Maximum density (Nr events per sample interval) 2
HorizonCube includes too Output HorizonCube | HorizonCube FFT 225 MF 113_truncated "l © Select...|
much irrelevant events (noise), Th Excoution Optiors
go back and increase the
Maximum density Q.comy) (bt
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Workflow cont’d:

6. Batch processing window will pop up.

7. Leave the process running until you read the message: Finished batch processing.
= Progress -0 n
OR?
End of process: 'Filtering HorizonCube'
Trimming the output horizoncube ... Done

Saving output for package 2

dTect Vé.0

iting 3D Horiz
Thu 12 Nov 2015,

Saving HorizonCube

: 19% (14.78/s) (14s)

Finished: Thu 12 Nov 2015, 16:51:55

End of process: '"Writing 3D HorizonCube'

Finished batch processing.

Processing ended

Workflow cont’d:

8. After processing, switch to the truncated HorizonCube via HorizonCube 3D Control
Center@ by selecting HorizonCube FFT 225 MF 113_truncated.

9. Close HorizonCube 3D Control Center.

" HerizonCube 30 Control Center o] = ==
[Pre-load .|

Active HorizonCube [ HorizonCube FFT 225 MF 113_truncated r| © Select .| [ Reload |

Check crossings between Horizons
Fill holes in a Horizon
» Processin | | Trim against Faults
‘ B Add more iterations
Edit a HorizonGube
Extract harizons
Get Continuous HorizonCube

’ Grid HorizonCubes
/'f | Analysis Merge HorizonCubes

Modify/Recalculate line
% Tools

Truncate HorzonCube

:Go

[© Closel [ @ e |
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Workflow cont’d:

Elements
Scene 1
PSR i Dot Dota
10. Right-click on In-line in the tree > Add Default Data. Oz et

@ Volur  Add at Well Location ...

~ Rand  pgq Color Blended
I

Elements Colof
- - . e Sc 1
11. Right-click on the inline 425 > Add > ; .‘.’“4-
. . . 5 425
HorizonCube Display, to display the truncated g Add 3 . Attribute
. N @ Cross-  Display * |4y Volume Processing Aftribute
HorizonCube in the scene. Zale ;“"’"“ﬁ“ | e
DRSSyl s Doy
. . . Elements
12. Switch back to the continuous HorizonCube | s
- - - . 5 @ Invline
by right-clicking on HorizonCube name > vl 425 . .
Select HorizonCube, to compare the two @ e Dy sto SECTTETTTTISTIR  HC,trim_D0-06_4ms Sier
ove Y HC_trim_DO-DE_4ms_3iter_Truncated
results. = Disgiay '

ot Ra'“"'ndme Ling | _ Peload v HorizonGube FFT 225 MF 113_truncated
™ 20 Line % Remove Progortional_HorizonCube

‘ The results should be similar to the ones shown below

Continuous
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2.4.1d Horizons From HorizonCube

Required licenses: OpendTect Pro, HorizonCube.

Exercise Objective:
Extract multiple horizons from a HorizonCube.
Scene 1
N In-line
@ Cross-lil Add Default Data
@ Z-slice Add and Select Data
@ Volume Add at Well Location ...
~ Randon  agq Color Blended
20 Line
._ EEﬁonzon 4 ¥ Indine
4 425,
Workflow: w4 o Add * |4 Atrbute
u;:mbscs- EIS,:IBY: * | % Volume Builder Attribute
» L-skce uphcate
1. Add the default data by clicking inline @ e o Uanoden |3 Sytems rts Dol
. e default data by clicking inline in © RO Contate wih wels
the tree. Next, add a HorizonCube © 3D o 8 Lock Treetem
. . 1 = R f Tr
overlay. Select the active HorizonCube ——_—
Continuous_HC_Fullif prompted.
= Moriond e X0 Condesl Contar e ==
Freloss
2. Open the HorizonCube 3D Control e ooncite commne i pa - [ soec.] (icnas
Center with the Q icon. A Gt coss s s
3. Select Extract Horizons under the , o bccite
fools menu and click Go ... sy o s
The active HorizonCube is %M
automatically displayed
D Ciose| | € Help

Workflow cont’d:

4. Scroll up and down using the slider, while
observing the HorizonCube events in the

|— & -:_———._-""—"-

scene. 77— —
— -

— ——

— S —
28 f _—#-__
Lnkio ColorTably |~ Cemieeiae — — —
B __—————-'-‘--"—"-‘
e ——

[Gon ]| cancel | @ e

5. When you locate a horizon you wish to
extract, click on Pick Horizon. A separate
pop-up window will appear. = et osaon B

Cutput 30 Horizon  event_263 - [ setect..| (= acE -

Tied to Leved | == -

6. Give an appropriate output name and click
OK. Base color | NI | | ™ MediumTurquoise: =

Ocancel 16 heip
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Workflow cont’d:

7. Repeatthe exercise a few times for the
events you wish to extract. Then click OK.

8. A separate batch processing window will
open. After the processing is done, the
extracted horizons can be loaded via

30 Line
horizons 3D > Load .. in the tree. D tongen | M
Faull A at Sections Only
FaukStickSet Addd Color Blended
& Boay Track New
Wel Creste with Constant 2
PickSet

= Eanet Hesizen

Pick Horzon

Event Index

23

Link to Color Table

4 Execution Opons

B0 @m

Picked harizons in the slider

= Select Input Hesizon ()

215 chosen

=]

w- Filer *

Demo 7 > shallow -=
4 event_102 =
¥ event_213 [ ]
] event_283

e Pal

Trim_D4 —> Truncation

Trim_D5 > FS7

T D6 —> FS8

Area subselection 103/302-T48/1248 (463 samples) O Seiect

D Cancel| | @ Help
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2.4.2a Stratal Terminations

Required licenses: OpendTect Pro, SSIS.

Exercise objective:
Annotate stratal terminations and lap-out patterns using standard Arrows.

Workflow:
Scene 1
N Indng
1. Add inline 425 using default data. o e e

@ Volur Add a1 Well Location

~ Rande Add Color Blended

20 Line
@ 30 Horizon

Z PickSet

[ Pelygen

3 Prestack Events

x
H [E] Annotations
B

Annotations
Ariere=.

3. Click on Arrows and select New Arrows Group... imo( TP T

& ~
2. Expand the Annotations item.

! annotations | = | (=] -'R‘

Arrows Annotations

4. Name the arrow group to Stratal Termination and Group name | Stratal Termination|

press OK to add this to the tree. _ _
[Go] (0o

OpendTect annotation (arrows, images, and scale) are handy tools to highlight and describe
features of interest. In seismic sequence stratigraphic interpretation arrows are used

traditionally to map lapout patterns and truncations.

Workflow cont’d:

5. Stratal Termination element should be
active in the tree (a click on the name
activates the item). Switch to the right
mode %

6. Now you pick on the seismic inline at
positions where you want to insert an
arrow. First click adds an arrow head.
Rotate and click one more time to pin it. Line color [ | width [5 2

Scale B

» Ctr + Click on the arrow to delete it.
« Change the type, color, width and size of the arrow via right-click on Tree > Annotations >

Arrows > Stratal Terminations > Properties...
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Workflow cont'd:

7. Continue the interpretation on this line.

8. Right-click on Stratal Termination and Save.

Optionally make different arrow groups:
*  Downlaps.

*  Onlaps.

* Truncations.

- Annotations
Sl

H .
Image
- Scale Bar

Bl Saveas..

¥ Properties ...
a Lock Treeitem
w= Remove from Tree
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2.4.2b Stacking Patterns

Required licenses: OpendTect.

Exercise objective:
Evaluate stratal stacking patterns using the HorizonCube slider.
glra.nni
:5:'“” Add at Well Location
Workflow: - n,':: Add Color Blanded
T 20 Line
@ 30 Horizon
1. Add inline with default data (if the line
. . . Scane 1
exists, skip this step). TOre )
1 0 s i Y
. L 'crnssdme”‘" Display 5 -i‘?:mm Frse
2. Add HorizonCube overlay on inline 425. Sl =
' Random Line ms;i;;;'m:la‘r‘l:l’lm; , [ Systems Tracts Display
T e - "
3. If no HorizonCube is selected, it will ask < 0oz 3 -
you to select a HorizonCube. You will oI L
choose Continuous_HC_Full.
1% Select 3D HorizonCube =8 e "%~
Filter "
Common stacking patterns are: Cortmnous_HC_Foll =
. Continuous_HC_Full_Trim —
+ Aggradation et it ol
+ Progradation Truncatad_HC.Fo_Tien x
+ Retrogradation (5]
+ and combination ofthese.
B[ 0o |[ @t |
_2015\Surfaces\Continuous_HC_Full hei

Workflow cont’d:

(@)~ B2k

Control Center 2D ...
Control Center 3D ..

4. Launch the HorizonCube slider.
T

5. Play with the sliders by moving the Top ¥ FortzoiGubs 30 Skders-
Slider & observe changesin the scene.

Link to ColorTable

Lock Tap/Base distance

[Qow ][ @ |

T e —— e T
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Workflow cont'd:

6. For better color contrast, you may want to
change the color scale of the background
image to Greyscale. See the steps below:

inf425 Zistep1 (2 qm mp (2500 | Q4500 [1aseismics

—== —— I Double Tasty
o Vil

Scena 1

) In-line Il Experimental
[¥] 425 I 1 Extremes
/| Continuous HC Full Il W Faults

9] 4 Dio stoerod median . [T]
g Cross-ine
& 7.k

Workflow cont'd:

7. (a) An example illustration of making observations:

*You have also learnt about this zone while doing spectral
decomposition (RGB Blending) & waveform segmentation.

[ Link to ColosTable

[ Lock TopBase distance

[(Ocuse |[ @ Hee
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Workflow cont’d:

7. (b) An example illustration of making observations:

Aggradation to progrdation
(flux dominated)

Link to ColorTable

Lock Top/Base distance

(D0 ][ @

Workflow cont’d:

7. (c)An example illustration of making observations:

Fall with su bsequént

progradation —aggrdation_—

—

[ Link to ColorTable

"] Lock TopBase distance

[ @

S——

Note: The scene is a bit zoomed out.
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2.4.2c Wheeler Scene

Required licenses: OpendTect Pro, SSIS.

Exercise objective:

Wheeler transform (flatten) seismic data and co-render the flattened seismic with
the flattened horizons of a truncated HorizonCube.

Basic concept of Wheeler diagrams (Flat horizons)

Distance (b) Distance
1 1
;/__ 5,
= =1
3
(a) 2D Structural Section (a) 2D Wheeler Diagram

Structural domain horizons / surfaces are representative of relative geologic time (from P.R. Vail)

RGT - Relative Geologic Time

Workflow cont’d:

T Sunvey Analysis  Processing [[EETIEY View Usiities  Help

b Jl e 23 B Hew

New Map View

1. Add Scenes > New [Wheeler]. o S New [Depth)

New [Horizon Flatiened] *
LWhasier)
Elements
Cownn 1 Cascade
W Indine 13
& Cross-ine Propatties
¥ Z-shce Save sceneto IDPDF  »

§ volume

~ Random Line v Scens 1

Tree scene 1

Y

2. If no HorizonCube is active, it will ask to B .
select a HorizonCube, Select i “’“I;T“‘“"'

H . . . -] o Cancel
Continuous_HC_Full. Otherwise, it will use
the active HorizonCube to create a new = Select 30 HorizonCube =R EOR %"
Wheeler scene. Fiter *

Continuous HC Full —
Continuaus_HC_Full_Tnm ;

Prapartional_HorizonCube .
Truncated_HC_Full
Truncated_HC_Full_Trim x

[ @cace || @ten |

_2015\Surfaces\Continuous_HC_Full hci

-230 -



Workflow cont’d:

It will launch a new empty scene with a special Tree Scene 2 attached to it.

SRS R Rt BT |

[

Wheeler
Tree

Workflow cont’d:

3. Add a default data in both the normal and Wheeler scenes.

4. Add a HorizonCube on inline 425.

Elements Celor

Wheeler scene: Continuo

& Zslic
@ Vol A0 3t Well Location
~ Fiane Add Color Blended

-231-




Workflow cont’d:

Your display may look like as shown below. Note that viewing a continuous
HorizonCube in Wheeler scene is not interesting. You may want to truncate it to
remove all convergence patterns (next slide).

S| 5 oot

-
¥| 4 Dvp stewred medan Ber 10
@ Cros

Workflow cont’d:

5. Make a truncated HorizonCube display (on-the-fly) using HorizonCube display
properties dialog.

6. Check Truncate HorizonCube, click next to 2 and press Enter from the keyboard.

7. Apply to all to apply the same HorizonCube settings to all displays. When you will
close the dialog, it will apply the same settings to all other scenes.

= HorizonCube display options =N R X"
Fill between lines () Yes @ Mo

B | Evomorns

Whesler scene: Continuous_HC_Full Use single color () Yes @ No

l R In-line
d
¥ 425 Transparency 0
| [E—w
il 4 D3 Select HonzonCube » <
> X = Line width |1 = Spacing 1

e #@ Cross-line Mowe O

& Zsiice l?."'_ "-—-—-—._______\ Horzontal resolubion |3 traces (-
— @ Volume Reload IS

>
~ Random L| = Remove | 1] Tooncate HorizonCube |2 | (everts por sample intera)
20 Line
30 Horizon Top [] ]
Base 47
Link to ColorTable
Lock Top/Basa distance
Saw as Defack B Hop
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Workflow cont’d:

Adjust the display:

8. Make an inline view.

9. Tile the scenes.

10. Change the z-scale of the
Wheeler to adjust the display
according to your view.

Suney Anslysis Processing  Scene [JEEEJ viiies Help

0 - s w1 Work Area .
A ,l. W' “ Ll, perl
| Tree scene 1 Viewer 20
R [comens Sl
e Scene 1
W Indine Toolbars v
¥ 425 ¥ Basemap .
6 E Cummvaus_HC_Fn?

7| 4 Dip steered median filter

QI v ive

% W View Cross-line

r View 2

ﬂ View North
9 /@ View North Z

Verw  Utiies  Help
Howe
Hew Map View
Now [Dopth]
Now [Hoiizon Fiastanad] .
Nowe [Whasior]

Cascade

Ty v
Properties

Save scene to 30 POF »
Scana 1
v Whesler scene: Contmass_HC_Full

= 25009 e
Set 7 scaling factor
IApply LD RGO Wheeler scene: Canllﬂ |
Z stretch 0.03435579

[ XX Fitto scena: [ e To Home ]

V| Save as Default

o=l @m_

Workflow cont’d:

11. Change the perspective -—' view to the orthographic J view.

12. Adjust the scene by co-visualizing both views. You may also need to zoom in.

Tip: Avoid rotating a

scene. Just use:

+ pan (mouse wheel
pressed or

Ctrl+left mouse
button pressed)

* zoom (spin mouse
wheel or
Ctri+Shift+Left
mouse button
pressed).
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Workflow cont’d:

13. Use the HorizonCube slider to slide the E; > B3 27 Vne
events up and down. Now you areready to 7| comweicemero . |
perform sequence stratigraphic COTOLCOS A

] . HorizonCube Slider ...
interpretation.

Link 1o ColerTabia

Lock TopBase Satancy

Ocm | [ @
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2.4.2d Systems Tracts

Required licenses: OpendTect Pro, SSIS.

Exercise objective:
Perform systems tracts interpretation with the SSIS plugin.

This exercise assumes that you are familiar with sequence stratigraphy and
the followings:

* Transgression & transgressive systems tract (TST)
* Normal Regression & highstand or lowstand systems tract (HST/LST)

* Forced Regression & falling stage systems tract (FSST)

Sequence Stratigraphic Models in OpendTect:

Each model has its own name, color code, base-level phase, Top surface name, top

surface color.
- o
* Manage Sequence Models [ = ]r (=] |
Sequence Model Depositional Sequence [V 3
Depositional Sequence Il -
Name Depositional Sequence Il Color
Depositii 2Q e [V
HST Genetic Sequence L
T.R Sequance 3
FSST Channel Stages
Stratal Packages
Lst Sequences
TsT Fluwial Depositional Sequence 2
N-layers
Undefined Mone | Top Undefined
Sequence Boundary is top of FSST ]
[ Add model ... £ Saveas | [Remove model ...

l_o OK ) Cancel ) Help ]

You can also make your own model if you press the Add model button.
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Worklow:

[ Tras sceme 1 o
§ o e
1. Add inline 425 (if it does not exist). I s e iocomn.

R Add Color Blanded

2. (Optional) In Exercise 2.4.2a, you made some annotations (arrows) on inline 425.
You may want to display them in the scene to begin with SSIS interpretation.

Sy Prestack Everts
& Annotations

e Following this, select the ones that you
\mae MW AITOWS group ..

Scal|

saved earlier on.

Workflow cont'd:

Tip: If you intend to study depositional shifts, we recommend

selection of a truncated HorizonCube (which is already pre-
processed).

3. Activate a truncated HorizonCube (Truncated_HC_Full).

*  Launch the 3D HorizonCube control center.g
*  Select the active HorizonCube.

= Monzondisbe 50 Conmal Canter sy

[Preteaa_ |
4. Add the HorizonCube display on inline 425, | s [mmmere o] e
[ | Crate 3 SieeniCude
.Q N o Sevninse
& i Indine 4 ferrs
Rl | - ST
Bibhds - e , |
W Cross-line all 3 DI LS 3503 3 ™
@ Zsice 25 * Ry Volume Buider Attribute Iz/!;” syt
Koo e
T isplay Puatack Datal > Mos Sy iemns Tincls Die lay,

e &t Comelate with Wells ..
4 20 Hoizon | 8 Lock Treeitern
2 Faul == Remove from Tree
FaulStickSet
Eady
A well

WomaLea

ﬁgm
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Workflow cont’d:

If you do not have any Wheeler scene
display, Add a Wheeler Scene*
(Scene > New Wheeler ..) .

Add inline 425 with default data for
the Wheeler tree/scene.

Add HorizonCube display.

Elements Color
Wheeler scens: Continuous

W inhne
i Cros!
& Z-slic
P voiur

~ Rand

Add Default Data
Add and Select Data
Add at Well Location
Add Color Blended

There are two ways of preforming S5IS interpretation:

. Stacking patterns in a normal (structural) scene.

. Or co-visualizing both the normal and Wheeler
SCEenes.

. In this exercise, we will co-visualize both scenes.

5 Suney Analysis  Processing [[EEIIEN View Utiities  Help

—

™ YN New
o A 1o E Hew Map View
€0 > SteplD New [Depth]
Tree scene 1 New [Horizon Flattened] *
4 Elernents
f Scene 1 Cascade
& W Indine Tile .
g Crossdine Properties
| [P 2ok Save scene 10 IDPDF  »
& ® volume
~ Randam Ling v Scene 1
S Q) Indine
=
V| 4 Dip stig : 5
i Cross-line al Adtribute
& Zslice Display b @y Volume Builder Attribute
TR o, .- o
~ Randomline | oo TOOP B Systems Tracts Display
20 Line Dlsnlrlay Prestack Data *
¥ 30 Horizon : Corelate with Wells
4 20 Harizon g Lock Treedtem
Fauht == Remove from Tree
FaultStickSet

* See Exercise 2.4 2c

Workflow cont’d:

& Sumey Frocey

Scene  View Utlties Help

al Aributes L
Q = & Volume Buider nid
Ei Cross-plot Data .
j E A wels .
8. Open the SSIS interpretation window by clicking on this @ = f*’“c”"“‘"“: &
. | . . . . . <= Fluid Contact Finder
icon.” @ An interpretation window will open, with the é S+ Newral Networks
familiar HorizonCube sliders on the left side; Sl e
interpretation column, base level curve, and timeline in & |n S ¢
the white pane on the right. - -
= Interpretation: Systems Fracts Dema =Ngoy %"
ad - L= AN
J HerzonCube: Trencated HC Full
Insart Insert Sequance Model: Depositional Sequance V'
Top Baie Absopte Sysems Sustgraphic Base Level
age (My) Tiscts Sudscet Resa " Fall
Horl:szlci)(r’\;ube =2 ssIS
e Nterpretation
Panel
Link to ColerTable - g
Leck TopBlase ostance Caat Lol *| SewANSuteces . B8
Q0wses | | O Caneat e el
oyt Tt Tpe: Ut -
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Workflow cont’d:

9. Open the Sequence Models selection window

by pr

essing:

View the options of the sequence models
available. For this exercise, the default
model (Depositional Sequence V) will be
used.

Close this window when you have finished
viewing the options.

10. To begin your interpretation, you will use the
HorizonCube sliders:

Slide the top slider all the way to the
bottom while co-visualizing the Wheeler
and normal scenes.

Slowly drag the top slider up until you find
a breaking point that would indicate a
different system tract.

= Interpretation Interpretation 1
ol L 3-F 4"

mnse
Eop Base

a3

Linic ta ColorTable

HerizonCube: Troncated_HC_Ful
ise | Sequence Model. Deposisonal Sequence

Absohute Syites £l
300 (M) Tuacts !

Spra Tescn

Workflow con

t'd:

B vien wiies Hep

Tip: You may want to tile the
scenes vertically.

Hew

Hew Map View
Hew [Depin]
MNew [Horizon Flattened) Ol

I inding 425 =4

Hew [Viheeles]
Cascade

e ™

| Propaies Hodzomal
Scene 1 [ Vorcal |

11. Position the top slider where you intend to insert a boundary.

Save scenw 1o 30 PDF .

¥ Whesler scens: Truncated HC_Ful

Systems Taact Type: Usdebened

Ralatin Geol T &
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Workflow cont’d:

12. Press the insert button which lies just above the top slider. This will
insert a boundary in the stratigraphic column.

= Interpretation: Systems Tracts Demo
T LI-FL

HoizonCate: Trancated_HC_Full

Saquente Medd O

Workflow cont’d:

13. Right-click in the middle of the package that you added and assign
the systems tract.
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Workflow cont’d:

14. The selected systems tract will be assigned.

Systems Taact Tige: HST

Filanin Geol T 197

Workflow cont’d:

15. By repeating these steps, the entire stratigraphic column can be
interpreted and systems tracts are assigned.
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Workflow cont’d:

16. You may want to overlay the inline with the interpreted Systems tract in both scenes.

17. Once done, you may want to Save H this interpretation.

Tree scene 1 L]
Elements Calor
Scene 1
= g In-line
> Ve
1 TN (| sttt
414 Dusplay * W Valume Processing Attribute

@ cossd Duplicate
Z-slice Reset Manipulation
Velume  Display Prestack Data *
~ Randol b Correlate with Wells

& Horz

i Tr:

You can save g ! more than one interpretation per HorizonCube.
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2.4 2¢ Statistical (Thickness) Curves

Required licenses: OpendTect Pro, SSIS.

Exercise objective:

Extract statistical (thickness) curves to express data-driven nature of base-level
variations.

This exercise requires an existing SSIS interpretation and an active* HorizonCube.

In Exercise 2.4.2d, you made some SSIS interpretation. You may want to use them as a
reference interpretation to extract statistical curves.

g

et BRI Do Ce

M AR LY T

m= N

I oodew F o

e g
* Processing = HorizonCube > 3D =___

Workflow:

1. In the SSIS window, launch the statistical curve extraction dialog: S.ll

8 Interpretation: Systems Tracts Demo = | 3|3
ot L A=F 4N
: neal odt | HorizonCube: Truncated_HC_Full

Insent '_ lngen Sequence Model: Depositicnal Sequence IV

Top -
i SystemsTracts Statistics =r o @ '
On 0K, the statistics Min, Max. Median. and Average
will ba calculated within the gren range
Woul be able to switch between the results by
right-clicking on the siatistical cune

Tips on area sub-selection: s ot i sance X
LOx ]| Ocmed |[ @ree
1. Try to plot the thickness = == T e
variations at a given T - e
depocenter vs. coastal regions
8 @ » Mt

per systems tract

“uneigrans

Link to ColorTable * Senence Brunde
2. Compare the two curves by P =]
taking snapshots. @@ —
O G | [ @
Systems Tract Typa: TST Relative Geol Tima: 410
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Workflow cont’d:

2.

perform statistics.

& Interpretation: Systems Tracts Demo =8|
ot L YA=F.%"
: + | HorizonCube: Truncated_HC_Full
Insen Insen Sequence Model: Depositinal Sequance IV
) [33%] Reading =N ECE %"
1 3%
@ Pause || O Abor |
Gridlines read 646
pasts [aepera—y
Top HET POnsat of Bave bavel fall
0 430 [P —
Link to ColoTabla - e * Sesuecon Brunan
Lock Top/Base distance Ciear | Lewel | [Save Al Surtaces .| [l
§ Ow/Saw | | ) Cancel 1§ rop
Systems Tract Typa: TST Relative Geol Time: 410

If you proceed further, it will start extracting data within the sub-selected area and

Workflow cont’d:

3. Once the processing is finished, an Average Thickness curve will appear in red.

= Interpretation: Systems Tracts Demo =) e e
< |2 | A &
E‘ lﬂ E’ X EN
at eledt | HorizonCube: Truncated HC_Full
Insert Insert Sequence Model- Depositional Sequence IV
Top Base Absolute Systems Stratigraphic Baselevel  Average Thickness
age (My) Tracts Surfaces Rise*™—"Fall 12 &7
Top HST3 #orsacors
WEnd of Temgrassion
Top LSTZ End of Ragremich
op FaT2 En ot Base evnl 4
Top HET2 OCcuat cf Base level fall
52 W of Trarugression
Top LET1 End of Regramich,
Tep FSSTH End cf Base eval il
» P HETT #Craat of Base vevel 13l
o 430 #End of Tramgreasion
43 “Unamigreds
Link to ColorTable ® Sequance Baurdery
Lock Top/Base distance Clear | Level *| |Save All Surfaces ... .ﬂ
(@ owsae | [ ©cancel || @Hep |
Systems Tract Type: HST Relative Geol Time: 328
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Workflow cont’d:

4. You may want to change the statistics and plot a different curve. To do that, just right-
click on the curve and choose other stats.
= Interpretation: Systems Tracts Demo =) S

@ 8B XA

HorizonCube: Truncated_HC_Ful

Insert Insedt Sequence Model: Depositional Sequence IV
Top Base Abschute Systems Stratigraphéc Base Level Average Thickness
age (My) Tracts Suriaces Rise® *Fall 12 &7
E op HETY [ -
z ®E0a of Trasagrestion
op LSTZ End of Rageassich
op FEST: Ent ot Base baval o
g HETZ [T e—
> 2 ®Ena of Traesgramicn
233 g LST1 End of Regramsi®
» 27 g FEST1 Ent ot Base boval
g ST $omat ot Base tevel 1y Min
Max
v Average
0 430 » 250) hiFsi #E0a of Tracagramicn Median
Link to ColorTable - e * Segeacce
Lock Top/Base distance Clear Level v | Save All Surfaces s

| @ Okisme | | £ Cancel 1§ Help
Systems Tract Type: FSST Relative Geol Time: 311
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2.4.2f Stratigraphic Surfaces

Required licenses: OpendTect Pro, SSIS.

Exercise objective:
Extract systems tract boundaries as seismic horizons of OpendTect.

There are several ways available to extract stratigraphic surfaces (or horizons) from a
HorizonCube.

In this exercise, you will learn three ways:

1. In SSIS window: one horizon at a time.
2. In SSIS window: multiple horizons.
3. In HorizonCube manager: extract events.

Workflow:

Method 1:

1. In the SSIS window, right-click on the surface name and choose Save as surface.
! Interpretation: Systems Tracts Dema =) -a) E
— IEJ é.l ::I >({ 3
HornzonCube: Truncated HC_Full
Insert Insert Sequence Model: Depositional Sequence [V

Top Base Absolute Systems Stratigraphic Base Level
age (My) Teacts Surlaces Rise " Fall

e LAT1

e PEST

op ==
Rename

(] a0 * L Delete
Hide Surtace Names

Linik to ColedTable * Ses

Lock TopBase distance Clear Lavel 1 | |Save Al Sufaces . | gl

© OxSaw | | © Cancel | [ & Help
Systems Tract Typa: HST Relative Geol Time: 315
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Workflow cont’d:

Method 1:

2.

In save surfaces dialog, specify a Horizon

name and press OK.

“ Save Surfaces

Specify Parameters
Area subselection 103/302-748/1248 {463 samples)

Surface Name: Top HST1

ESSECE =X

Qutput 3D Horizon  Top HST1

~]| © seect .. | | @ acB

Tied to Level —

Base color

[=]

Orange

&

]
L ©Qok | ©cancet |[ @tHew |

Workflow cont’d:

Method 1:
3. It will start extracting a horizon from the HorizonCube. In case, the HorizonCube is
truncated, it will start interpolating the horizon.
& Irterpretation: Systems Tracts Demo =3
> o 8 B X

HonzonCube: Truncated_HC._Full
|- Save Surfaces
Specify Parapatacs

= [0%] Horizon Creator

Systems Tract Typa: HST Relative Gaol Time: 315

=l .
Area subsok .
o
LD Pese || O azen
Outgut TOH| Reading HoszenCuba . Ininas processed 0 hect o8 -
Titd t Leval =
Base coke Orange -l
[« ) Cancel i) Help
Lk to ColorTable - T * sapne
Lock TepBae distance o Lawe

| |Sme a8 Sutaces

Q) OkSave | | ) Cancel £ Hep
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Workflow cont’d:

Method 1:

4. The extracted horizon

~ Random Line
I 20 Line
% 3D Hor=~

4 20 Hol A0

Fau

Fauks Add Color Blended ...
Track New ...
Create with Constant Z

® sy
= Well
i PickSet

is copied as a general OpendTect horizon to the project
database. Hence, you can display the horizon in the scene to QC it.

e

#! Select Input Horizon (£}

=3 EoR =5

.- Filter *
| ToBeDeleted_Manual
ToBeDeleted_Test_Trck
TODELETE BugTesting
ToDelate_TestBug
| Top FSST1
7| Top HSTY

Training_ 0004
[ Tramning_ 0006 B

T D ~> F54

X ejld

Avea subselection | 103/302-T48/1248 (463 samples) :O Select ..

: B\l il
ta\F3_Demo_2015\Surfaces(Top_HST TR

Workflow cont’d:

Method 2:

1.

1=\ Interpretation: Systems Tracts Demo

B &g

Insert

Top
u]

Base

0 410
Link to ColorTable

Lock TopBase distance

Systems Tract Type: TST

% EN

54 HerizonCuba: Trancated_HC_Full

If you want to save all surfaces, then proceed with this part.

| Sequence Modal: Dapesitionsl Sequance IV

Absolute
age (My)

Systems
Tracts

Stratigraphic
Surfaces

Base Level
Rise *—*Fall

TrgHETE 90w of Base e Tl

Wing of Traragression

End of Fagpasmih
£0a of Basa et 0

#5ran of Basa vl 1t

B ot Tramagressesn

W LSTY Ero of Ragram

oo PEET1 (IS T—— ]

op ST [T p——

1 #6000l Traragrusson

Relatrve Geol Tame: 176

-
® Sesuance Beundey

==l

@ Oksae | [ © Concel || @Hep |
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Workflow cont’d:

MEthOd 2: = Save Surfaces = | B3
Specify Parameters
2. On the left panEI, you see the Area subselection | 103/302-T48/124B (463 samples) © Select
surfaces names that you have R
interpreted. You will have to add ﬂ - S
i i op H!
them to the right. Top HST1
3 [=]
. C
3. For each surface that is added, you wess
will specify the Qutput Horizon PR
wface Name: Top
name. [ 0z F|@ st ] @ace 2
Tied to Level =]
Base color White -
QoK || O Cancel @ Hep
Tip: You can copy the input name for
output horizon, e.g. MFS2 (using mouse
drag over the label and CTRL+C).
Workflow cont’d:
Method 2: ) Sove Sators b
Specify Parameters
4. Following this procedure, you can Arsa subselection | 1037302-748/1248 (463 sanles) O st
add multiple horizons in the list.
Select surfaces 10 save
5. Once done, proceed by pressing the - ?;2552;3‘ i
op 1
OK button. - [roresre
Top LST2
MFS3 -
6. It will output all of them as general
OpendTect horizons and you can QC | e 72 _ .
. . . Output 3D Horizon MFS3 -I € Select ... | ¥ 4GB -
the outputs by displaying them in the 5 -
. Tied to Level -~ x
scene as shown in pt. 4 (Method 1). : -
Base color Lime hd
) cancel £d Heip
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Workflow cont’d:

Method 3:

Directly extract horizons from a
HorizonCube using HorizonCube

manager.
1. Survey > Manage > HorizonCube >
3D

2. Select Continous_HC_Full & press
copy to horizons icon.

SN s Prcessey Scems Vew Lusbes e

B =R

L7 SeerSan
e

= Manage 30 HorizonCube

Filler * 's
> Continuous_HC_Full <
Continuous_HC_Full_Trim

Inversion based HorizonCube

Inversion based HonzoenCube 151

Inversion based HorzonCube 151 Gap filed
Imversion based HonzonCube 2nd

Inversion based HorizonCube copy

Inversion based HorizonCube copy v2
OlHC_Tracking

OIHC_Tracking_Ir2
Proportional_HonzoaCube_Full =

Undefined

: Center :

Free space on disk: 1567 GB

ole s
HorizonCube data
~
—
o
| Dose || @hep

Workflow cont’d:

Method 3:
3. In the pop-up window you may
choose one horizon or multiple
horizons (say Event 4 and Event 6
only) to be converted to general
OpendTect horizons. The Base
Horizon Name is the prefix for the
output horizon name. On OK, it will
start extracting the horizons.

4. Once done, close this window.

Uncheck-all: Ctri+Z or uncheck the list
through the small check box available at
the top of the list.

Group selection: Mouse drag over the
check boxes in the list.

/. Extract Horizons from HorizonCube

-

Select by

103 to 748; Cd
103 to 748; Cd

Al ia Jao. o

Select Event(s) || Event 1 (Inl:
|| Event 2 (Inl

Eaniedellal

=e e

30210 1248 ) ~
30210 1248 )

20040440

| Event 4 (Inl: 103 to 748; Cd
Event 5 (Inl: 103 to 748; Cil

: 103 to 748; Crl:
1030748

Eugnt 7 ol

302 to 1248 )
302 to 1248

kT XEELITE

| Fuant R {inl-

ANT tn TAR- CA

Area subselection | 103/302-748/1248 (219 samples)

IND #n 1748 L

Base Horizon Name

0 oK

0%

[ D Cancel 1 9 Help ]
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Workflow cont’d:

Method 3:

5. To QC the outputs, you may want to
display the extracted events in the
scene as follow:

7 20 Line I
@ [30 Horn 1
& o Lexd

[l ~dd at Sections Only
Faung  Add Color Blended .

Track New .
B
’ o (Creata with Constant 7

/= Select Input Horizon (s) == "%
.- Filer |*

" Horizon_altemative Al
" Harizen_stap1

=
| gg:;gﬁzl;ész_m m
t

| Trim_D4 ~> Truncation o
L= Trim N5 > FST

Area subselection | 103/302-748/1248 (463 samples) 9 Select ]

IO_WH_QM
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2.4.2g Stratigraphic Attributes

Required licenses: OpendTect Pro, HorizonCube

Exercise objective:

Define and understand the HorizonCube/SSIS attributes.

Workflow:

1. Launch the 3D attribute set windc:w."‘fI

2. Select a HorizonCube density attribute.

= Attribute Se130
File

T el
=4 KA N N UL W )3

-2

=] [ © Select
Time gate (m3) -0 8

Injast HorizonCul

We suggestusing a Continuous HorizonCube as an input forthis attribute because it

requires horizons within a specified time gate. The truncated HorizonCube removes such
events and hence this attribute is not suitable for such inputs.

Workflow cont’d:

3. Specify the attribute name and add it as new.

Filg

Attribute Set 3D - olEl
D > &
sl A 2R T 1505
Altribute st <nol Saved= <All= ~ | |HorizenCube Density - ?
HorzonCube Density-8 8)ms Input HorizonCube Conlinuous_HC_Full v ) Select..
Time gate (ms) -8

8

Adtribute Name HorzenCune Densit(-8,8)ms

[#] Save on Close

Aad as new | [ I

@ close || [ Help
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Workflow cont'd:

4. Following the previous steps (2-3), define* a few more attributes e.g.
HorizonCube layers and Systems tract (Common |D, Unique ID, and Isochron)
attributes.

<All> 7| HonzonCube Layer =] ?

Impul HonzonCube  Continuous_HC_Full ZI © Select .

Ni events per layer |10

Note the input HorizonCube <Al [=] [Systems Tract I

fOI' thls attr’ibute iS the Input HorizonCube | Truncated HC_Full B’e Select...]
truncated one because the
interpretation is made on

that input Output SystemsTract (&I RIN] =

Sequence Model : Depositional Sequence [V
HST -1

F35T:2

LST: 3

TST:4

Undefined - &

Select Interpretation |Systems Tracts Dem[ Level 1 2

* Per defined attribute, you will have to specify its name and press the button add as new.

Workflow cont'd:

5. Once you have defined these five attributes, save H the attribute setas e.g.
Stratigraphic Attributes. If the name already exists, then overwrite.

6. Close the attribute set window.

- ———— o
= Save Attribute as =R EER X" e =
Fils
Salect output Attribute
s AR XN T 1S
L ks
Fla [+ [ ———y \-A., =] [Msnzoncuos Dwsey =7
30 UV Attribs Texturs + HC -1 HatnCaba Dansty 35 put HosizonCube | Continuous_HC_Ful 7] [© Seect
ChimneyCube aftributes Crmionms Tooct: G Tine gate fsa) |8 0
delme
Demo sttributes. =
FaulCube atiributes x
FaukEnhancementFilter with Edge presening fit
Irversion atinbutes -
b -
Namea | Stratigraphic Attributes|
L
Q Ok ) Cancel @ Help [
Attt Warow | HomzonCube Densityl 8.8 Add ws vew | [0
) Savw 08 Close @ e

%
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Workflow cont’d:

7. Next you may want to display these attribute on an inline before processing.

Iy in-y
W Cn Add Defwht Data W nane
2. Add and Solact Data « DD
; v;" Add at Well Location > ¥ 4 Dipster 04 v Attribute
pr Add Color Blended @ Cross-line Desplay ' Volume Buider Attribute
- © Z.shce Duplicate @ HorizonCube Display
® Volme Reset Manipuiation s s Tracts Disph
5 ;‘S’I'_"_I"“" ¢ Comelate with Wells =
© 3DHorizon | o LockTreetem
s 20 Horizon | = Remove from Tree

= Select X"

E=EEon

Select Layer 2

g
. HorizonCube layers
Steering | Systems Tracts Common ID
) Systems Tracts Unique ID
Q@ Aftributes | Systems Tracts Isochron

&)
Y

QoK || Ocancel |[ @rep |

Workflow cont’d:

8. Following the same steps, overlay the remaining attributes on the same

inline.
-y Indine
4 @ Inane .

+ 7[435 — - =
@ coesine | [IDERE vl T Systems Tracts Isochron m
# Z-sice Duplicate @ HorizonCube Display Systems Tracts Unique ID i
._v::;»:mlm Resst Manipulsic e Systems Tracts Common D F1

2 Line f"’f""“"‘““""*" HorizonCube layers n
= W Horeon |5 e HorizonCube Density[-8.8]ms 1

" 20 Horzon from e 4 Dip steered median filter i

- Your inline vi look like thi
- our Inline view may Io0K like 1S
@ select = ew may: ool
— after overlaying six attributes on
Select Layer 2
each other.
Stored [ HorizonCube Density[-8.8]ms
HorizonCube laye
Steenng | Systems Tracls Common ID
Systems Tracts Unique ID
© Attributes | Systems Tracts Isochron
&
QOK | Q) Cancel ) Help
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Workflow cont'd:

9. Your attributes may have a coloured (default undefined values) areas
which could be set to transparent by following these steps.

4500 PV FTa—
Flipped s B
Ranges/Clipping ... &
Cotr
Set as default
/% Manage ColorTable E=NiEE <"

Add, remowe, change color tables

Colortable  Status -]

Porosity Edited

Paorosity-1 Own

Pressure Default

Rainbaw Edited

Rainbow Plus  Default =

Red-White-8l,.. Edited Please specify
Red-White-81... Own

Red-White-81... Own The Edited colortable will be replaced

Red-White-Eiue Defaul 1 i e vill
Rasis” O S DS o s e

TR T — | Soorentaion None 5] Aoon
%‘EE%-;:“ %«1 Undefined color | Tnns
g:"n:'::?:”b“ g::.d - Marker color |
[ Remove . | [ impon .. | [(Sweas.. |
[ O |(Ocns |[ @ne |

Your results may look like this:

HorizonCube Density:
Black regions in this case represents gaps in depositione g
unconformities and condensed sections.

HorizonCube Layers:
This is like an input model containing layer definition per 10th event A
good input for geologicalreservoir modeling.

Systems Tracts Comon ID:

Arepetition of same colour in this case represents the same systems
tract, which has a common ID in this volume  Again, this volume can be
use for modelling or prediction purposes.

Systems Tracts Unique ID:
All systems tracts have their own unique IDs in this volume.

Systems Tracts Isochron:

This is a thickness volume per systems tract. A good product to explain
the base-level variations based on your data. Or adding another
dimension to the Wheeler diagrams when this attribute is used as an
overlay in the Wheeler scenes (e.g. 4D Wheeler diagrams).

- 254 -




2.4.2h Stratal Slicing

Required licenses: OpendTect Pro, SSIS.

Exercise objective:
Analyze 3D seismic data by slicing through all available data.
WOI’kﬂOW: 5 Survey Analys\sScanB View Utiliies He
Q ] | e . greate ﬁelsmlcgmut * InelB
. . = T reate Honzon Output +
1. Go to Processing > HorizonCube > 3D. § [Teescenel  Resiar Bach Job
E'QS":“'S = Dip Steering v
I B8 1 | o GMT Mapping Tool ...
6 | & CuossiB 3 20
. & Z-slice Madagascar
. = ® voume 7! ssis v
2. In the HorizonCube 3D Control Center
select on Create a HorizonCube RS S e
from the list and click Go... Acke Hoczoncate - [ Seei ] [ R
. Process 5
.43 = Cr o
Creale Honzons from SteeringCube
Ect Hongors from SiearngCube
Inderpolate Logs slong & HorzonCuke
L,,_f; | Anahysis
5
[ D cuose || @ree
Workflow cont’d:
3. In HorizonCube Creator, click on
Read horizons... ! HorizonCube Creator 3D = o %
Eead horizons |
Fault | - © Select .. Clear
HorizonCube calculation mode
4. Check three horizons Demo 4, Horzon Mode E
Demo 6, Demo 7 and click OK.
= Horizon sorter = o0 E -
Select horizons Area subselection - © Select ...
.- Output HorizonCube ]| © Select ..
D 3 —>TopF £ -
v sz 4> T[?.I?!C;Ir;i S _Malyze
gmgi__: ;g?callan i & 1l {F Execution Options ...
¥ Demo 6 > F58
) Do 6.Copied [ QR ][ ©cose || @Hep
F3-Horizon-FS6 :
Qcaed
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Workflow cont’d:

5. The table will be filed automatically with two packages. Select Model Driven:
Proportional for the both the packages. Type in an output name to the HorizonCube
Proportional_HorizonCube and press Run to start the batch processing.

Settings for the proportional
HorizonCube are based on event
sampling (spacing at maximum
thickness and fixed number of events).

¥ HorizonCube Creator 30 o |23
Read horizons ...|
Faults - B select ... Clear |
HorizonCube calculation mode
Horizon Mode

Demo 7 —> shallow IModeI Driven: Proportional v|
Demo 6 --> F5& Settings ... ]
Demo 6 > F58 | Model Driven: Proportional - |
Demo 4 --> Truncation Settings ...
Area subselection 100/300-750/1250 (463 samples) D select ...

Ioulpul HerizonCube Proportional_HorizenCube » |© select...

Analyze ...
Batch execution |Single Process ¥ | |4 Options ...

©) Close| | Help

Workflow cont’d:

6. When processing is finished, set an active HorizonCube: click on Select button in
HorizonCube 3D Control Center and pick Proportional_HorizonCube.

7. Press Close.

= HorizonCube 3D Control Center

Active HorizonCube  Proportional_HorizonCube

Croate 8 StoenngCube

Fitar & SteeringCube

Create a HorizonCube

Comvert to StearingCubse

Creata 2D Seisme: Lalice

Croate Horizons from SteerngCube
Ed#t Horizons from SteeringCube
Interpoiate Logs slong a HorizonCube

Processing

>
(]

Pro-load

- ]

[So=e] one
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Workflow cont’d:

8. Make a Wheeler scene: Scene > New [Wheeler].

9. Load an empty volume in Wheeler scene: Right-click
on Volume in the Wheeler scene tree > Add.

10. Right-click on the wvolume > Display > Position...

11. Set ranges to the full survey : click on the # icon and

[T view utiities Help

New

New Map View

New [Depth]

New [Horizon Flattened] »
New [Wheeler]

Casrada

Wheeler scene
iy In-line
W Cross-ine
& Zslice
@ Volume
~ Randol
20 Lim  Add Color Blended
@ 30 Horzom
@ 2D Horizon
Fault

LB
® volume
v
~| <right-cl Add .
¢ Bandom Lino ke Hsopram
2D Line Duplicate A Properties ...
Rasat Man: G

< 3D Horizon

20 Horizon el e T
Fault a Lock T
FaultStickSet | == Remove from Tree

=" Positioning
Specify the elements position

o

press OK. In-line Range 100 = 750 :E
Cross-line Range 300 & 1250 <
ZRange 0 ST B
Qcumsl | @ew
Workflow cont’d: S
= Select =RECE ="
Select Layer 1
12. Select 4 Dip steered median filter from the list ® Stored [ { Original Seismics =
of attributes and press OK. Steering -:éa._.. :
Ta Al Cube Std
Aftributes Tb Al Cube from HorizonCube
8a PorosityCube from HC-NN
‘Wheeler &b Gamma from HorizonCube
9.1 Simitarity on FEF seismic
s 23 Do teerd Sk e -
2 Finer[r
[G5] (0 coma | @1
L] :| View Indine

13. Click View Z or View North Z to rotate the
volume.

14. In mouse position mode ﬁ , click on section
and pull down to slice through. Slice the
volume upward and downward.

In similar way you may slice in inline and
crossline directions

% | @ View Cross-line
7| ® ViewZ
== b View North
X
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Workflow cont’d:

Optionally a Wheeler Cube can be created as follows: "SUﬁ Ma:s'_f
15. Click on , || icon > 3D tolaunch Attribute Set window. 2 |
16. Select Similarity attribute from the attribute list. "
17. Type in a name, e.g. Similarity, and press Add as new.
18. Uncheck Save on Close and close the window.
= Ansibute Set 30 o
*Pe DN A E
ot 3ot <0t s> e G| T —
Simaarity Input Dkt 4 Dip steered median fillor =| | D Select
.Sn:s.uu --ul” & el 2 .
Stpering None -
+
4
+
Adtribut Name | Similarty ||noo s new] [l
e
Workflow cont’d:

19. Create wheeler volume: go to Processing >

SSIS > Create Wheeler Output

Scene View Utiiies Help
Create Seismic Output »
Create Horizon Qutput »
(Re-)Start Baich Job ...

> 3D.

= Diip Steering ]
= GMT Mapping Tool ..
@ HorizonCube
Madag:
Create Wheeler Output

20

Flatten Horizon/Seismics * m

e

20. Fill the required fields as shown below and press OK to start processing.

= Create Wheeler Volume [o & = g =
Input HorizonCube | Proportional_HorizonCube :| © Select ... Soloct Input Data
Input Data Similarity 7] |O Select I Stored
@ Aribuos
Volume subselection | 100/300-750/1250 (463 samples) O Select ...

2

Output Wheeler Cube Wheeler_Similarity 7] |© Select....| @ CBVS Z| =

1+ Execution Options ...
Ocucal L0
Qo[ @10
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Workflow cont’d:

21. Display the Wheeler Similarity cube in a volume
by selecting the attribute from the Wheeler tab:

22. Click on Wheeler_Similarity attribute in the tree
to make it active and change the color bar to
Similarity.

23. Slice the volume upward and downward for
the z-axis to see geomorphologies.

T select =R Ech "=

Select Layer 1

Stored 6§ Wheeler-stratal-sheing
Steering | Wheeler_Seis
Alftributes

s
O Concel| | @b

o el BURE L
|y 0.85 l .095 1 Seismics
_classes
%y Wheeler scane: Propo | g Rag-white-Black

Red-White-Blue
| SandShale
® SandShale-none
11 Seismics

2 f]

1 SunRise
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2.5.1a Coloured Inversion

Required licenses: OpendTect Pro, Seismic Coloured Inversion.

Exercise objective:

Invert the seismic data to relative acoustic impedance using SCI plugin.

Workflow:
1. Launch the Atfribute Set 3D window.

2. Choose Colored Inversion from the
Attribute list.

3. For Input Data click Select and choose 1
Original Seismics.

4. Toggle the Single Operator option to
create a global SCI operator.

5. Click on Analyze and Create ...
to launch the SCI main window.

Adl v
2D ..
a0 ..

Amribute Set 30

d AR TTLY -0

et Data 1 Ononal Semecs ~[DEma

[ =

-omm

Workflow cont'd:

In order to design an operator with the SCI application, it is first necessary to select
and analyze the seismic and well data spectra. This is achieved by loading some
seismic trace data and well log impedance data (in time).

N =IN|
ST T
cHHep(EinuEe 822 2B 0
- 3.: 100~ T 100 Setsic Hean
6. Click on i to pop up the ] ]
Select Input Data window. ' Selctinput Dsta TN
Input Seismic | Input Wel Logs
. .. . . Select Traces | QC
7. Check if 1 Original Seismics £ 7 e ]
is selected. ] 30 Survey Area
0l ®Ful Start End Inc
1 Sub | Inine: |1 i}
8. Click Load Seismic to load 0 e ma
0 Load Traces 00
the default 40 traces. [osassmmepamToces: [0 & »
100 = Clear Traces  Clear Unselected Traces 0 Selected
9. For Time Range toggle Sub ol Tine
and enter 500 and 1500 ms ] P R .
as range Start and End E"”i Ful OO Siar 500 .
. . 1 ® Sub ; . |
respectively. o] L
l_r_ Help # Close |_F1
Log Inpat (e domain) - Tiee (as): TSOTES Amp: 144262 _
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Workflow cont’d:

10. Switch to Input Well Logs tab.

a Select Input Data

Define Format...

FieldWells/Logs Top Base HorzTime HorzSrc In-Line X-Lin
H ect Input a ?
11. Click Load wells. = S -
Input Sessmic  Input Well Logs
Reload Wels Define Format._.
12. Select the well F3-04 and choose FawietsLogs Top Base HonTime FazSe niine Xl
P-Impedance log. "'°'§og ' 250 l?‘éé ndefed ww
Ampedance 56 146
. AT Fopp Teoancetel 50 o1 wndefined 722 W
13. For Time Range toggle Sub and GenerateAlLog Pimpedance =~ 0 124
enter 500 and 1500 ms as range Y S R il
- Pimpedance_rel b
Start and End respectively. B e 2o undefoed M N
L] Pimpedance_rel 0 1825
Clear Wells
14. Close the Select Input Data Time ’ ’
WindOW. Select Hon f..[l‘e:;wels Clear Unselected Wells Reshow Wells
Range Select Honzon
Full Range Absolute
® Sub Ful © Horizon  span 500
You can add, generate new log from 2/5ib O Maker ena 15
select input data window. Right click on @ Help — )
any of the wells, then you can chose to
add or create a new Al logs.
Workflow cont’d:
‘A,:\d'-'a'\tec Controls Y=

15. Click on the advanced controls icon :m
to choose the seismic sampling rate for
the well log data resampling.

16. Go to Time Domain tab.

17. Log Data Resampling should be set to
Interval Source: Seismic. Once set,
close this dialog.

Frequency Domain | Design Oparator Wisll Logs Info | Parameter Test

Data Conditioning
Narmalisation
Interval Source

dI Nomalse G Seismic () User

Taper Ends Using Papoulis Windowing
¥ Taper Traces Taper Length: |48 ms

7] TaporLogs  Taper Langth: |48 me

Log Data Resampling

Intenval Source

o Help

- 261 -




Workflow cont'd:

18. Click on ‘l to pop up the
Design Controls Dialog.

19. Smooth the amplitude-
frequency plot of seismic data
by setting an appropriate
Smoothing Operator Length
(keep an eye on the Seismic
Mean curve).

a

Seismic Coloured Inversion: F3_Demo_2015 - Untitled

File View Tools Help

THE2y SanE®E ®eLLE 0

Raw
- Design Controls

Smoc Sersmic Mean
Smoothing Operaor Lengih

Fit Wedl Log Gurves.

# Full Range
Alpha: .0 555
Diesign Opseratod

# Auto Galc

# Auio Galc. Num 7o
Energy. 939058 %

GC Against It Soismic
& Help

4000000 -

Amp

2000000

0 | bttty

Sagmic Mean .
T Em
e |,
460
40
B T T
50 100
* Close Freq (Hz)
| Loginput Detrend (Bime domeir)
1000000
2
H 0

1000 1500 1000 1500
Time (ms) Time (ms)
Indivicual Vells Gabal
arn |00 L s )
Raw Seismic - Freq (Hz): 3.4821 Amp (dB): 37.5567
Workflow cont'd:

As a rule of thumb, any Operator (time
domain) larger than 200 is too high. You
can adjust the operator by changing the
number of zero crossings.

20. Tweak other parameters (low cut, R —— =l SlEs
high cut) of the design operator T HMEP DREEE B 2 =
such that it overlaps the seismic o om
bandwidth (check in the Seismic 2Y | e
Mean curve) and the residual 10| Adhe: 0718
(Blue curve in QC) is nearly zero. RS Pyt

-104 Aa Cale Ful L;NCM He Ful ‘:":“c": L

21. Save the Operator [ and wy L= - —
optionally you can save the 3
session ] . e

I{" Energy: 39,9037 %
00 - I{ QC Agains! Inpud Seismie
22, Close the SCI| main window. [ | i e
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Workflow cont’d:

23. You will return to the attribute set

window. Q = a L\

Auntribute Set 30 - olEl

24. The input wavelet will already be N I TLY I
Selected for yDU. A 0 R ey | Coersaiein = [

IgutCats 1 Ol Swtsmcs [ seea

Analyse and Croate

25. Give a name to the new attribute : e
and Add as a new. e Tom) (G

Workflow cont’d:

- Atiribute Set 3D - o IEl

2t e Bk

Amsute sat| nons | -7
Ineututa 1 Ongindt Serics -/ © swea

Analyas and Creste

26. Save the attribute set by clicking ;
d iCOn. Input waveiet ke | 51_sa ~ | D Seieat

be Operator () Time Variand

Aty Nare Saiaone Coton imepetion asa ere [

# Save on Ciose Q) ciose | | G e
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Workflow cont'd:

27. A new window will pop up, Name
your attribute set and press OK.

e Save Attribute as - o IEN

Select output Attribute

Filter |*

3D UVQ Attribs Texture + HC Al
ChimneyCube attributes
ChimneyCube Training
Demo aftributes
FaultCube attributes
Inversion aftributes

mv first attibute set
< >

X @

Name |Color Inversion |

@ cancel | | g Help

Workflow cont'd:

28. Add an inline in the tree (Inline >
Add).

29. Right-click on the empty attribute
for inline 425 and follow Select
Attribute > Stored Cubes > 1
Original Seismics.

30. Right-click again on inline 425 and
select the color inversion attribute
that you have just created (Select
Attributes > Attributes > Seismic
Color Inversion).

Tree scene 1 ]
Elements Color
Scene 1
A/ In-line:

@ Cros Add Default Data
@ Z-slic Add and Select Data
@ Vel g atwel Location

~ Rani
Add Color Blended

L
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Workflow cont’d:

31. Now you can see the results, and compare it with original data

a. eismic

b. Colored Inversion of the Seismic
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2.5.2a Extracting Horizontal Variograms

Required licenses: OpendTect Pro, Deterministic Inversion.

Exercise objective:
Extract horizontal variogram parameters from color inverted grids.

Scenes View Utilities Help

Create Seismic Output » | S oo @

Create Horizon Output » EF XTI v

. ) (Re-)Start Batch Job ... Horizon Curvature
1. Extract an attribute map using Dip Steering ,
. . - Isopach .
Stratal Amplitude. Go to Processing o i MsppnaToot-
> Create Horizon QOutput > Stratal Madagascar ..
Amplitude. il :
@ StratalAmplitude = @ 8
2. In the pop up window, select the Quantty o ouput F[Eseea]
quant'ty tO OUtpUt. ‘Window Cption @ Single Horizon Double Horizon
@ Select — lG!tﬂ_-%l-Fk
- . Select Quantity to output :
3. In the Attributes section, select ’
Sefsmic Colored Inversion. soree
@ Attributes E
il Ect.
See exercise 2.5.1 on how to define the Coloured 2

Inversion attribute.

4. Hit OK. (O conee] (@ 0 ]

F T
|4 Execution Options ...

Ocx |0 Camxl: _. € el

Workflow cont’d:

5. Keep thfa wm_dow opU_on as (] Stotmarmplitaic =E—)
defaU|t7 le Slngle Horlzon Quanlny!ooutput[sewsmm Color Inversion 'I E Select...

Window Option @ Single Horizon Double Horizon

6. Select the target horizon: Demo

0 --> FS4 Horizon. Horizon (i) [Demo 0~ Fs4 | [© seteat..]
7. Set offset top: -20, bottom: 20 ZomemTe B Bamn |

ms. Area subselection 226/645-314/695 (463 samples) (© seteat |
8. Select the amplitude option to option [Max____ ¥

output: Max.

Outputfold as an exira aftribute ) Yes @ No

9. Name the attribute.

Aftribute Name Stratal Amplitude |

10. Start the process: click on OK. b Execution Onlicns e
I gg OK || € cancel || @) Heip
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Workflow cont’d:

11. In the tree, Right-click on 3D Horizon
and select Load.

12. Select the horizon Demo 0 --> FS4
and Hit Ok.

13. Add attribute at horizon location:
Right-click on Demo 0 --> FS4 > Add
> Horizon Data.

5 # 3D Horizon

@ Annotations

< (30 Horizog

@ 50 Horizd ML
Fault Add at Sections Only
Fault Sticl  Add Color Blended ...

® Body Track New

. Well

Create with Constant Z ...

' Pickset

B Select Input Horizon (s) )

W - Filter =

/] Demo 0 — FS4 Bl =
Demo 1 MFS4 -
(2} Demo 2> FS6 = |
— Demo 3 => Top Foresets
Demo 4 —= Truncation X
Demo 5> FST —
Demo & —>FS8
Demo 7 => shallow

Area subselection 100/200-750/1250 (463 samples) _rO Select...

‘Q Cam’.ﬂl: @ el |

Dema_2015\Surtaces\Demo_0_—__FS4.nor

) RAZw L | Attribute
< 2D Horiz D'SD@!‘ * |4 Volume Processing Attribute
Fautt Tracking Contour Display
et = X
ody
bwer [ Worklows !
i Pickset | m Save

> Polygon | & Save as
& Prestack & |

Delete from Database
% Remove from Tree

Workflow cont’d:

14. Select the Stratal Amplitude attribute
you just created.

15. Hit OK.

= | B i |

Select one or more attributes to be displayed
on the horizon. After loading, use 'Page Up'
and ‘Page Down’ buttons to scroll.

Make sure the attribute treeitem is selected
and that the mouse pointer is in the scene.

.
) Horizon Data

@ - Filter *

|71 Thickness-to-Dem4
(] testhorizon
|| Stratal Amplitude

| QOK ©) cancel
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Workflow cont’d:

16. Right-click on Stratal Amplitude in the tree.

17. Follow: Tools > Variogram.

With this option, you access the horizontal
variogram. It allows you to analyze lateral
variability of your data around the horizon. This
information is in particular used when building
the background model for broadband seismic
inversion.

18. Hit OK.

= % 3D Horizon
I Demo 0 -

5 ﬂli ht-c... B0

£ Z value

%] Siraial

@ 2D Horizon ~ Move

Fault

Fault Stick |

® Body
Well

¥ Pickset
[ Polygon
= Prestack Ev

Display
Save as Horizon Data .

Tools

Select Attribute

® Remove

| e
Set Z values

Filtering ...
Gridding

r
™ Semi-variogram parameters o | B -

Specify semi-variogram parameters

Maximum range (m) 1992 %

Max number of pairs per lag distance 1000 <

|0 Cancet: { eHe\p

Workflow cont’d:

In this window, the objective is to fit a variogram model (Green) by setting it’s sill and range
that best fit your data (Blue curve). Try to achieve a good fit at least for smaller lag distances.
Mind the impact of number of pairs per lag on the smoothness of the data extracted curve.

19. The analysis can be done in different
directions; Inline, Diagonal,
or Crossline (i.e. the analysis is
anisotropic) : change the direction and
observe the impact on the variogram.

20. Modify sill and range, using the
sliders, to fit a variogram model to the
data.

21. Choose out of the three available
variogram models; Exponential,
Spherical and Gaussian.

) Variogram analysi

s

(o[ ]

Variogram analysis

sill

Direction: [Inling &

294

2.5

Normalized Variance
-
o

Jﬁw

0.296

500

1000 1500 19
Lag distance (m)

|range |:

Variogram parameters are used for example
when building the initial model for MPSI
inversion.

Variogram model |exponential .~

spherical
| gaussian

) Close L 9Halp J
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2.5.2b Extracting Vertical Variograms

Required licenses: OpendTect.

Exercise objective:

Workflow:

& Volume Builder

| Cross-plot Data >
Well »

& Layer Modeling 4

Lo L

= Fluid Contact Finder ..
Neural Networks v
S8IS J
Velocity Model Building *
Well Correlation Panel ...

| Well logs vs Atiribues ...

Attributes vs Attributes ...

Open Cross-plot ...

Extract vertical variogram parameters from impedance well logs.

1. To extract P-Impedance logs from various wells: Go to Analysis > Cross plot
Data > Well logs vs. Attributes.

Processing Scenes View Ulilities Help

Attributes g t@ = ;: o @

==

Which affributes do you want to use?

# Specify

1N
[ ¥ 030 _|[© cancel

Workflow cont’d:

2. Select all wells that will be used for
data extraction.

3. Select Impedance logs
associated with the wells.

4. Toggle Extract in time and set
step: 1 ms.

5. Extract between Markers:
FS8 and FS4.

6. Select log resampling method
as Take Nearest Sample.

7. Set the radius around wells to 0
and press OK.

1 Attribute/Well Cross-plotting e

= Attribute

[1 Original Seismics]

[3D UVQ 6 biased Texture+Energy+SystemsTracts]
[3D UVQ Texture+HC attribs+ Energy disk]

[4 Dip steered median filter]

[5 ChimneyCube]

[7a Al Cube Std]

[7b Al Cube from HorizonCube]

Cild well " - Log
¥ FO2-1 Density

| FO3-2 Sonic

7 F03-4 Gamma Ray

7| FO6-1 Porosity

[= P-impedance ]
P-impedance_rel

Extract Between |Markers ~ || Extractin time Step (ms) 1

selected zone [ Fs8 - |rsa -]

Distance above/below (m) 0 0

Log resampling method | Take Nearest Sample =
Radius around wells (m) D

Filter position - O select...

Ocaru:el_ 9 Help
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Workflow cont'd:

'w Well attribute data
. B2 XY, Y x@mmpld f = snon1000%" ]
8. Cross plot table window :
Well dataF02-1F03-2F03-4F06-1
pOpS Up. X-Coord Y-Coord Z(ms) * MD(m) | Pimpedance | |
F03.2 619101 5089491 592 589.91998291 4149800
9. Select P-Impedance F03-2 619101 6089491 593 59091996291
F03-2 619101 5089491 594 £91.91996291 4150060
Column. F03-2 619101 6089491 505 59291996261
F03-2 619101 5089491 s95 59391398281
. . o~ F03-2 619101 6089491 597 59491996291
10. Click on this ﬁ icon F03-2 619101 5089491 598.01 59591996291
to start the variogram EN12 £19101 AnRGAG1 saan 407 61004201 PN - |
analysis. T
well: FO3-2
11. Variogram parameters
. r B
window pops up. @ Semi-variogram parameters (115 IS
. Specify semi-variogram parameters
12. Click OK.

Maximum range (msec) |50 =

The vertical variogram parameters used here are comparable

L i \ N Step (msec) 1 =
to the horizontal variogram analysis of Exercise 2.52a. The

main difference is in the number of available data points. Min number of pairs per lag distance (10 =
Variogram analysis requires a minimum number of pairs per
lag distance and therefore sufficient data must be input in @OK |[0 Caan @ Her ]

orderto obtain a representative variogram.

Workflow cont'd:

1=

0

13. The variogram analysis can be BB Veriogrom seohssy
done for either all the wells S

(recommended) or for one particular Seurce: [AIWells
We" sill
1.751
o 15
14. Modify sill and range, using the § PR
sliders, to fit a variogram model TE e M
(Green) to the data (Blue). s 0P
=]
20 40 5
Lag distance (msec)
15. Choose out of the three available SN | = T
variogram models; Exponential, vatooram moge o=
Spherical and Gaussian. ’
([ cuse ][ @ e |

It's recommended to use the same model for this vertical variogram analysis, as used previously for
horizontal variogram analysis (Exercise 2.5.2a).
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2.5.3a Neural Network Prediction

Required licenses: OpendTect Pro, Neural Networks.

Exercise objective:

To convert seismic information to porosity using a neural network inversion workflow.

Well data Preparation

1. Well(s) need to be available in the survey. If they are not available: import wells (track,
logs, markers, optionally time-depth curve or checkshot).
2. Tie well to the seismic (see exercise 1.5.1).

¥ Attribute Set 3D

ELERL TR T 1S

Workflow:

1. Open attribute set window “g.

= Lowd Atbute =
- . . Select input Attribute
2. Click on file> Open set , or click on <&, R

Filter *
3. Select the saved set ‘Inversion e
attributes’ and Hit Ok.

REF

a0

sdtest L
Segmentation attributes (waveform) ~ |
Segmentations attributes (Dip-steered 3D)

Seismic Spectral Blueing and Coloured Inver: -

" = ’

) cancel| | g Help

S\Attribs\Inversion_attributes.attr

Workflow cont’d:

4. Open the neural network plugin with the§ > jcon WLES QBZD HAE
> 3D or go to Analysis > Neural Networks > 3D. .

Y
& Neural Network management By

Meural Network Manager 30

Create New Metwork: Get

5. Select Property prediction [Well Data] from the [Patter racognition Picksets]..) | [Stored Network )
Neural Network manager.

Property prediction [WellData] . 3| From Job file .. 1

Active Neural Network

Input Output

© close | [ @ Help |
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Workflow cont’d: 5 i e

IR Eraining dite 35§ EX1RGE now

6. Data selection window pops up.

7. Select the input attributes as on
the picture.

8. Select the target quantity among
the available well logs: Porosity.

9. Set the percentage of data to be
used as test set: 40%

Sbect inpunt attributes

Percentage

Péan-stanciand number of hicden nodes

RS stoned

et touse | 7 FOR-1
7 For-2
7 Fos4

Setect target %) Fo8.1

Extract between [Statol dta> = cEndol datax

Target contains ® Grdinary well log vabues ) Lithology codes

Distance sbowe/below [m) & 0
wsed fon testset 30 % Raduss srownd walls 15
Verncal Lumgiling methed Tie Neatost samgse
Qx| 1 cancel [@nee
PP PARSRR T—

Workflow cont’d:
[F=5 Eol| ==
v -
Wells to use [[¥] FO2-1
V| F03-2
J| FO3-4
FO6-1
10. Select all the wells. =
11. Limit the extraction window as shown on
the picture.
Extract between |Fs8 -] [rsa -
12. Select Average Vertical sampling method _
Distance above/below (m) 0 ]

and Press OK.

Radius around wells 0

I QOK IQCancel ﬂHalp
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Workflow cont’d:

An optional step is to QC the extracted data set (tested and training) by plotting
Acoustic Impedance (Y) versus Porosity (X)

13. Highlight Porosity column and press X .

14. Highlight Al 0 column, and press Y+-

15. Click on F.:.

7
& Input Data

la-Elg

I ESA

Y. ix @mp 4 i == snow 0005

X-Coord Y-Coord Z(ms)
Training data 619101 6089491 596.48
Training data 619101 6089491 59749
Training data 619101 6089491 59849
Training data 619101 6089491 599.49
Test data 619101 6089491 600.49
Test data 619101 6089491 601.49
Test data 619101 6089491 602.49
.Tmining data 619101 6089491 603.49

Data Set Training data

.

*Referen Acousticl Acoustic I Acous
3828565 4006971

0.596
0.597

0.5980....
0.5990...

0.6
0.601

0.6020...
0.6030...

40765... 40326..

41008... 40731..
40070... 40914..

40327... 4M723..

40542... 41429,
40732... 41675..

4151797 40541

ticy Acoustic |
40012, [EREE
TR 42000
EC iR 4209738
41675... [Erralim
CRLUORY 4239096
4200099 ElrirEx]
FROEERN 4323147
Lyl 4369237

Acousticl Acousticl Acoustic|

42389... 44136..
4278584 444301,
43230... 4470581
436011... 4494539
44137... 45167,
44440, 4542741
4470698 4566790
4494653 4587793

[(©rn] (@ oe) (@ver]

45185...
4542655
4566731
4587762
46046,
4607702
46080..
46081,

Porosity |*
0.3501...
0.3501...
0.2486...
0.2445...
0.3388...
0.3219...
0.3248...
0.2409... [+

Workflow cont’d:

16. Cross plot window pops up.

17. Click on * in previous window to
move Y column and see how other

attribute plot against Porosity.

18. Close cross Plot window.

19. Press Run in Previous Window.

B <NLA train/test duta> Cross-plot - a x
shaw 10000%5 [f} Y2 BothData Sets ~ oy | FRIRBER B D

% =075
P(x)

s
e

02 0.226 028 0275 03 [k~ 035 0378
Porusity
¥ Selected: 0
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Workflow cont’d:

20. The balancing data window pops up.

) Data preparation =68

step.

In this step, you have the option to balance
your data. If the data is not properly sampled,
balancing is a recommended pre-processing

21. Tocontinue, Press OK.

Specify data preparation for ‘Porosity’

407

Count

0.9259 0.25 03 0.35 0.3902
Value
Balance data @ Yes No

Data points per class [E
Percentage noise when adding 1

Datarangeto use 0.2243  0.39196

. ) cancel| ‘_g Help |

Workflow cont’d:

22. The Training data window pops up.

23. Tocontinue, Press OK.

=% NM training [20]

Train Neural Network => 'Porosity’ [September27 2016 15:42:03]

j—oemeeed RMS . Reforence limo
" ,:" - t::’. Acoustic Impadance 12
'L—_—J- () Acoustic impedance -3
0.5] 5 -
Acoustic impedance -4
25
Acoustic Impoedance 0

) Acoustic Impedance 4

Vectors trained 21600 Recume Clear ___

On OK, save as

0 co

& Help
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Workflow cont’d:

24. Back in the Neural Network, Output

) Neural Network mar t

ERE

Meural Network Manager 3D

Create New Network:

Get:

property is highlighted.

25. Click on Info to see summary

Of Neural Network characterisation.

[Paﬂem recognition [PickSets] . [Stnred MNetwork ]

[Property prediction [WeliDats)...| | [ FromJobfile.... |

Active Neural Network

Acoustic Imped: _
Arnuinbio bmann de

«[.m »

Input Output
Reference time . | [0 M
Acoustic Imped:

Acoustic Imped: =
Acoustic Imped:
Acoustic Imped:

Workflow cont’d:

26. Neural Network info (report) pops
up.

27. Click on Save Report (optional).

-
¥ NN info

L B [y

Type:
Hidden layer has 4 nodes
Traiming stats:

Number of used input vectors: T4%
Fumber of invalid input veeters: 0

Porosicy

Test scats:

NWumber of used input vectors: 483
Humber of imvalid input vectors: 0

Poresicy
Data mean:
Data scandard deviation:

Supervised {(direct prediction)

T 0.115829

0.300373
) 7276

0.221728
0.369145
0.0280442
0.627
0.020771

Q Ciose | [ @ Hein |
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Workflow cont’d:

28. Store the Neural Network.

= Neural N rk manag l‘:l@ﬂ‘

Neural Network Manager 3D

Create New Network: Get.

[Pattern recognition [PickSets] .| | [Stored Network ...

|Property prediction [WeliDatal...| | [ From Jobfie.. |

Active Neural Network

Input Qutput
Reference time . | [FECEL I
Acoustic Imped:

Acoustic Imped: =
Acoustic Imped:
Acoustic Imped:
Acousticimped: _

Anniiatio Inma de

«[.m r

(o] (o]
(Do) (@

Workflow cont’d:

29. Give a name to the Neural Network

output.

30. Press OK.

) Save Neural network as =N
Select output Neural network
Filter | *
[chimneycube ~
NN Porosity training

NN-Test

UVQ 10 classes [-12, 24l ms on MFS4 E
UVQ 10 classes [-12, 60] ms on FS8

UVQ 10 classes [0, +24] ms on MFS4
Volume-based segmentation between FS7 and
Volume-based segmentation between F38 and ~—
< ftt ¢

o X &0

Name Neural Network]

) cancel gHeIp

_..emo_2015\NLAS\NN_Porosity_training.nn
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Workflow cont’d:

31. Create Porosity Cube.

32. Create seismic output using:

Y Survey Analysis Byile:EHULE Scene  View  Utilities Help
Yol " L creaeSesmeouut 2 - Single Attribute »
Multi Attribute . EE

MultiCube DataStore ...
* Along Horizon 12

™y Between Horizons  *

Create Horizon Qutput  » 2D <=> 3D 3
A | iniine 425 |2 A wells 4 Angle Mute Function ..
S RTETT (Re-)Stant Batch Job ... P4 Bayesian Classification .
V) .E]emen!s ~ Dip Steering ¥ FromWell Logs ...
i »
- Goar i1 | = GMT Mapping ool F’resl.aus Processing
stang Velocity 3
= Indine | & HorizonCube 4 _
‘ =[] 42¢ N Volume Builder ...
o 3 Re-sort Scanned SEG-Y ...
o i Cross- 5515
C ¥ Z-slice

Workflow cont’d:

33. Select quantity to output

34. New window pops up.

8 Create Volume Attribute

35. Toggle Neural Network. Guantiyto ot

Volume subselection -

B Select

[E=E =%

Select Quantity to output

36. Select Porosity.

Attributes
3? PrBSS OK @ Meural Network
o)

Y

Sens

(%) Cancel\_ € Help

> | B =

E e

© Select ]

[z][© seea..| mcevs  [7]

ns .|

© 0k | [ cancel| [ @ Heip |
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Workflow cont’d:

38. Give a name to the output Cube.

39. Press Ok.

(@) Create Volume Attribute ESSESE )

. Quantity to output Porosity Z| @I

Volume subselection - (© seteat.|
Null traces @ Discard Pass
Scalevalues: ShiftFactor
Output Cube [Porosit -] (© seteat| @icavs  [+]
Batch execution  Single Process (4,; Options...|

Workflow cont’d:

40. To apply the output on an inline to perform
QC by giving Right click on Inline > Add
and Select data.

41. In the selection window, under the Neural
network category, select Porosity and
Press Ok.

Elements Color
Scenel
N In-lin~
@ Cross Add Default Data
® Z-slici Add and Select Data
® volur Add at Well Location ...
~ Rand Add Color Blended
2D Line
'1_-r Select SE)

Selectfirst layer

Stored
Steering
Aftributes

@ Neural Network

C

EY

Porosity |

| QOK ||0Cancel] @Helpl
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Workflow cont’d:

42. The Porosity prediction result display on Inline 425 should look like the image below.

2.6.1 Well workflows

TheWell Log Prediction workflows in this section are Supervised Machine Learn-
ing workflows and require only well logs as inputs.

The target logs are used for generating/predicting missing logs.

Log Prediction produces continuous logs.
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2.6.1a Log-Log Density

Required licenses: OpendTect Pro & Machine Learning

Exercise objective:
To predict missing logs using the log-log prediction tool, which is part of the machine learning
plugin. In this case, we want to predict the Density log.

Well data Preparation
Well(s) need to be available in the survey. If they are not: import wells (track, logs,

markers, optionally time-depth curve or checkshot).

Workflow: -

% Machine Learning Control Center - [m]

1. Open the Machine Learning Control Center with the &, icon.

Survey |F3 Demo 2020

~ Workflows

Neural

L8

» [ @ EL R e

X

2. Click on Wells. &3 v
-l Lithology classification
3. Select Log-Log prediction, and Hit Go. ES@ismic I
b Tl

0
Workflow cont’d: [Emseroon ] v | e
<Input D>
Output Deep Leaming Example Data | =1 © Select .|
4. Press Select - Input Data in the "Log-log prediction”
window. Select @ icon in the “Target Log Definition™.
» . T . urvey Log Name pelts @
5. In the "Specify Log Data to predict” window, Select ) "
Survey?, Target Log (e.g. Density), and the Wells that
will be used for the data extraction.
The well FO2-1 is not selected, and will be used as a Byt
blind well.
€ ciose @ o
6. Press OK. P——— Frre
Survey F3_Demo_2020
F3_Demo_2020_old
Target log
= - * )
[ F02-1 O
[ F03-2
(4 Fo3-4 L
[ FO5-1 1]
* The option to select data from other surveys is available only in commercial projects S P
0K Cancel
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Workflow cont’d:

7. “Deep Learning: Target Log definition”
window pops up.

A new data from different survey”* can be
added by clicking on g icon.

8. Press Proceed [Input Data Selection].

9. In the "Select Input Logs” window, Select
logs that will be used to predict ‘Density’ log
(e.g. Sonic, Gamma Ray).

10. Press OK.

Survey Log Name Wells
1 F3 Demo 2020 Density [3] 'F03-2', 'FO3-4" and 'F06-1' #
®
o
@ Proceed [Input Data Selection] >> | €3 Close
% Select Input Logs - m} X

P~

Input Logs ® Specify now (O Read Saved Setup

®= - Filter [* |

[ Density_BLT ~
[ Gamma Ray]

[] Litholog (10=sand 15=silt 20=silty shale 30=<
[J P-Impedance

[J p-Impedance_rel

[] Porosity

.
re

>

€ cancel

* The option to select data from other surveys is available only in commercial projects ‘

Workflow cont’d:

11. “Input Log Selection” window pops up.

Input Logs can be madified in here. Keep the
default parameters as indicated in this window.

12. Type a new name for the Ouiput Deep Learning
Example Data (e.g. DL_Example_Density_st10).

% Input Log Selection

- a X
13. Press Proceed. =
Survey Input Log 1 Input Log 2 -
1 F3 Demo 2020 Gamma Ray ~ Sonic ™|
Stepout from center log sample |10 S
Extract between <Start of data> | <End of data> i
Log sampling Z Step (m) [0.1524
Edge/Gap Policy ® Exclude incomplete O Add data
Qutput Deep Learning Example Data |DL_Examp!eLDensity_5t1l] | ~ | © select ...
Qclose | wapply @
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Workflow cont’d:

14. The Train tab get activated. Train the
extracted examples data using suitable
learning algorithm. Keep the defaults

‘o . ’ 2 Log-log Prediction - u] X
parameters, “Scikit-learn” platform and e
“Random Forest” Model_ Input Deep Learning Example Data DL_Example_Density_st10 ~ |© select ... I
Different machine learning platforms and
parameters can be tested. Output Deep Learning Model |DL,Mudel,SciLutLearn,RandomForests | © select... |
y . =
7

& 00

15. Specify a new Output model name (e.g.
DL_Model_ScikitLearn_RandomForests).

Type
Ensemble v

Model

16. Press Run. .

Estimators. 100

Max Depth: 50

Reset Back

€iclose @
Workflow cont’d: i Log-log Prediction - o X
Extract Data  Train  Apply
Survey Data Root | C:\Surveys © select ...
17. Press “Apply” tab Survey |F3_Dema_2020
Check all the selected default parameters are 3 Demo.2020.01
OKk.
*The Survey and Training model can be
modified in here.
* 'S
DL_Model_ScikitLearn_RandomForests ()
n
0]

18. Press Proceed.

Name: DL_Model ScikitLearn_ RandomForests.
Type: Log-Log Prediction.

Number of inputs: 2.

Output: Density.

Created by: assia.

ated at: Fri 09 Jul 2021, 16:12:56.
Last Modified: Fri 09 Jul 2021, 16:13:46.
Object ID: 100060.64

[Brroceed>>]| Batese @

* The option to select data from other surveys and training model is available only in commercial projects |
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Workflow cont’d:

19. “Apply training model” window pops up. i

Input log for 'Gamma Ray' Gamma Ray

20. Apply the trained model to a blind
well. Select F02-1.

21. Type a new name for the predicted log
(e.g. Density_Predicted).

22. Keep default parameters and Press
Run to continue.

Log name for 'Density' | Density - Predicted|

Apply to [®] = *

Input log for 'Sonic' Sonic

& 03-4
] @ Fo-1|
O & Fo3-2
[ Fo6-1

<

Extract between  <Start of data>

SR

~ | |<End of data> ~

Log sampling Z Step (m) (0.1524

g/cc (Gram/cm3) £

Dcioe

Workflow cont’d:

23. QC results by displaying the predicted
log adjacent to the recorded log

24. Click on the Well Manager icon A_r.

25. Select the well “F02-1" and the logs
“Density” and "Density-Predicted”.

26. Click on view logs icon g .

] - Fitor - o wl - Loa

=]
Fo3 2

> Fo34 < o

L Fos-1

IS} o

*

Croain
= ol
© Cose || @ tien

Froa space on disk: 2003 GB

Density Density-Predicted
@ Logviewer: D.. — a X & Logviewer: D.. — a X
Density of F02-1 Density - Predicted of F02-1

2 05 21 215 22 2 21 22 23
50 1500 1500
7501 750 75 A%QTSO
100 1000 10001 i 1000
125 gi 1250 12501 % 1250

>
2 2.05 21 215 22 221 22 23
Density Density - Predicted

Dowe
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Workflow cont’d:

If result is satisfactory, go back to the
“Apply training” window, and apply the
trained model to all the wells where you
want to predict density log.

27. Select all wells.

28. Type a new name (e.g. Density
Predicted). Keep default parameters
and Press Run to continue.

P
Input log for 'Gamma Ray' Gamma Ray v

Input log for "Sonic' Sonic v

Apply to [ - ‘* €3
@& > o34 < (|
@ F02-1
& F03-2 o
[ & Fo6-1 W
Extract between | <Start of data> ~ | | <End of data> >
Log sampling Z Step (m) [0.1524 |
Log name for 'Density' |Density -Predicted ~ | gfcc (Gramfem3)
B
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2.6.1b Log-Log Porosity

Required licenses: OpendTect Pro & Machine Learning

Exercise objective:

plugin. In this case we want to predict the Porosity log.

To predict missing logs using the log-log prediction tool, which is part of the machine learning

Well data Preparation

logs, markers, optionally time-depth curve or checkshot).

Well(s) need to be available in the survey. If they are not available: import wells (track,

2. Click on Wells.

Workflow: -

1. Open the Machine Learning Control Center with the = icon.

Y ELT HEILE

% Machine Learning Control Center - [m] b4

Survey F3 Demo 2020

v Workflows

B3 e

Lithology classification

4. “Log-log prediction” window pops up.

5. Press Select - Input Data in the “Log-log prediction”
window. Select @ icon in the “Target Log Definition”.

6. “Log Data to predict” window pops up.

7. In the "Specify Log Data to predict” window, Select

Output Daep Laarming Exampis Data |

3. Select Log-Log prediction and Hit Go. ﬁsmsmic N
i
: o Neural
o Networks
)
Workflow cont’d: S T o

[<input Data>

Survey®, Target Log (e.g. Porosity), and the Wells that
will be used for the data extraction.

Well FO2-1 is not selected, and will be used as a blind
well.

8. Press OK.

* The option to select data from other surveys is available only in commercial projects

Q0ise
Q s @
Survey Data Roat | C:\Surveys © select ...

Survey | F3_Demo_2020
F3_Demo_2020_old

T L
= - - £
[ Fo2-1 =)
| FO3-2
1 FO3-4 a
Fo5-1 ]
ok | cancel
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Workflow cont’d:

Survey Log Name:

Wells

1 F3 Demo 2020 Parosity [3]'FO3-2, 'FO3-4' and 'FO6-1"

9. “Deep Learning Target Log definition”
window pops up.

10. Keep the default parameters and Press
Proceed [Input Data Selection].
11. Select Input Logs window pops up.

12. Select the Density, Sonic and Gamma Ray
logs that will be used to predict the

eE e

T

% Proceed [Input Data Selection] >> = €3 Close

7+

v ~ Logs to be used to predict ‘Porosity’

Density
Sonic
Gamma Ray
[J P-Impedance
[J P-Impedance_rel
O Ve

‘Porosity’ loq. [ 7a Al Cube Std_AL
Y g 1 Densitv - Prediction ﬂ
13. Press OK. @ ok | © cancal|
Workflow cont’d:
14. Input Log Selection window pops up.
Input Logs can be modified. Keep the default parameters
as indicated in this window.
15. Type a new name for the Output Deep Learning Example
Data (e.g. DL_Example_Data_Porosity_st10).
16. Press Proceed.
= Input Log Selection - [m] X
Survey Input Log 1 Input Log 2 Input Log 3 >
1 F3 Demo 2020 Density ~ Gamma Ray ~  Sonic v
Stepout from center log sample [10 =
Extract between | <Start of data> ~ <EI‘EI of data> ~
Log sampling Z Step (m) [0.1524
Edge/Gap Policy ® Exclude incomplete O Add data
Output Deep Learning Example Datal DL_Example_Data_Porosity_st10 - | 6 Select ...
Dclose || ¥ Ay | @
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Workflow cont’d:

17. The Train tab opens. Select the Machine
learning platform: Scikit-learn (Random

Forests).

parameters can be tested.

Different machine learning platforms and

18. Keep the defaults parameters. Enter new

Output model name (e.g.

Model_Porosity_ from_DEN_DT_GR).

19. Press Run.

#x Log-log Prediction - o
ExtractData  Train  Apply
Input Deep Learning Example Data DL_Example_Data_Porosity_st10 -~ € Select ...

Output Deep Learning Model | Model_Porosity_from_DEN_DT_GR | € Select ...

500

Qcose @

Workflow cont’d:

20. The ‘ML training log’ window pops up. When

the process finish, Click Close.

21. In the ‘Apply tab’ of the Log-log Prediction
window, verify all defaults selected data are

correct.

be modified in this window.

The Survey and the Training Model can

22. Press Proceed.

ST

i Log-log Prediction o
ExtractData  Train  Apply
Survey Data Root | €:\Surveys © select

Survey  F3_Demo_2020
F3_Demo_2020_20jul21
F3_Demo_2020_old

[Model_Porosity_from_DEN_DT_GR

Qe
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Workflow cont’d:

23. The ‘Apply’ created training model
window pops up.

24. Apply the trained model to a blind
well (not used in the training
process). Select FO2-1.

25. Keep default parameters and Press
Run to continue.

26. When the computation finishes,
Press Close.

Input log for 'Density' Density
Input log for ‘Gamma Ray' Gamma Ray
Input log for "Sonic' Sonic
Apply to (] - *
[J® >Fo34<

[E®Fo2a
0 & Fo3-2
0 & Fos-1

Extract between  <Start of data>

Log sampling Z Step (m) |0.1524

S PHTIN

~  <End of data> ~

Log name for 'Porosity’ | Porosity_from_DEN_DT_GR ~ | (Fraction)

B

Oam

Workflow cont’d:

QC results by displaying the predicted log
adjacent to the recorded log.

27. Click on the Well Manager 41 icon.
28. Select the well FO2-1, and the logs
Porosity and predicted porosity:

Porosity-from_DEN_DT_GR.

29. Click on view logs.

3 ;
-] ¥
= 2
.
-

° .
= -
Go=] @

Porosity

i Porosity_from_DEN_DT_GR of F02-1

0.3 0.35 0.4
5001 500
750 750
1000 1000
12501 — 1250
=
0.3 0.35 04

Parosity_from_DEN_DT_GR

0 Close

Predicted-Porosity

%@ Logviewer: Porosityof FO2.. — 0O X

Porosity of FO2-1
0.275 03 0325 0.35 0.375 04

500 [500

750

[750

1000 [Looo

1250 % [1250

0.275 03 0325 0.35 0375 04

Porosity
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Workflow cont’d:

If result is satisfactory, go back to the
previous Step “Apply Training Model”.

30. Select all wells where you want to
predict porosity.

31. Keep default parameters and Press
Run to continue.

32. QC the predicted well porosity logs
as in the previous step.

= Apply Train_Model_Scikit-leam_AL" - [m] X
Input log for "Senic' [Sonic 4|
Input log for 'Gamma Ray' |Gamma Ray =l
Apply to v - i [v Time Sort ﬂ
® F02-1 [
® FO6-1
& FO3-2 [+ ]
@ > F034 < u

Extract between [<Start of data> | |<End of data> |

Log sampling Z Step (m) |0.1524
Log name for ‘Density’ [rain Model Scikit-learn AL ~|

IW‘ € Close I
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2.6.2 Lithology Classification

Required licenses: OpendTect Pro & Machine Learning

Exercise objective:

To predict lithology logs using the “Lithology classification tool”, which is part of the machine
learning plugin.

Well data Preparation
Well(s) need to be available in the survey. If not, import wells (track, logs, markers,
optionally time-depth curve or checkshot).

Workflow:

For the purpose of this exercise, we will create a fake :
lithology log using Mathematics (as no lithology log exists *
in the survey)

o=
1. Open the Well Manager A
2. Select All Wells in the “Well Manager”, and Hit N u
Create. -
) Qcose | @Hop
Workflow cont’d:
3. In the “Calculate a New Well Log” window, Specify the parameters as indicated
below to create a fake litho-log:
a. Select: MathFunctions.
b. Type the Formula: GR<407?1:2 . .
Calculate new ogs for 'F02-1', 'F03-Z, 'FO3', 'FO6-1"
c. Hit Set. Mattfuntions - sat(Squrerot) + | Diset | 3
Formula (ike d!\fscn‘) set
d. Select Gamma Ray log. o — T —
e. Select for the Formula Results, Classification
f. Type Name for new log: Litho_Fake.
‘am\aros.ll-s-m '
i . Output sample distance 0.1524 Feat  Intes/extrapolate input logs? No
d. Select Output Unit of Measures: None. o —
[Ead]ow- @
4. Press Calculate.
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Workflow cont’d:

5. Open the Machine Learning Control Center
with the ., icon.

6. Click on Wells.

Survey |F3 Demo 2020

g @B Ty VN

. . v v Workfl
7. Select Lithology classification. |§|§ el OrLDgT(fg prediction
> Lithology classification
8. Hit Go. —_—
3 Seismic
= E Seismic +
S I__Wells
: < Neural
P Networks
€3 Close 9
Workflow cont’d: E
<Input Data>
Output Deep Learming Example Data O select .. )
9. “Lithology Classification” window pops up. Press Select
- Input Data. Select @ icon in the “Target Log Definition”.
10. “Log Data to predict” window pops up. Select:
Survey*, Target Log, and Wells as indicated in the ®
window.
In this case the “Litho_Fake” log will be predicted. -
[ J
The well FO2-1 is not selected, and will be used as a t Qoo
blind well. e
11. Press OK. ey o i o=
Survey |F3_Demo_2020
F3_Dema_2020_20jul21
F3_Demo_2020_old
Toret Lo [ P
[w - . L]
T (=)
_FOJZ
1 FO34 a
* The option to select data from other surveys is available only in commercial projects
(not in the free dema project) [®ox ] [ Qcacel
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Workflow cont’d:

Survey Log Name Wells
1 F3 Demo 2020 Litho_Fake [3]'F03-2, 'FO3-4" and 'FO6-1'

[

I e C]

11. “Deep Learning: Target Log definition”
window pops up.

12. Press Proceed [Input Data Selection].

4 Select Input Logs - [m] *
13. Inthe “Select Input Logs” window, Select Input Logs ® Specify now O Read Saved Setup
the Density, Sonic and Gamma Ray logs. = .
i liter
14. Press OK. :

[] Gamma Ra
[ITitholog (10=sand 15=silt 20=silty shale 30=s
[] p-Impedance

[ p-Impedance_rel

[ porosity

O po psi from DEN_DT_GR
.
<

>
0 Cancel

Workflow cont’d:

15. “Input Log Selection” window pops up.

Input Logs can be modified here. Keep the default parameters as indicated in the window.

16. Specify a new name for the "Output Deep Learning
Example Data” (e.g. DL_Example_Data_Lithology_st10).

% Input Log Selection - [m} X
1 7' Press Proceed‘ Survey Input Log 1 Input Log 2 Input Log 3 >
1 F3 Demo 2020 Density ~ Gamma Ray ~ | Sonic v |l

Stepout from center log sample [10 >
Extract between | <Start of data>  ~ |<End of dErta> w
Log sampling Z Step (m) [0.1524

Edge/Gap Policy ® Exclude incomplete ) Add data

Output Deep Learning Example Date{ DL_Example_Data_Lithology_st10] | | 8 select ...

Breers] O ~aw | @
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Workflow cont’d:

e £ Lithology Classificat - o x
18. Select Training Type New. R
Extract Data  Train  Apply
Input Deep Learning Example Data DL_Example_Data_Lithology_st1 ~ @ Select ... i

Training Type (21 New [ Resume [ Transfer

19. “Train” tab becomes active. Train the extracted
examples using the default learning algorithm
Output Deep Learning Model © select... )

(e.g. Keras (tensorflow). &
ing platform €1
Clear Tensorboard log files 0
Different machine learning platforms and o = ©
parameters can be tested. = o
20. Keep the defaults parameters. Specify a new B
Qutput model name
(Model_Litho_Keras(tensorflow).
21. Press Run.
Ociose @
Workflow cont’d:
2 Machine Leaming training log - [u] X
L —

Trainable params: 34,606

Non-trainable params: 524

22. The Machine Learning training log file pops up.
Otherwise Click on @ icon.

Saving model.

Model saved.

23. Hit Reload to refresh the window.

Process: 'Machine Learning Training'

24, When the processing is done, Close the training 10g =inicnea: wes 21 st 2021, 13:30:37

file. Finished batch processing.

| @ ciose || |# sReload
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Workflow cont’d:

@
25. Hit Proceed in the ‘Lithology Classification- - °
Train” Window. o *
26. “Apply” tab get activated, Verify the Survey and
Model are correct. Otherwise, modify accordingly.
*The Survey, Training model can be T —
modified here. EETTE
Survey Data Root | C:\Surveys O select ..
Survey | F3_Demo_2020
27. Press Proceed. Fa_pene. 20020601
Model_Litho_Keras(tensorflow) -
* The option to select data from other surveys is available only in
commercial projects (not in the free demo projects)
o=
Workflow cont’d:
Input log for 'Density’ Density M
28 ”Appfy Created training model" Input log for 'Gamma Ray' Gamma Ray v
WIndOW pOpS Up. Input log for 'Sonic' | Sonic w
. . Apply to [®] - * '3
29. Apply the trained model to a blind 0@ > Fo34 < =
well (not used in the training
O @& Fo3-2 =
process). Select FO2-1. 0 @ Fas-1 i
30. Keep default parameters. Type a new
Log name for the predicted lithology
|og “Litho Fake Predicted”. Extract between ' <Start of data> v <End of data> v
Log sampling Z Step (m) (0.1524
31. Press Run to continue. Log name for 'Litho_Fake' |Litho_Fake_Predicted -
O close
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Workflow cont’d:

& Manage Wells - a X
W]~ Filter * €3 [w- Log
s B~=. e
- -Impedance
QC results by displaying the predicted B~ I o medance.fe E'
log adjacent to the recorded log N s
+. | Density_BLI e
W g Litholog (10=sand 15=silt 20=silty shal | *
H Porosity from DEN DT GR ”
. A . +
32. Click on the Well Manager “! icon. : |
) % 5 ) X e (Gl b b Import...  Create ...
33. Select the blind well F02-1, Litho Fake @ [suctace coorainate: (evessi oo, canorze.on - 32336
R R - Reference Da vation [KB): 30.00m
and Litho_Fake_Predicted logs. S S s
et (o mrNeS, s, AP
gize: < 1 kB
34 CI|Ck on view IOgS. Last modified: Wed 21 Jul 2021, 13:53:07
o o e
= ol
(2]

Free space on disk: 64.69 GB

Workflow cont’d:

35. Compare the original vs predicted Predicted Litho log  Original Lithe log - Predicted Litho log - Original Litho log

litho-log.

Note: The missing parts at the top ; |

and base of the predicted log are 7

due to missing values in the input

logs. i

SRER . E=l
@
o] =
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Workflow cont’d:

4 Apply ‘Model_Litho_Keras(tensorflow)’ = u} X
If result is satisfactory, go back to the Input log for 'Density’ | Density o
previous step and Apply the trained Input log for 'Gamma Ray' Gamma Ray ~
model to all Wells Tnput log for 'Sonic” [Sonic -
Apply to [] - [* 1
S > F03-4 < =
& F02-1
36. Select All Wells. Keep default @ F03-2 o
parameters as indicated in the . &7 i
window. ’
37 Press Run tO Continue- Extract between <Start of data> v <End of data> v

Log sampling Z Step (m) |0.1524 |

Log name for 'Litho_Fake' |Litho_Fake_Predicted v

(SR ]l G
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2.6.3 Seismic Bodies - Supervised 3D

Required licenses: OpendTect Pro & Machine Learning

Exercise objective:

To predict seismic geo-bodies using the “Seismic bodies (supervised 3D)” tool which is part of the
machine learning plugin. In this exercise, we want to predict Chimney location.

Seismic data Preparation
Seismic need to be available in the survey. If not, import seismic, and interpret key
seismic bodies locations (e.g. Chimney yes, Chimney no), or use existing trained model.

ECTIETLT

Workflow:
Survey F3 Demo 2020

. . . e =
1. Open the Machine Learning Control Center with the ** icon. v LJEDEEE
|§ 1? Wells Horizon-based seismic facies
; = Seismic bodies (supervised 3D)
Seismic Image Segmentation
Seismic Image Regression

§ . ~ 49 2D Seismic
Seismic
Horizon-based seismic facies

2. Click on Seismic.

3. Select Seismic bodies (supervised 3D), and Hit Go. Seismic bodies (supenvised 20)
—_— Seismic Image Segmentation
,g' Seismic + Seismic Image Regression
‘LWeHs v Pre-trained models

UNet 3D Fault Predictor
UNet Fill Missing Traces

oy Neural UNet Supersample Bin Size
o  Networks

Using Internal Python 3.7.7

3 ol [(Guacata 1rain  asply
Workflow cont’d: oo O
Output Deep Learning Examgle Data O select [}

4. “Seismic Classification” window pops up. Select Input
Data in the “Extract Data” tab.

- "VU%\ : . Bxample data Locations. Surveys @
5. In the "Class Definition” window. Select @ icon in to
"Add Class Definition”.
£ Chose
6. In the “Select PointSet” window, Select the Survey
and the 15t Class Example Locations (e.g. Chimney yes).
7. Press OK in the “Specify Class Example Locations” ——
W|nd0W i Select PointSet @ 'F3 Demo 2020 - o X
Survey Data Root | C:\Surveys © select ..

Survey | F3_Demo_2020
F3_Demo_2020_20jul21

£ Specify Class Example Locations - o x F3_Demo_2020_old
Survey PointSets Locations ®
1 F3 Demo 2020 'Chimneys yes' 152 ~
]
S * @ )
[ 3D body =
=] [ 3D Body
[ Chimneys no ]
Class Name |Chimneys yes )
L] FFST
[Soc || Dcancel Dlgas
[ Inner points crassplot anomaly
[] Quter rim crossplot anomaly v

[esoo
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Workflow cont’d:

jth—ne;! o - 1|cn—ni?::m 152 - 1 s
8. In the “Deep Learning: Class Definition” Window, Hit
icon (@)|to add more PointSet. B[ Do
% Select PointSet @ 'F3 Demo 2020° - ] *
Survey Data Root | C:\Surveys © select ...
9. Inthe “Specify PointSet” window, Select the Survey Survey |F3_Dema_2020
and the 2" class example locations (e.g. Chimney Entivo v
no).
m] -~ * 1
10. Press OK in the “Specify Class Example Locations” 130 body ~=
. [13D Bod,
window.
L] Chimneys yes o
1 FrsT
[ gas
[] Inner points crossplot anomaly
[l Quter rim crossplot anomaly Y.
[E=] oo ©
- o x
Survey PointSets Locations ®
®
n
Class Name Chimnéys no
@ cancel
Workflow cont’d:
t2 Deep Leaming: Class Definition - a X
Class Example data Locations Surveys (©]
i 1 Chimneys yes [1] ‘Chimneys yes' 152 1 &
11. In the “Deep Learning: Class 2 Chimneys no [l'Chimneysno' 152 1 ®
Definition” window, Verify that the
default selected data are correct. &
Press Proceed [Input Data Selection]. Dcwse
« . . .. ” 2 Input seismics for prediction - current survey - o x
12. In the “Input Seismic for prediction e O B -
window, Select the appropriate 3D o= . 5
seismic cubes, and seismic attributes. T | A
2 Steering BG Detailed
[ 3 Steering BG Background [+ ]
13. Press OK. [ 3a Steering PCA111 MF225 "

[ 3b Steering FFT225 MF113
[] 4 Dip steered median filter
[ 5 ChimneyCube

[] 6 Whaeler-stratal-slicing

7a Al Cube Std

[[] 7b AI Cube from HorizonCube
[]] 8a PorasityCube from HC-NN
[[] 8b Gamma from HorizonCube
<

(o] (0o
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Workflow cont’d:

14. “Input Data” window pops up.

Input cubes can be modified. Keep the default
parameters as indicated in this window.

15. Specify a new name for the Ouiput Deep
Learning Example Data (e.g.
DI_Example_Chimney_st8x8x1674).

= Input Data - ] X
16. Press Proceed. Survey Input 1 Input 2 Input 3 Input 4 f
1 F3 Demo 2020 1 Original Seismics * 2 Steering BG Deta * 4 Dip steered medi - 7a Al Cube Std =]
Stepouts Inl: 8 % ‘Crl: 8 C‘ Z:16 7 Zstep(ms) |4
Edge/Gap Policy @ Exclude incomplete () Add data
Output Deep Learning Example Data |DLExampleﬁChimneyﬁsthleﬁZ*! | ~| © select ...

B 0o v @

Workflow cont'd: L | T 5

Tnput Deep Learnis le Data |DL_Example_Chimney_stBxx1674

Training Type [ New [ Resume (] Transfer

Output Deep Learning Madel | Model_Keras_Chimney

17. Train tab opens-up. Select one of the
learning algorithm (e.g. Keras-tensorflow) to
train the extracted examples data.

Different machine learning platforms and
parameters can be tested. Keep the defaults
parameters.

Model_Keras Chimney).

19. Press Run.

20. Once the computation is done, Close the ML
log window.

© select

[@oee | [ €releos

500
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Workflow cont’d:

21. Select the "Apply” tab. Check all selected

data Ok.

I Seismic Classification
Extract Data  Train  Apply

Survey Data Root | C:\Surveys

Survey | F3_Demo_2020
F3_Demo_2020_20jul21
F3_Demo_2020_old

*The Survey, Training model can be
modified here if necessary.

22. Press Proceed.

* The option to select data from other surveys is available only in commercial projects

- o x
| € salect ...
7
o
=

4.
G 0

Workflow cont’d:

23. In the “Apply created training model” window, Verify, all the default selected input 3D

cubes are correct.

a. To optimize computation time, Modify “Volume sub-selection” and set it to an
area of interest, where Chimneys have been interpreted (e.g. Inline range: 670-
710, Crossline range: 300-1250).

b. Specify a new name for the 3D output cubes: Classification, Chimney yes,
Chimney no, and Confidence.

24. Press Run to continue.

Ex Positions - o X
Specify Positions
Volume subselection Range |

Inline Range[670 2] 710
Crossline Range | 300 50
Time Range (ms) [0 2| 188 2

[Go | Bcarce @

£+ Apply Model_Keras Chimney’

Input Cube ['1 Original Seismics'] E 1 Original Seismics
Input Cube ['2 Steering BG Detalled] B 2 Steering BG Detailed
Input Cube ['4 Dip steered median filter'] E 4 Dip steered median filter

Input Cube ['7a Al Cube Std'] 7a Al Cube Std

Volume subselection |R: 670/300 - 710/1250. (463 sample)

Output prefix Model_Keras_Chimney
[ Output ‘Classification’ [| Chimney - Classification
[] Output 'Chimneys yes' || Chimney - Chimneys yes

[ Output 'Chimneys no' || Chimney - Chimneys no

Output 'Confidence’ | Chimney - Confidence
Batch size 32
£4] Predict using GPU

[-] Execute in Batch 4. Options ...

~ B select ...
~ ) select ...
- E select ...
- O Select ...

© Select ...

© Select ... | W CBYVS
| O Select ... WicBVS
© Select ... |WICBYVS
~| | select ... @

ciose
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Workflow cont’d:

25. When the processing is done, Close the
“Progress Viewer” and the “Apply Model”
windows.

Input Cube ['1 Original Seismics'] & 1 Original Seismics ~| © select ...
Input Cube ['2 Steering BG Detailed’] [ 2 Steering BG Detailed ~| © select ...
Input Cube ['4 Dip steered median filter'] & 4 Dip steered median filter ~| © select ...
Input Cube ['7a AI Cube std'] & 7a AI Cube std ~| © Select ...
Volume subselection R: 670/300 - 710/1250. (463 sample) © select ...
Output prefix | Model_Keras_Chimney v

[ Qutput ‘Classification’ | Chimney - Classification © select... ®CBVS v

[ Output 'Chimneys yes' | Chimney - Chimneys yes -| © select... ®cavs
[] Output ‘Chimneys no' | Chimney - Chimneys no | © Select... =CBVS o
(] Qutput 'Confidence’ | Chimney - Confidence © select... ®CBVS >

Batch size 32

[ Predict using GPU

[ Execute in Batch 4,k Options ..
Workflow cont'd: & Seet -2
Select first layer
Filter |*
QC results: display the predicted ® Stored 1 Original Seismics ~
i ili ) . 4 Dip steered median filter
Chimney Yes probability 3D cube O Steering e
Attributes 7a Al Cube Std
. . . 7b AI Cube from HorizonCube
26. Right Click on the: Scene > Inline > Add 5 e v
< >
and select Data.
[

27. Select the predicted 3D Chimney location Dcancel @
probability (e.g. Chimney_yes), and overlay @ select - 0o X
the seismic (e.g. 1 Criginal Seismic). Select first layer

. R L Filter |*
Modify the Inline number to be within the
. t @ Stored BLI Vs -
|npU range' O Steerin Chimney - Chimneys no
EELIL Chimney - Chimneys yes

28. Right-click on the Inline number, and Type bz C:im"ev'ﬂ'aﬁ:éﬁca”m
in the Inline field: inindss0 2} S e e e e ¥

< >

0 Cancel 9
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Workflow cont’d:

QC results: display the

predicted Chimney and overlay the original seismic on in-line 690.

1200

Tree scene 1 -]
Elements Color ™
Scene 1
v N In-line
v [1690
5 ChimneyCube -
1 Original Seismics 11

i Cross-line

¥ Z-slice

® volume

¢~ Random Line
(% 2D Line

@ 3D Horizon
~4 2D Horizon

~ Fault

W Faultset
FaultStickSet

¥ Shapefile

& Prestack Events
> Annntatinons

<

In-line: 690
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2.6.4 Seismic Unet 3D Fault Predictor

Required licenses: OpendTect Pro & Machine Learning

Exercise objective:

To predict fault’s location using the “ Seismic — Pre-trained models - Unet 3D Fault Predictor” tool
which is part of the machine learning plugin. In this exercise, we want to predict faults location.

Seismic data Preparation
Seismic need to be available in the survey. If not, import seismic, and interpret some
“key fault” locations or use an existing trained model.

el DE R L

Workflow: Survey |F3 Demo 2020
E v B0 3D Seismic
. . . — | Horizon-based seismic facies
1. Open the Machine Learning Control Center with the #* LT Seismic bodies (supervised 30)

Seismic Image Segmentation

icon' Seismic Image Regression
ﬁ — v 29 2D Seismic
. . . Horizon-based seismic facies
2. C|Ick on Se|Sm|C Seismic bodies (supervised 20)
Seismic Image Segmentation
. sl Seismic + Seismic Image Regression
3. Select the "Pre-trained models — Unet 3D Fault w» LS Wels v F’f
Predfctor” and H|t GO. UNet Fill Missing Traces
& nNeural UNet Supersample Bin Size
: ® Networks
€ Close 0
Workflow cont’d: B
Input Cube ['Seismic Data'] ~| | © select ...
4. “Apply Unet 3D Fault Predictor” window Apply veriap (%) [In: 10 5] |0 10 (5] [z 10 &
pops up. Volume subselection Al © select ...
Output 'FauItVDIume' ©) Select ...| | CBVS v
5. Select Input Cube (e.g. 4 Dip steered [ Predict using cou
median filter). Use a volume subselection =) Execute In Batch |44k Options ...
to optimize the processing time. o

6. Specify a new name for the “Output
Fault Volume to Cube” (e.g.
Fault_Prob_Unet).

Try running the prediction without the GPU, if it
fails, as a result of lack of memory.

7. Hit Run.

8. When the processing finish, Press
button © to close the Progress Viewer
window.

arning Applier'

srocessing finished successfully
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Workflow cont’d: °

Select first layer
Filter |*

® Stored Chimney - Confidence
Fault_Likelihood_Thinned_from_DSMF_seis

) | O stoering
QC the output fault probability results on the In-line 680. )| e

Velocity model (RMS;
™y locity moded (RMS)

[

9. Right Mouse click on In-line > Add and select Data

> Store. Select the created Fault Probability cube w= QD:_ mj =
(e.g. Fault_Prob_Unet_In680), and Hit OK. 8 = i == Irinqalic B
_Tree scene 1
10. Type in the Inline field: 680, and Hit Enter. el Coler
v 4§ In-line
The same way, add to the display, the existing Thinned v %m_h

likelihood probability display.

11. Right-Click on Inline 680 > Add > Attribute
>Stored. Select the existing thinned fault likelihood
(e.g. Fault_Likelihood_Thinned_from_DSMF _seis),

Attribut -aul
and Hit OK. » Yty met (87
Qo @

Tree scene 1
Elements Colol

Scene 1
v W Inline

v [4680

] Fau\t_LIkeI\ho(xj_Tmmed_fmm_DSMF_se\* -

FTFauN_Prob_onet o

Workflow cont’d:

Predicted fault probability (un-thinned)

¥y Saj S S L& WY

12. Display the predicted fault probability, and
Compare with the thinned fault likelihood.

Time

Note:

The thinned fault likelihood, contains more small
faults and noise. Whereas the predicted fault
probability, contains more faults information and
less noise.

The predicted fault probability is un-thinned.
To be able to make a fair comparison with the
thinned fault likelihood, a thinning needs fo be
applied to the predicted fault probability
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Workflow cont’d:

The next step, is to apply a thinning to the
predicted fault probability.

13. Select: faults and fractures > 3D icon &

m

I - R

-

=
f& Faults and Fractures 3D Control Center - (m] X
14. The Faults and Fractures 3D Control Center Avalable Fitors
window POpS up. Select Filters > Atibutes | |CIPsteered Madian Pier
Skeletonization. Ridg Enbmcare ke
Skeletonization
15. Press Go. i f Filters
‘m} Planes
% Tools
[ ]
@ e
Workflow cont'd:
& Volume Skeletonization - o X
Input Volume ‘& © Select ...
16. The Volume Skeletonization window pops Volume subselection (690/200-680/1250 (463 samples) © seect..
up. Apply along Inline -
Thrcshold . &
17. Set the parameters as specified in the feeppliestore ¥ D1
Window OuluulCubelThmned_?t_wob_Unel_I()&O_mweshuld I OSelect . | CBVS

a. Volume subselection: Inline range = 680
b. Threshold: 0.5
c. Type a new name for the “"Output
Cube” e.g.
Thinned_ft_prob_Unet 1680 _threshold”

18. Hit Run.

19. The Progress Viewer window pops up.

Once the computation is done, Hit Close

icon [n

i+ Execution Options ...

0w @
a7

Thinning
. 100%

Finished: Thu 22 Jul 2021,
dTect V6.6

13:12:59

Process: 'Attribute volume writer'

2021, 13

Started: Thu 22 Jul :12:55

t_I680_threshold'
5% (364.364(5) (25)
%

Attribute volume writer'
w22 Jul 2021, 13:12:59

End of process: 'Attribute volume writer'

Finished writing output volume to disk at: Thu 22 Jul 2021, 13:12:59

Finished batch processing.

Processing finished successfully.
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20.

21.

Workflow cont’d:

Display: the new thinned predicted fault
probability. Right mouse click on the Inline 680
> Add > Attributes. Select the new thinned
predicted fault probability (e.g.
Thinned_ft_prob_Unet 1680 threshold). Please
make note the name should not contains
characters like ‘.’

Compare with the existing thinned fault likelihood.

Notice that the thinned fault likelihood, contains
more small faults and noise, whereas the thinned
predicted fault probability, output more faults
information and less noise.

Thinned predicted fault probability
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2.6.5 3D Seismic and Wells RockProperty

Prediction

Required licenses: OpendTect Pro & Machine Learning

Exercise objective:

To predict rock property using the 3D Seismic + Wells, Rock Property Prediction tool which is part
of the Machine Learning plugin. In this exercise, we want to predict a Porosity cube.

Well data Preparation

Seismic (and/or attributes) and Well(s) need to be available in the survey. If not, import
seismic and wells (track, logs, markers, time-depth curve or checkshot).

2. Click on Seismic + Wells > 3D Seismic

Workflow: “Rlndita

1. Open the Machine Learning Control Center with the = icon .

Survey |F3 Demo 2020

@R R

g " Prohosvmein]
=% Wells Rock Property Prediction
H

3. Select Rock Property Prediction, and Hit Go. ﬁ —
= Seismic +
..LWeIIs
: - Neural
o  Networks
€3 Close 0
Using Internal Python 3.7.7
Workflow cont’d: o
=In| Data= -—g Select ...
4, “Prediction from seismic” window pops up. Press
Select - Input Data. Lot '
5. Select @] icon in the “Target Log Definition”.
The “ Specify Log Data to predict” window pops up.
€ 0lose
6. Select: Survey*, Target Log (e.g. Porosity), and Wells
that will be used for the data extraction, as indicated in the
window. S| 0
The well FO2-1 is not selected, and will be used as a i T O solect..
blind well. Survey |F3_Demo 2020
F3_Demo_2020_20jul21
F3_Demo_2020_old
7. Press OK.
Target Log
=] - * i
F02-1 =
[/l Fo3-2
[ Fo3-4 a
] FO6-1 [0}
* The option to select data from other surveys is available only in commercial projects
@ok|  Scancel
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Workflow cont’d:

3 Deep Leamning: Target Log Definition
Survey
1 F3 Demo 2020

8. Deep Learning: Target Log definition
window pops-up.

*A new data selection from different
survey can be added by clicking on @

i

In the “Input seismic for prediction” window,
Select a suitable 3D data to use as input for
the training e.g. RMS attribute, Q Factor
attribute, Instantaneous phase attribute,
Dominant frequency attribute, Seismic
volume etc.

Input Seismics ® Specify now O
Use 3D data
® - *

=

[J 5 ChimneyCube

[+] 7a Al Cube Std

10. Press OK.

* The option to select data from other surveys is available only in commercial projects

[ 1 Original Seismics A
[] 2 Steering BG Detailed

[ 3 Steering BG Background

[] 3a Steering PCA111 MF225

] 3b Steering FFT225 MF113
|/ 4 Dip steered median filter

[ 6 Wheeler-stratal-slicing

tom HorizonCu

- [m) x
Log Name Wells
Porasity [3] 'F03-2', 'FO3-4' and 'FO6-1" ol
=
o

|°p.oceed [Input Data Selection] >3| €3 Close

Read Saved Setup

O

Workflow cont’d:

11. “The Input Data” window pops up.

Input data can be modified using the drop down selection.
Keep the default parameters as indicated in this window.

12. Specify a new name for the Output Deep Learning Example
Data (e.g. DL_Example_Data_Porosity_stOx0x16z4).

% Input Data

13. Press Proceed.

Survey
1 F3 Demo 2020

Input 1
4 Dip steered medi ~

Extract between | <Start of data>

Log sampling Z Step (m) [2

Input 2

7a Al Cube Std

<End of data>

Stepouts Inl: 0 <

Edge/Gap Policy @ Exclude incomplete O Add data

v

cl:0 3|[z:16 2] Zstep(ms) 4

Output Deep Learning Example Data DLExample,Data,Dorosity,stUxDx16z4 |

[Bproceed > ]| | @ close

| O Select ...

- Apply @
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Workflow cont’d:

[=| x

2 DIL_Example_Data_Porosity_stOx0x1 O select ... ’
O select ... It

14. The Train tab gets activated. Train the extracted —
examples data using the default learning =
algorithm Scikit-learn (Ensemble: Random =
Forests).

Different machine learning platforms

and parameters can be tested.

Keep the default parameters for this

exercise. i Qo @

15. Specify a new Output model name e.g. T mmm——

Porosity_Model_SL_RandomForests. vt e e Mot ooy, it S1_sandomres (@ st ] &

o

°

16. Press Run. =
Dciose @

Workflow cont’d: )

17. Hit Close in the “Machine Learning training log” o
window, when the processing finishes.

18. The Apply tab get activated. The Survey, Training ot : - .
model can be modified here. Keep the default e
selection as indicated in the window. Press P -t
Proceed Survey Data Root | C:\Surveys © select ...

Porosity_Model_SL_RandomForests:

) 16:09:55

[Ermesi>] Qoe @
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Workflow cont’d:

% Apply Porosity_Model_SL_RandomForests’ - a x
Inputmhe['40upstee-edmaduanﬁltev'] 4 Dip steered median filter ~ O Select ...
TInput Cube ['7a Al Cube Std'] 7a Al Cube Std ~ Select .
19. The "App|y created training model” Volume subselection |R: 362/300 - 362/1250. (463 sample) @
window pops up. App|y first the Output 'Porosity’ [Porosity_Predicted_ML_RandomForest: - | € Select .. @cevs -
trained model on 1 Inline. &2 Bomcute notch {5 Optios ..
Dciose
20. In the volume sub-selection, Select — o
Inllne_range 362._Choose an Inline ety Postions
crossing a well with porosity log e.g. . T 1=l
F02-1. N TG
Crossline Range 1250
21. Hit OK Time Range (ms) 1848
22. Inthe “Apply the trained model”, O @
Keep default parameters, Specify a
new name for the output porosity to S Appy Forasity Model SL RendomForess - o x
Cube (eg POrOSity_PrediCted_ML Input Cube [4 Dip steered median filter'] 4 Dip steered median filter | O select ...
RandomForests). Input Cube ['7a AI Cube Std') 7a Al Cube Std ~| © Select ...
- Volume subselection [R: 362/300 - 362/1250. (463 sample) © select ...
23. Press Run to Contlnue Output 'Porosity’ |[Porosity_Predicted ML_RandomForest: - © Select ... @ cBVS ~

Execute in Batch 4,4 Options ...

(S oo

Workflow cont’d:

When the computation finishes, close the Progress
viewer window.

QC results by displaying the predicted Porosity on o Select Layer3 7
the test Inline (e.g. 362) and overlay the crossing Fiter [+
well FO2-1, with the porosity log. R i e T rom DeNE sl B
S Porasity_Predicted_ML_RandomForests
Attributes . Thinned_ft_prob_Unet_I680_threshold
24. Right Mouse Click on the Inline folder > Add ™y i i)
Default Data e.g. Deep Steered Median Filter. :
Type: 362 in the In-line field Change the In-line O @
N0 10 362 inind32 = [o2s [ Wos | mwPorosity

25. Right Mouse Click on the In-line 362 > Add >
Attributes. Select under Stored the new
predicted porosity (e.g.
Porosity Predicted ML_RandomForests), and ™
Hit OK.

26. Modify the Porosity colour limit to (0.25-0.35)
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L] .
Workflow cont’d: @ select Wells - o x

Select Input Wells

=] - Filter |*

27. Right Mouse Click on the well folder> Add, l:g;; =)
Select the well FO2-1, Hit Ok. TR =
[J Fo6-1 oW

28. Right Mouse Click on the Well F02-1 > Display
> Properties, Select Porosity log, Change the
color bar to Porosity. Modify the Porosity color

range similar to the predicted porosity cube Qoncel| @
range (0.25 _ 0.35). ...veys\F3_Demo_2020\WellInfo\F02-1.well

29. Apply to All Wells, and Hit Close.

1@ Display properties o F02-1 - D x
0.25 0.35 | ENPorosity In-Iin' leftlop Centerlog Rightlog Markers Track
Select log Porosity ~
Specify data range ~| O Aip

Log range (min/max) 0.257652 | 0407561 | (] Logarithmic

Style (] Well log [ Seismic [-] Log tube

Line thickness |1 &
Line color [ =B -
Fill Left of log ~ [ single color
Fill vith | Porosity ~| I flip color table
1 Porosity “los s
Log display width (m) 30 |

Apply Current to all wells  Reset all

[ Save as Default Wsave [DCose | wReset @
I 4. R
Workflow cont’d: 2 Pestions - o x
Specify Positions
Volume subsslection [Range - !Jjﬂ
Inline Range [100 = |750 5

Crossline Range [300 =] [1250 =]

If result is satisfactory, go back to the previous
Step and Apply the trained model to the entire

survey. ok I € cancel ‘ @ Help [

30. Go back to the Apply tab > Volume sub-
selection > In-line range and reset of the
entire range.

Time Range (ms) [0 - 188 =

31. Keep all other default parameters and
Press Run to continue.

Py Apply ‘Porosity_Model_SL_RandomForests’ - O X
Input Cube ['4 Dip steered median filter'] = 4 Dip steered median filter v | |6 Select ..
Tnput Cube ['7a AT Cube Std'] 7a AI Cube Std ~| |© select ...

Volume subselection IAII | ) Select ...

Output *Porosity’ | Porosity_Predicted_ML_RandomForests | € Select ... &) CBVS v

Execute in Batch < Options ...

| @run | Sciose
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2.6.6 Seismic Image to Image - Fault Pre-
diction

Required licenses: OpendTect Pro & Machine Learning

Exercise objective:

To predict seismic features using the Seismic Image to Image workflow in the machine learning
plugin. In this exercise, we will predict fault locations from seismic data.

Warning 1: To predict real faults use the pre-trained U-Net fault predictor

In this exercise we train a U-Net to predict faults from pre-processed seismic input. The input is
Edge-Preserved Smoothed (EPS) seismic data. The target is a mask volume with ones (faults)
and zeros (no-faults) that was created from Thinned Fault Likelihood (TFL) computed from the
EPS volume. Note that from a geoscience perspective this is not a meaningful exercise because
we do not need a machine learning model to predict a desired outcome that can be computed
directly with an algorithm. The main purpose of this exercise is to learn how to run image-to-
image workflows.

' l '<V// m."/}’l

Input EPS* seismic Target mask (0,1) of TFL* from EPS

*EPS and TFL-mask are NOT delivered with F3. To replicate this workflow first create EFS and TFL (from EPS) in the Faults &
Fractures plugin. Next create a mask from TFL with the mathematics attribute using this formula: TFL> 0.01 27 1:0

Exercise objective:

Warning 2: heavy GPU requirements
In this exercise we create 1008 cubelets of
128x128x128 samples. These cubelets are
extracted from half the input - and target volumes. Al
The trained U-Net is applied to the full volume.
Application is very fast (minutes) but training takes
several hours on a GPU. The graphics card we
used is a Nvidia GeForce RTX 2080 Ti with 11 GB Survey |F3 Demo 2020

et HE RS

£ Machine Learning Contrel Center - [m} X

DDR6 memory. In principle the exercise can also B v "’SD Seis";‘csed e
. w OriZon-ba: selsmic racies
be run on a CPU but then training may take |§ Wl Seismic bodies (supervised 30)
several days. Seismic Image Segmentation
\\"“: e v 20 2D Seismic
Workflow: : Horizon-based seismic facies
Seismic bodies (supervised 2D)
. . — Seismic Image Segmentation
1. O.pen the chhme Learning Control Center B2 scomic + Seismic Image Regression
W|th the E-“, Icon. Wells ~ Pre-trained models
UNet 3D Fault Predictor
- - . UNet Fill Missing Traces
2' CIICK on Sersm.lc. : . Neural UNet Supersample Bin Size
pe Networks
3. Select Seismic Image to Image, and Hit Go. 2
°
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Workflow cont’d:

4. Seismic Image Transformation window pops up.

5. Select Target Data in the Extract Data tab. Click @
on the target data specification.

6. Inthe Select target image seismic window, Select
the Survey and the target cube
TFL_from_EPS_mask

Use O 2D data

@ 3D data

Survey Data Root |fauto/d25/surveys © Select

Survey[ E3 Demo 2010 =

F3_Demo_Deptn 626

9_d25
2019 _Depth_d35
Decimated 2019 d25 =l

Timesot [
original Seismic e 300 e
P-Impedance log cubes
Predicted facies a
Steering BG Detailed
TFL from EPS i
T rom EPS_mask
=t
TFLV6.2
imp Zeros 244 =

Volume subselection |R: 1001300 - 7501250 (463 sample)

Comoms T s

<Input Data>

Output Deep Leaming Example Data

Seisric Data Survey @

oo ota Slection] 55| | €3 Cose

- Ddee @

Workflow cont’d:

7. The Deep Learning: Target Seismics
Definition window pops up.

8. Press Proceed [input Data Selection]

*Additional seismic attributes can be added using the J@l icon . Keep the defaults data. ‘

Deep Learning: Target Seismics Definition

Seismic Data

UTFL_from_EPS_mask F3_Demo_2018

Survey

| @ Proceed [Input Data Selection] >> | €) Ciose

* The option to select data from other surveys is available only in commercial projects ‘
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Workflow cont’d:

9. Select Edge Preserved Smoothed as
input seismic to be used for the prediction

10. Press OK

Input seismics for prediction - current survey

| - " Time Sort ~ § #
7a Al Cube Std 4=
8a PorosityCube from HC-NN
9-8 UVQ6 Hor 4-8 segment J =
Edge Preserved Smoothing line 300

[ v/ Edge_Preserved_Smoothed | E

1l

Gamma Ray log cube from well FO6-1

GR with undef

GR+zeros |

& ok €) cancel

Workflow cont’d:

11. In the Input Data window set the Image dimensions of the cubelets to 128 x 128 x 128
samples. Note: to extract 2D images set one of the dimensions to 0.

12. Specify the Inline, Crossline, Time Ranges and the corresponding Overlap* percentages
to such that we extract approx. 1000 cubelets from one half of the input and target
volumes (see image for specifications).

13. Specify a name for the Ouiput Deep Learning Example Data (e.g.
ML _train_data EPS2TFL_128x128x128) and press Proceed.

2 Input Data v oA °
Survey Input 1 >
1F3_Demo_2018 Edge Preserved Smoothed - d
Images Dimensions |Inl: 128 *| | Cn: 128 =] |Z: 128
Inline Range | 100 2| |425 =| Step |1 = Overlap (%) | 70
Crossline Range | 300 *| [1250 <| Step |1 +| Overlap (%) |60 = 1 Number of |1
Time Range (ms) |0 ~| (1848 2| step |4 Overlap (%) | 60 ~| fStep |204 Number of |8
Total number of Images |1008

Qutput Deep Leaming Example Datal ata EPS2TFL_128x128x128 ~ e Select ...

*Qverlap: if the number of examples that can be extracted from a given range and overlap does not fit exactly, the last example
is extracted from the boundary backwards.
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Example cubelets. Dimensions are: 128 x 128 x 128 samples

Input: EPS

Target: TFL mask (1= fault, 0 = no fault)

Workflow cont’d:

Extract Data | Train | Apply

. . Input Deep Learing Example Data | ML_train_data_EPS2TFL_L: - | | @ Select . )
14. Specify the Ouitput Deep Learning Model T IS R r—
name (e.g. ML_U-

Net_EPS2TFL_1 28x1 28X1 28) Output Deep Leaming Model et_EPS2TFL_128x128x128 -

© Select .

[B) ==

-
.

15. In the Train tab, Select Keras (tensorflow) as r':::‘“:'m':’;:;""“‘ a3
Machine learning platform

v %)

Parameters

16. Select the Parameters tab L=

The machine learning plugin supports two
platforms: Keras (tensorflow) for deep
learning (convolutional neural networks) and
Scikit Learn for all sorts of other machine
learning models (e.g. Random Forests).
Supported models and training parameters
are specified in the Parameters tab.

@ Proceed >> | | € Close @ rep
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Workflow cont’d:

17. In the Parameters tab Select Type U-
Net

18. Set Baich Size to 2. A U-Net needs a lot
of GPU memory in the training phase. If
memory is exceeded, training stops with
an error message. You can then try to
rerun with a smaller batch size. Try with
the largest possible batch size as
training performance increases with
batch size.

19. Set the number of Epochs to 100 (this is
the number of training cycles through all
examples that are offered in batches of

Extract Data | Train

Apply

Input Deep Leaming Example Data | ML_train_data_EPS2TFL_L: ~

Seismic Image Transformation

Training Type v New

Output Deep Learning Model Jet_EPS2TFL_128x128x128 ~

Parameters

Type
[ e "]
Batch Size

2 v
Epochs: 100 |
Patience: 50

Initial Learning Rate (%): 10

Epoch drop (%): 33.33

© Select ]

Resume Transfer

© Select

@) =

-
-

B0

Batch Size). —
Back
20. Set Patience to 50. This parameter
avoids early stopping when the error
does not decrease after this number of
EpOChS' © ciose @ rep
21. Go back to the Training tab.
Workflow cont’d:
22. In the Training tab Press Run Training | Pasameters

23. The Machine Learning training log
window pops up. This window can also
be started by pressing the f=3| icon.
Press Reload to refresh.

Machine leamning platform:
Keras (tensorflow)

Parameters

£500 JE

24. TensorBoard, a program to examine
models and track training performance
is started automatically in a browser.

127/201 [mm
1281201 [um
129/201 [mm

141/201 [um
142/201 [am
143/201 [smanamsasnassaasss

Machine Learning training log

ETA: 1:46
-ETA: 1:4d -
-ETA: 1:43 -

1088:
Ioss:
I083:
I0ss:

.]- ETA: 1:33 - loss:
ETA: 1,32 - loss:
.]- ETA: 1:31 - loss:

> onnes] - ETA 1:17 - loss
| ETA: 1:16 - loss:

..] - ETA: 1:50 - loss: 0.1290 - accuracy: 0.3462
ETA: 1:48 - loss: 0.1286
)~ ETA; 1:47 - loss: 0,1286

- loss: 0.1280 -
loss: 0.1280

ss: 0.1277

:0.1270 -

acouracy: 0.3611

accuracy: 0.3556

accuracy: 0.3600
accuracy: 0.3647
accuracy: 0.3689
acecuracy: 0.3734
accuracy: 0.3775
accuracy: 0.3816
accuracy: 0.3856
accuracy: 0.3897
accuracy: 0,3937
accuracy: 0.3977
accuracy: 0.4014
accuracy: 0.4053
accuracy: 0.4090
accuracy: 0.4127

0.1286
0.1262 -
0.1283 -
0.1280

0.1279

01276

0.1276

01273

273

1272 -
1270 - accuracy: 0.4164
accuracy: 0.4200
accuracy: 0.4235
accuracy: 0.4269
accuracy: 0.4303
accuracy: 0.4337
1266 - accuracy: 0.4370
0.1266 - accuracy: 0.4402
0,1266 - accuracy: 0.4434

=

0.1268 -
1268
1267 -
1267
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Workflow cont’d:

Seismic Image Transformation

Exitract Data | Train | Apply
Survey Data Rool | /autolg25/surveys - | © Select

25. When training is finished, Select the Suvey e Bepth 6.25 =
Appfy tab :.:Esz_a:a_uﬁz?_nzan; M1996A
Maui-NZ_Channels_2018
MOL_Chimney_2019_d25
MOL_Chimney_2019 Depih_d25

26. Select the trained model ML_U- MOl w205
MySurvey

Net EPS2TFL_ 128x128x128 and Press MySunvey2

NexenUK_Buzzard-4D-OBN_2017

Proceed OGDCL_Fatehpur_Ladhana_Blocks_2018 NH

Penobscot_2D_Workfiow_Flattened06

Lo

Time Sot 4 §

ML_U-Net EPS2TFL_128x128x128
TL_U e _SESZTFL_IZEX 128X 128

=i -2l

1YPe SeISMIC IMage | FanSIoMmanon,
Data Type: 3D Volume.

Number of inputs: 1

Qutput: TFL_from_EPS_mask

Created by: cases.

Created al: Fri 08 May 2020, 11:11:57.
Last Modified: Fri 08 May 2020, 12:28:33.
Object ID: 100060.61

O | O

Workflow cont’d:

27. In the Apply window Select the Input Cube Edge Preserved_Smoothed.

28. Specify the Output Cube name that will be created by the trained model, e.g. ML_U-
Net_TFL_prediction.

29. Press Run to start processing.

*
Input Cube [Edge_Preserved_Smoothed] | Edge_Preserved_Smoothed —| © select ...
Apply Overlap (%) |Inl: 10 ~| [Cr: 10 | |Z:10 =
Volume subselection |R: 100/300 - 750/1250. (463 sample) e Select ..
Output TFL_from_EPS_mask' to Cube | ML_U-Net_TFL_prediction - | © select . ™ CBVS = W

v| Execute in Batch | £} Options ...

=
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Workflow cont’d:

TISEYS7 8T TSMTIUST =]
(38.974/3) (4m:57s)
(35.818/3) (4m: 453}
(31.977/3) (Sm: 408}
(32.208/2) (4m:3ls)
(38.037/8) (4m:158)
(35.885/8) (3m:558)
(32.626/3) (4m:323)
(35.888/3) (3m:308)
(39.657/3) (3m:18s)
(32.601/3) (3m: 463}
(41.071/8) (2m: 478}
(40.578/3) (2m:37s)
(36.023/3) (2m: 433}
(40.634/3) (2m:128)
(41.354/3) (Im:58s)
(36.046/3) (2m:1s)
(35.882/3) (im:373)
(33.960/2) (m: 398}

30. A Progress Viewer window pops up. Applying
the trained U-Net is very fast. The resulting
fault prediction can be viewed e.g. as overlay
on the EPS of inline 425.

Process: 'Deep Learning Applier’
Finisned: Mon 06 Apr 2020, 00:07:06

End of process: 'Deep Learning Applier’
Finished batch processing.

Processing finished successiull

Inline 500 EPS + TFL mask Inline 500 EPS + U-Net Prediction
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2.6.7 Seismic Image Regression (Unet) - Fill
Seismic Traces

Required licenses: OpendTect Pro & Machine Learning

Exercise objective:

To fill blank seismic traces using the ‘Seismic Image Regression’ workflow which is part of the
machine learning plugin. The model will have to learn how to recreate an image from example
images containing blank traces. Therefore, we need an input data set in which we have
deliberately blanked some of the traces.

For the purpose of this exercise:

«  We use OpendTect’s attribute engine to
randomly blank +/- 33% of all traces

+  We select examples from one side of the
volume for training the U-Net

+  We apply the trained U-Net to the full
volume, so that we can validate the
interpolation results in the blind test zone

B T

Note: In this exercise we train a 2D Unet but you can equally well train a 3D Unet. The differences between 2D and 3D Unets are
as follows:

1. A 2D model trains much faster (hours vs days)

2. 2D models can be trained on workstations with less GPU / CPU capacity

3. Interpolation results are comparable although 2D interpolation may introduce some striping (like a footprint)

4. Application of a trained 3D model is much faster than a trained 2D model (minutes vs hours)

Randomly blank traces workflow:

To train our 2D Unet regression model we create a data set with 33% randomly blanked traces.
From this cube we extract examples for fraining in a restricted area. The trained model is
applied to the entire volume, whereby the area from which no examples are extracted acts as
blind test area. The real value is of course when we apply the trained model to an area with
real missing traces (which we don’t have in this case). Random blanking (replacing the values
with hard zeros) is done in OpendTect’s Attribute engine and can be done in different ways. In
this case, we will create an attribute set to perform the following tasks:

1. Math attribute with formula: “randg(1)”. This generates random values with a Gaussian
distribution and 1 standard deviation;

2. Apply this attribute to a horizon and save as horizon data;

3. Horizon attribute that retrieves the random values from the saved horizon data. A Horizon
attribute replaces a value at an inline, crossline position with the value extracted from the
given horizon;

4. Math attribute with formula: “abs(value)> 1 ? 0: seis”. We assign the retrieved horizon data
to the variable “value” and the seismic data to “seis”. This attribute assigns values larger
than the absolute value of 1 standard deviation to zero while all other values are given the
value of the seismic data.

5. Additional attributes in the set are used to compare/QC results before and after prediction.
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Randomly blank traces workflow:

Create a new 3D attribute set to randomly blank traces as explained in the following steps.

@ Atibute Set 2D

e
O-wetsEHR Bk

Attritute st <nek saved> <All> - Mathematics SRk AR~
MathFunctions st (Squareroot) ~ | Inset | il |
Formul (like ‘naarstk: + o) * farstk') Set
1. Select the 3D Attributes engine al icon.
2. Create a new 3D attribute set_|
These attributes that will be explained in the
next steps.
3. Save as attribute set @ with the name
‘ML_Random_holes_interpolation’.
i e
T (@] @
Attribute set | wm1._Random_holes_interpolation
random
Retrieve horizon data
Seismic with random missing traces as zeros
difference
Gain_corrected_Filled_Seis_[1425
Gain_corrected seismic
difference between gain corrected seis and ML pred
Randomly blank traces workflow:
4. Create 1¢' attribute with name - e
‘random’ as indicated in the attribute An,,mmfa;m}:mf,’ﬁt"* = e T
set window and Hit ‘Add as new'. - T —— = * W
E random missing | Formula (like ‘nearstk + c0 * farstk’) [randg(1 ) £
difference
5. Set Math attribute with formula: e
“randg(1)”. .
This generates random values with a
Gaussian distribution and 1 standard
deviation:; -
o
Apply this attribute to an horizon and
save as horizon data as indicated in
the next step.
< > Attribute Name |random Addasnew [l
I save on Clase 2]
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Randomly blank traces workflow:

Create a seismic horizon at Z = 1 s. Then apply the random attribute to this horizon and save this
as horizon data. This horizon data will be used in the attribute that does the actual blanking.

6. Create a constant seismic horizon at Z = 1s.

7. Right mouse click on the 3D Horizon < New < With
constant Z.

Output 30 Hoetzon [fire—Ts]

8. Enter Z value (ms)= 1000. Type an Output 3D Horizon e B s
name e.g. Hrz_1s. Hit Create. Dt = -
'Ié rza::' Sel;:l Attribute
9. Display the horizon — attribute ‘random’. Save as D2DU ey
Horizon data. ) e
@ Body = Remove

A B AR PN BT DAL

Randomly blank traces workflow:

Create an horizon attribute that retrieves the random values from the saved horizon data. The
horizon attribute replaces a value at an inline, crossline position with the value extracted from the
given horizon.

10. Create 2" attribute “Retrieve horizon data”
as indicated in the attribute set window and Hit
‘Add as new’.

O st
O sohect ..

11. Select the Input Data that will be blanked ‘4
Dip steered Median filter’.

12. Select the constant horizon “"Hrz_1s” created
in the previous step.

+
L]
E]

13. Select Output “"Horizon Data” and Horizon
Data “random”.

Attt Namme [Retrieve artzon dta Al e [l e
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Randomly blank traces workflow:

Create an attribute that will randomly blank traces as zeros in the input seismic.

14. Create 3" attribute ‘Seismic with random missing
traces as zeros’ as indicated in the attribute set

window and Hit ‘Add as new’. AW VO

Adtribuite set | Random holes. wobin: Basic Mathematics ?

random attewncnons | o (sowsa ooty +| | weert | [ |
15. Set a Math attribute with formula: “abs(value)> 1 s o om0 - 102 =
? 0: seis”. This assign the retrieved horizon data to s bl

the variable “value” and the seismic data to “seis”.
This attribute assigns values larger than the absolute
value of 1 standard deviation to zero while all other
values are given the value of the seismic data.

| =«=

16. Select the previously created attribute ‘Retrieve
Horizon Data’ in the ‘For Horizon to use’'.

it Karme Seisic with random missing traces as zevos | |Ackd o rew (18] e

2 sove on o [Eo=]@

17. Select the seismic you wish to blank in the ‘seis’
(e.g. 4_Dip steered median filter).
Blank traces workflow cont’d: cements color
Seene 1
S; ‘ . Add Default Data
Bl & . AddandSelectData .. N
= . 1 Add at well Location ...
A | Add Color Blended
& Select - o 'S
Select first layer
Filker |*
O Stored f;ﬂuom X .
18. Display the new seismic attribute with S T
blanked traces. Right mouse click on the B [t o

difference between gain corrected seis and ML pred

In-line. Select "Add and Select Data”

19. Select the attribute “Seismic with
random missing traces as zeros” and Hit Ok.

Notice that random traces have been
blanked.
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Blank traces workflow cont’d :

20. Select, "Create a Seismic Output” from the
attribute — Seismic with random missing traces as
ZEeros.

21. In the "Create Single Attribute Volume” window,
keep the default parameters. Type an Output name
(e.g. Seismic with random missing traces as zeros)
and Run.

22. Close the progress window when the processing
finish

23. Display/QC the created seismic

This seismic will be used as input for the next step, ML
Seismic Image Regression prediction.

Processing  Stene View ilites Teraliubis  Help

Create Seismic Ouipt * Attributes b e Single Atribute kD
Create Horizon Output  * D<=>3 ) Muit Attribute Volume ... D |
m =l

s 05 2eros ] |©) Select

Valuine subsedoction [100/300-750/1250 (46: ) © selest ..

‘Quantity to output | Seismi with randam o

Null traces @ Discard Pass
] 5cala values:  Shit
Output Cube |Seismic with random missing traces as zeros - | ) Select .. | CBVS

Balch execution Single rocess {4 Options ...

Grn | Do @

Processing finished sucoessfully.

Exercise objective:

To fill blank seismic traces using the ‘Seismic Image Regression” tool which is part of the machine
learning plugin. The model will have to learn how to recreate an image from example images

containing blank traces.

Workflow:

1. Open the Machine Learning Control Center with the % Ehind H el DL LIS

icon.
2. Click on Seismic.

3. Select the ‘Seismic Image Regression” and Hit Go.

5 Machine Learming Control Center — o *

Survey |F3 Demo 2020

v 0 3D Seismic
LE |§- Wells Harizon-based seismic facies
- > Seismic bodies (supervised 3D)
Seismic Image Segmentation
- Seismic Image Regression
& Selsmic v @@ 2D Seismic
Horizon-based seismic facies
— Seismic bodies (supervised 2D)
?;E Seismic + Seismic Image Segmentation
- LWGUS Seismic Image Regression
~ Pre-trained models
UNet 3D Fault Predictor

Neural

Networks
)

-
]
e
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Workflow cont’d:

4. In the ‘Extract Data’ tab, Press the Select
button. The “Deep Learning Target Seismic
Definition” window pops up.

5. Press the + icon and Select the target

seismic volume (e.g.4 Dip steered median filter).

And OK.

*Note: it is possible to create a Training Set from
examples extracted from multiple surveys. To do this,
press the + icon again and select the target volume to
add to the table below.

6. Press Proceed [Input Data Selection]. The
“Input seismic for prediction” window pops up

Apply

<Input Data> =

Output Deep Learming Example Data O select... | b [

. Dee Laaming Target s Definitien - 0 x
Sesmic Data suvey

x

a

3 1 5 Dciose
£ Selecttarget image - o x
Survey Data Root |C\Surveys O salect ..

Survey |F3_Demo_2020
F3_Demo_2020_20jul21
F3_Demo_2020_oid
My_New_Survey_AL
My_survey_AL

1 Original Seésimics
2 Steering BG Detaled

| 3o D6 Becigroand
3a Steesing PCALLL MF225

Volume subselection (a1

‘Sessmic Data Survey

1 4 Dip steered median fiter 3 Demo 2020 #
=
-
m

[ ot o st o] | @i

* The option to select data from other surveys is available only in commercial projects

Workflow cont’d:

7. Select the input seismic data (i.e. the seismic
with the missing traces as zeros) and Press OK.

8. In the “Input Data” window set the dimensions
of the input features. To minimize processing
time for this exercise, Set the Images dimension
to: 0x128x128, overlap: 0x0x0 and Inline range:
(100 —400).

Note: If the current HW has large amount of GPU and
CPU/computing power, the recommended Image
Dimensions are 128x128x128.

9. Specify the name of the Output Deep
Learning Example Data (e.g.
ML_Ex_FillMissingTraces 0x128x128 ) and
Press Proceed to start the extraction process.

10. When this process is finished Press
Proceed in the “Seismic Image Transformation”
window to continue to the Training tab.

% Input seismics for prediction - current suvey o ox
Input Seismics ® Specify now O Read Saved Setup
- - o
[ Chimney - Confidence: "
[J Fault_Likellhood_Thinned_from_DSMF_seds
[ Foult_Prob_Unet o
[ Filled_Seismic_IL425 7l
Pogaty pregicted M
[ Seismic with random missing traces as 26
I_EV_WH e With random missing traces as 2ercs, ,,

>

=] e
Survey Tnput 1 >
1 F3 Demo 2020 Selsmic with rando -
Images Dimensions Inl: 0 S O 128 32128 3
Inline Range 1003|400 3| Step |1 s Overap (%) 0
Crossline Range 3002|1250 3 Step 1 2| Overap (%) 0
Time Range (ms) |0 (1848 2l sten s =] Overao (%) [0
Output Deep Leaming Examgle Data [ML_Ex_FillMissingTraces_0x128x128 | | © select ...

Quon |~ | @

Toin Aosky
eirost Data O sebet
Ot Dot Lsring Exrol Dk W Ex. FilbirgTraces iuizeatss | @ seoct | (04
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Workflow cont’d:

11. After the training data is selected the
available models are shown. For seismic image
workflows we use Keras (TensorFlow).

12. Check the Parameters tab to see which

models are supported and which parameters can
be changed.

13. Specify a name for the “Output Deep
Learning Model” (e.g.
ML_Unet_FillMissingTraces_0x128x128).

14. Hit Run.

15. Open the processing log file to follow the
progress. When the log file shows “Finished
batch processing”, the Proceed button turns
green. You can press Proceed or Open

the Apply tab.

ExtractData  Train  Apply
Input Deep Learing Example Data ML_Ex_FillMissingTraces_0x128x128 v | © Select. LIRSS

Training Type & New [ Resume [ Transfer

Output Deep Leaming Model ML_Unet_FillMissingTraces_0x126x128 | ~ | © Select ... ]

[

-

400

) 13

Dbroceed >> | E¥Cose @

cose | |4smeont

Workflow cont’d:

16. Once the Training is done, the trained model
can be applied. Select the trained model and
Press Proceed.

17. The Apply window pops up. Here you can
optionally apply to a Volume subselection. Type
an Output name (e.g.
Seismic_ML_Unet_FillMissingTraces_0x128x128)

Note: You can run on GPU or CPU using the Predict using
GPU toggle. Running the application on a GPU is many
times faster than running it on a CPU.

18. Press Run to create the desired output.

19. Close the ‘Progress Viewer’ window when the
processing is finished.

Exract Data_ Train ety
Survey Data Root | €\Surveys O Sefect.

Survey | F3_Doma_1020
F3_Dema_2020 20021
F3_Dermo_2020_okl
y_How,_Surver_AL
My _survey AL

M Unet, Filbissing Traces 0w 280128

Ubiet 7l Missing Traces,

. Aty ML Lnet Filbissnglaces 0128

[EPLTRTERSR| . [ ———— O seet
Apply Overlap (%) [n: 80 30 O 10 30 2010 3

[ — Oselct.

Dracessi firiched successtuly
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Workflow cont’d:

Compare the original seismic data with the Unet predicted
filled seismic results. The line is extracted from the blind test
area.

20. Right Mouse Click on In-line > Add and select Data
> Store. Select the created Filled Seismic
(e.g. ML_Unet_FillMissingTraces_0x128x128), and Hit OK.

21. Type in the Inline field: 425, and Hit Enter.

The same way, add to the display, the original seismic and
seismic with missing fraces .

22. Right-Click on Inline 425 > Add > Afttribute
>Stored. Select the original seismic
(e.g. 4 Dip steered median filter), and Hit OK.
23. Right-Click on Inline 425 > Add > Attribute -
>Stored. Select the seismic with missing traces
(e.g. Seismic with random missing traces as zeros), and =

© Stering

Hit OK.

-

@ za .
2 @ vol  AddstWell Location .. ¥
B Ran  Add Color Blended
& Setect - o x
Select first layer
Filter [+
@ stored Filled_Seismic_L425 "
O Steering Porosity_Predicted_ML_RandomForests
Seismic with random missing traces as zeros
Attributes Seismic with random missing traces s zeros_IL4
Y I Seismic_ML_Unet_FIIMissingT races_0x128x128
PSS ——pe— N
Ous @

=T [l D ¢

-ee scene 1

ements
Scene 1

M W In-line
v [ 425
E] Seismic_ML_Unet_FillMissingTraces_0x128x128
v 4 @ In-line
= » al Auitute | &
H@c Dispiay v W Valume Builder Attribute
Bez Duplicate @ HorizonCube Display
=1 I Reset Manipulation ¥ Systems Tracts Display
T T - o x
Seect Loyer2 Select Loyer 2
Filter |~ il
Douinel Saisnics +® Stored. Fault_Prob_unet L]
Do ] 0 gy | iniiemias
T Ferosey redetes 1. Fandomiorests
7o K1 Cube S0 i [ Sosmic wih randsen wissing traces a5 zerws |
70 A1 Cub tom Horaide & S i randem mizsng aces 5 281,
Do € b [Eel oo @

Workflow cont’d:

24. Compare visually in the blind test
area the:

- Original seismic (4 Dip steered
median filter)

- Randomly blanked traces seismic

(Seismic with random missing

traces as zeros)

- Unet filled seismic
(ML_Unet_FillMissingTraces_0Ox1
28x128)

25. For more accurate comparison,
Set similar colour range for the 3

seismic cubes. Highlight the seismic

cube, Set the colour bar range to (-
8000, 8000).

-so00 [J I3 0D Seismic 1
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Workflow cont’d:

For a better quantitative comparison, create a new attribute ‘difference’ that computes the
difference between the predicted and the original seismic.

@ Aivibuie Sec 30 o x
File

“USYEA WME

26. Select the 3D attribute icon al . Open the s« - Wt 2

A , i Moibiunctiors - st (e o) < Thomt 52 >
attribute set = . Select the attribute set aresinen s ([ e =
“ML_Random_holes_interpolation” T plapla———————=

d¥foronce between gain corol

27. Create a 4" attribute “difference” as
indicated in the attribute set window and Hit
‘Add as new'.

| ==

28. Select the Original seismic (e.g. 4 Dip
steered median filter) for ‘Seis’, and the
predicted seismic (e.g.

Attribute Names dfforence A s e [ e

ML_Unet_FillMissingTraces_0x128x128) for o °
‘pred’
Workflow cont’d:

Display/QC the attribute “difference”. Difference = Original seismic (4 Dip steered median filter) —
Predicted seismic (ML_Unet_FillMissingTraces_0x128x128)

L
Select Layer 2
Filter *
+ o Attibate 5 O Stored | random
* @ Volume Bullder Attribute = Retrieve horizon data
@ HorizonCube Disploy O Steering | seismic with randem missing traces a5 zeros
% Systems Tracts Display @® Attributes

Gain_corrected_Filled_Seis
- Gain_conrected seismic
difference bebween gain corrected seis and M|

@ok | Ocancel @

[N

29. Right-Click on Inline 425 > Add >
Attribute. Select the attribute ‘difference”,
and Hit OK.

Notice the small values of the difference, e e
range (-593, 590). e

30. For more accurate comparison,

Modify the color range to similar range as B 1
the original and predicted seismic [- £ e
8000,8000] oy
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Workflow cont’d (Optional):

For more accurate comparison, apply an RMS gain scaled correction to the original and predicted
seismic, than compute the difference.
Create a new Gain correction attributes to be applied on the original and predicted seismic.

31. Select the 3D attribute icon A% . Open the
attribute set . Select the attribute set
“ML_Random_holes_interpolation”

Ui a Rl -

\L_Random_holes_int <All> Scaling ? &

Inpust Distn | Seismic_ML_Unet_FillMissing Troces (21263128 O et
Type Window.
Gasis RMS

32. Create a 5" attribute
“Gain_corrected_Filled_Seis” as indicated in the

attribute set window and Hit ‘Add as new’ i
33. Select the Input Data -
“Seismic_ML_Unet_FillMissingTraces 0x128x128'

Workflow cont’d (Optional):

For more accurate comparison, apply an RMS gain scaled correction to the original and predicted
seismic, than compute the difference.
Create a new Gain correction attributes to be applied on the original and predicted seismic.

SRR A BAE
34, Select the 3D attribute icon all . Open s = L
the attribute set “®. Select the attribute set

“ML_Random_holes_interpolation”

Input Data [4 Dip steered median fiter © Select ...
Type Window:
Basis RMS

Start ((ms)) Stop ({ms})

Tme Gate 1 0 1848

35. Create a 6 attribute “Gain_corrected e
seismic” as indicated in the attribute set

window and Hit ‘Add as new’ -
B
36. Select the Input Data ‘Gain_corrected
seismic”
< » Adtribute Name Gain_corrected seismic Add as new [l =
e [Eo=]0
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Workflow cont’d (Optional):

Create a new attribute that will compute the difference between the RMS gain corrected original
seismic and ML predicted seismic

37. Select the 3D attribute icon al - e

Open the attribute set = . Select the SR RE A BE
. Attribute set [Random_holes_webind Basic ~  Mathematics. ~| [2]
attnbute Set random MathFunctions | sart (Squareroot) ~  Inset 2% il |
“"ML_Random_holes_interpolation™ ;’fr'mi“"i‘““m‘:‘;m Formd (e et = 0 o) s - e =
- - - e e For‘see’ ues (GolTomctd bl *
Gain_cofrectid seismic For 'pred’ wse Gain_comrected Filled_Seds_IL425

difference between gain cormes

38. Create a 7™ attribute "difference

between gain corrected seis and ML
pred” as indicated in the attribute set
window and Hit ‘Add as new’.

[ SR

39. Select the “Gain_corrected seismic”
as input for ‘seis’ and the
"Gain_corrected_Filled_Seis” as input
for ‘pred’

Attribute Name |difference between gain comected seis and M| Add as new [l =

21 5ave on Close G | @

Workflow cont’d (Optional):

Display the attribute “Gain_corrected_Filled_Seis” (RMS scaled
Seismic_ML_Unet_FillMissingTraces_0x128x128) and the “Gain_corrected seismic”(RMS
scaled 4 Dip steered median filter).

wonlll Wz ] mron st TR R S Y A

40. Right-Click on Inline 425 > Add > Attribute.
Select the atfribute “Gain_corrected_Filled_Seis”,
and Hit OK.

41. Right-Click on Inline 425 > Add > Attribute.
Select the atiribute ‘Gain_corrected seismic”, and
Hit OK.
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Workflow cont’d (Optional):

Compare quantitatively in the blind test area the RMS gain corrected difference between the

original seismic and the predicted seismic.

42. Display the “difference between gain corrected
seis and ML pred” seismic attribute. Right mouse
click on the In-line 425. Select “Add and Select
Data”.

43. Select the attribute "difference between gain
corrected seis and ML pred” and Hit Ok.

Notice the very low values of the “difference
between gain corrected seis and ML pred”. The
range [-0.257, 0.257].

44. For more accurate comparison, display the
difference attribute with similar colour range as the
gain corrected original and predicted seismic.
Highlight the seismic cube, Set the colour bar
range fo [-2, 2].

[Z_ T W= | | 5300 seismic 1 R @R

a00

800, 8O0 1000

i

500
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Glossary

A

Absolute Impedance
Full-bandwith impedance inversion response in which the "missing" low-
frequency part of the spectrum has been added by the inversion method.
For example - in model-driven inversions the low-frequency model is typ-
ically created by interpolating impedance well logs guided by mapped seis-
mic horizons.

Accomodation Space
The available space for sediments to fill (measured from seafloor to base-
level).

Al

Acoustic Impedance: the product of seismic velocity and density.

Attribute
An attribute is a derived quantity from a seismic input set. Attributes in
OpendTect are defined by a name, a value, and a position in 3D space
(inline, cross-line and Z (2WT or depth)). Attributes can be calculated from
single-trace, multi-trace, and multi-volume inputs. They can be steered
and/or chained. Steered attributes are multi-trace attributes in which the
trace segments are found by following a (pre-)calculated dip-azimuth.
Chained attributes are attributes derived from other attributes. For
example, Similarity and Energy are separate attributes that can be
chained to calculate the Similarity of the Energy using the "Position" attrib-
ute.

Attribute Set
An attribute set is an entity consisting of a group of attributes. Usually
attributes in a defined attribute set have something in common. For
example, all attributes in a set have the potential to highlight an object
type of interest, or a combined attribute, using all other attributes as inter-
mediate results. This would be a desirable output.

B

Base level
The surface at which sediment supply, relative sea level changes and
wave energy are in balance. This is the surface at which the accom-
modation space equals zero: there is neither deposition, nor erosion.
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Body
A body is an element that defines an arbitrary three dimensional geo-
logical shape (or a geo-body). The body can also be created manually or
by using polygons.

Cc

ChimneyCube
A volume that highlights vertical disturbances in seismic data. The cube is
used in fluid migration path studies, in prospect ranking and for fault seal
analysis. A ChimneyCube is generated by a neural network that was
trained on picked examples (chimneys and non-chimneys). It gives at
every sample location the "chimney probability" i.e. the likelihood of
belonging to the class of identified seismic chimneys.

Chrono-stratigraphy
A set of relative geologic time lines as stored in a HorizonCube.

CLAS
A plugin for petrophysical analysis. CLAS stands for Computer Log Ana-
lysis System.

Closed Source
Software that is released in binary form only. The commercial plugins to
OpendTect are released as closed source extensions. Such extensions
are only permitted if OpendTect is run under a commercial (or academic)
license agreement.

Color Blending
Combined display of three (four) attributes that are displayed in the Red
Green and Blue color channels. Optionally the fourth channel (alpha) dis-
plays transparency. Color blending is aka as RGB (RGBA) blending.

Crossline Dip
Dip in the direction of the Crossline axis, or in the direction of increasing
crosslines.

D

Dip-Steering
The process of auto-tracking seismic data by following the pre-calculated,
local dip and azimuth of the seismic. Dip-steering is used for: a) extracting
seismic trace segments along seismic reflectors as input to multi-trace
attribute calculations, b) computing special attributes such as polar dip,
azimuth, and volume curvature attributes, c) filtering seismic data (known
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as dip-steered filtering, aka structurally oriented filtering), and d) auto-
tracking chrono-stratigraphic horizons in the creation of a HorizonCube.

Dip-Steering Cube
A volume computed from seismic data with at every sample position
information about the local dip and azimuth of the seismic data. Ina 3D
Steering Cube this information is stored in two attributes per sample:
inline dip and cross-line dip. On 2D seismic only one value is stored: the
line-dip. Dips in a Steering Cube are measured in the line direction and
expressed in us/m or mm/m, for time and depth data, respectively.

E

EEI
Extended Elastic Impedance. Scaled and rotated impedance response at
a paarticular angle. Rotation is typically optimized to predict a certain well
log property of interest.

El
Elastic Impedance. Impedance response at a particular angle of incid-
ence.

Element

An element is a sub-division of various items (of the tree) that are dis-
played in a 3D scene. Inline, crossline, timeslices, horizon, wells etc are
some elements. Each element is sub-divided into a sub-element. For
instance an inline element can have further sub-elements e.g. inline # 120
that can contain upto eight different attributes.

Eustatic sea-level
Sea-level relative to center of earth.

Explicit Representation
A representation of a 3D object in OpendTect in the form of a triangulated
surface.

F

Fault Stickset
The faults are interpreted on a section as a stick, and all sticks that belong
to one fault are grouped in one sticksets. Therefore, a fault stickset con-
tains an unordered collection of the interpreted sticks.

Forced regression
Deposition characterized by progradation and incision. Base-level is fall-
ing decreasing accomodation space, forcing the system to prograde.
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Forced regression occurs during the Falling stage systems tract.

G

GMT
An open source mapping package developed and maintained by the
University of Hawaii (http://gmt.soest.hawaii.edu/). GMT stands for Gen-
eric Mapping Tools.

GPL License
Gnu General Public License (http://www.gnu.org/licenses/gpl.html) is an
open source license under which OpendTect can be run. The license
allows redistribution of (modified) source code under the same licensing
conditions (copy left principle). It is not allowed to combine the open
source part with closed source plugins, which is why OpendTect is also
licensed under a commercial license agreement and under an Academic
license agreement.

H

Horizon Data
It refers to a stored attribute grid in a horizon. An attribute is calculated on-
the-fly or in a batch process. On-the-fly, a user needs to store by right-
clicking on it an selecting Save attribute... option. The saved attribute can
also be managed in the Manage horizon. It may be noted that a horizon
can contain unlimited stored attribute/horizon data.

HorizonCube
A dense set of auto-tracked (or modeled) seismic horizons that is indexed
and sorted according to relative geologic time (= chrono-stratigraphy).

Implicit Representation
A representation of a 3D object in OpendTect in the form of an iso-surface
through a cube of values.

Incision
Depositional feature caused by erosion.

Inline Dip
Dip in the direction of the Inline axis, or in the direction of increasing inline
numbers.
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Madagascar

An open source seismic processing package. See: http://en.wiki-
pedia.org/wiki/Madagascar_(software)

Meta Attribute

A meta-attribute is an attribute created from multiple input attributes. In
OpendTect, a meta attribute is created either through neural networks, or
through mathematical manipulations and/or logical operations. For
example, TheChimneyCube and TheFaultCube are meta-attributes. See
the Ridge enhancement filter attribute set from the Default attribute sets
for an example of a meta-attribute created through math and logic. The
meta-attribute in this set is the last attribute in the list.

MLP Neural Network

Multi-Layer-Perceptron type of neural network. The network is used for
seismic object detection (creating Chimney Cubes, Fault Cubes, Salt
Cubes etc.) and for predicting rock properties from seismic data (Porosity,
Vshale, Sw etc). An MLP network is trained on a data set with known
examples (supervised learning). In the training phase the network aims to
find the optimal, non-linear mapping between input attributes and target
attributes. The network in OpendTect is a fully-connected, three-layer
MLP (input layer, hidden layer, output layer). The non-linear trans-
formation takes place in the hidden layer.

MPSI

N

A plugin for stochastic acoustic impedance inversion. MPSI stands for
Multi-Point Stochastic Inversion.

Normal regression

0

Deposition characterized by aggradation and progradation. The base
level is rising but the consumption of accommodation space by sed-
imentation exceeds the creation of accommodation space by the base
level rise. Normal regression occurs during high stand and low stand sys-
tems tracts.

Open Source

Software that is released with its source code. OpendTect is released as
open source product that can be extended with closed source plugins.
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Such extensions are only permitted if OpendTect is run under a com-
mercial (or academic) license agreement.

P

PDF
PDF is Probability Density Functions. In OpendTect these are created in
the cross-plot tool by selecting a desired area in the cross-plot domain.
The density of the points in the selected area is a measure for the prob-
ability of the desired target variable that can then be predicted by applying
the derived PDF function to (scaled) input volumes in a Bayesian clas-
sification scheme.

Pickset
A Pickset is a collection of picked locations, i.e. inline-crossline-Z inform-
ation. pointsets are part of a Pickset Group. For example a Pickset Group
containing points at fault locations may consist of different fault pointsets
to differentiate between large faults and small faults, or to reflect points on
different inlines.

Pickset Group
A Pickset group is a collection of different pointsets. Usually pointsets are
grouped because they refer to the same object, e.g. Chimney_yes or
Chimney_no.

R

Regression
Seaward shoreline & facies shift. Regression can be Normal (base level
rises) or Forced (base level falls).

Relative Impedance
Band-limited impedance inversion response computed by methods such
as colored inversion.

Relative sea-level
The net effect of eustatic sea level changes and local tectonic fluc-
tuations.

Retrogradation
Depositional trend characterized by sediments building landwards aka
back-stepping.
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S
SEG-Y

A file format for exchanging seismic or seismic-like data. It is used for both
2D and 3D pre- or post-stack data. A file being SEG-Y compliant does not
mean that it can be loaded into OpendTect. There are several possible
problems. One of these is missing trace identification and/or positioning.
Another issue is lack of true compliance ->SEG-Y Rev 0, -> SEG-Y Rev
1). The different types of SEG-Y are shown below: * SEG-Y Rev 0: The ini-
tial SEG-Y specification in 1975. Itis very precise in some areas but totally
unspecified in other, crucial areas. This has led to an almost uncountable
number of variants. Some are sort-of SEG-Y standard, others blatantly
non-compliant. * SEG-Y Rev 1: In 2002 the Revision 1 document made an
end to the most obvious shortcomings of ->SEG-Y Rev 0, especially in the
area of ->trace positioning and ->trace identification. Still many SEG-Y
files or files claimed to be SEG-Y are Rev 0 or badly (i.e. not) compliant
with Rev 1. This is why OpendTect has numerous options for the SEG-Y
reading process. * SEG-Y Textual header: The first 3200 bytes of a SEG-
Y file must be filled with textual comment on the contents of the SEG-Y
file. Older textual headers are encoded in EBCDIC rather than ASCII,
which makes them impossible to read in a standard text editor. * SEG-Y
EBCDIC header: -> SEG-Y Textual header. * SEG-Y Tape Header: The
part of a SEG-Y file that gives information about all traces in the file. This
information is in the ->SEG-Y Textual header and ->SEG-Y Binary
header. * SEG-Y Binary header: The second part of the SEG-Y Tape
header contains binary information about, amongst others, values for num-
ber of samples per trace, byte encoding, sample interval, and SEG-Y Revi-
sion. * Trace identification: Every trace in OpendTect needs to have an
identification in form of a trace number (2D data) or inline/crossline (3D
data). For pre-stack data the offset forms and extra trace identification. *
Trace positioning: In OpendTect, every seismic trace needs to be located
in 3D space. For 3D data, the position can be derived from the->Trace
identification (inline- and crossline numbers). Traces in 2D lines have their
own, separate X- and Y- coordinate. For pre-stack data there must also

be an offset available.

SSIS
A plugin to perform a sequence stratigaphic analysis (systems tracts,
Wheeler transforms) from seismic data using HorizonCube input. SSIS
stands for Sequence Stratigraphic Interpretation System.

Stratal Slicing
The process of cutting through a seismic volume along surfaces that are
computed proportionally between mapped top and bottom horizons, aka
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proportional slicing.

Systems Tracts
Subdivisions of sequences that consist of discrete depositional units that
differ in geometry from other systems tracts and have distinct boundaries
on seismic data. Different systems tracts are considered to represent dif-
ferent phases of baselevel changes.

T

Trace Identification
Every trace in OpendTect needs to have an identification in form of a trace
number (2D data) or inline/crossline (3D data). For pre-stack data the off-
set forms and extra trace identification.

Trace Positioning
In OpendTect, every seismic trace needs to be located in 3D space. For
3D data, the position can be derived from the->Trace identification (inline-
and crossline numbers). Traces in 2D lines have their own, separate X-
and Y- coordinate. For pre-stack data there must also be an offset avail-
able.

Transgression
Landward shoreline & facies shift characterized by aggradation and ret-
rogradation. The base-level is rising and more accommodation space is
created than is consumed by sedimentation

Tree
The tree is the docking window, which is detachable and movable. This is
used to display the data into a scene. The tree is attached to a scene and
is labeled as Tree Scene 1. Where '1'is the scene number. Each tree has
its own elements that are displayed in corresponding scene.

V)

UVQ Neural Network
Unsupervised Vector Quantizer type of neural network. This network is
used for clustering (segmenting) data into a user-defined number of
clusters. Cluster centers are found in a training run on a subset of the
data. In the application phase the network generates two outputs: 1) the
index number of the winning cluster and 2) the match, a value between 0
and 1 indicating how close the input vector is to the vector representing
the winning cluster. UVQ segmentation can be performed in 2D mode
(waveform segmentation along mapped horizons) and in 3D mode (gen-
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erates 3D bodies). A display of the cluster centers is a useful diagnostic in
waveform segmentation (Neural Network module: Info button).

Vv

VMB
A plugin for picking velocities from semblance gathers, and in a surface-
consistent-manner. VMB stands for Velocity Model Building.

W

Waveform Segmentation
Process of clustering seismic trace segments with a UVQ network along a
mapped horizon into a user-defined number of clusters.

WCP
A plugin to pick and QC well log markers with the help of seismic data and
(optionally) the HorizonCube. WCP stands for Well Correlation Panel.

Wheeler Transform
Process of flattening seismic data (or attributes) according to the chrono-
stratigraphic horizons in a HorizonCube. In a Wheeler scene the vertical
axis represent relative geologic time.
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Position, Zoom, Pan, Rotate 29

Pre-load 28

Pre-Load Data 28

Random Line 33, 35

Random Line Through Wells 35

Ridge Enhancement Filter 55

Scene 230

SEG-Y 4

Seismic and Wells RockProperty Prediction 307
Seismic Bodies Supervised 3D 297

Seismic Feature Enhancement 67

Seismic Image Regression Unet Fill Seismic Traces 319
Seismic Image to Image - Fault Prediction 312
Seismic Unet 3D Fault Predictor 303

Set up Survey usingPetrelDirect 12

Setup 4

Spectral Blueing 58

Spectral Decomposition 136

SSIS 225, 230, 235, 242, 245, 255

Stacking Patterns 227
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Statistical Curves 242

Steering 39, 107, 150

Stratal Slicing 255
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Stratal Terminations 225
Stratigraphic Attributes 160, 251
Stratigraphic Surfaces 245

Survey 4,12

Survey Setup & Load SEG-Y 4
Systems Tracts 235

Table 2

Table Of Contents 2

TD Conversion On-The-Fly 119

TD Volume Conversion In Batch 122
Thalweg Tracker 103

Thinned Fault Likelihood 153
Tracking 90, 200

Tracking In 2D Viewer 90

Truncate HorizonCube 220
Unconformity Tracker 107, 150
uvQ 184,187

Volume 122, 155
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Waveform Segmentation - Quick UVQ 184
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